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머리말

이 설명서는 Sun StorEdge™ Configuration Service를 사용하여 Sun StorEdge 3000 
Family 를 구성, 모니터링, 관리하는 방법에 대해 설명합니다. Sun StorEdge 
Configuration Service 설치에 대한 자세한 내용을 보려면 Sun StorEdge 3000 Family 
소프트웨어 설치 설명서를 참조하십시오. 

또한 이 설명서에서는 Sun StorEdge Configuration Service와 함께 제공되는 유틸리티
로, 호스트와 어레이 간에 시스템 메시지를 주고 받는 Sun StorEdge 3000 Family 
Diagnostic Reporter도 참조합니다. Sun StorEdge Diagnostic Reporter 설치에 대한 자
세한 내용을 보려면 Sun StorEdge 3000 Family 소프트웨어 설치 설명서를 참조하십시
오. Sun StorEdge Diagnostic Reporter 사용 방법에 대한 자세한 내용을 보려면 Sun 
StorEdge 3000 Family Diagnostic Reporter 사용 설명서를 참조하십시오.

달리 지정하지 않는 한 Sun StorEdge 3120 SCSI Array, Sun StorEdge 3310 SCSI Array, 
Sun StorEdge 3320 SCSI Array, Sun StorEdge 3510 FC Array 및 Sun StorEdge 3511 
SATA Array는 모두 어레이로 참조하십시오.

이 설명서는 Sun 하드웨어 및 소프트웨어 제품에 대해 잘 알고 있는 숙련된 시스템 관
리자를 대상으로 합니다.
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이 설명서의 구성
이 설명서에서 다루는 내용은 다음과 같습니다.

1 장에서는 Sun StorEdge Configuration Service 기능에 대해 소개합니다.

2 장에서는 Sun StorEdge Configuration Service를 설치하고 사용하기 전에 어레이가 
올바르게 구성되었는지 확인하는 절차에 대해 설명합니다.

3 장에서는 Sun StorEdge Configuration Service를 설정하는 절차에 대해 설명합니다.

4 장에서는 어레이를 구성하는 방법에 대해 설명합니다.

5 장에서는 LUN 필터를 만들어 공통 저장 장치를 공유하는 대형 광 섬유 채널 네트워
크를 유지 관리하는 방법에 대해 설명합니다(FC 및 SATA에만 해당).

6 장에서는 어레이를 모니터링하는 방법에 대해 설명합니다.

7 장에서는 어레이의 무결성을 유지 관리하는 방법에 대해 설명합니다.

8 장에서는 현재 어레이 구성을 변경하거나 이 구성에 추가하는 방법에 대해 설명합니
다.

부록 A에서는 RAID(redundant array of independent disk)에 대한 기초 정보를 제공
합니다.

부록 B에서는 독립형 JBOD를 모니터링하는 방법에 대해 설명합니다.

부록 C에서는 클러스터 구성을 설정하는 방법에 대해 설명합니다(SCSI에만 해당).

부록 D에서는 호스트 세계 이름을 결정하는 방법에 대해 설명합니다(FC 및 SATA에만 
해당).

부록 E에서는 전체 이벤트 모니터링 및 전자 메일 알림 기능을 설정하는 방법에 대해 설
명합니다.

부록 F에서는 여러 증상에 대한 문제 해결 방법을 제공합니다.

부록 G에서는 Sun StorEdge Configuration Service의 오류 코드와 메시지 목록을 제공
합니다.

용어에는 제품 설명서에서 사용된 RAID 용어와 정의가 나와 있습니다.
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UNIX 명령어 사용
이 설명서에서는 시스템 종료 및 부팅, 장치 구성 등에 대한 절차와 기본적인 UNIX® 명
령어에 대해서는 설명하지 않습니다. UNIX 명령어 정보를 보려면 다음을 참조하십시
오.

■ 시스템과 함께 제공된 소프트웨어 설명서

■ Solaris™ 운영 체제 설명서. 이 설명서는 아래 위치에 있습니다.

http://docs.sun.com

쉘 프롬프트

쉘 프롬프트

C 쉘 machine-name%

C 쉘 수퍼유저 machine-name#

Bourne 쉘 및 Korn 쉘 $

Bourne 쉘 및 Korn 쉘 수퍼유저 #
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활자체 규약

관련 문서
아래의 표에 관련 소프트웨어 문서의 목록이 나와 있습니다. 모든 관련 문서의 전체 목
록을 보려면 해당 어레이용 Sun StorEdge 3000 Family 설치, 작동 및 서비스 설명서를 
참조하십시오.

활자체1

1 브라우저 설정은 아래 내용과 다를 수 있습니다.

의미 예제

AaBbCc123 명령, 파일 및 디렉토리 이름 - 화
면에 표시되는 컴퓨터 출력

.login 파일을 편집하십시오.
모든 파일을 보려면 ls -a 를 사용합니
다.
% You have mail.

AaBbCc123 화면에 표시되는 컴퓨터 출력과 
반대로 사용자가 직접 입력하는 
내용

% su

Password:

AaBbCc123 책 제목, 새 단어나 용어, 강조할 
단어. 실제 이름이나 값으로 대체
되는 명령줄 변수

사용 설명서의 6장을 읽어 보십시오.
이러한 옵션을 class 옵션이라고 합니다.
이 작업을 수행하려면 반드시 수퍼유저
여야 합니다.
파일을 삭제하려면 rm 파일이름을 입력
하십시오.

제목 부품 번호

Sun StorEdge 3120 SCSI Array 릴리스 노트 819-1993

Sun StorEdge 3310 SCSI Array 릴리스 노트 819-1994

Sun StorEdge 3320 SCSI Array 릴리스 노트 819-1995

Sun StorEdge 3510 FC Array 및 Sun StorEdge 3511 SATA Array 릴리스 노트 819-1996

Sun StorEdge 3000 Family 2.0 Software 설치 설명서 817-6633

Sun StorEdge 3000 Family RAID 펌웨어 4.1x 사용 설명서 819-1992
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Sun 설명서 액세스
모든 Sun StorEdge 3000 Family 설명서는 다음 위치에서 온라인으로 볼 수 있습니다.

http://www.sun.com/products-n-solutions/ hardware/docs/
Network_Storage_Solutions/Workgroup/ 

다음 위치에서 SCSI, FC 및 SATA Array에 대한 세부 정보를 얻을 수 있습니다.

http://docs.sun.com/app/docs/coll/3120SCSIarray

http://docs.sun.com/app/docs/coll/3310SCSIarray

http://docs.sun.com/app/docs/coll/3320SCSIarray

http://docs.sun.com/app/docs/coll/3510FCarray

http://docs.sun.com/app/docs/coll/3511FCarray

다음 사이트에서 다양한 Sun 설명서를 볼 수 있으며 인쇄 및 구입이 가능합니다.

http://www.sun.com/documentation

Sun 기술 지원부에 문의
최신 뉴스와 문제 해결 팁을 보려면 해당 어레이용 릴리스 노트를 검토하십시오. 이러
한 릴리스 노트는 xxiii페이지에 "Sun 설명서 액세스"에 나와 있는 사이트에 있습니다.

설명서에 나와 있지 않은 이 제품의 기술에 대한 질문이 있는 경우 다음 사이트를 참조
하십시오.

http://www.sun.com/service/contacting

미국 내 전용 서비스 요청을 제기하거나 확인하려면 다음의 Sun 지원 전화 번호로 문의
하십시오. 800-USA4SUN

Sun StorEdge 3000 Family Configuration Service 2.0 사용 설명서 817-2987

Sun StorEdge 3000 Family Diagnostic Reporter 2.0 사용 설명서 817-2988

Sun StorEdge 3000 Family CLI 2.0 사용 설명서 817-6628

제목 부품 번호
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국제 기술 지원 서비스를 받으려면 다음 웹 사이트에서 해당 국가의 영업 사무소에 문
의하십시오.

http://www.sun.com/service/contacting/sales.html

508 액세스 용이성 기능
Sun StorEdge 설명서는 시각 장애가 있는 사용자를 위해 보조 기술 프로그램과 함께 사
용할 수 있는 508 규격 HTML 파일로도 제공됩니다. 이 파일들은 해당 제품의 설명서 
CD뿐 아니라 xxiii페이지에 "Sun 설명서 액세스"절에 나와 있는 웹 사이트에도 있습니
다. 또한 소프트웨어 및 펌웨어 응용프로그램에서는 키보드 이동 및 단축키를 제공합니
다. 자세한 내용은 사용자 설명서를 참조하십시오.

Sun에서는 여러분의 의견을 기다립니다.
Sun은 여러분의 의견과 제안을 통해 설명서를 향상시키고자 합니다. 다음 사이트에서 
의견을 보내실 수 있습니다.

http://www.sun.com/hwdocs/feedback

피드백을 보내실 때는 다음과 같이 설명서의 제목과 부품 번호를 기입해 주십시오. Sun 
StorEdge 3000 Family Configuration Service 2.0 사용 설명서, 부품 번호 817-2987-11
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1 장

소개

이 절에서는 Sun StorEdge Configuration Service 기능에 대해 간략하게 설명합니다.

주 – 본서에서 간략하게 프로그램이라고 언급하는 경우도 있습니다.

Sun StorEdge Configuration Service는 Java™ 프로그래밍 언어를 기반으로 한 정교한 
프로그램으로, 저장 장치 구성, 유지 관리 및 모니터링 도구를 어레이의 중앙 집중 관리 
응용프로그램 하나로 통합한 것입니다.

시스템 관리자는 네트워크에 있는 단일 콘솔로부터 알기 쉬운 GUI를 통해 네트워크 저
장 장치의 초기화, 구성 변경, 상태 모니터링 및 루틴을 유지 관리하기 위한 일정 지정 
등의 작업을 수행할 수 있습니다.

또한 네트워크 전체의 저장 수요가 늘어나면서 지속적으로 변화하는 저장 요구 사항에 
맞춰 관리자는 용량을 동적으로 할당, 재할당 또는 확장할 수 있습니다. 

상태가 변경되면 프로그램은 콘솔 디스플레이, 전자 메일, 영숫자식 호출기 등을 통해 
이를 알립니다. 또한 HP OpenView 같은 SNMP(Simple Network Management 
Protocol) 엔터프라이즈 관리자에게 경고를 보낼 수도 있습니다. 

Sun StorEdge Configuration Service는 다음 두 가지 구성 요소로 이루어져 있습니다.

■ Sun StorEdge Configuration Service 에이전트 – 연결된 디스크 저장 장치를 모니터링
하고 장치 상태를 콘솔에 보고합니다. Sun StorEdge Configuration Service의 일부
인 에이전트 소프트웨어를 네트워크 상의 각 서버에 설치해야 합니다. 

■ Sun StorEdge Configuration Service 콘솔 – 에이전트에서 보고한 정보를 표시합니다. 
콘솔은 단일 워크스테이션에서 장치를 원격으로 구성하고 관리하는 기능도 제공합
니다. 콘솔은 네트워크의 서버를 관리하는 컴퓨터에 설치해야 합니다.
1
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2 장

설치 전 유의 사항

이 장에는 Sun StorEdge Configuration Service를 사용하기 전에 알고 있어야 할 중요
한 정보가 나와 있습니다. 이 장에서 다루는 내용은 다음과 같습니다.

■ 3페이지의 "소프트웨어 설치"
■ 3페이지의 "예제 화면"
■ 4페이지의 "수퍼유저 권한"
■ 4페이지의 "Sun StorEdge 3120 SCSI Array"
■ 4페이지의 "Sun StorEdge 3000 Family JBOD"

소프트웨어 설치
설치 지침에 대해서는 Sun StorEdge 3000 Family 소프트웨어 설치 설명서를 참조하십
시오.

예제 화면
이 설명서에서는 프로그램을 보여주는 예제 화면이 많이 제공됩니다. 이 화면들의 출력
에서 Sun StorEdge 3310 SCSI Array, Sun StorEdge 3320 SCSI Array, Sun StorEdge 
3510 FC Array 또는 Sun StorEdge 3511 SATA Array가 구분될 수 있습니다. 기능(예제 
화면)이 특정 어레이에만 해당한다고 명시적으로 표시하지 않는 한 모든 어레이에 적용
됩니다.
3



수퍼유저 권한
Sun StorEdge Configuration Service 콘솔을 실행하려면 수퍼유저(관리자)여야 합니
다.

Sun StorEdge 3120 SCSI Array
Sun StorEdge 3120 SCSI Array에는 구성 요소 및 경보 특성을 보고 드라이브 장애를 확
인하는 등의 Sun StorEdge Configuration Service 어레이 기능만 지원됩니다. Sun 
StorEdge 3120 SCSI Array와 관련된 절차에 대해서는 215페이지의 "JBOD 모니터링"을 
참조하십시오.

Sun StorEdge 3000 Family JBOD
Sun StorEdge 3000 Family JBOD에는 구성 요소 및 경보 특성을 보고 드라이브 장애를 
확인하는 등의 Sun StorEdge Configuration Service 어레이 기능만 지원됩니다. Sun 
StorEdge 3000 Family JBOD와 관련된 절차에 대해서는 215페이지의 "JBOD 모니터링"
을 참조하십시오.

주 – JBOD(Just a Bunch of Disk)는 제어기 없이 서버에 직접 연결된 어레이를 말합니
다.
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3 장

Sun StorEdge Configuration Service 
시작 및 설정

이 장에서는 Sun StorEdge Configuration Service를 시작하는 방법에 대해 설명하고 연
결된 저장 장치가 표시되는 기본 창의 개요를 제공합니다. 어레이를 구성하고 모니터링
하기 전에 수행해야할 절차에 대해서도 설명합니다. 이 장에서 다루는 내용은 다음과 
같습니다.

■ 6페이지의 "Sun StorEdge Configuration Service 시작"

■ 6페이지의 "UNIX 호스트에서 Sun StorEdge Configuration Service 시작"

■ 7페이지의 "Microsoft Windows 호스트에서 Sun StorEdge Configuration Service 
시작"

■ 7페이지의 "기본 창"

■ 11페이지의 "설정 절차"

■ 12페이지의 "서버를 추가하려면" 

■ 17페이지의 "서버를 삭제하려면"

■ 18페이지의 "로그인 및 로그아웃하려면"

■ 19페이지의 "제어기를 관리할 서버를 할당하려면" 

■ 22페이지의 "관리 서버의 할당을 해제하려면"

■ 22페이지의 "에이전트 매개변수를 구성하려면" 

■ 25페이지의 "저장 장치 구성을 확인하려면" 

■ 27페이지의 "논리 드라이브 구성을 저장하려면" 

■ 28페이지의 "Solaris 호스트 파티션을 만들려면" 

■ 30페이지의 "Windows 2000 및 Windows 2003 호스트 파티션을 만들려면"

■ 31페이지의 "IBM AIX 호스트 논리 볼륨을 만들려면"

■ 32페이지의 "HP-UX 호스트 논리 볼륨을 만들려면"

■ 33페이지의 "다음 장에서 다루는 사항"
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Sun StorEdge Configuration Service 시작
이 절에서는 Sun StorEdge Configuration Service를 시작하는 방법에 대해 설명합니다.

주 – 콘솔을 시작하려면 수퍼유저(관리자)여야 합니다.

콘솔이 실행 중이어야 이벤트 경고를 받을 수 있으므로 어레이를 구성한 후에는 콘솔 
워크스테이션에서 Sun StorEdge Configuration Service를 최소화 모드로 항상 실행해
야 합니다. 또는 콘솔을 계속 실행하는 대신 Sun StorEdge Configuration Service와 함
께 제공되는 유틸리티인 Sun StorEdge Diagnostic Reporter를 사용할 수도 있습니다. 
이 유틸리티는 백그라운드로 실행되면서 호스트와 어레이로부터 지정된 전자 메일 주
소로 메시지를 보내는 서비스를 제공합니다. 자세한 내용은 Sun StorEdge 3000 Family 
Diagnostic Reporter 사용 설명서를 참조하십시오. 이벤트 경고를 받는 다른 방법에 대
해서는 249페이지의 "Sun StorEdge Configuration Service를 사용하지 않고 SNMP 트
랩 보내기"를 참조하십시오.

주 – Sun StorEdge Configuration Service에서 어레이를 보고 관리하려면 각 HBA 카
드가 기본 제어기에 연결되어 있어야 합니다.

▼ UNIX 호스트에서 Sun StorEdge Configuration 
Service 시작
명령 프롬프트에서 다음을 입력합니다. 

# ssconsole
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▼ Microsoft Windows 호스트에서 Sun StorEdge 
Configuration Service 시작 
Windows 2000에서는 시작 → 프로그램 → Sun StorEdge 3000 Family → Configuration 
Service를 선택합니다. 

Windows 2003에서는 시작 → 모든 프로그램 → Sun StorEdge 3000 Family → 
Configuration Service를 선택합니다.

기본 창
프로그램이 처음 초기화될 때 기본 창은 비어 있습니다. 사용 중인 콘솔의 Managed 
Servers 목록에 서버를 추가할 수 있는 Add Server 창이 표시됩니다. 서버 추가에 대한 
자세한 내용을 보려면 12페이지의 "서버를 추가하려면"을 참조하십시오.

처음 초기화한 후 및 Managed Servers를 선택한 후 프로그램을 시작할 때마다 기본 창
에는 Managed Servers 목록에 있는 서버의 아이콘이 표시됩니다. 계속하려면 OK 또는 
Cancel을 누릅니다.

메뉴, 도구 모음 및 탭

기본 창에는 주요 기능을 사용하기 위한 메뉴 표시줄, 탭 및 도구 모음이 포함되어 있습
니다.
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메뉴 모음

다음은 주 메뉴 옵션입니다.

도구 모음

메뉴 모음 아래에 있는 도구 모음에는 자주 사용되는 기능의 바로 가기 아이콘이 있습
니다. 사용하려는 기능의 아이콘을 선택하십시오. 기본 창에서 도구 모음 아이콘은 사
용 가능한 자원에 따라 활성 또는 비활성(회색)으로 나타납니다.

표 3-1 기본 창 도구 모음 아이콘 

아이콘 설명

Server List Setup. 콘솔에서 관리하는 서버를 추가하거나, 서버 
정보를 편집하거나, 사용 가능한 서버를 관리하도록 지정합니다.

View Event Log. 저장 장치 상태의 변경, 하드웨어 상태 변경, 작
동 상태 알림 등의 이벤트를 보여줍니다.

Save Event Log. Event Log 창으로 이동하지 않고도 이벤트 로그
를 저장할 수 있는 Save Event Log File 대화 상자를 표시합니다.

Login

Logout

Server List Setup

Save Report

Exit

View Report

View Group

View Server 

View HBA Card*

View Controller

View Logical Drive

View Physical Drive

View Enclosure 

View FRU

Event Log

File View

Configure Host/WWN (FC and SATA only) 

LUN Filter Properties (FC and SATA only)

Save Configuration

Load Configuration

Standard Configure

Custom Configure

Configuration Array Administration

Rebuild

Parity Check

Schedule Parity Check 

Media Scan

Controller Assignment

Controller Maintenance

Download FW for Devices

View Peripheral Device

Contents

About sscsConsole

Help

Array Admin in Progress

Agent Options Management

Display HDD under LD

*는 대역 외 관리에만 표시됩니다 .
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주 – 패리티 검사 같은 어레이 관리 프로세스를 실행 중인 경우 Configuration 메뉴 명
령과 도구 모음 아이콘을 일시적으로 사용할 수 없을 수 있습니다. 콘솔이 서버의 자원 
목록을 새로 고칠 때에도 메뉴 명령이 비활성화됩니다. 새로 고치는 동안 위성 접시 모
양이 서버 아이콘에 표시되어 있습니다.

Delete Event Log. eventlog.txt 파일의 내용을 수동으로 삭제합니
다. 이 프로그램은 최대 10,000개까지 이벤트를 축적하는데, 이 최
대 한도에 도달하면 이벤트 로그가 자동으로 최근 500개의 이벤트
로 줄어듭니다.

Save Report. 현재 날짜를 기준으로 선택한 서버에 있는 각 저장 
장치 구성 요소에 대한 데이터를 포함하는 XML 파일을 만듭니다.

Standard Configure. 선택한 어레이 제어기에 하나의 RAID 수준
으로 하나 이상의 논리 드라이브를 만듭니다. Sun StorEdge 
Configuration Service가 저장 장치를 자동으로 구성하는 미리 정
의된 구성을 원하는 경우 사용하십시오.

Custom Configure. 선택한 어레이 제어기에 여러 RAID 수준으
로 논리 드라이브나 논리 볼륨을 구성 또는 재구성할 수 있는 여러 
가지 선택을 제공합니다. 
선택한 제어기에 여러 RAID 수준으로 논리 드라이브를 구성 또
는 재구성할 수 있는 여러 가지 선택을 제공합니다. 제어기 ID 및 
매개변수의 설정 또는 변경, RAID 세트 및 대기 드라이브의 정의 
또는 수정 등을 비롯한 구성을 수동으로 정의하려는 경우 사용하
십시오.

표 3-1 기본 창 도구 모음 아이콘  (계속)

아이콘 설명
3 장 Sun StorEdge Configuration Service 시작 및 설정 9



탭

도구 모음 아래에 있는 탭을 사용하여 다른 Sun StorEdge Configuration Service 보기
로 신속하게 이동할 수 있습니다.

장치 아이콘

구성된 어레이에 표시되는 일반 장치 아이콘에 대한 설명을 보려면 25페이지의 "저장 
장치 구성을 확인하려면"을 참조하십시오.

물리(하드) 드라이브

어레이를 완전하게 구성함에 따라 기본 창에는 여러 구성 요소가 표시됩니다. 논리 드
라이브를 구성하는 물리적 드라이브는 기본적으로 표시됩니다. 그러나 기본 창에서 보
다 효율적으로 탐색을 관리할 수 있도록 View → Display HDD under LD의 선택을 취
소하면 물리적(하드) 드라이브를 표시하지 않을 수도 있습니다. 

탐색

이 프로그램은 표준 Java 프로그래밍 언어 키보드와 탐색 작업을 따릅니다.

표 3-2 기본 창의 탭

탭 설명

기본 Sun StorEdge Configuration Service 창으로 이동하려면 클릭
하십시오.

LUN Filter View(LUN 필터 보기)로 이동하려면 클릭하십시오(FC 
및 SATA에만 해당).
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사용 중에 콘솔이 잠기는 경우

UNIX 시스템에서 콘솔이 사용 중에 잠기는 경우 Sun StorEdge Configuration Service
를 중지한 다음 에이전트에 영향을 주지 않으면서 창을 닫았다가 다시 열 수 있습니다.

▼ Sun StorEdge Configuration Service를 중지하려면

1. 명령 프롬프트에서 다음을 입력합니다.

2. 프로그램을 다시 실행합니다. 

에이전트에 영향을 주지 않고 창이 다시 나타납니다.

설정 절차
이 절에서는 어레이를 구성 및 모니터링하기 전에 수행해야 할 다음과 같은 설정 절차
에 대해 설명합니다.

■ 12페이지의 "서버를 추가하려면"
■ 17페이지의 "서버를 삭제하려면"
■ 18페이지의 "로그인 및 로그아웃하려면"
■ 19페이지의 "제어기를 관리할 서버를 할당하려면"
■ 22페이지의 "관리 서버의 할당을 해제하려면"
■ 22페이지의 "에이전트 매개변수를 구성하려면"
■ 25페이지의 "저장 장치 구성을 확인하려면"
■ 27페이지의 "논리 드라이브 구성을 저장하려면"
■ 28페이지의 "Solaris 호스트 파티션을 만들려면"
■ 30페이지의 "Windows 2000 및 Windows 2003 호스트 파티션을 만들려면"
■ 31페이지의 "IBM AIX 호스트 논리 볼륨을 만들려면"
■ 32페이지의 "HP-UX 호스트 논리 볼륨을 만들려면"

# ssconsole stop
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▼ 서버를 추가하려면
제어기를 관리할 서버를 할당해야 합니다. 서버를 구성하기 전에 Server List Setup을 
통해 Managed Servers 목록에 서버를 추가해야 합니다.

1. Sun StorEdge Configuration Service가 실행되고 있지 않은 경우에는 이를 시작합니
다.

2. File → Server List Setup을 선택합니다. 

Server List Setup 창이 나타납니다.

3. (선택적)다음과 같이 서버를 그룹으로 구성합니다.

서버 수와 위치에 따라 서버를 그룹으로 구성하는 것이 유용할 수 있습니다. 예를 들어, 
각 저장실에 여러 대의 서버가 있을 경우 위치별로 그룹을 만들 수 있습니다. 

a. Server List Setup 창에서 Groups을 누릅니다. 

Group List Setup 창이 나타납니다. Group Name 필드에 이름을 입력하고 Add를 누릅
니다.
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b. 그룹을 삭제하려면 Available Groups 목록에서 그룹 이름을 선택하고 Delete를 누
릅니다.

c. 그룹의 추가 및 삭제가 끝나면 OK를 누릅니다. 

Server List Setup 창이 나타납니다.

4. 다음과 같이 서버를 추가합니다.

a. Available Servers 목록에서 Add를 누릅니다. 

Add Server 창이 나타납니다.

b. Server name 필드에 서버 이름을 입력하고 Return 키를 누릅니다. 

Server name 필드의 이름이 해당 서버의 이름이 됩니다. 이 이름이 네트워크의 이름 
서버 데이터베이스에 있는 경우 Sun StorEdge Configuration Service가 서버의 IP 
주소를 확인하여 IP Address 필드에 이 이름을 표시합니다.

프로그램이 해당 이름의 IP 주소를 찾지 못하는 경우에는 이름을 잘못 입력했거나 
서버의 이름 데이터베이스에 기록되어 있지 않은 것입니다.

c. 필요한 경우 서버의 TCP/IP 주소를 IP Address 필드에 입력합니다.

프로그램이 아직 IP 주소를 표시하지 않은 경우 IP 주소를 직접 입력하십시오.

IP Address 필드 아래에 있는 Get IP Address by Name을 선택해도 프로그램이 IP 
주소를 검색하고 자동으로 표시합니다. 이전 단계에서 설명했듯이 이 방법은 네트워
크에 이름 서버 데이터베이스가 있고 해당 데이터베이스에 기록된 대로 서버 이름을 
입력한 경우에만 가능합니다. 그렇지 않으면 IP 주소를 직접 입력해야 합니다.
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d. (선택적) 서버를 모니터링할 때 암호를 묻지 않도록 Sun StorEdge Configuration 
Service를 설정하려면 Sun StorEdge Configuration Service를 설치할 때 할당된 
ssmon 암호를 입력합니다.

암호에 대한 자세한 내용은 18페이지의 "로그인 및 로그아웃하려면"을 참조하십시
오.

5. 서버의 Automatic Discovery를 선택 또는 선택 해제합니다.

a. 서버 자원 목록 데이터에 대한 액세스까지 제한하는 보안 수준이 높은 환경이 필요
한 경우에는 Auto Discovery에 대해 No를 선택합니다.

No를 선택하면 프로그램이 시작될 때 서버 정보를 가져오지 않습니다. 서버 아이콘
은 보라색 대신 흰색으로 표시되어 검색되지 않았음을 나타냅니다. 검색되지 않은 
서버를 두 번 누르면 Sun StorEdge Configuration Service가 ssmon 사용자 암호를 
요청합니다. 또한 서버를 선택하고 File → Login을 선택할 수도 있습니다.

콘솔이 시작될 때 이 서버에 대해 사용 가능한 모든 정보를 가져오려면 Auto 
Discovery에 대해 Yes를 선택합니다. 

b. Auto Discovery에 대해 Yes를 선택하는 경우 이전에 ssmon 사용자를 서버(또는 도
메인이나 DNS 트리가 있는 경우에는 서버 그룹)에 설정할 때 입력한 것과 같은 모니
터링 암호를 입력합니다.

Auto Discovery을 사용하여 서버를 설정한 경우에는 Sun StorEdge Configuration 
Service에 로그인할 때 ssmon 암호를 입력하지 않아도 됩니다. 그 이유는 자동으로 
모니터링 권한이 생기기 때문입니다. 그러나 관리 또는 구성 작업을 수행하는 명령
을 선택하면 이전에 설정한 ssadmin 또는 ssconfig 사용자의 암호를 입력하여 보
안 수준을 변경하라는 로그인 대화 상자가 매번 나타납니다.

c. OK를 누릅니다.

6. (선택적) 전자 메일 주소를 설정합니다. 

a. Sun StorEdge Configuration Service에서 전자 메일을 통해 이벤트 메시지를 보내
려면 Mailing Lists 탭을 선택하고 다음의 지침에 따라 진행합니다. 

서버에서 발생한 이벤트에 대한 정보를 받기 위해 자신의 전자 메일 주소와 선택한 
사용자의 주소를 입력할 수 있습니다.

주 – 콘솔을 포그라운드로 계속 실행하는 대신 Sun StorEdge Configuration Service와 
함께 제공되는 유틸리티인 Diagnostic Reporter를 사용할 수 있습니다. 이 유틸리티는 
백그라운드로 실행되면서 호스트와 어레이로부터 지정한 전자 메일 주소로 메시지를 
보내는 서비스를 제공합니다. 자세한 내용은 Sun StorEdge 3000 Family Diagnostic 
Reporter 사용 설명서를 참조하십시오. Sun StorEdge Configuration Service에서 전자 
메일을 수신하도록 하기 위한 트랩 설정 정보는 235페이지의 "전자 메일과 SNMP"를 
참조하십시오. 이벤트 경고를 받는 다른 방법에 대해서는 249페이지의 "Sun StorEdge 
Configuration Service를 사용하지 않고 SNMP 트랩 보내기"를 참조하십시오.
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b. 각 사용자의 전자 메일 주소를 Mail Address 필드에 입력합니다.

c. Severity 목록 상자에서 심각도 수준의 목록을 스크롤하여 다음 옵션 중에서 선택합
니다.

Critical(심각) - 네트워크 관리자의 작업이 필요하다는 메시지로, 장치, 전원 공급 장
치 또는 팬에 문제가 생긴 경우입니다.

Warning(경고) - 일반적으로 내부 프로그램 이벤트를 나타내는 메시지입니다. 이런 
메시지가 자주 나타나면 서버나 네트워크에 문제가 있을 수 있습니다. 

Informational(정보) - 서버의 장치에 대한 메시지로,
네트워크 관리자의 작업이 필요 없는 경우입니다.

어느 수준을 선택하든 선택한 수준 및 그 이상의 심각도로 표시된 이벤트 메시지를 
받게 됩니다. 예를 들어, Informational을 선택하면 모든 중요한 이벤트에 대한 메시
지를 받게 됩니다. 이와 반대로 심각한 상황에 대한 메시지만 받으려는 경우 Critical
을 선택하면 Informational 또는 Warning 이벤트에 대해서는 메시지를 받지 않습니
다.

d. Add to List를 누릅니다.

목록에서 사용자를 삭제하려면 우편 주소를 선택하고 Delete from List를 누릅니다.
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e. 사용할 메일 서버를 지정합니다. 

Setup Mail Server 버튼은 메일 서버가 이전에 정의되었는지 여부에 따라 Change 
Mail Server로 전환됩니다.

새로 설정하려면 Setup Mail Server를 누릅니다. 다음과 유사한 Mail Server Setup 
창이 나타납니다.

f. 전자 메일 메시지를 지정된 대상 주소에 전송하는 SMTP(Simple Mail Transfer 
Protocol) 메일 서버의 IP 주소 또는 이름을 입력합니다.

Mailing Lists 탭이 표시된 Add Server 창이 나타납니다.

7. Add Server 기능을 완료합니다.

a. (선택적) 이 서버를 그룹의 일부로 만들려면 Grouping 탭을 선택합니다. 

Add Server 창이 나타납니다.

b. 선택 가능 항목을 보려면 Group 목록 상자를 선택하고, 그룹을 선택하고, OK를 누
릅니다. 
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8. 서버를 더 추가하려면 단계 3 ~ 7을 각 서버에 대해 반복합니다.

9. 이 콘솔을 통해 제어할 서버를 Managed Servers 목록으로 이동합니다.

■ 이 콘솔을 통해 사용 가능한 모든 서버를 관리하려면 대화 상자의 맨 위에 있는 Add 
All을 누릅니다.

■ 각 서버를 관리되는 열로 이동하려면 각 서버를 개별적으로 선택하고 두 목록 상자 
사이에 있는 Add를 누릅니다.

■ 서버를 추가하는 동안 수정이 필요한 경우 196페이지의 "서버 항목 편집"을 참조하
십시오.

10. 서버를 모두 추가하고 나면 OK를 눌러 기본 창으로 돌아갑니다.

주 – 어레이가 여러 호스트에 연결되어 있고 에이전트가 각 호스트에 설치되어 있으면 
각 호스트의 IP 주소를 Managed Servers 목록에 입력하여 추가해야 합니다.

▼ 서버를 삭제하려면
1. File → Server List Setup을 선택합니다. 

Server List Setup 창이 나타납니다.

2. Managed Servers 목록에서 삭제할 서버를 삭제합니다.

3. Remove를 누릅니다.

이 서버가 Available Servers 목록으로 이동됩니다.

4. Delete를 누릅니다.
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▼ 로그인 및 로그아웃하려면
로그인 및 로그아웃 기능은 프로그램 내에 보안을 제공합니다. 다른 클라이언트와 호스
트에 속해 있는 저장 장치 자원을 관리자가 허가 없이 재할당하거나 제거하는 것을 방
지하기 위해 관리 기능에는 액세스 로그인과 암호가 필요합니다.

Sun StorEdge Configuration Service를 설치한 후 다음 세 가지 보안 수준에 별도의 암
호를 할당해야 합니다.

■ ssmon – 소프트웨어의 모니터링 수준을 나타내며 제어기의 경고를 표시합니다. 

■ ssadmin – 소프트웨어의 관리 수준을 나타내고 재구성, 패리티 검사 및 패리티 검사 
예약 기능을 액세스하고 모니터링할 수 있습니다. 

■ ssconfig – 는 구성 수준을 나타내며 구성 명령과 프로그램의 모든 영역을 사용할 
수 있습니다.

사용자 및 암호 설정에 대한 자세한 내용은 Sun StorEdge 3000 Family 소프트웨어 설
치 설명서를 참조하십시오.

주 – 모니터링 작업 시 ssmon 암호를 묻지 않도록 Sun StorEdge Configuration 
Service를 설정하는 방법에 대한 자세한 내용은 12페이지의 "서버를 추가하려면"의 4d 
단계를 참조하십시오.

1. 로그인하려면 File → Login을 선택하고 지정된 보안 수준에 할당된 암호를 입력합니
다.

서버를 추가할 때 ssmon 암호가 지정된 경우 서버를 모니터링할 때 로그인하지 않아도 
됩니다. 서버를 추가할 때 ssmon 암호가 지정되지 않은 경우 서버를 모니터링하려면 
콘솔이 시작될 때마다 ssmon으로 로그인해야 합니다.

모니터링 사용자 자격으로만 지속적으로 액세스하게 합니다. 관리 또는 구성 수준이 필
요한 명령을 선택하면 그 수준에 해당하는 로그인 대화 상자가 나타나며 해당 암호를 
입력하여 로그인합니다. 작업을 완료하면 로그아웃합니다.
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2. 로그아웃하려면 File → Logout을 선택합니다. 

관리 또는 구성 수준에서 로그아웃할 때 모니터링 모드로 로그아웃할지 또는 서버 전체
에서 로그아웃할지 여부를 선택합니다.

▼ 제어기를 관리할 서버를 할당하려면
어레이를 관리하고 모니터링하려면 어레이의 주 제어기에 할당된 논리 드라이브의 파
티션에 매핑된 호스트 LUN(logical unit number)에 에이전트가 액세스할 수 있어야 합
니다. 에이전트는 어레이의 중복 구성에서 보조 제어기에 할당된 논리 드라이브의 파티
션에 매핑된 모든 호스트 LUN을 무시합니다. 

주 – 논리 드라이브와 LUN에 대한 설명은 201페이지의 "RAID에 대한 기본 정보"을 참
조하십시오. 

같은 어레이가 여러 서버에 연결되어 있는 경우 이들 각 서버에서 실행 중인 에이전트
가 이 어레이를 관리하고 모니터링하도록 할 수 있습니다. 한 번에 한 서버만 모니터링 
명령을 어레이 제어기에 보낼 수 있는 제한 때문에 여러 서버에서 동시에 보낼 경우 일
부 모니터링 명령은 실패할 수 있습니다. 이로 인해 보고가 정확하지 않게 되거나 프로
세스의 응답이 중지될 수 있습니다. 이를 방지하기 위해 에이전트를 구성하여 서버에서 
어레이 모니터링을 활성화 및 비활성화할 수 있습니다.

어레이 관리용 서버를 할당하려면 다음 절차를 수행하십시오.

주의 – Sun StorEdge Configuration Service에서는 한 번에 최대 32대의 어레이를 모니
터링하고 관리할 수 있습니다. 그러나 어레이 수가 증가할수록 콘솔 응답 시간이 감소
될 수 있습니다.

1. 직접 연결된 모든 서버가 12페이지의 "서버를 추가하려면"의 지시에 따라 추가되었는
지 확인합니다. 

이렇게 하면 모든 호스트 이름이 Controller Assignments에 나타납니다.
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2. 기본 창에서 Array Administration → Controller Assignment를 선택합니다. 

Assign Server to Manage a RAID Controller(RAID 제어기를 관리할 서버 할당) 창이 
나타납니다. 

3. 관리할 제어기를 선택합니다.

4. Server to manage this controller 목록에서 서버를 선택하고 Apply를 클릭합니다.

이렇게 하면 선택한 서버가 어레이 제어기를 관리할 수 있습니다. 또한 표시된 다른 모
든 서버가 같은 어레이를 관리할 수 없게 됩니다.

5. 보기를 닫으려면 Close를 누릅니다.

다음 예에서 볼 수 있듯이 기본 창에는 이 어레이를 모니터링하도록 설정된 서버 아래
에만 어레이 제어기 장치 아이콘이 표시됩니다. 
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서버 할당 변경

제어기를 관리할 서버를 할당하면 관리 서버와 관련된 정보가 생성됩니다. Sun 
StorEdge Configuration Service는 이 정보를 제어기에 저장하여 관리 서버를 추적하는 
데 사용합니다. 예를 들어, 유지 보수를 위해 서버를 종료하고 제어기를 관리할 다른 서
버를 할당하는 경우 Sun StorEdge Configuration Service은 제어기에서 저장된 서버 정
보를 읽어 제어기가 이미 관리되고 있음을 경고합니다.

"view and edit Host luns(호스트 LUN 보기 및 편집) → Edit Host-ID/WWN Name 
List(호스트 ID/WWN 이름 목록 편집)"라는 펌웨어 응용프로그램 메뉴를 선택하면 관
리 서버 이름을 볼 수 있습니다. 펌웨어 응용프로그램에 액세스하는 방법에 대한 자세
한 내용은 해당 어레이의 Sun StorEdge 3000 Family RAID Firmware Users Guide를 
참조하십시오.

예를 들어, 어레이를 새 위치로 이동하기 때문에 서버 할당을 변경하려면 어레이를 이
동하기 전에 21페이지의 "서버의 할당을 해제했으면 22페이지의 "터미널 창을 사용하
여 서버를 수동으로 삭제하려면"의 단계에 따라 서버를 수동으로 삭제할 수 있습니다."
의 단계에 따라 관리 서버의 할당을 해제해야 합니다. 

어레이를 이미 이동한 경우에는 어레이가 시작될 때 다른 서버에서 제어기를 관리하고 
있다는 경고 메시지가 나타납니다. "force" 옵션이 원래 서버의 에이전트의 할당을 해제
하지 않기 때문에 사용자가 원래 관리 서버를 할당 해제해야 현재 서버 할당을 덮어 씁
니다. 원래 서버의 할당을 수동으로 해제하지 않으면 이 장치도 새 서버와 함께 계속 모
니터링하고 관리해야 합니다.

서버의 할당을 해제했으면 22페이지의 "터미널 창을 사용하여 서버를 수동으로 삭제하
려면"의 단계에 따라 서버를 수동으로 삭제할 수 있습니다. 

서버 이름은 ASCII
문자 세트에 대한 16진수 값으로
저장됩니다
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▼ 관리 서버의 할당을 해제하려면
1. 기본 창에서 Array Administration → Controller Assignment를 선택합니다.

2. 서버의 할당을 해제할 어레이 제어기를 선택합니다.

3. Server to manage this controller 목록에서 아무 것도 선택하지 않고 Apply를 누릅니
다.

4. Close를 눌러 확인합니다.

5. 19페이지의 "제어기를 관리할 서버를 할당하려면"의 단계에 따라 제어기를 관리할 서
버를 선택합니다.

▼ 터미널 창을 사용하여 서버를 수동으로 삭제하려면

펌웨어 응용프로그램에 액세스하는 방법에 대한 자세한 내용은 해당 어레이의 Sun 
StorEdge 3000 Family RAID Firmware User's Guide를 참조하십시오. 

1. Main Menu에서 "view and edit Host luns → Edit Host-ID/WWN Name List → 
sscsMgr → Delete Host-ID/WWN Name List"를 선택합니다. 

2. Yes를 눌러 확인합니다.

▼ 에이전트 매개변수를 구성하려면 
에이전트 매개변수는 저장 장치에 연결하는 방법을 지정합니다. 이 절에서는 폴링 시
간, 장치 검색 주기, 스마트 모니터링, 대역 외 저장 장치 관리 등의 에이전트 매개변수
를 구성하는 절차에 대해 설명합니다.

1. 기본 창에서 View → Agent Options Management를 선택합니다. 

Agent Options Management 창이 나타납니다.

주 – 하나 이상의 그룹이 구성된 상태에서 그 중 하나를 기본 창에서 선택한 경우에는 
Agent Options Management를 사용하지 못할 수도 있습니다. 사용할 수 있도록 하려
면 그룹 이외의 다른 아이콘을 선택하고 View를 누릅니다.
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2. Monitoring Frequency에서 상태에 대해 폴링할 시간 간격을 초 단위로 입력합니다.

이 값은 장치와 제어기의 상태 변화 및 에이전트에 의한 엔클로저 모니터링의 상태 변
화에 대한 연속적 폴링 사이의 시간 간격입니다. 기본값은 60초입니다. 콘솔이 장치의 
상태 변화를 보다 자주 업데이트하게 하려면 이 값을 줄이십시오.

주 – 폴링 간격을 늘리면 I/O 로드가 심한 경우 오류 메시지 전달에 부정적인 영향을 
미칠 수 있습니다.

3. Periodic Device Discovery Time에 새 장치가 있는지 확인할 시간을 분 단위로 입력합
니다.

장치 검색 주기 값은 새 장치가 있는지 여부를 알아보기 위해 각 장치 ID를 검색하는 빈
도를 결정합니다. 기본값 0은 새 장치에 대해 검색하지 않도록 지정합니다. 값을 늘릴수
록 장치 ID의 스캔 빈도가 줄어듭니다.

이와 반대로 값을 줄일수록 장치 ID의 스캔 빈도가 늘어나 더 자주 검색됩니다. 최소값
은 5분입니다.
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4. 이벤트에 대한 Interval of trap generation에, 각 트랩 메시지를 보내는 시간 간격을 초 
단위로 입력합니다. 

값이 60초 이상이면 이벤트가 삭제되거나 수정될 때까지 특정 트랩에 대해 이 간격으로 
메시지를 보냅니다. 예를 들어, 팬이 고장나면 고쳐질 때까지 이에 대한 메시지가 60초
마다 보내집니다.

값이 0이면 Sun StorEdge Configuration Service 및 Sun StorEdge Diagnostic Reporter
는 특정 이벤트에 대해 메시지를 한 번만 보냅니다. 예를 들어, 팬이 고장나더라도 전자 
메일을 한 번만 보냅니다.

5. Timeout of heartbeat lost에서, 실패한 서버 메시지를 다시 전송하는 데 대기하는 시간
을 분 단위로 설정합니다. 

기본값은 15분이며 값의 범위는 1분에서 30분 사이입니다. 

6. Enable SMART Monitoring을 설정하려면 해당 확인란을 선택합니다.

SMART 모니터링은 하드 드라이브가 예측되는 고장을 보고하는 한 방법입니다. 대부
분의 디스크 판매자는 이 기능을 갖춘 드라이브를 제공합니다. 에이전트는 불필요한 요
청을 감지하여 이 기능을 모니터링합니다. 이 요청이 기본 호스트 운영 체제의 장치 드
라이버와 충돌하면 SMART 모니터링이 꺼질 수 있습니다. SMART 모니터링에 대한 자
세한 내용은 해당 어레이의 Sun StorEdge 3000 Family RAID Firmware User's Guide
를 참조하십시오.

7. JBOD 지원을 사용하려면 24페이지의 "JBOD 지원을 사용하려면"을 참조하십시오.

8. Password 필드를 비롯한 Controller Primary Agent Information 아래의 매개변수는 
대역 외 관리에 해당되는 매개변수입니다. 

이러한 매개변수의 구성에 대한 자세한 내용은 112페이지의 "대역 외 저장 장치 관리"
를 참조하십시오.

9. 위의 옵션 중 변경한 것이 있으면 OK를 눌러 변경 사항을 저장합니다.

10. Close를 눌러 절차를 마칩니다.

▼ JBOD 지원을 사용하려면
JBOD(Just a Bunch of Disks) 지원은 서버에 직접 연결된 JBOD가 있을 때만 사용합니
다. 이를 통해 주변 장치 상태와 이벤트를 모니터링할 수 있습니다. RAID 어레이에 연
결된 JBOD가 있는 경우 RAID 제어기는 JBOD 상태와 이벤트를 모니터링합니다. 

주 – JBOD 지원을 활성화하면 I/O에 영향을 미칠 수 있습니다.

1. 기본 창에서 View → Agent Options Management를 선택합니다. 

Agent Options Management 창이 나타납니다.
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2. Enable JBOD support를 선택합니다.

JBOD 모니터링에 대한 자세한 설명은 215페이지의 "JBOD 모니터링"을 참조하십시오.

▼ 저장 장치 구성을 확인하려면
Sun StorEdge Configuration Service를 설치했고 관리할 저장 장치의 서버를 모두 추가
했으면 저장 장치 구성을 확인해야 합니다. 

주 – 대부분의 어레이는 미리 구성된 상태로 제공됩니다. 기존 구성을 완전히 제거하고 
새로 설정하려면 35페이지의 "완전 구성"을 참조하십시오. 현재 구성을 변경하거나 현
재 구성에 추가하려면 141페이지의 "구성 업데이트"를 참조하십시오.

1. 서버 아이콘이 온라인 즉, 서버 아이콘이 보라색이어야 합니다. 

2. 기본 창을 관찰하고 저장 장치 구성을 확인합니다.

3. 여러 서버를 관리하는 경우 확인하려는 서버를 선택합니다. 

서버 아이콘이 보라색이 아닌 경우 서버의 상태를 확인합니다(표 6-1 참조).  같이 
서버 아이콘에 위성 접시 모양이 부착되어 있으면 서버가 검색 중일 수 있으며 잠시 후 
사용할 수 있습니다. 

4. 확인할 서버의 저장 장치 왼쪽에 표시되는 컨테이너 기호 를 누릅니다.

프로그램은 서버에 연결된 각 제어기를 다음 그림과 같이 그래픽으로 표시합니다. 

5. 기타 세부 정보를 보려면 확인할 제어기의 저장 장치 옆에 있는 컨테이너 기호( )를 
누릅니다.

어레이가 아직 구성되지 않은 경우 논리 드라이브(제어기의 LUN)는 표시되지 않습니
다.
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어레이가 완전 구성된 경우 Sun StorEdge Configuration Service가 관련 장치를 표시합
니다. 다음 예제의 장치와 비슷합니다. 

논리 드라이브 왼쪽의 컨테이너 기호 를 선택하면 할당된 물리적 드라이브가 표시
됩니다.

주 – View → Display HDD under LD를 선택하거나 선택 취소하면 논리 드라이브를 
구성하는 물리적(하드) 드라이브를 볼 수 있습니다.

설치한 제품에 따라 구성은 위의 그림과 상당히 다를 수 있습니다.

어레이가 구성되지 않은 경우 구성 방법에 대한 자세한 내용은 35페이지의 "완전 구성"
을 참조하십시오.

6. RAID 수준과 논리 드라이브 구조를 확인합니다.

7. 어레이가 의도한 대로 구성된 경우 다음 절로 진행하십시오. 

구성을 변경하려면 35페이지의 "완전 구성"을 참조하십시오. 

관리 서버

어레이

보조 제어기

주 제어기

논리 드라이브

분할된 논리 드라이브

사용 가능한 물리적
드라이브

엔클로저
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▼ 논리 드라이브 구성을 저장하려면
논리 드라이브 구성 정보가 제어기 및 이에 연결된 물리적 드라이브에 저장되어 있더라
도 화재와 같은 극한 상황에서는 제어기와 드라이브가 모두 손상될 수 있습니다. 따라
서 어레이와는 별도로 현재 논리 드라이브 구성의 백업 복사본을 기타 외부 미디어에 
여러 개 보관해야 합니다. 하나 이상의 백업 복사본을 금고나 작업장 외부의 안전한 장
소에 보관하십시오. 구성의 백업 복사본을 사용하면 어레이를 완전히 새로 구성하지 않
고도 새 제어기에 구성을 복원할 수 있습니다. 현재 구성의 백업 복사본이 없는 경우 데
이터를 손실할 수 있습니다. 저장된 구성에는 제어기 매개변수 설정과 LUN 매핑이 포
함되어 있습니다.

다음과 같은 경우 제어기 구성을 항상 파일에 저장해 두십시오.

■ 새 저장 장치 시스템 엔클로저를 설치하거나 기존 엔클로저의 제어기에 대한 SCSI 
ID를 변경하는 경우

■ 제어기를 교체하는 경우

■ 제어기의 논리 드라이브를 다시 구성하거나 추가하는 경우

■ 고장난 드라이브로부터 대기 드라이브로 데이터를 다시 작성하는 경우

파일로부터 구성을 복원하려면 132페이지의 "논리 드라이브 구성 복원"을 참조하십시
오.

1. 저장할 구성이 있는 제어기를 선택합니다.

2. Configuration → Save Configuration을 선택합니다. 

Save Configuration 창이 나타납니다.
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3. 필요한 드라이브와 폴더로 이동하여 .cfg 확장자로 표시된 업데이트할 구성 파일을 
찾습니다.

파일을 디스켓 또는 어레이 외부의 드라이브에 저장합니다. 즉, 구성 파일의 복사본을 
작업장 외부의 안전한 곳에 보관합니다.

4. 구성 파일의 이름을 지정하고 Save를 누릅니다. 

Save Configuration 창이 나타납니다.

5. 저장하려는 구성에 대한 설명을 입력하고 OK를 클릭합니다.

제어기 구성 정보는 .cfg 파일에 저장됩니다.

호스트 파티션 만들기
저장 장치 구성을 완료한 후 OS를 통해 새 장치의 파티션을 나눌 수 있습니다. 

▼ Solaris 호스트 파티션을 만들려면
다음 절차는 일반적인 지침입니다. 자세한 정보는 Sun Solaris OS 설명서의 파티션 및 
파일 시스템 만들기를 참조하십시오.
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1. Sun StorEdge 3310 SCSI Array나 Sun StorEdge 3320 SCSI Array에서만 Solaris OS
가 같은 ID로 된 여러 개의 LUN을 인식할 수 있습니다. 추가로 LUN을 할당하려면 
/kernel/drv/sd.conf를 수정해야 할 수도 있습니다. 이 파일을 수정하는 방법에 대
한 자세한 내용은 해당 어레이의 Sun StorEdge 3000 Family 설치, 작동 및 서비스 설명
서를 참조하십시오.

2. Solaris OS에서 새 장치와 LUN이 인식되는지 확인합니다. 상세한 절차에 대해서는 해
당 어레이의 Sun StorEdge 3000 Family 설치, 작동 및 서비스 설명서를 참조하십시오.

3. 다음을 입력하여 새 장치에 레이블을 붙입니다.

format 명령은 시스템 디스크 및 어레이에 연결된 다른 드라이브를 표시합니다.

어레이에서 사용할 수 있도록 장치를 설정하기 전에 format 명령으로 새 장치의 레이
블을 지정해야 합니다. format 명령이 실행되면 사용 가능한 장치가 표시됩니다. 

4. 사용할 장치를 선택합니다. 

메시지가 나타나면 장치의 레이블을 지정하십시오.

5. 기존 파티션 테이블을 보려면 partition을 입력합니다.

기존 파티션 테이블을 보려면 partition을 입력한 후 print를 입력해야 합니다.

6. 필요에 따라 파티션 테이블을 편집하고 변경한 경우에는 레이블을 지정합니다.

7. newfs 명령을 사용하여 파티션에서 파일 시스템을 만듭니다.

8. mount 명령을 사용하거나 /etc/vfstab를 편집한 후 mountall 명령을 사용하여 파
일 시스템을 마운트합니다.

# format
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▼ Windows 2000 및 Windows 2003 호스트 파티션
을 만들려면
다음 단계는 일반적인 지침입니다. 자세한 내용은 Windows 2000 및 Windows 2003 설
명서를 참조하십시오.

1. Windows 2000에서는 시작 → 설정 → 제어판 → 관리 도구→ 컴퓨터 관리 → 디스크 관리
를 선택합니다.

Windows 2003에서는 시작 → 관리 도구 → 컴퓨터 관리 → 디스크 관리를 선택합니다.

디스크 관리에서 새 드라이브가 디스크 아이콘  으로 표시되어 있어야 합니다.

2. 서명할 디스크를 마우스 오른쪽 버튼으로 누르고 Write Signature을 선택합니다.

3. 파티션을 만들 디스크를 선택하고 OK를 누릅니다.

4. 드라이브 용량이 표시된 드라이브를 마우스 오른쪽 버튼으로 누르고 Create Partition
를 선택합니다.

5. 파티션 마법사의 프롬프트에 적절히 응답합니다. 

서명할 디스크를 마우스
오른쪽 버튼으로 누릅니다 .

파티션을 만들 드라이브를
마우스 오른쪽 버튼으로 클릭합니
다 .
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▼ IBM AIX 호스트 논리 볼륨을 만들려면
저장 장치 구성을 완료한 후 서버에서 논리 볼륨을 하나 이상 만들어야 합니다.

다음 절차는 일반적인 지침입니다. 자세한 정보는 AIX OS 설명서의 논리 볼륨 만들기
를 참조하십시오.

1. 다음을 입력하여 호스트에서 드라이버를 인식하고 있는지 확인합니다.

디스크에 PVID(물리적 볼륨 ID)가 할당되었는지 확인합니다. 이 정보는 두 번째 열에 
표시됩니다. PVID가 할당되지 않은 경우 열에 "None"이라고 나타납니다.

2. PVID가 할당되지 않은 경우 smitty를 열고 Devices → Fixed Disks → Change /Show 
Characteristics → Assign Physical Volume Identifier를 선택합니다.

3. smitty에서 볼륨 그룹을 만듭니다. 

System Storage Management → Logical Volume Manager → Volume Groups → Add a 
Volume Group을 선택합니다.

4. smitty에서 파일 시스템을 만듭니다. 

System Storage Management → File Systems → Add/Change/Show/Delete File 
Systems를 선택합니다.

5. 논리 볼륨을 마운트합니다.

# lspv
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▼ HP-UX 호스트 논리 볼륨을 만들려면
저장 장치 구성을 완료한 후 서버에서 논리 볼륨을 하나 이상 만들어야 합니다.

다음 절차는 일반적인 지침입니다. 자세한 정보는 HP-UX OS 설명서의 논리 볼륨 만들
기를 참조하십시오.

1. 다음을 입력하여 호스트에서 드라이버를 인식하고 있는지 확인합니다.

2. System Administration Manager(sam) 세션을 시작합니다.

3. Disks and File Systems → Volume Groups를 선택합니다.

4. 창 맨 위의 Actions 메뉴에서 Create를 누릅니다.

5. Create New Volume Group Name 창에서 Select New Volume Group Name을 누르
고, New Volume Group에 이름을 입력한 다음 OK를 누릅니다.

6. Create New Volume Group 창에서 Select Disk(s)를 누르고, Volume Group에서 포
함시킬 드라이브를 선택한 다음 OK를 누릅니다.

7. Create New Volume Group 창에서 Define New Logical Volume(s)을 누릅니다.

a. LV name 필드에 논리 볼륨의 이름을 입력합니다.

b. Approx Free Mbytes 필드에 표시되어 있는 값은 해당 볼륨 그룹에 남아 있는 MB를 
지정하는데, 이 값을 사용하여 새 논리 볼륨의 크기를 결정합니다.

논리 볼륨을 여러 개 만들 수도 있지만 두 개 이상 만들어야 합니다. 해당 볼륨 그룹
의 전체 용량을 가진 논리 볼륨 하나를 만들려는 경우에는 Approx Free Mbytes 필
드에 표시된 숫자를 입력합니다. 논리 볼륨을 여러 개를 만들려는 경우에는 각 논리 
볼륨의 크기를 지정하고 첫째 논리 볼륨의 크기를 입력합니다.

c. Mount Directory 필드에서 논리 볼륨을 마운트할 디렉토리를 입력하고 Add를 누
릅니다.

d. 또 다른 논리 볼륨을 추가하려면 a-c 단계를 반복합니다.

e. 논리 볼륨 추가가 끝나면 OK를 누릅니다.

8. Create New Volume Group 창에서 OK를 누릅니다.

9. 논리 볼륨 만들기 작업을 마쳤으면 Disk and File System 창을 닫고 sam을 닫습니다.

# ioscan -fnC disk
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다음 장에서 다루는 사항
이제 Sun StorEdge Configuration Service가 설치되고 설정되어 사용할 수 있습니다. 
추가 작업은 다음 장을 참조하십시오.

■ 73페이지의 "어레이 모니터링"에서는 Sun StorEdge Configuration Service를 사용
하여 저장 장치를 모니터링하는 방법에 대해 설명합니다.

■ 121페이지의 "어레이 유지 보수"에서는 어레이를 유지 보수하는 방법에 대해 설명합
니다. 여기에는 패리티 검사, 패리티 검사 예약, 실패한 드라이브 재구성, 백업 파일
에서 구성 복원 등에 대한 상세 정보가 들어 있습니다.

■ 141페이지의 "구성 업데이트"에서는 저장 장치 어레이의 구성 업데이트에 대해 설명
합니다. 여기에는 제어기 기능 변경, 대기 드라이브 만들기 및 변경, 사용 가능한 서
버의 정보 편집 등에 대한 내용이 들어 있습니다.
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4 장

완전 구성

Sun에서는 제품 출하 전에 어레이의 논리 드라이브를 미리 구성합니다. 어레이가 구성
되어 있지 않거나 기존 구성을 완전히 삭제하고 다시 시작하려는 경우 이 장을 참조하
십시오. 기존 구성을 변경하려면 141페이지의 "구성 업데이트"를 참조하십시오.

이 장에서 다루는 내용은 다음과 같습니다.

■ 36페이지의 "논리 드라이브 및 논리 볼륨 구성"
■ 37페이지의 "표준 구성을 사용하려면"
■ 42페이지의 "사용자 정의 구성을 사용하려면"
■ 54페이지의 "논리 볼륨을 만들고 분할하려면"
■ 57페이지의 "구성을 지우려면"
■ 57페이지의 "구성 수준에서 로그아웃하려면"

■ 57페이지의 "호스트 LUN 할당"
■ 58페이지의 "호스트 LUN을 추가 또는 변경(매핑)하려면"
■ 59페이지의 "호스트 LUN을 삭제(매핑 해제)하려면"

■ 60페이지의 "구성 파일"
■ 60페이지의 "구성을 백업 파일에 저장하려면"

Sun StorEdge 3310 SCSI Array나 Sun StorEdge 3320 SCSI Array에서 클러스터 구성을 
설정하려면 223페이지의 "클러스터 구성 사용 (SCSI에만 해당)"을 참조하십시오.

패리티 검사 같은 어레이 관리 프로세스를 실행 중인 경우 구성 메뉴 명령과 도구 모음 
아이콘을 일시적으로 사용할 수 없을 수 있습니다. 콘솔이 서버의 자원 목록을 새로 고
칠 때에도 메뉴 명령이 비활성화됩니다. 새로 고치는 동안 위성 접시 모양이 서버 아이
콘에 표시되어 있습니다.

주의 – 어레이를 구성하기 전에 기존의 모든 데이터를 외부 장치에 백업하십시오. 재구
성을 하면 기존 논리 드라이브 구성을 덮어쓰게 됩니다. 논리 드라이브 구성을 덮어쓰
면 모든 데이터가 지워집니다.
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논리 드라이브 및 논리 볼륨 구성
이 절에는 표준 또는 사용자 정의 구성을 사용하여 논리 드라이브 및 논리 볼륨을 구성
하는 방법에 대해 설명하는 정보가 나와 있습니다.

논리 드라이브
단일 RAID 수준을 사용할지 또는 다중 RAID 수준을 사용할지 여부에 따라 논리 드라
이브를 구성할 때 표준 구성이나 사용자 정의 구성을 사용할 수 있습니다. 

논리 볼륨
논리 볼륨은 사용자 정의 구성으로만 만들어집니다. 그러나 Sun StorEdge 
Configuration Service에 아직도 논리 볼륨을 만들고 관리하는 기능이 남아 있지만 물
리적 드라이브와 논리 드라이브의 크기와 성능으로 인해 더 이상 논리 볼륨을 사용할 
일이 없어졌습니다. Sun 클러스터 환경 같은 현재 구성에서는 논리 볼륨이 적절하지 않
으며 이 같은 구성에서는 논리 볼륨이 작동하지도 않습니다. 논리 볼륨 대신 논리 드라
이브를 사용하십시오.

지원되는 최대 논리 드라이브, 논리 파티션 및 LUN 
할당 수
아래의 표에서는 Sun StorEdge 3310 SCSI Array, Sun StorEdge 3320 SCSI Array, Sun 
StorEdge 3510 FC Array 및 Sun StorEdge 3511 SATA Array의 최대 논리 드라이브 수, 
논리 드라이브당 파티션 수, 논리 볼륨당 파티션 수 및 최대 LUN 할당 수에 대해 설명
합니다.
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▼ 표준 구성을 사용하려면
단일 RAID 수준으로 어레이 제어기에 연결된 모든 저장 장치를 구성하려면 Standard 
Configuration 옵션을 사용하십시오. 이 경우 RAID 제어기, 최적화 모드, RAID 수준 
및 대기 드라이버를 원하는지 여부만 지정하면 됩니다. 그러면 Sun StorEdge 
Configuration Service가 RAID 수준과 사용 가능한 드라이브의 수에 따라 하나 이상의 
논리 드라이브를 만들면서 자동으로 저장 장치를 구성합니다. 후기록(Write-Back) 캐시
가 기본적으로 선택됩니다. 구성이 완료되기 전에 결과를 확인하여 승인하거나 거절할 
수 있습니다.

주의 – 표준 구성에서는 대용량 논리 드라이브 하나가 만들어집니다. 장치 용량이 큰 
FC 및 SATA 구성에서는 논리 드라이브 크기가 해당 OS의 장치 용량 한계를 초과할 수
도 있습니다. 표준 구성을 사용하기 전에 반드시 사용 중인 OS의 장치 용량 한계를 확인
하십시오.

표 4-1 지원되는 최대 논리 및 물리적 드라이브, 파티션 및 LUN 할당 수

어레이 물리적 드라이브 수
논리 드
라이브 
수

논리 드라이브
당 파티션 수

논리 볼륨당 파티
션 수

LUN 할당 수

Sun StorEdge 
3310 SCSI Array 
및 Sun StorEdge 
3320 SCSI Array

36(어레이 1/확장 
장치 2)

16 32 32 128

Sun StorEdge 
3510 FC Array

108(어레이 1/
확장 장치 8)

32 32 32 128(지점간 모드)
64(지점간 모드, 중복 구성)
1024(루프 모드)
512(루프 모드, 중복 구성)

Sun StorEdge 
3511 SATA Array

72(어레이 1/확장 
장치 5)

32 32 32 128(지점간 모드)
64(지점간 모드, 중복 구성)
1024(루프 모드)
512(루프 모드, 중복 구성)
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주의 – 표준 구성을 사용하기 전에 기존의 모든 데이터를 외부 장치에 백업하십시오. 
표준 구성은 기존 논리 드라이브 구성을 덮어씁니다. 논리 드라이브 구성을 덮어쓰면 
모든 데이터가 지워집니다.

주의 – UNIX 시스템에서는 기존 구성에 새 논리 드라이브를 추가하기 전에 해당 어레
이에 연결되어 있는 모든 파일 시스템을 마운트 해제해야 합니다.

1. ssconfig 사용자로 로그인합니다.

2. 구성할 어레이를 선택합니다.

3. 논리 드라이브의 최적화 모드를 Sequential I/O(기본값)로 설정할지 아니면 Random 
I/O로 설정할지 여부를 결정합니다.

선택한 최적화 모드에 따라 어레이에 포함시킬 수 있는 디스크의 최대 수와 논리 드라
이브에서 사용 가능한 최대 용량, 전체 어레이 용량 및 캐시 블록 크기가 달라집니다.

최적화는 Change Controller Parameters 창의 Cache 탭에서 설정되며 기본적으로 
Sequential로 설정됩니다. Sequential I/O와 Random I/O에 대한 자세한 내용 및 최적
화 모드를 변경하는 방법에 대한 절차를 보려면 177페이지의 "Cache 탭"을 참조하십시
오.

4. Configuration → Standard Configure를 선택합니다. 

Standard Configuration Warning 메시지가 나타납니다. 계속하려면 OK를 누릅니다.
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Standard Configuration Options 창이 나타납니다. 현재 ssconfig로 로그인되어 있지 
않으면 로그인 대화 상자가 나타납니다. 

사용 가능한 드라이브 수 및 서버에 Solaris OS가 설치했는지 아니면 Windows OS를 설
치했는지 여부에 따라 창의 옵션이 해제되어 있을 수 있습니다.

주 – 장치 용량이 큰 FC 및 SATA 구성에서는 논리 드라이브 크기가 해당 OS의 장치 용
량 한계를 초과할 수도 있습니다. 표준 구성을 사용하기 전에 반드시 사용 중인 OS의 장
치 용량 한계를 확인하십시오.

클러스터 구성 옵션에서는 쿼럼 RAID 5 논리 드라이브(100MB)를 만들고 나머지 용량
을 두 개의 대용량 RAID 5 논리 드라이브에 할당합니다. 이 옵션에는 3개 이상의 물리 
드라이브가 필요합니다.

5. 창의 맨 위에 표시된 서버와 제어기 ID가 올바른지 확인합니다.

창의 맨 위에 표시된 서버와 제어기가 올바르지 않은 경우 Cancel을 눌러 구성 창을 닫
고 주 창으로 돌아갑니다. 적절한 장치를 선택하고 창을 다시 선택합니다.
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6. 드라이브 중 하나를 대기 드라이브로 사용할지 여부를 표시합니다.

Use a standby drive를 선택하면 프로그램이 대기 드라이브를 사용하지 않는 RAID 수
준을 비활성화합니다. 예를 들어, RAID 0은 결함을 허용하지 않으므로 대기 드라이브
가 필요 없습니다.

7. 사용 가능한 RAID 수준에서 구성 중인 논리 드라이브에 적절한 RAID 수준을 선택합
니다.

RAID 수준의 정의에 대한 자세한 내용은 201페이지의 "RAID에 대한 기본 정보"를 참
조하십시오.

3개 이상의 드라이브가 RAID 3 또는 5를 사용해야 합니다. RAID 1을 선택하면 모든 논
리 드라이브에서 물리적 드라이브가 2개 이상 필요합니다. 드라이브를 네 개 이상 선택
하면 RAID 1+0 수준의 논리 드라이브가 만들어집니다.

8. (Solaris OS에만 해당) OS에서 새 논리 드라이브를 사용할 수 있도록 새 논리 드라이브
에 대한 레이블이 자동으로 지정되도록 하려면 Write a new label to the new LD를 누
릅니다.

9. 논리 드라이브를 지금 즉시 사용하려면 On-line Initialization을 선택합니다.

논리 드라이브 초기화 작업에는 몇 시간이 걸릴 수 있으므로 논리 드라이브를 온라인으
로 초기화하도록 선택할 수 있습니다.

온라인 초기화를 사용하면 초기화가 완료되기 전에도 논리 드라이브를 구성하고 사용
할 수 있습니다. 그러나 제어기가 I/O 작업을 수행하면서 논리 드라이브를 만드므로 논
리 드라이브를 온라인으로 초기화할 경우 오프라인으로 초기화할 때보다 시간이 더 필
요합니다.

On-line initialization을 선택하지 않은 경우 초기화가 완료된 후에야 드라이브를 구성
하고 사용할 수 있습니다. 제어기가 I/O 작업을 수행하지 않으면서 논리 드라이브를 만
드므로 오프라인으로 초기화할 때가 온라인으로 초기화할 때보다 시간이 덜 필요합니
다.

10. 스트라이프 크기를 선택합니다.

표 4-2에 지정된 것처럼 최적화 모드에 따라 스트라이프 크기를 할당하려면 기본값을 
선택하거나 다른 스트라이프 크기를 선택합니다.

이미 스트라이프 크기를 선택했고 논리 드라이브에 데이터를 기록한 경우에 논리 드라
이브의 스트라이프 크기를 변경하려면 논리 드라이브의 데이터를 다른 위치로 백업하
고, 논리 드라이브를 삭제한 다음 원하는 스트라이프 크기를 가진 논리 드라이브를 만
들어야 합니다.

표 4-2 최적화 모드에 맞는 기본 스트라이프 크기

RAID 수준
Sequential I/O
(순차 I/O)

Random I/O
(임의 I/O)

0, 1, 5 128 32

3 16 4
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11. 논리 드라이브의 Write Policy(기록 정책)로 Default, Write-through(동시 기록) 또는 
Write-back(후기록) 중에서 지정합니다.

기록 정책은 캐시된 데이터를 디스크 드라이브에 기록할 시기를 결정합니다. 디스크에 
데이터를 기록하는 동안 데이터를 캐시에 보관할 수 있으면 순차적으로 읽을 때 저장 
장치의 속도가 향상될 수 있습니다. Write policy 옵션으로는 write-through와 write-
back이 있습니다.

동시 기록 캐시를 사용하면 제어기가 호스트 OS에 프로세스가 완료되었음을 신호하기
도 전에 디스크 드라이브에 데이터를 기록합니다. 동시 기록(Write-Through) 캐시는 후
기록(Write-Back) 캐시보다 쓰기 작업의 성능과 처리량이 낮지만 정전이 발생할 경우 
데이터 손실의 위험이 가장 적으므로 보다 안전합니다. 그러나 배터리 모듈이 설치되어 
있기 때문에 전원이 메모리에 캐시된 데이터에 공급되며 전원이 다시 켜지면 데이터가 
디스크에 기록될 수 있습니다.

후기록 캐시를 사용하면 데이터가 실제로 디스크 드라이브에 기록되기 전에 제어기가 
디스크에 기록할 데이터를 받아서 메모리 버퍼에 저장한 다음 즉시 쓰기 작업이 완료되
었다는 신호를 호스트 OS에 보냅니다. 후기록 캐싱을 사용하면 쓰기 작업의 성능과 제
어기 카드의 처리량이 향상됩니다. 후기록 캐시는 기본적으로 설정되어 있습니다.

주 – Change Controller Parameters 창의 Cache 탭에 있는 Write Back 필드에서 지정
한 설정이 모든 논리 드라이브의 기본 전역 캐시 설정이 됩니다(177페이지의 "Cache 탭
" 참조).

■ Default(Write -through 또는 Write-back) – Change Controller Parameters 창의 
Cache 탭에 있는 Write Back 필드에서 지정한 전역 기록 정책을 할당합니다. 기록 정
책에 대한 전역 설정이 바뀌면 이 논리 드라이브에 대한 기록 정책도 자동으로 바뀝
니다.

지정된 이벤트가 발생할 경우 기록 정책을 write-back cache에서 write-through 
cache로 동적으로 전환하도록 어레이를 구성할 수 있습니다. 기록 정책은 기록 정책
을 "Default"로 구성한 논리 드라이브에서만 자동으로 전환됩니다. 이벤트 트리거 작
업에 대한 자세한 내용은 187페이지의 "Peripheral 탭"을 참조하십시오.

■ Write-back – 전역 기록 정책의 변경 사항에 관계없이 write-back cache를 할당합니
다.

■ Write-through – 전역 기록 정책의 변경 사항에 관계없이 write-through cache를 할
당합니다.

12. OK를 누릅니다.

새 구성이 표시된 Confirm Configuration Operation 창이 나타납니다. 

13. 표시된 구성을 허용하려면 OK를 누르고 그렇지 않으면 Cancel을 눌러 콘솔로 돌아갑
니다.

14. (HP-UX OS에만 해당) 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
ioscan -fnC disk 명령을 실행해야 합니다.
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주 – System Administrator Manager(sam)를 사용하여 파일 시스템을 마운트 해제한 
경우 ioscan 명령을 실행하기 전에 닫아야 합니다.

15. (IBM AIX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
198페이지의 "IBM AIX 호스트에서 Object Data Manager 업데이트"에 설명되어 있는 
Object Data Manager(ODM)를 업데이트해야 합니다.

매체 검색

논리 드라이브의 초기화가 완료되었을 때 데이터 무결성을 유지하기 위해 매체 검색이 
자동으로 시작되어 수동으로 중지할 때까지 계속 실행됩니다. 매개 검색이 실행 중인지 
확인하려면 이벤트 로그를 보십시오. 이벤트 로그 창에 대한 자세한 내용은 107페이지
의 "이벤트 로그 창"을 참조하십시오. 매체 검색에 대한 자세한 내용은 125페이지의 "물
리 디스크에서 불량 블록 검색(매체 검색)"을 참조하십시오.

▼ 사용자 정의 구성을 사용하려면
사용자 정의 구성을 통해 여러 RAID 수준을 사용하여 논리 드라이브를 다양하게 구성 
또는 재구성할 수 있습니다. 새로 만든 논리 드라이브를 논리 볼륨에 추가할 수도 있습
니다.

주의 – UNIX 시스템에서는 기존 구성에 새 논리 드라이브를 추가하기 전에 해당 어레
이에 연결되어 있는 모든 파일 시스템을 마운트 해제해야 합니다.

1. ssconfig 사용자로 로그인합니다. 

2. 구성할 어레이를 선택합니다.

3. Configuration → Custom Configure를 선택합니다. 
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Custom Configuration Options 창이 나타납니다.

■ New Configuration - 다양한 RAID 수준과 기타 RAID 매개변수를 사용하여 새 논
리 드라이브를 구성하고 새 논리 드라이브를 논리 볼륨에 추가할 수 있습니다. New 
Configuration 명령은 어레이 제어기에 있던 이전의 구성을 지웁니다.

■ Add LDs/LVs to the Current Configuration - 새 논리 드라이브/논리 볼륨을 기존 
구성에 추가합니다. 이 명령은 제어기에 있는 다른 구성 논리 드라이브를 지우지 않
습니다.

■ Dynamically Grow and/or Reconfigure LDs/LVs - 논리 드라이브 및 논리 볼륨의 
용량을 확장하고, 드라이브를 기존 논리 드라이브 및 논리 볼륨에 추가하고, 모든 구
성원 드라이브를 복사하여 대용량 드라이브로 교체할 수 있습니다.

■ Make or Change Standby Drives – 어레이 제어기에 연결할 새 대기 드라이브를 하
나 이상 추가합니다.

■ Change Host LUN Assignments – 호스트 채널에 논리 드라이브, 논리 볼륨 및 파티
션을 할당할 수 있습니다.

■ Change Controller Parameters – 제어기 매개변수를 수정할 수 있습니다.

■ Manage Existing LDs/LVs and Partitions – 각 논리 드라이브 및 논리 볼륨을 삭제
하고 기존 논리 드라이브 및 논리 볼륨에서 파티션을 만들거나 삭제할 수 있습니다.
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■ Configure Web Server(Sun StorEdge Enterprise Storage Manager Topology 
Reporter 소프트웨어 필요) – 웹 브라우저를 통해 어레이를 관리/모니터링할 수 있
도록 웹 서버를 구성할 수 있습니다. 

이 장에서는 새 구성 옵션에 대해 자세히 설명합니다. Configure Web Server 옵션에 대
한 자세한 내용은 118페이지의 "웹을 통한 저장 장치 관리"를 참조하십시오. 나머지 옵
션에 대한 자세한 내용은 141페이지의 "구성 업데이트"을 참조하십시오. 

새 구성 옵션
새 구성 옵션을 사용하면 환경에 맞게 논리 드라이브 구성을 사용자 정의할 수 있습니
다. 여러 RAID 수준으로 하나 이상의 논리 드라이브를 구성하고 분할할 수 있습니다. 
그런 다음 두 개 이상의 논리 드라이브(분할 안됨)를 논리 볼륨에 추가하고 논리 볼륨을 
최대 32개의 파티션으로 분할할 수 있습니다.

주 – UNIX 시스템에서 콘솔이 사용 중에 잠기면 프로세스 번호를 확인한 다음 11페이
지의 "사용 중에 콘솔이 잠기는 경우"에 설명된 대로 창을 닫았다가 다시 엽니다.

새 구성을 사용하기 전에

New Configuration을 사용하여 논리 드라이브나 논리 볼륨을 처음으로 만들기 전에 
다음 단계의 정보를 알아 두는 것이 좋습니다. 이 정보를 알고 있으면 논리 드라이브나 
볼륨을 보다 쉽게 만들 수 있습니다. 

주 – Sun 클러스터 환경 같은 현재 구성에서는 논리 볼륨이 적절하지 않으며 이 같은 
구성에서는 논리 볼륨이 작동하지도 않습니다. 대신 논리 드라이브를 사용하십시오. 자
세한 내용은 36페이지의 "논리 볼륨"을 참조하십시오.

1. 삭제할 논리 드라이브를 이미 구성한 경우 할당된 LUN의 매핑을 해제하는 방법을 비
롯하여 자세한 내용은 149페이지의 "논리 드라이브 또는 논리 볼륨을 삭제하려면"을 참
조하십시오.

주 – 미리 구성된 Sun StorEdge 3511 SATA Array에서는 중복성을 지원하는 논리 드라
이브를 새로 만들 수 있도록 먼저 논리 드라이브의 매핑을 해제하고 삭제해야 합니다.
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2. 논리 드라이브의 최적화 모드를 Sequential I/O(기본값)로 설정할지 아니면 Random 
I/O로 설정할지 여부를 결정합니다.

선택한 최적화 모드에 따라 어레이에 포함시킬 수 있는 디스크의 최대 수와 논리 드라
이브에서 사용 가능한 최대 용량, 전체 어레이 용량 및 캐시 블록 크기가 달라집니다.

최적화는 Change Controller Parameters 창의 Cache 탭에서 설정되며 기본적으로 
Sequential로 설정됩니다. Sequential I/O와 Random I/O에 대한 자세한 내용 및 최적
화 모드를 변경하는 방법에 대한 절차를 보려면 177페이지의 "Cache 탭"을 참조하십시
오.

3. 논리 드라이브에 포함할 전체 물리 디스크 수를 결정합니다. 디스크 수는 선택한 최적
화 모드에 따라 달라집니다.

데이터 보안이 중요한 경우에는 대기 드라이브에 나머지 파일을 두십시오.

임의 및 순차 최적화에 대한 최대 디스크 수 및 논리 드라이브 당 최대 사용 가능 용량에 
대한 자세한 내용은 179페이지의 "임의 및 순차 최적화의 최대 디스크 수 및 최대 사용 
가능 용량"을 참조하십시오.

주 – 논리 드라이브가 253GB보다 큰 경우 47페이지의 "253GB보다 큰 논리 드라이브를 
준비하려면"을 참조하십시오.

4. 대기(예비) 드라이브를 로컬로 설정할지 또는 전역으로 설정할지 여부를 결정합니다.

대기 드라이브는 논리 드라이브에 연결된 물리 드라이브가 고장나면 자동으로 데이터
를 다시 작성하는 여분의 드라이브로 표시된 드라이브입니다. 대기 드라이브가 다른 드
라이브를 대체하려면 적어도 오류가 발생한 드라이브와 크기가 같아야 합니다. 또한 고
장난 드라이브는 RAID 1, 3 또는 5로 만든 것이어야 합니다.

로컬 예비 드라이브는 지정된 하나의 논리 드라이브에 서비스를 제공하도록 할당된 대
기 드라이브입니다. 지정된 이 논리 드라이브의 구성원 드라이브가 실패하는 경우 로컬 
예비 드라이브는 구성원 드라이브가 되어 자동으로 재구성을 시작합니다.

전역 예비 드라이브는 지정된 하나의 논리 드라이브에 서비스를 제공하는 것 이상의 역
할을 합니다. 어떤 논리 드라이브든 구성원 드라이브가 실패하는 경우 전역 예비 드라
이브는 해당 논리 드라이브에 연결하여 자동으로 재구성을 시작합니다. 전역 예비 드라
이브는 만든 순서대로 사용됩니다.

5. RAID 수준을 결정합니다. 프로그램이 해당 RAID 수준으로 만들 수 있는 논리 드라이
브의 최대 크기를 자동으로 계산합니다.

6. 논리 드라이브를 분할할지 여부를 결정합니다.

파티션은 논리 드라이브(또는 논리 볼륨)를 분할한 것입니다. 파티션을 사용하면 파일 
관리, 여러 사용자 또는 다른 용도를 위해 별도의 논리 드라이브(또는 논리 볼륨)가 있
는 것처럼 만들 수 있습니다.
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주 – 초기 구성 작업 중에 또는 논리 드라이브가 만들어진 후에 파티션을 나눌 수 있습
니다.

주 – 파티션이 두 개 이상 있는 논리 드라이브는 논리 볼륨에 추가할 수 없습니다.

7. New Configuration 창에 표시되는 디스크 용량을 파악합니다.

■ Max Drive Size(최대 드라이브 크기, MB) - 선택한 물리적 디스크 당 최대 드라이브 
크기(각 디스크의 전체 용량)를 표시합니다. 

이 값을 낮추어 더 작은 논리 드라이브를 만들 수 있습니다. 나머지 부분은 157페이
지의 "논리 드라이브 또는 논리 볼륨의 용량 확장"에 설명된 대로 드라이브를 확장하
여 나중에 사용할 수 있습니다.

■ Available Size(MB) - 모든 디스크의 전체 용량 즉, 전체 논리 드라이브 또는 논리 볼
륨 크기를 표시합니다.

주 – 논리 드라이브의 최대 사용 가능 용량은 가장 작은 물리 디스크의 크기와 같습니
다. 예를 들어, 논리 드라이브의 일부가 되도록 18GB 디스크를 추가한 다음 70GB 디스
크를 추가하면 최대 사용 가능 용량은 드라이브 당 18GB가 됩니다.

주 – 디스크 용량은 1024의 배수로 표시됩니다. 특정 용량 정의에 대해서는 77페이지의 
"장치 용량"을 참조하십시오.

8. 논리 드라이브가 논리 볼륨의 일부가 되어야 하는지 여부를 결정합니다. 

주 – Sun 클러스터 환경 같은 현재 구성에서는 논리 볼륨이 적절하지 않으며 이 같은 
구성에서는 논리 볼륨이 작동하지도 않습니다. 대신 논리 드라이브를 사용하십시오. 자
세한 내용은 36페이지의 "논리 볼륨"을 참조하십시오.

주 – 파티션이 두 개 이상 있는 논리 드라이브는 논리 볼륨에 추가할 수 없습니다.

9. 논리 볼륨을 분할할지 여부를 결정합니다.

주 – 초기 구성 작업 중에 또는 논리 볼륨이 만들어진 후에 파티션을 나눌 수 있습니다.
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▼ 253GB보다 큰 논리 드라이브를 준비하려면
Solaris OS에는 newfs를 포함하여 다양한 작업을 위한 드라이브 구조가 필요합니다. 
논리 드라이브의 크기가 253GB 보다 큰 경우 Solaris OS에 적절한 드라이브 구조를 표
시하려면 펌웨어 응용프로그램을 사용하여 Host Cylinder/Head/Sector Mapping 
Configuration을 구성해야 합니다. 펌웨어 응용프로그램에 액세스하는 방법에 대한 자
세한 내용은 해당 어레이의 Sun StorEdge 3000 Family RAID Firmware User's Guide
를 참조하십시오.

1. 펌웨어 응용프로그램에서 "view and edit Configuration parameters → Host-Side 
Parameters → Host Cylinder/Head/Sector Mapping Configuration → Sector Ranges 
→ Variable"을 선택한 다음 Yes를 선택하여 선택을 확인합니다. 

2. Head Ranges를 선택하고 64를 지정합니다.

3. Cylinder Ranges를 선택하고 Variable을 지정합니다. 

주 – 장치 크기 제한에 대해서는 해당 운영 체제 설명서를 참조하십시오.

▼ 새 구성을 사용하여 논리 드라이브를 만들고 분할하려면

New Configuration을 사용하여 논리 드라이브를 처음으로 만들고 분할하기 전에 44페
이지의 "새 구성을 사용하기 전에"의 단계를 검토해 보십시오. 

다음 단계는 새 논리 드라이브의 새 구성을 만드는 작업의 예입니다. 이 예에서는 세 개
의 논리 드라이브가 선택되어 RAID 5 논리 드라이브로 구성됩니다. 그런 다음 작은 논
리 드라이브가 만들어지고 분할됩니다.

주의 – New Configuration 명령을 사용하기 전에 기존의 모든 데이터를 외부 장치에 
백업하십시오. Sun StorEdge Configuration Service는 어레이 제어기에 정의된 새 논리 
드라이브를 자동으로 초기화합니다.

1. ssconfig 사용자로 로그인합니다. 

2. 구성할 제어기를 선택합니다.

3. 응용프로그램에 적합한 최적화 모드를 선택했는지 확인합니다.

최적화는 Change Controller Parameters 창의 Cache 탭에서 설정되며 기본적으로 
Sequential로 설정됩니다. 최적화 모드를 변경하는 방법의 절차에 대해서는 177페이지
의 "Cache 탭"을 참조하십시오.

4. Configuration → Custom Configure를 선택합니다. 

5. New Configuration을 누릅니다. 

New Configuration Warning 메시지가 나타납니다. 
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6. OK를 누릅니다. 

7. 창의 맨 위에 표시된 서버 및 제어기가 올바른지 확인합니다.

표시된 서버와 제어기가 올바르지 않은 경우 Cancel을 눌러 New Configuration 창을 
닫고 주 창으로 돌아갑니다. 적절한 디스크 제어기를 선택하고 New Configuration을 
다시 선택합니다.

8. Select disks for Logical Drive 목록에서 첫 번째 디스크를 선택하고 Add Disk를 누릅
니다. 

계속해서 다음 두 디스크를 추가하여 아래쪽 목록 상자에 디스크가 세 개 표시되도록 
합니다. 

잘못 선택했거나 변경하려는 경우에는 드라이브 목록에서 드라이브를 선택하고 
Remove Disk를 누릅니다.

주 – 논리 드라이브가 아직 분할되지 않았기 때문에 Part Size(MB) 및 Available 
Size(MB)가 같습니다. 단일 논리 드라이브는 단일 파티션으로 간주됩니다.

주 – SATA 디스크와 FC 디스크를 섞어서 논리 드라이브를 만드는 것은 지원되지 않습
니다.
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9. RAID Level을 선택합니다. 예를 들어, RAID Level 5를 선택합니다.

이 RAID 수준이 해당 논리 드라이브의 모든 디스크에 적용됩니다. 

이 예에서는 새 논리 드라이브가 세 개의 물리적 디스크로 구성되어 있으며 Available 
Size(MB) 필드에 표시된 대로 총 103428MB입니다.

2U 어레이에 대한 각 RAID 수준의 논리 드라이브당 최대 디스크 수는 다음과 같습니
다.

■ RAID 0 - 36개
■ RAID 1 - 2개
■ RAID 1+0 - 36
■ RAID 3 또는 5 - 31개

RAID 1의 경우 드라이브를 네 개 이상 선택하면 RAID 1+0 수준의 논리 드라이브가 만
들어집니다.

10. Max Drive Size(최대 드라이브 크기)를 설정합니다.

Max Drive Size는 각 디스크의 전체 용량을 표시합니다. 이 값을 낮추어 더 작은 논리 
드라이브를 만들 수 있습니다.

Max Drive Size – 각 디스크의
전체 용량을
표시합니다 .

Available Size – 모든
디스크의 전체 용량
즉 , 전체 논리 볼륨의
크기를 표시합니다 .
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주 – Max Drive Size(최대 드라이브 크기)는 변경하지 않고 Partition Size(파티션 크
기)만 변경하면 지정된 파티션 크기로 새 파티션이 만들어집니다. 나머지 논리 드라이
브 크기 용량은 마지막 파티션으로 이동합니다. 나머지 용량은 157페이지의 "논리 드라
이브 또는 논리 볼륨의 용량 확장"에서 설명한 대로 드라이브를 확장하여 나중에 사용
할 수 있습니다.

11. Channel 및 ID 목록 상자에서 새 논리 드라이브를 매핑할 호스트 채널과 ID를 선택합
니다.

호스트 채널은 직접 또는 스위치나 기타 장치를 통해 호스트 컴퓨터에 연결됩니다. 서
버에서 어레이까지의 물리적 연결에 따라 적절한 호스트 채널을 선택합니다.

ID는 호스트가 논리 드라이브를 확인할 때 사용하는 고유 주소입니다.

주 – 지금 논리 드라이브를 매핑하지 않으려면 Channel 목록 상자에서 Do Not Map을 
선택합니다.

12. 논리 드라이브를 지금 즉시 사용하려면 구축되는 동안 On-line Initialization을 선택합
니다.

논리 드라이브 초기화 작업에는 몇 시간이 걸릴 수 있으므로 논리 드라이브를 온라인으
로 초기화하도록 선택할 수 있습니다.

온라인 초기화를 사용하면 초기화가 완료되기 전에도 논리 드라이브를 구성하고 사용
할 수 있습니다. 그러나 제어기가 I/O 작업을 수행하면서 논리 드라이브를 만드므로 논
리 드라이브를 온라인으로 초기화할 경우 오프라인으로 초기화할 때보다 시간이 많이 
걸립니다.

On-line initialization을 선택하지 않은 경우 초기화가 완료된 후에야 드라이브를 구성
하고 사용할 수 있습니다. 제어기가 I/O 작업을 수행하지 않으면서 논리 드라이브를 만
드므로 오프라인으로 초기화할 때가 온라인으로 초기화할 때보다 시간이 덜 필요합니
다.

주 – 논리 볼륨에는 On-line Initialization이 적용되지 않습니다.

13. Stripe Size를 선택합니다.

표 4-2에 지정된 것처럼 최적화 모드에 따라 스트라이프 크기를 할당하려면 Default를 
선택하거나 다른 스트라이프 크기를 선택합니다.

표 4-3 최적화 모드에 따른 기본 스트라이프 크기

RAID 수준
Sequential I/O
(순차 I/O)

Random I/O
(임의 I/O)

0, 1, 5 128 32

3 16 4
50 Sun StorEdge 3000 Family Configuration Service 2.0 사용 설명서 •  2005년 7월



이미 스트라이프 크기를 선택했고 논리 드라이브에 데이터를 쓴 경우에 논리 드라이브
의 스트라이프 크기를 변경하려면 논리 드라이브의 데이터를 다른 위치로 백업하고, 논
리 드라이브를 삭제한 다음 원하는 스트라이프 크기를 가진 논리 드라이브를 만들어야 
합니다.

주의 – 스트라이프 크기 변경이 응용프로그램에 미치는 영향을 테스트한 후에만 스트
라이프 크기를 변경하십시오.

14. Write Policy(쓰기 정책)로 Default, Write-through 또는 Write-back 중에서 지정합니
다.

기록 정책은 캐시된 데이터를 디스크 드라이브에 기록할 시기를 결정합니다. 디스크에 
데이터를 기록하는 동안 데이터를 캐시에 보관할 수 있으면 순차적으로 읽을 때 저장 
장치의 속도가 향상될 수 있습니다. Write policy 옵션으로는 write-through와 write-
back이 있습니다.

동시 기록 캐시를 사용하면 제어기가 호스트 OS에 프로세스가 완료되었음을 신호하기
도 전에 디스크 드라이브에 데이터를 기록합니다. 동시 기록(Write-Through) 캐시는 후
기록(Write-Back) 캐시보다 쓰기 작업의 성능과 처리량이 낮지만 정전이 발생할 경우 
데이터 손실의 위험이 가장 적으므로 보다 안전합니다. 그러나 배터리 모듈이 설치되어 
있기 때문에 전원이 메모리에 캐시된 데이터에 공급되며 전원이 다시 켜지면 데이터가 
디스크에 기록될 수 있습니다.

후기록 캐시를 사용하면 데이터가 실제로 디스크 드라이브에 기록되기 전에 제어기가 
디스크에 기록할 데이터를 받아서 메모리 버퍼에 저장한 다음 즉시 쓰기 작업이 완료되
었다는 신호를 호스트 OS에 보냅니다. 후기록 캐시를 캐싱을 사용하면 쓰기 작업의 성
능과 제어기 카드의 처리량이 향상됩니다. 후기록 캐시는 기본적으로 활성화되어 있습
니다.

주 – Change Controller Parameters 창의 Cache 탭에 있는 Write Back 필드에서 지정
한 설정이 모든 논리 드라이브의 기본 전역 캐시 설정이 됩니다(177페이지의 "Cache 탭
" 참조).

■ Default(Write -through 또는 Write-back) - Change Controller Parameters 창의 
Cache 탭에 있는 Write Back 필드에서 지정한 전역 기록 정책을 할당합니다. 기록 정
책에 대한 전역 설정이 바뀌면 이 논리 드라이브에 대한 기록 정책도 자동으로 바뀝
니다.

지정된 이벤트가 발생할 경우 기록 정책을 write-back cache에서 write-through 
cache로 동적으로 전환하도록 어레이를 구성할 수 있습니다. 기록 정책은 기록 정책
을 "Default"로 구성한 논리 드라이브에서만 자동으로 전환됩니다. 이벤트 트리거 작
업에 대한 자세한 내용은 187페이지의 "Peripheral 탭"을 참조하십시오.

■ Write-back - 전역 기록 정책의 변경 사항에 관계없이 write-back cache를 할당합니
다.

■ Write-through - 전역 기록 정책의 변경 사항에 관계없이 write-through cache를 할
당합니다.
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15. 이 단계는 다음에 수행할 작업에 따라 달라집니다.

■ 다른 논리 드라이브를 또 만들려면 New LD를 누르고 1 ~ 14단계를 반복합니다. 

■ 이 논리 드라이브를 논리 볼륨에 추가하려면 Add to LV를 누르고 54페이지의 "논리 
볼륨을 만들고 분할하려면"을 참조하십시오.

■ 이 논리 드라이브를 분할하려면 다음 단계를 계속 수행하십시오. 이 예에서는 작은 
논리 드라이브를 만들고 분할합니다. 

■ 논리 드라이브 만들기를 마친 후 이 논리 드라이브를 논리 볼륨이나 파티션에 추가
하지 않으려면 Commit을 누릅니다.

16. 작은 논리 드라이브를 만들려면 Max Drive Size 필드에 2000을 입력합니다. 

주 – 6000MB가 아닌 4000MB가 전체 논리 드라이브의 크기로 표시됩니다. 그 이유는 
드라이브가 RAID 5 수준이므로 패리티를 위해 하나의 드라이브에 해당하는 용량
(2000MB)을 잃어버리기 때문입니다.

17. 파티션을 만들려면 Part Size 필드에 1000을 입력하고 Add Partition을 누릅니다.
52 Sun StorEdge 3000 Family Configuration Service 2.0 사용 설명서 •  2005년 7월



주 – 논리 드라이브를 논리 볼륨에 추가하려는 경우에는 드라이브를 분할하지 마십시
오. 분할된 논리 드라이브는 논리 볼륨에 추가할 수 없습니다.

같은 크기의 파티션을 여러 개 만들려면 만들 파티션 수만큼 Add Partition을 누릅니
다. Part Size 필드에 파티션의 크기를 입력하고 만들 파티션 수를 곱할 수도 있습니
다(예: 100 * 128). 나머지 MB는 마지막 파티션에 추가됩니다.

파티션을 추가할수록 Available Size(MB)에 표시된 남은 용량이 추가된 파티션 크기만
큼 줄어듭니다.

다음 예에서 볼 수 있듯이 원래의 4000MB 중 1000MB는 파티션 0에 할당됩니다. 나머
지 3000MB는 자동으로 파티션 1로 이동됩니다. 나머지 사용 가능한 용량은 Available 
Size(MB) 필드에 표시됩니다.

18. (Solaris OS에만 해당) OS에서 새 논리 드라이브를 사용할 수 있도록 새 논리 드라이브
에 대한 레이블이 자동으로 지정되도록 하려면 Write a new label to the new LD를 누
릅니다.
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19. Commit을 눌러 논리 드라이브의 구성을 완료하거나 New LD를 눌러 다른 논리 드라
이브를 구성합니다. 

New LD를 누르면 아직 사용하지 않은 사용 가능한 디스크가 모두 표시됩니다.

이 어레이의 논리 드라이브 구성이 완료되면 Commit을 누른 다음 OK를 누릅니다. 완
료된 구성이 나타납니다. 

주 – OK를 누른 후에는 논리 드라이브 구성을 변경할 수 없습니다. 

주 – 초기화하는 동안 LD/LV 크기는 0MB로 표시됩니다.

20. (HP-UX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
ioscan -fnC disk 명령을 실행해야 합니다.

주 – System Administrator Manager(sam)를 사용하여 파일 시스템을 마운트 해제한 
경우 ioscan 명령을 실행하기 전에 닫아야 합니다.

21. (IBM AIX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
198페이지의 "IBM AIX 호스트에서 Object Data Manager 업데이트"에 설명되어 있는 
Object Data Manager(ODM)를 업데이트해야 합니다.

▼ 논리 볼륨을 만들고 분할하려면 
논리 볼륨은 두 개 이상의 논리 드라이브로 구성되며 최대 32개의 파티션으로 분할할 
수 있습니다. 작업을 수행하는 동안 호스트는 분할되지 않은 논리 볼륨이나 논리 볼륨
의 파티션을 하나의 물리 드라이브로 인식합니다. 

주 – Sun 클러스터 환경 같은 현재 구성에서는 논리 볼륨이 적절하지 않으며 이 같은 
구성에서는 논리 볼륨이 작동하지도 않습니다. 대신 논리 드라이브를 사용하십시오. 자
세한 내용은 36페이지의 "논리 볼륨"을 참조하십시오.

1. 47페이지의 "새 구성을 사용하여 논리 드라이브를 만들고 분할하려면"의 단계 1 ~ 11에 
설명된 대로 논리 드라이브를 만듭니다.

주 – 논리 볼륨에 추가할 논리 드라이브는 분할하지 마십시오. 분할된 논리 드라이브는 
논리 볼륨에 추가할 수 없습니다.
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2. Commit을 누르기 전에 논리 드라이브를 논리 볼륨에 추가하려면 Add to LV를 누릅니
다.

논리 드라이브가 LV Definition 상자에 추가됩니다. 논리 볼륨의 전체 크기가 Available 
Size(MB) 필드에 표시됩니다. 

주 – 논리 볼륨이 아직 분할되지 않았기 때문에 Part Size(MB) 및 Available Size(MB)가 
같습니다. 단일 논리 볼륨은 단일 파티션으로 간주됩니다.

주 – SATA 논리 디스크와 FC 논리 디스크를 섞어서 논리 볼륨을 만드는 것은 지원되지 
않습니다.

3. 논리 볼륨에 추가할 다른 논리 드라이브를 또 만들려면 New LD를 누릅니다.

4. 논리 드라이브를 만들고 Add to LV를 눌러 논리 볼륨에 추가합니다.

논리 볼륨에 추가할 모든 논리 드라이브에 대해 이 단계를 반복하십시오.

논리 드라이브가
논리 볼륨에 추가되면
LV Definition
상자에 표시됩니다 .

Available Size – 모든
디스크의 전체 용량
즉 , 전체 논리 볼륨의
크기를 표시합니다 .
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5. 파티션을 만들려면 Part Size 필드에 파티션의 크기를 입력하고 Add Partition을 누릅
니다.

같은 크기의 파티션을 여러 개 만들려면 만들 파티션 수만큼 Add Partition을 누릅니
다. Part Size 필드에 파티션의 크기를 입력하고 만들 파티션 수를 곱할 수도 있습니
다(예: 100 * 128).

파티션을 추가할수록 Available Size(MB)에 표시된 남은 용량이 추가된 파티션 크기만
큼 줄어듭니다.

6. 논리 볼륨에 논리 드라이브를 모두 추가한 다음 다른 논리 볼륨 또는 개별 논리 드라이
브를 또 만들려면 Commit LV를 누릅니다.

논리 볼륨을 모두 만들었고 개별 논리 드라이브를 만들지 않으려면 Commit을 누릅니
다.

주 – 논리 볼륨을 모두 만들었고 New Configuration 창을 종료하려고 할 때 Commit 
대신 Commit LV를 실수로 누른 경우에는 다른 논리 드라이브를 또 만들거나 Cancel을 
누르고 논리 볼륨을 다시 구성해야 합니다.

기존 구성에 논리 볼륨을 추가 또는 삭제하거나 논리 볼륨을 분할하려면 141페이지의 "
구성 업데이트"를 참조하십시오.

7. (HP-UX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
ioscan -fnC disk 명령을 실행해야 합니다.

주 – System Administrator Manager(sam)를 사용하여 파일 시스템을 마운트 해제한 
경우 ioscan 명령을 실행하기 전에 닫아야 합니다.

8. (IBM AIX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
198페이지의 "IBM AIX 호스트에서 Object Data Manager 업데이트"에 설명되어 있는 
Object Data Manager(ODM)를 업데이트해야 합니다.

매체 검색

논리 드라이브의 초기화가 완료되었을 때 데이터 무결성을 유지하기 위해 매체 검색이 
자동으로 시작되어 수동으로 중지할 때까지 계속 실행됩니다. 매개 검색이 실행 중인지 
확인하려면 이벤트 로그를 보십시오. 이벤트 로그 창에 대한 자세한 내용은 107페이지
의 "이벤트 로그 창"을 참조하십시오. 매체 검색에 대한 자세한 내용은 125페이지의 "물
리 디스크에서 불량 블록 검색(매체 검색)"을 참조하십시오.
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▼ 구성을 지우려면
New Configuration 창에서 구성을 진행하는 동안 언제든지 구성을 지울 수 있습니다.

1. 표시된 모든 물리적 드라이브와 논리 드라이브를 삭제하려면 Clear를 누릅니다. 

2. New LD를 눌러 새 논리 드라이브를 정의하거나 Commit을 누릅니다.

3. Commit을 누를 때 경고 메시지가 나타나면 OK를 누릅니다. 

Sun StorEdge Configuration Service는 선택한 어레이 제어기의 전체 구성을 초기화합
니다.

주 – 논리 드라이브가 초기화 프로세스를 완료하면 호스트 LUN이 자동으로 매핑됩니
다.

▼ 구성 수준에서 로그아웃하려면
구성 작업을 완료하면 프로그램의 모니터링 수준으로 다시 로그인합니다. 

1. File → Logout을 선택합니다.

2. Logout to monitoring mode를 선택하고 OK를 누릅니다.

호스트 LUN 할당
서버에서 논리 드라이브/논리 볼륨을 인식하려면 호스트 채널/ID에 매핑되어야 합니
다. 논리 드라이브/논리 볼륨이 호스트 채널/ID에 매핑되면 논리 장치 번호(LUN)가 
됩니다. 다음 절에서는 논리 드라이브/논리 볼륨을 호스트 채널에 매핑하는 방법 및 논
리 드라이브/논리 볼륨을 제거하는 방법에 대해 설명합니다.

주 – 논리 드라이브/논리 볼륨을 처음 만들 때 Do Not Map(매핑 안 함)을 선택하지 않
으면 논리 드라이브/논리 볼륨의 초기화 프로세스가 완료된 후에 호스트 LUN이 자동
으로 매핑됩니다.
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주 – Sun StorEdge 3310 SCSI Array와 Sun StorEdge 3320 SCSI Array에서는 최대 128
개까지 LUN을 할당할 수 있습니다. Sun StorEdge 3510 FC Array와 Sun StorEdge 
3511 SATA Array에서는 최대 1024개까지 1024 LUN을 할당할 수 있습니다. 즉, 각 호
스트 ID에 최대로 할당되는 LUN 수가 32입니다.

▼ 호스트 LUN을 추가 또는 변경(매핑)하려면
1. Configuration → Custom Configure를 선택합니다.

2. Change Host LUN Assignments를 선택합니다. 

Change Host LUNs Assignments 창이 나타납니다.

3. Select Host Channel and SCSI ID 목록 상자에서 LUN을 할당할 채널과 ID를 선택합
니다.

사용 가능한 모든 논리 드라이브가 Partitions 아래에 표시됩니다. 참조하기 쉽도록 
Used LUNs(사용된 LUN)에는 지정된 채널에 사용되는 LUN 목록이 표시되고 
Partition Assignment에는 파티션이 할당된 채널, ID 및 LUN의 목록이 표시됩니다. 
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4. 매핑할 파티션을 선택하고 Assign Host LUN을 누릅니다. 

여러 파티션(최대 32개)을 매핑하려면 첫 번째 파티션을 선택하고 마지막 파티션으로 
스크롤한 다음 Shift 키를 누른 채 눌러서 첫 번째와 마지막 사이에 있는 모든 파티션을 
선택합니다. 그런 다음 Assign Host LUN을 누릅니다. 그 결과, Unmap Host LUN이 
활성화됩니다.

5. 작업이 완료되면 OK를 눌러 변경 사항을 저장하고 주 메뉴로 돌아갑니다.

주 – 호스트 채널을 매핑할 때 오류 메시지가 나타나면 단계 1 ~ 5를 반복하십시오.

▼ 호스트 LUN을 삭제(매핑 해제)하려면
1. Change Host LUN Assignments 창이 나타나면 Host LUN Assignments 필드에서 삭
제할 LUN을 선택합니다.

2. Unmap Host LUN을 누릅니다.

3. 작업이 완료되면 OK를 눌러 변경 사항을 저장하고 주 메뉴로 돌아갑니다.
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구성 파일
현재 구성의 백업 복사본을 디스켓 또는 어레이가 아닌 외부 장치에 보관해야 합니다. 
구성 정보가 어레이 제어기 및 이에 연결된 물리 드라이브에 저장되어 있더라도 화재나 
홍수와 같은 극한 상황에서는 제어기와 드라이브가 모두 손상될 수 있습니다. 구성의 
백업 복사본을 사용하면 저장 장치 어레이를 완전히 새로 구성하지 않고도 새 제어기에 
구성을 복원할 수 있습니다 

다음과 같은 경우 어레이 제어기 구성을 항상 파일에 저장해 두십시오.

■ 새 저장 장치 시스템 엔클로저를 설치하거나 기존 엔클로저의 제어기에 대한 SCSI 
ID를 변경하는 경우

■ 제어기를 교체하는 경우

■ 제어기의 논리 드라이브를 다시 구성하거나 추가하는 경우

■ 고장난 드라이브로부터 대기 드라이브로 데이터를 다시 작성하는 경우

▼ 구성을 백업 파일에 저장하려면
1. 저장할 구성이 있는 제어기를 선택합니다.

2. Configuration → Save Configuration을 선택합니다.

Save Configuration 창이 나타납니다.

3. 필요에 따라 구성 파일을 저장할 드라이브와 폴더로 이동합니다. 

파일을 디스켓 또는 어레이 외부의 드라이브에 저장합니다.
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4. 구성 파일의 이름을 지정하고 Save를 누릅니다.

Save Configuration 창이 나타납니다.

5. 저장하려는 구성에 대한 설명을 입력합니다.

6. OK를 누릅니다. 

제어기 구성 정보는 .cfg 파일에 저장됩니다.

구성 로드
드라이브나 제어기가 손상되어 교체해야 하는 경우에는 구성 파일을 로드하는 방법 및 
논리 드라이브 구성을 복원하는 방법이 설명되어 있는 132페이지의 "논리 드라이브 구
성 복원"을 참조하십시오.
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5 장

LUN 필터링(FC 및 SATA에만 해당) 

이 장에서는 Sun StorEdge 3510 FC Array 및 Sun StorEdge 3511 SATA Array의 LUN 
필터를 만들어 공통 저장 장치를 공유하는 대형 FC 네트워크를 관리하는 방법에 대해 
설명합니다. 이 장에서 다루는 내용은 다음과 같습니다.

■ 63페이지의 "개요"
■ 65페이지의 "LUN 필터 할당"

■ 65페이지의 "LUN Filter 보기에 액세스하려면"
■ 65페이지의 "새 호스트를 수동으로 추가하려면"
■ 67페이지의 "HBA 장치를 수동으로 추가하려면"
■ 69페이지의 "표준 호스트 매핑을 제거하려면"
■ 70페이지의 "LUN 필터를 할당하려면"
■ 72페이지의 "LUN 필터를 삭제하려면"

개요
저장 장치 구조를 효율적으로 관리하기 위해서는 데이터의 액세스 방법과 보안 방법이 
중요합니다. LUN 필터링 지원을 통해 Sun StorEdge Configuration Service는 저장 장
치에 대한 액세스를 중앙에서 안전하게 관리할 수 있는 유틸리티를 제공합니다. 

여러 서버가 동일한 FC Array에 연결된 경우 LUN 필터링은 호스트(서버)에서 논리 드
라이브로 가는 독점 경로를 제공하여 연결된 다른 서버가 논리 드라이브를 보거나 액세
스하지 못하도록 합니다. 즉, LUN 필터는 호스트 장치에서 FC Array 장치에 액세스하
는 방법과 이를 보는 방법을 구성하며, 일반적으로 FC Array 장치를 하나의 호스트에만 
매핑하여 다른 호스트가 이 FC Array 장치를 액세스하거나 사용할 수 없도록 합니다. 
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또한 LUN 필터링을 사용하면 여러 논리 드라이브나 파티션을 같은 LUN에 매핑할 수 
있기 때문에 필요한 경우 서로 다른 서버가 고유한 LUN 0을 갖도록 할 수 있습니다. 
LUN 필터링은 각 HBA(호스트 버스 어댑터)가 허브를 통해 볼 때 논리 드라이브 수의 
두 배를 보는 경우 매핑을 명확하게 하는 데 유용합니다.

각 FC 장치에는 WWN(World Wide Name)이라는 고유한 식별자가 할당됩니다. WWN
은 IEEE에서 할당하며 IP의 MAC 주소 또는 인터넷의 URL과 유사합니다. WWN은 해
당 장치가 사용되는 동안 계속 유지됩니다. LUN 필터링에서는 WWN을 사용하여 특정 
논리 드라이브를 독점적으로 사용할 수 있는 서버를 지정합니다. 콘솔의 주 메뉴에서 
간단한 끌어서 놓기 방법을 사용하여 WWN으로 식별되는 호스트의 FC HBA 카드에 
각 논리 드라이브를 매핑할 수 있습니다. 

다음 예에서 논리 드라이브(LUN 01)를 호스트 채널 0에 매핑하고 WWN1을 선택하면 
서버 A는 해당 논리 드라이브에 대한 독점 경로를 갖게 됩니다. LUN 필터링을 사용하
면 해당 호스트의 HBA 장치만 논리 드라이브를 볼 수 있고 액세스할 수 있지만, 다른 
HBA 장치는 할 수 없습니다. 세 서버 모두 해당 서버에 필터가 할당되지 않는 한 LUN 
02와 LUN 03을 계속 보고 액세스할 수 있습니다.

그림 5-1 LUN 필터링의 예제

LUN 필터링의 장점은 여러 OS가 설치된 여러 호스트가 공통 FC 포트를 통해 한 어레
이에 연결되면서도 LUN 보안을 유지할 수 있다는 점입니다.

LUN 02 LUN 03

WWN1 WWN2 WWN3

C

LUN 01

서버 A 서버 B 서버 C
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LUN 필터 할당
LUN 필터를 할당하는 단계는 다음과 같습니다.

■ LUN Filter 보기에 액세스
■ 원하는 호스트가 표시되지 않은 경우 새 호스트를 수동으로 추가
■ 원하는 HBA가 표시되지 않은 경우 HBA 장치를 수동으로 추가
■ 표준 매핑 제거
■ LUN 필터 할당

▼ LUN Filter 보기에 액세스하려면
1. 주 창에서 Filter View 탭을 누릅니다. 

2. 컨테이너 기호 를 누르면 장치 트리가 확장되고 왼쪽 창에는 서버(호스트) 정보가, 
오른쪽 창에는 어레이 장치 정보가 자세히 표시됩니다. 

▼ 새 호스트를 수동으로 추가하려면
왼쪽 창에서 Hosts 아래에 원하는 호스트 장치가 표시되지 않은 경우 Configure 
Host/WWN 창을 통해 수동으로 추가합니다.

1. 주 창에서 Filter View 탭을 누릅니다.

2. Configuration → Configure Host/WWN을 선택합니다.

주 – Configure Host/WWN 옵션이 설정되어 있지 않으면 왼쪽 창의 아이콘 중 하나를 
선택하여 이 옵션을 설정합니다.
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3. ssconfig 또는 ssadmin으로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니
다. 암호를 입력하고 OK를 누릅니다.

Configure Host/WWN 창이 나타납니다.

4. Available Hosts 아래에서 해당 호스트를 찾습니다.

■ 해당 호스트가 있으면 9단계로 진행합니다.

■ 해당 호스트가 없으면 5단계로 진행합니다.

5. Available Hosts 창 아래에서 Add를 누릅니다.

Add/Edit Host 창이 나타납니다.

6. 호스트 이름, IP 주소 및 OS를 입력한 다음 Add를 누릅니다.

Add/Edit HBA 창이 나타납니다.

7. 어댑터 이름과 적절한 WWN을 입력한 다음 OK를 누릅니다.

WWN을 결정하는 방법에 대한 자세한 내용은 229페이지의 "호스트 WWN 확인 (FC 및 
SATA에만 해당)"을 참조하십시오.

8. OK를 눌러 Add/Edit Host 창을 닫습니다.

9. Available Hosts 목록 아래에서 호스트를 선택하고 Add를 눌러 Connected Hosts 목
록에 호스트를 추가합니다.

10. OK를 눌러 Configure Host/WWN 창을 닫습니다.

확인 메시지가 나타납니다.

11. Close를 누릅니다.

Filter View 탭으로 돌아가면 새 호스트를 LUN 필터링에 사용할 수 있습니다.
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12. (선택적) 여러 호스트를 한 어레이에 매핑하려면 Configuration → LUN Filter 
Properties를 선택한 다음 Select Sun StorEdge 3000 Family System 목록 상자에서 해
당 어레이를 선택합니다.

Hardware Filter 및 Map to Multiple Hosts 확인란을 선택한 다음 OK를 누릅니다.

주 – Hardware Filter 확인란의 선택을 취소하면 LUN 필터 매핑은 할당할 만들 수 없
고 표준 맵만 할당할 수 있습니다.

▼ HBA 장치를 수동으로 추가하려면
왼쪽 창에서 Hosts 아래에 원하는 HBA 장치가 표시되지 않은 경우 Configure 
Host/WWN 창을 통해 수동으로 추가합니다. 각 어레이에 WWN을 최대 64개까지 추
가할 수 있습니다.

1. Configuration → Configure Host/WWN을 선택합니다.

주 – Configure Host/WWN 옵션이 설정되어 있지 않으면 왼쪽 창의 아이콘 중 하나를 
선택하여 이 옵션을 설정합니다.

2. ssconfig 또는 ssadmin으로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니
다. 암호를 입력하고 OK를 누릅니다.

Configure Host/WWN 창이 나타납니다.

3. Connected Hosts 목록 아래에서 HBA 장치를 추가할 호스트를 선택한 다음 Remove
를 누릅니다.
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4. Available Hosts 목록 아래에서 해당 호스트를 선택하고 Edit를 누릅니다.

Add/Edit Host 창이 나타납니다.

5. Add를 누릅니다. 

Add/Edit HBA 창이 나타납니다.

6. 새 어댑터 이름과 적절한 WWN을 입력하고 OK를 누릅니다.

WWN을 결정하는 방법에 대한 자세한 내용은 229페이지의 "호스트 WWN 확인 (FC 및 
SATA에만 해당)"을 참조하십시오.

7. OK를 눌러 Add/Edit Host 창을 닫습니다.

8. Available Hosts 목록 아래에서 호스트를 선택하고 Add를 눌러 Connected Hosts 목
록으로 다시 호스트를 옮깁니다.

9. OK를 눌러 Configure Host/WWN 창을 닫습니다.

확인 메시지가 나타납니다.
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10. Close를 누릅니다.

LUN Filter 보기로 돌아가면 새 HBA 장치가 회색으로 나타납니다. LUN 필터링에 사
용할 수 있습니다. 

▼ 표준 호스트 매핑을 제거하려면
LUN 필터를 할당하려면 먼저 표준 호스트 매핑(M 레이블 로 표시)을 어레이에서 
제거해야 합니다. 표준 매핑을 사용하면 모든 호스트가 표준 매핑된 모든 논리 드라이
브를 볼 수 있습니다. LUN 필터링은 매핑을 특정 호스트로 제한합니다. 

1. 주 창에서 Filter View 탭을 누릅니다.

2. 오른쪽 창에서 각 All Hosts 항목을 눌러 Storage Pools로 끌어다 놓습니다.

3. 경고 메시지가 나타나면 Yes를 누릅니다.

확인 메시지가 나타납니다.

4. Close를 누릅니다.

Filter View 탭으로 돌아가면 논리 드라이브에서 M 레이블  이 제거된 것을 볼 수 있
습니다.
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▼ LUN 필터를 할당하려면
표준 매핑을 제거한 후 논리 드라이브를 호스트로 매핑하여 LUN 필터를 할당할 수 있
습니다.

1. 주 창에서 Filter View 탭을 누릅니다.

2. Storage Pools 아래에서 논리 드라이브를 선택하여 Hosts 아래의 적절한 HBA 장치
(  )로 끌어다 놓습니다.

경고 메시지가 나타납니다.

주 – 어레이에 연결된 HBA 장치를 알 수 없는 경우 왼쪽 창에서 논리 드라이브를 호스
트(서버)로 끌어다 놓습니다. 프로그램이 호스트의 각 HBA 장치에 대해 어레이를 필터
링할 것인지 묻습니다. 필터링을 사용하면 해당 호스트의 HBA 장치는 논리 드라이브
를 볼 수 있지만, 다른 HBA 장치는 볼(액세스할) 수 없습니다.

3. Yes를 누릅니다.

Specify Map Information 창이 나타납니다. HBA 장치가 여러 개 있는 경우 프로그램은 
호스트에 나열된 첫 번째 HBA 장치에 논리 드라이브를 자동으로 매핑합니다.

4. 원하는 채널 및 LUN ID 번호로 논리 드라이브를 주 또는 보조 제어기에 할당한 다음 
OK를 누릅니다. 

확인 메시지가 나타납니다.

5. Close를 누릅니다.

HBA 카드에 대한 기본 제어기 또는 보조 제어기의 할당은 처음 LUN 필터를 할당할 때 
선택되며 LUN 필터의 할당을 삭제하고 다시 시작해야만 변경할 수 있습니다.

LUN 필터를 한 어레이의 두 번째 호스트에 적용하려면 67페이지의 "HBA 장치를 수동
으로 추가하려면" 및 70페이지의 "LUN 필터를 할당하려면"의 단계를 반복하십시오.

다음 예에서 Sun StorEdge 3510 FC 장치에는 두 개의 개별 호스트에 대한 LUN 필터
(문자 F는 필터를 나타냄)가 있습니다.
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주의 – 두 명의 사용자가 동시에 같은 논리 드라이브에 액세스하면 데이터가 손상될 수 
있으므로 경고 메시지가 나타납니다. 일부 호스트 운영 체제에서만 이러한 동작이 발생
합니다. Yes를 다른 호스트를 추가합니다.
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▼ LUN 필터를 삭제하려면
1. 주 창에서 Filter View 탭을 누릅니다.

2. 오른쪽 창에서 관련 WWN을 선택하여 Storage Pools로 끌어다 놓습니다.

경고 메시지가 나타납니다.

3. Yes를 누릅니다.

확인 메시지가 나타납니다.

4. Close를 누릅니다. 
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6 장

어레이 모니터링 

이 장에서는 Sun StorEdge Configuration Service를 사용하여 어레이를 모니터링하는 
방법에 대해 설명합니다. 기본 창과 기본 창에서 아이콘을 두 번 클릭할 때 나타나는 구
성 요소 보기 창에 대해서도 설명합니다. 또한 이벤트 로그의 작동 방법과 보고 기능을 
사용하는 방법에 대해서도 설명합니다. 이 장에서 다루는 내용은 다음과 같습니다.

■ 73페이지의 "기본 창"
■ 81페이지의 "장치의 상세 정보 보기"
■ 105페이지의 "이벤트 로그"
■ 109페이지의 "보고서 저장"
■ 112페이지의 "보고서 보기"
■ 112페이지의 "대역 외 저장 장치 관리"
■ 118페이지의 "웹을 통한 저장 장치 관리"

주의 – Sun StorEdge Configuration Service에서는 한 번에 최대 32대의 어레이를 모니
터링하고 관리할 수 있습니다. 그러나 어레이 수가 증가할수록 콘솔 응답 시간이 감소
될 수 있습니다.

기본 창
기본 창을 통해 모든 어레이 장치의 상태를 한 눈에 파악할 수 있습니다. 또한 여기에는 
콘솔에서 모니터링하는 서버에 연결된 장치와 논리 드라이브의 상태가 표시됩니다. 장
치에는 어레이 제어기, 디스크 저장 장치 엔클로저, 물리 디스크 드라이브 및 기타 SCSI 
장치가 포함됩니다.
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이 창의 트리 구조에서는 각 서버에 연결된 모든 장치에 대한 상세 정보를 제공합니다. 
트리 왼쪽의 컨테이너 기호  또는 는 장치의 표시가 확대 또는 축소되었는지 여부
를 나타냅니다. 컨테이너 기호 는 더 많은 장치를 보려면 기호를 누르라는 의미입니
다. 컨테이너 기호 는 해당 수준 이하의 모든 장치를 표시한다는 의미입니다.

다음 그림은 기본 창의 확대된 보기의 예입니다. 구성된 어레이에 표시되는 일반 장치 
아이콘에 대한 설명을 보려면 25페이지의 "저장 장치 구성을 확인하려면"을 참조하십
시오.

 

주 – SN#은 어레이의 고유 ID를 나타냅니다.
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다음 그림은 축소된 보기의 예입니다.

 

자세한 내용을 보려면 아이콘을 두 번 눌러 구성 요소 보기 창을 엽니다. 구성 요소 보기
는 이 장의 후반부에서 설명합니다.

장치 상태
기본 창의 다른 기능으로는 언제 장치 상태에 주의를 기울여야 하는지 쉽게 식별할 수 
있도록 장치 상태를 색상과 기호로 구분하는 것이 있습니다. 상태는 장치 트리를 따라 
전파되므로 사용자는 장치 수준으로 고장을 추적할 수 있습니다. 장치 상태 색상과 기
호 설명에 대한 자세한 내용은 표 6-1을 참조하십시오.

표 6-1 장치 색상 및 기호 상태

색상 기호 상태

보라색 없음 그룹, 서버 또는 장치가 온라인 상태입니다. 

흰색 없음 사용자가 이 서버에 로그인하지 않았습니다.

노란색 그룹 또는 서버의 하나 이상의 구성 요소가 작동하지 않지만 어
레이는 작동 중입니다. 자세한 내용은 76페이지의 "저하된 상태"
를 참조하십시오.

빨간색 이 그룹 또는 서버에서 하나 이상의 구성 요소가 작동하지 않아 
장치를 심각한 상태에 빠뜨립니다. 자세한 내용은 76페이지의 "
심각한 상태"를 참조하십시오.
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저하된 상태

장치가 저하된 상태가 되는 이유로는 다음과 같은 것들이 있습니다(여기에만 국한되지 
않음).

■ 논리 드라이브의 크기와 여기에 포함되어 있는 물리적 드라이브 수에 따라 고장난 
물리적 드라이브가 하나 이상 있는 논리 드라이브는 저하된 상태에서 작동할 수 있
습니다. 논리 드라이브의 상태와 이 논리 드라이브를 구성하는 물리적 드라이브의 
상태를 확인하려면 91페이지의 "논리 드라이브 보기"를 참조하십시오.

■ 전원 공급 장치, 팬 및 온도를 비롯하여 환경 구성 요소 중 한 가지 이상이 작동하지 
않지만 어레이는 작동하는 경우 엔클로저, 어레이 및 서버 아이콘이 저하된 상태를 
나타냅니다. 자세한 내용은 93페이지의 "엔클로저 보기"를 참조하십시오.

■ 온도가 임계치 한계를 초과하는 경우 제어기를 종료하는 옵션이 설정되어 있기 때문
에 제어기가 종료된 경우에는 제어기가 저하된 상태에서 동작합니다. 자세한 내용은 
187페이지의 "Peripheral 탭"을 참조하십시오.

■ Sun StorEdge 3510 FC Array나 Sun StorEdge 3511 SATA Array의 경우 저하된 상
태는 배터리가 21일 이내에 만료되거나 사용 날짜가 대체 배터리에 대해 설정되지 
않았음을 나타낼 수 있습니다. 일반 배터리 정보에 대해서는 100페이지의 "배터리 정
보"를 참조하고, 서비스 날짜에 대한 자세한 내용은 102페이지의 "배터리 교체 시 사
용 날짜를 확인하려면"을 참조하십시오. 대체 배터리 설치에 대한 자세한 내용은 
Sun StorEdge 3000 Family FRU 설치 안내서를 참조하십시오.

심각한 상태

장치가 심각한 상태가 되는 이유로는 다음과 같은 것들이 있습니다(여기에만 국한되지 
않음).

■ 논리 드라이브의 크기와 여기에 포함되어 있는 물리적 드라이브 수에 따라 고장난 
물리적 드라이브가 하나 이상 있는 논리 드라이브는 심각한 상태에서 작동할 수 있
습니다. 논리 드라이브의 상태와 이 논리 드라이브를 구성하는 물리적 드라이브의 
상태를 확인하려면 91페이지의 "논리 드라이브 보기"를 참조하십시오.

■ 전원 공급 장치, 팬 및 온도를 비롯하여 환경 구성 요소 중 두 가지 이상이 작동하지 
않지만 어레이는 작동하는 경우 엔클로저, 어레이 및 서버 아이콘이 심각한 상태를 
나타냅니다. 자세한 내용은 93페이지의 "엔클로저 보기"를 참조하십시오.

■ 제어기 장치가 펌웨어 응용프로그램을 사용한 설정한 임계치 범위를 초과하거나 충
족시키지 못하는 경우 제어기 아이콘이 심각한 상태를 나타냅니다. 자세한 내용은 
189페이지의 "제어기의 환경 상태 보기"을 참조하십시오.

■ Sun StorEdge 3510 FC Array나 Sun StorEdge 3511 SATA Array에서 저하된 상태는 
배터리가 만료되었음을 나타낼 수 있습니다. 배터리에 대한 자세한 내용은 100페이
지의 "배터리 정보"를 참조하십시오.
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장치 용량
Sun StorEdge Configuration Service 창은 논리 드라이브 같은 장치의 용량을 나타내는 
경우가 많습니다. 장치 용량은 모두 1024의 배수로 표시됩니다.

■ 1KB = 1024바이트
■ 1MB = 1024KB = 1,048,576바이트
■ 1 GB = 1024MB = 1,073,741,824바이트
■ 1TB = 1024GB = 1,099,511,627,776바이트

온라인 도움말
온라인 도움말에 액세스하려면 Help → Contents를 선택합니다. 온라인 도움말은 
HTML 형식이며 OS에 따라 Microsoft Internet Explorer 또는 Netscape Navigatorô에
서 실행될 수 있습니다. 온라인 도움말에는 프로그램의 주요 기능에 대한 정보가 포함
되어 있습니다.

제품 구성의트리 보기
각 서버(또는 서버 그룹)에서 트리 보기의 장치들은 맨 위에 서버(또는 그룹), 그 다음에 
어레이 제어기가 오는 식의 계층적 구조로 배열됩니다. 표시되는 어레이 및 제어기에 
따라 나머지 장치(논리 드라이브, 물리 드라이브 및 엔클로저)가 표시되는 방식은 약간 
다를 수 있습니다. 이 장에서는 트리 보기로 표시할 수 있는 창 보기를 제공합니다.

그룹

그룹은 장치 트리 내 서버의 논리 모음입니다. 이 새로운 데이터 객체로 복수의 서버가 
하나의 범주 아래에 포함될 수 있습니다. 

그룹 객체 는 전체 트리 객체처럼 표시되며 작동합니다. 이것은 아이콘 모양이며 일
반적으로 서버의 상태를 의미합니다. 다음 그림에서는 하위 또는 기본 서버 객체를 보
여주기 위해 확장된 그룹 아이콘을 보여줍니다.
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그룹은 복수의 서버가 하나의 범주 아래 포함되도록 하는 새로운 데이터 객체입니다. 
그룹은 개념상 도메인과 비슷합니다. 도메인을 통해 서버를 조직적으로 구성할 수 있습
니다. 관리되는 모든 서버의 선형 트리 대신 서버를 세트나 그룹으로 구성할 수 있습니
다.

그룹은 서버와 비슷하게 색상 및 기호로 구분됩니다. 해당 색상과 상태는 다음과 같은 
우선 순위를 갖습니다. 

■ 심각 – 빨간색(가장 높음)
■ 응답 없음 – 회색
■ 저하 – 노란색
■ 최적 – 보라색
■ 로그인되지 않음 – 흰색

서버 아이콘은 저장 장치 시스템에 대한 최상위 상태의 색상을 나타냅니다. 또한 서버
가 응답이 없거나 로그인되지 않은 다음의 경우를 제외하면 그룹 아이콘은 서버의 최상
위 상태를 나타냅니다.

그룹 아이콘이 선택 해제(비활성화)되면 이는 해당 그룹에 연결된 모든 서버가 응답하
지 않음을 나타냅니다. 또한 그룹의 전체 서버 수 이하의 서버가 응답하지 않는 경우 그
룹 아이콘이 빨간색으로 표시되면서 심각한 상태임을 나타냅니다. 예를 들어, 그룹에 
네 개의 서버가 있는데 세 개 이하의 서버가 응답하지 않는 경우 그룹 아이콘은 빨간색
으로 표시됩니다.
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그룹 아이콘이 흰색(로그인되지 않음)인 경우 해당 그룹 내에 있는 하나 이상의 서버가 
아직 완전히 구성되지 않았거나 상태 전환 중일 수 있습니다. 표 6-2에서는 두 서버 그룹
의 색상 구분을 보여줍니다. 

그룹이 반드시 필요한 것은 아닙니다. 예를 들어, 그룹이 없지만 15개의 서버가 있거나 
또는 하나의 그룹에 10개의 서버가 있고 최상위에 5개가 더 있도록 프로그램을 구성할 
수 있습니다. 프로그램에서는 모든 조합을 사용할 수 있습니다.

허용된 그룹의 수와 한 그룹 내의 서버 수는 사용 가능한 시스템 메모리에 의해서만 제
한됩니다. 서버가 그룹의 구성원인데 사용자가 그룹 목록 상자에서 해당 그룹을 삭제하
면 해당 그룹에 속한 서버는 그룹 없음 범주로 재할당됩니다. 트리는 기본 창에서 다시 
매핑됩니다.

모니터링 프로세스 
콘솔은 서버의 에이전트와 통신하여 네트워크 상에 있는 저장 장치를 모니터링합니다.

서버가 구성될 때 Auto Discovery가 지정된 경우 프로그램이 시작되면 각 관리 서버의 
에이전트와 통신하면서 콘솔 소프트웨어가 시작됩니다. Auto Discovery가 지정되지 
않은 경우 각 서버를 두 번 누르고 암호를 제공하여 해당 서버의 검색 프로세스를 시작
해야 합니다.

네트워크가 얼마나 복잡한지에 따라 콘솔과 각 서버의 에이전트 간에 TCP/IP 연결을 
설정하고 자원 목록 정보를 받는 데에는 몇 분 정도 걸릴 수 있습니다. 이 경우 기본 창
의 서버 아이콘 오른쪽에 위성 접시 아이콘이 표시됩니다. 자원 목록을 새로 고치면 위
성 접시 기호는 활성 서버 기호로 대체됩니다.

각 서버의 에이전트는 자원 목록을 주기적으로 검색하여 변경 사항을 확인합니다. 변경 
사항이 있으면 에이전트가 이벤트를 콘솔에 보냅니다. 이벤트에 따라 콘솔은 해당 서버
에 대한 마지막 검색으로부터 자원 목록을 요청하여 기본 창에 표시된 대로 서버 표시

표 6-2 두 서버 그룹의 색상

서버 1
 아이콘 색상

서버 2
 아이콘 색상 그룹 아이콘 색상

회색
회색

회색
노란색, 빨간색, 보라색 또는 흰색

회색(응답 없음)
빨간색(심각)

흰색 흰색 흰색(로그인되지 않음)

흰색 노란색 노란색(저하)

흰색 빨간색 빨간색(심각)

흰색
빨간색

보라색
모든 색상

보라색(최적)
빨간색(심각)

노란색
보라색

노란색 또는 보라색
보라색

노란색(저하)
보라색(최적)
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를 업데이트할 수 있습니다. 이 프로세스가 진행되는 동안 위성 접시 아이콘이 서버 아
이콘에 부착되며, 새로 고침 작업이 완료되고 콘솔 기본 창이 업데이트될 때까지 사용
자는 서버에서 구성 및 어레이 작업 명령을 실행할 수 없습니다.

프로그램이 실행 중이고 서버 에이전트와 콘솔이 연결되어 있으면 에이전트가 주기적
으로 신호를 콘솔에 ping하거나 전송하여 서버의 상태를 확인합니다. 콘솔이 일정한 수
의 연속적 응답(핸드셰이크)을 에이전트로부터 받지 못하면 콘솔은 서버를 오프라인으
로 표시하고 서버와의 연결을 끊습니다. 서버 아이콘은 비활성화되며 주위에 물음표 기
호가 표시됩니다.

원래 비활성 상태였던 서버를 Auto Discovery 기능으로 활성화한 경우 콘솔은 주기적
으로 서버와 다시 통신하려고 시도합니다.

경우에 따라 주기적으로 상태를 스캔할 때 서버에서 자원 목록을 검색해야 할 수 있습
니다. 이를 위해서는 서버 아이콘을 두 번 눌러 Server View 창을 표시한 다음 이 창에
서 Rescan을 누르면 됩니다.

자동 검색 옵션
Managed Servers 목록에 서버를 추가하는 중에 Auto Discovery 옵션을 선택한 경우
(14페이지의 "서버의 Automatic Discovery를 선택 또는 선택 해제합니다." 참조) 프로
그램은 자동으로 이들 서버에서 자원 목록에 대한 검색을 실행합니다. 프로그램에서 제
공하는 정보를 가져올 때는 모니터링 암호를 입력하지 않아도 됩니다. 네트워크의 복잡
성과 서버의 수에 따라 검색 작업을 완료하는 데 몇 분 정도 걸릴 수 있습니다.

그러나 시작할 때 Auto Discovery 옵션을 사용하지 않도록 선택한 경우 서버 아이콘은 
흰색으로 표시되며 이는 현재 이들 서버에 대해 제공할 수 있는 정보가 없음을 나타냅
니다. 이 경우 각 서버 아이콘을 두 번 눌러 해당 모니터링 암호를 지정해야 합니다. 

File ∅ Login을 선택해도 됩니다. 서버의 암호가 지정되면 검색 프로세스는 선택한 서
버에서 자원 목록에 대한 검색을 시작합니다. 

주 – 서버 자원 목록 데이터에 대한 액세스까지 제한하는 보안 수준이 높은 환경이 필
요한 경우에는 Auto Discovery에 대해 No를 선택하십시오(14페이지의 "서버의 
Automatic Discovery를 선택 또는 선택 해제합니다." 참조).
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장치의 상세 정보 보기 
Sun StorEdge Configuration Service는 각 에이전트 또는 서버의 상세 정보 및 여기에 
연결된 어레이 장치의 상세 정보를 제공합니다. 디스크 제어기의 기능에 따라 각 보기
의 필드는 다를 수 있습니다.

이 절에 설명되어 있는 명령은 File 메뉴 아래의 Save Report와 View Report를 제외하
고 View 메뉴에서 액세스합니다.

■ 그룹 보기
■ 서버 보기
■ HBA 카드 보기
■ 제어기 보기
■ 논리 드라이브 보기 
■ 물리 드라이브 보기 
■ 엔클로저 보기
■ FRU 보기
■ 어레이 관리 진행
■ 에이전트 옵션 관리
■ 보고서 저장
■ 보고서 보기

그룹 보기 
View Group에는 주 창에서 선택된 그룹에 포함된 서버가 표시됩니다.

View Group에 액세스하려면 기본 창에서 그룹 아이콘 을 두 번 누르고 View → 
View Group을 선택합니다.

Server List에 지정한 그룹에 연결된 모든 서버가 표시됩니다. 
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나열된 서버에 대한 상세 정보를 보려면 목록에서 해당 상태 레코드를 선택하고 View
를 누르거나 상태 레코드를 두 번 누릅니다. 해당 서버를 설명하는 창이 나타납니다.

서버 보기 
View Server에는 기본 창에서 선택한 서버의 특성이 표시됩니다.

View Server에 액세스하려면 기본 창에서 서버 아이콘 을 두 번 누르거나 서버 아이
콘을 선택하고 View → View Server를 선택합니다.
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TCP/IP 네트워크의 일부인 소켓 포트는 서버와 클라이언트 간을 연결합니다.

■ Card List - 지정한 서버에 연결되어 있거나 설치된 어레이 제어기 및 호스트 어댑터
를 표시합니다. 

주 – 이중 포트 HBA는 장치가 연결될 수 있는 별도의 채널을 갖기 때문에 별도의 항목
으로 표시됩니다.

■ Rescan - 선택한 서버에 명령을 보내 기존 자원 목록을 다시 검색하고 콘솔을 새로 
고칩니다. 일반적으로 각 관리 서버는 자원 목록을 주기적으로 스캔하며 변경 사항
이 있으면 콘솔을 업데이트합니다. 할당된 모든 장치를 진단하려면 Rescan을 누릅니
다. 이 버튼을 선택하면 주기적으로 상태를 자동 업데이트하는 데 방해가 됩니다.

■ Probe - 선택한 서버에 명령을 보내 새 자원 목록(예: RAID 제어기, JBOD 및 확장 장
치)을 조사합니다. 새 장치를 추가했거나 장치 이름을 변경한 경우 이러한 사항이 기
본 창의 트리 보기에 바로 표시되게 하려면 Probe를 누르십시오.
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HBA 카드 보기
View HBA Card에는 주 Sun StorEdge Configuration Service 창에서 선택된 HBA(호
스트 버스 어댑터) 카드의 특성이 표시됩니다. 이 창은 대역 외 관리를 사용할 때만 표시
됩니다.

View HBA Card에 액세스하려면 주 Sun StorEdge Configuration Service 창에서 호스
트 어댑터 아이콘  을 두 번 누르거나 HBA 아이콘을 선택하고 View → View HBA 
Card를 선택합니다.

View HBA Card에는 호스트 어댑터 카드와 해당 장치 드라이버의 장치가 표시되고 어댑터에 
연결된 장치의 목록이 나타납니다. Sun StorEdge Configuration Service 채널 번호는 0부터 
시작합니다. 창 맨위에 나열된 서버가 HBA가 설치된 서버입니다.
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제어기 보기
View Controller에는 어레이를 구성하는 구성 요소가 표시됩니다. 

View Controller에 액세스하려면 기본 창에서 어레이 아이콘 을 두 번 누르거나, 
어레이 아이콘을 선택하고 View → View Controller를 선택합니다. View Controller 
Configuration 창이 나타납니다.

창의 아래쪽에 있는 탭에서는 RAID 제어기의 LUN, 여기에 연결된 물리적 드라이브, 
제어기가 위치한 엔클로저, 주변 장치의 구성 등에 대한 상세 정보를 제공합니다. 다른 
탭의 정보를 보려면 탭을 누릅니다.

Controllers 탭

이 창에 액세스하려면 기본 창에서 어레이 아이콘 을 두 번 누르거나 어레이 아이
콘을 선택하고 View → View Controller를 선택합니다. 그런 다음 Controller 탭을 누릅
니다. 

Controller 탭에는 제어기 목록이 표시됩니다. 제어기에 대한 상세 정보를 보려면 해당 
제어기를 두 번 누르거나 해당 제어기를 선택하고 View를 누릅니다. 제어기가 주 제어
기인지 보조 제어기인지에 따라 View Primary Controller Configuration 창이나 View 
Secondary Controller Configuration 창이 나타납니다. 88페이지의 "View Primary 
Controller Configuration 및 View Secondary Controller Configuration"를 참조하십시
오. 
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Physical Drives 탭

이 창에 액세스하려면 기본 창에서 어레이 아이콘 을 두 번 누르거나 어레이 아이
콘을 선택하고 View → View Controller를 선택한 다음 Physical Drives 탭을 누릅니다. 

아래 예제에서는 Physical Drives 탭이 표시된 View Controller Configuration 창이

나타납니다. 

Physical Drives 탭에는 어레이와 연결된 물리적 드라이브의 목록이 나타납니다. 나열
된 물리 드라이브에 대한 상세 정보를 보려면 드라이브를 두 번 누르거나 드라이브를 
선택하고 View를 누릅니다. View Physical Drive 창이 나타납니다. View Physical 
Drive에 대한 자세한 내용은 92페이지의 "물리 드라이브 보기"를 참조하십시오.

Scan SCSI Drive

Sun StorEdge 3310 SCSI Array와 Sun StorEdge 3320 SCSI Array의 경우 드라이브가 
고장나면 Scan SCSI Drive 버튼이 표시됩니다. 어레이를 종료하지 않고도 SCSI 하드 드
라이브를 검색하여 사용할 수 있습니다.

Sun StorEdge 3510
FC Array의 경우
View FRU가
표시되지 않습니다 .

Sun StorEdge 3510
FC Array의 경우
Scan SCSI Drive
창이 표시되지
않습니다 .
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Identify Drive On

예를 들어, 특정 채널 ID에서 오류가 나타나서 이 오류를 초래한 드라이브를 확인해야 
할 경우에 물리적 드라이브 하나를 식별하려면 목록에서 해당 드라이브를 선택하고 
Identify Drive On을 누릅니다. 선택된 드라이브의 LED가 황색으로 바뀌고 버튼이 
Identify Drive Off로 전환됩니다. Identify Drive Off를 눌러 드라이브의 LED를 다시 
녹색으로 바꿉니다.

Enclosure Info 탭

이 창에 액세스하려면 기본 창에서 엔클로저 아이콘 을 두 번 누르거나 어레이 아
이콘 을 선택하고 View → View Controller를 선택합니다. Enclosure Info 탭을 선
택합니다. 그런 다음 엔클로저를 선택하고 View를 누릅니다.

Enclosure Info 탭에 있는 정보는 전원 공급 장치, 팬, 엔클로저 온도 등의 상태를 나타
냅니다. View Enclosure에 대한 자세한 내용은 93페이지의 "엔클로저 보기"를 참조하십
시오.

FRU 보기

(Sun StorEdge 3310 SCSI Array에만 해당) 어레이에 대한 FRU ID(현장 대체 가능 장치 
ID) 정보를 표시하려면 View FRU를 누릅니다. FRU ID 정보의 예는 103페이지의 "FRU 
보기"를 참조하십시오.
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제어기 매개변수 보기

채널, RS 232, 캐시, 디스크 어레이, 드라이브 I/F, 호스트 I/F, 중복성, 주변 장치, 네트워
크 매개 변수 및 지원되는 프로토콜에 대한 상세 정보를 보려면 View Controller 
Parameters를 누릅니다. 정보를 보려면 원하는 항목의 탭을 누릅니다. 제어기 매개변수
를 변경하려면 171페이지의 "제어기 매개변수 변경"을 참조하십시오.

채널 매개변수

제어기마다 RS-232 포트와 이더넷 포트 하나씩 있습니다. 이 아키텍처는 제어기 하나가 
고장나더라도 계속적인 통신을 보장합니다. 어레이가 중복 모드인 경우에도 통신이 한 
번에 한 제어기에만 설정되기 때문에 주 제어기에 대해 CurClk 및 CurWid 매개변수가 
표시됩니다. 따라서 사용자가 한 LUN을 주 제어기에 매핑하고 다른 LUN은 보조 제어
기에 매핑한 경우 주 제어기에 설정된 연결만 직렬 및 이더넷 포트 메뉴를 통해 표시됩
니다. 따라서, 주 ID가 채널에 매핑되지 않고 보조 ID가 매핑된 경우 CurClk 필드에 
"Async"가 표시됩니다. 

View Primary Controller Configuration 및 View Secondary Controller Configuration

View Primary Controller Configuration 창과 View Secondary Controller 
Configuration 창에는 기본 창에서 선택한 RAID 제어기의 특성이 표시됩니다. 주 제어
기의 특성을 표시하려면 기본 창에서 주 제어기를 선택하고 View → View Controller를 
선택하거나 주 제어기를 두 번 누릅니다.
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다음은 주 제어기의 두 가지 예입니다.

Sun StorEdge 3510
FC Array의 경우
View FRU가
표시되지 않습니다 .
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다음은 보조 제어기의 두 가지 예입니다.

Sun StorEdge 3510
FC Array의 경우
View FRU가
표시되지 않습니다 .
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논리 드라이브 보기
View Logical Drive에는 기본 창에서 선택한 논리 드라이브의 특성이 표시됩니다. 

이 보기 창에 액세스하려면 다음 중 한 방법을 사용하십시오. 

■ 기본 창에서 논리 드라이브 아이콘 을 두 번 누릅니다. 

■ 논리 드라이브 아이콘을 선택하고 View → View Logical Drive를 선택합니다. 

나열된 디스크 드라이브에 대한 자세한 내용은 드라이브의 상태 레코드를 두 번 누르거
나 드라이브를 선택한 후 View를 누릅니다. View Physical Drive 창이 나타납니다. 
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물리 드라이브 보기 
View → View Physical Drive를 선택하면 선택한 물리적 드라이브의 특성이 표시됩니
다. 이 창에 액세스하려면 기본 창에서 물리적 장치 를 두 번 누르거나 해당 장치를 
선택하고 View → View Physical Drive를 선택합니다.

■ Remaining Size – 물리적 드라이브의 용량 중 일부가 하나 이상의 논리 드라이브에
서 사용되는 경우 사용하지 않는 나머지 용량

■ RPM – 물리적 드라이브의 분당 회전 수

■ SMART Drive – 드라이브에 고장 예측 기능이 있는지 여부를 나타냅니다.

■ Node Name WWN(FC 및 SATA에만 해당) – 물리적 드라이브를 고유하게 식별합니
다.

■ Alternate I/O Path (FC 및 SATA에만 해당) – 제어기와 물리적 드라이브 사이의 사
용 가능한 경로의 상태를 보고합니다. 두 드라이브의 상태가 Active이면 이는 제어기
와 물리적 드라이브 사이에 중복 경로가 있음을 나타냅니다.

Sun StorEdge 3310
SCSI Array 또는 Sun
StorEdge 3320 SCSI
Array의 경우 Node
Name WWN과 Alternate
I/O Path가 표시되지
않습니다 .
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엔클로저 보기
View Enclosure 창에는 기본 창에서 선택한 어레이 엔클로저의 구성 요소 및 알람 특성
이 표시됩니다. Sun StorEdge 3511 SATA Array의 경우 SATA MUX 및 SATA Router 
정보도 View Enclosure에 나타납니다. 

SCSI의 경우 엔클로저는 모델 이름으로 식별되는데, Sun StorEdge 3310 A 또는 Sun 
StorEdge 3320 A는 ID가 항상 14 또는 15이고, Sun StorEdge 3120 A는 ID가 ID 스위치 
위치에 따라 달라집니다. FC 또는 SATA의 경우 엔클로저는 모델 이름으로 식별되는
데, Sun StorEdge 3510F A 또는 Sun StorEdge 3511F A는 ID가 항상 해당 SES가 포함되
어 있는 엔클로저의 마지막 ID입니다. 모델 이름 뒤에는 A 또는 D가 오는데 A는 RAID 
어레이 장치를 나타내고, D는 JBOD를 나타냅니다.

엔클로저를 보려면 볼 어레이의 엔클로저 아이콘 을 두 번 누르거나 엔클로저 아이
콘을 선택하고 View → View Enclosure를 선택합니다. 

창 위쪽의 두 영역은 엔클로저를 식별하고 관련 정보를 제공합니다. 엔클로저가 여러 
개 있는 경우에는 Enclosure Number 목록 상자를 사용하여 같은 제어기에 연결된 다른 
엔클로저를 반영할 수 있습니다.

Alarm State는 어레이에 SCSI Accessed Fault-Tolerant Enclosure(SAF-TE)(SCSI) 또는 
SCSI Enclosure Services(SES)(FC 또는 SATA) 카드가 있는 경우에만 적용됩니다. 

■ Alarm State 필드에 Alarm!이 나타나면 이는 드라이브, 팬, 전원 공급 장치 또는 배
터리의 고장으로 인한 알람이나 엔클로저의 이상 기온으로 인한 알람이 있음을 의미
합니다. 상자에서 경보음이 울립니다. 
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■ 알람 상태가 시작된 후에도 프로그램에서 계속 모니터링하게 하려면 이 어레이의 우
측 손잡이에 있는 Reset 버튼을 눌러야 합니다.

주 – 제어기 이벤트도 경보음을 울릴 수 있습니다. 제어기 이벤트로 인해 경보음이 울
린 경우에는 Reset 버튼을 눌러도 효과가 없습니다. 경고음 음소거에 대한 자세한 내용
은 193페이지의 "제어기 경고음 음소거하기"을 참조하십시오.

전원 공급 장치, 팬 및 온도 센서 위치에 대한 자세한 내용은 94페이지의 "환경 상태"를 
참조하십시오. the Sun StorEdge 3510 FC Array나 Sun StorEdge 3511 SATA Array에
서 배터리 정보를 표시하려면 Battery를 누르고 100페이지의 "배터리 정보"를 보십시오
. FRU ID와 어레이에 있는 모든 FRU의 정보를 표시하려면 View FRU를 누르고 103페
이지의 "FRU 보기"를 보십시오.

환경 상태
View Enclosure 창의 Environmental State 영역은 전원 공급 장치, 팬 및 온도의 상태를 
비롯하여 섀시 구성 요소의 상태를 보고합니다. 개별 구성 요소의 상태뿐 아니라 어레
이의 전체 환경 상태도 제공합니다. 제어기의 환경 상태에 대해서는 189페이지의 "제어
기의 환경 상태 보기"을 참조하십시오.

View Enclosure 창은 Firmware Rev 필드에서 SAF-TE(SCSI Accessed Fault-Tolerant 
Enclosure) 펌웨어 개정(SCSI Array)과 SES(SCSI Enclosure Services) 펌웨어 개정(FC 
및 SATA Array)을 지정합니다. I/O 모듈 위에 있는 SAF-TE 및 SES 프로세서는 환경 
상태를 모니터링합니다.

환경 구성 요소 중 하나 이상이 작동하지 않지만 어레이는 작동하는 경우 기본 창의 엔
클로저, 어레이 및 서버 아이콘이 노란색(저하) 장치 상태 기호 를 나타냅니다. 구성 
요소 중 하나 이상이 작동하지 않아 어레이가 심각한 상태가 된 경우 기본 창의 엔클로
저, 어레이 및 서버 아이콘이 빨간색(심각) 장치 상태 기호 를 나타냅니다. 장치 상태 
기호는 View Enclosure 창의 Summary 영역에 표시되는 전체 환경 상태에 해당합니다.

Component/Status 목록은 개별 구성 요소 상태를 보고하는데, 이 상태는 항상 어레이
의 전체 상태에 해당하지는 않습니다. 예를 들어, 전원 공급 장치 #0를 어레이에서 꺼내
면 어레이가 전원 공급 장치 #1을 사용하여 계속 작동하므로 노란색 장치 기호(저하)가 
기본 창에 표시됩니다.
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다음 View Enclosure 창 예제에서 볼 수 있듯이 Summary 아래의 Power에 대한 전체 
상태도 Degraded를 지정합니다 그러나, 개별 구성 요소 상태 아래의 Power Supply #0
은 Critical 상태를 표시합니다. 팬 #0은 전원 공급 장치 #0 안에 있기 때문에 
Critical. 상태를 표시합니다.
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전원 공급 장치 및 팬 위치

아래의 그림은 Sun StorEdge 3000 Family 어레이의 전원 공급 장치 및 팬 위치를 나타
낸 것입니다. Sun StorEdge 3120 SCSI Array의 전원 공급 장치 및 팬 위치에 대해서는 
215페이지의 "JBOD 모니터링"을 참조하십시오.

그림 6-1 Sun StorEdge 3310 SCSI Array 및 Sun StorEdge 3320 SCSI Array의 전원 공급 장치 
및 팬 위치

전원 공급 장치 #0
팬 #0

팬 #1

어레이 전면

전원 공급 장치 #1

우측 사이드

좌측 사이드
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그림 6-2 Sun StorEdge 3510 FC Array 및 Sun StorEdge 3511 SATA Array의 전원 공급 장치 
및 팬 위치

SAF-TE 및 SES 온도 센서 위치

어레이 내의 다른 지점에서 온도를 모니터링하는 것이 SAF-TE/SES의 가장 중요한 기
능 중 하나입니다. 고온일 때 모르고 지나치면 상당한 손상을 초래할 수 있습니다. 엔클
로저 내의 주요 지점에 각각 센서가 설치되어 있습니다. 다음 표에서는 각 센서의 위치
를 보여 주는데, View Enclosure Component/Status 목록에 표시된 Temperature #(온
도 번호)에 해당합니다. Sun StorEdge 3120 SCSI Array의 온도 센서 위치에 대해서는 
215페이지의 "JBOD 모니터링"을 참조하십시오. 

표 6-3 Sun StorEdge 3310 SCSI Array 및 Sun StorEdge 3320 SCSI Array의 SAF-TE 온도 센
서 위치 

온도 ID 위치

0 포트 A 드라이브 미드플레인 온도 센서 #1

1 포트 A 드라이브 미드플레인 온도 센서 #2

2 포트 A 전원 공급 장치 온도 #1(전원 공급 장치 #0)

3 포트 B EMU 온도 #1(후면에서 볼 때 좌측 모듈)

4 포트 B EMU 온도 #2(후면에서 볼 때 우측 모듈)

5 포트 B 드라이브 미드플레인 온도 #3

6 포트 B 전원 공급 장치 온도 #2(전원 공급 장치 #1)

전원 공급 장치 #1

전원 공급 장치 #0

어레이 전면

팬 #0

팬 #1

팬 #2

팬 #3

좌측 사이드

우측 사이드
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SES 전압 센서

전압 센서는 어레이의 전압이 정상 범위 내에 있는지 확인합니다. 상태를 확인하고 전
압 센서의 위치를 확인하려면 Sun StorEdge 3000 Family RAID Firmware Userís 
Guide를 참조하십시오.

표 6-4 Sun StorEdge 3510 FC Array 및 Sun StorEdge 3511 SATA Array의 SES 온도 센서 위
치

온도 ID 위치

0 드라이브 미드플레인 좌측 온도 센서 #1

1 드라이브 미드플레인 좌측 온도 센서 #2

2 드라이브 미드플레인 중앙 온도 센서 #3

3 드라이브 미드플레인 중앙 온도 센서 #4

4 드라이브 미드플레인 우측 온도 센서 #5

5 드라이브 미드플레인 우측 온도 센서 #6

6 상단 IOM 좌측 온도 센서 #7

7 상단 IOM 좌측 온도 센서 #8

8 하단 IOM 좌측 온도 센서 #9

9 하단 IOM 좌측 온도 센서 #10

10 하단 전원 공급 장치 온도 센서 #11

11 우측 전원 공급 장치 온도 센서 #12
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SATA MUX 및 SATA 라우터 정보
모든 SATA 드라이브의 SATA MUX(멀티플렉서) 보드 정보를 보려면 SATA MUX Info 
탭을 선택하십시오. 각 드라이브는 MUX 보드 위에 있습니다. MUX 보드에 대한 정보
에는 해당 MUX 보드에 연결된 드라이브의 채널 번호와 ID, MUX 브드 일련 번호, 
MUX 보드 유형(활성-수동 또는 활성-활성), 경로 제어기(PC150) 펌웨어 개정 번호 및 
펌웨어 부트 개정이 포함되어 있습니다.

RAID 제어기 뒤에 있는 액세스 가능한 모든 SATA 라우터를 보려면 SATA Router 탭을 
누릅니다. SATA 라우터가 있는 섀시의 엔클로저 ID 및 엔클로저 일련 번호, 라우터가 
제어하는 채널 번호, 라우터가 있는 IOM 보드의 슬롯 위치, 라우터 펌웨어 개정 번호, 
라우터 펌웨어 부트 개정, CSB(고객 지정 동작) 개정(라우터의 운영 동작을 정의하는 메
모리 상주 매개변수의 모음), 하드웨어 개정 번호 및 자체 테스트 개정 번호 같은 정보가 
표시됩니다.
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배터리 정보

주 – Sun StorEdge 3120 SCSI Array, Sun StorEdge 3310 SCSI Array 또는 Sun 
StorEdge 3320 SCSI Array에는 Battery Information 창이 적용되지 않습니다.

전원이 끊기더라도 배터리가 72시간 동안 계속 캐시에 전원을 공급합니다. 전원이 다시 
켜지면 캐시의 데이터가 디스크로 덤프됩니다. Sun StorEdge 3510 FC Array에서는 
Sun StorEdge Configuration Service가 배터리의 유효 수명을 모니터링하여 Battery 
Information 창에 그 상태를 표시합니다. 프로그램이 공장에서 프로그래밍된 배터리 종
류, 제조일자 및 사용 날짜를 사용하여 배터리 만료 날짜를 계산합니다. 
100 Sun StorEdge 3000 Family Configuration Service 2.0 사용 설명서 •  2005년 7월



주 – 배터리 FRU의 경우 Sun StorEdge Configuration Service가 102페이지의 "배터리 
교체 시 사용 날짜를 확인하려면"에 설명된 대로 설정할 수 있도록 사용 날짜를 확인해
야 합니다. 

배터리 만료일 21일 전에 기본 창의 엔클로저 아이콘이 저하(노란색) 상태를 표시합니
다. 배터리 FRU에 사용 날짜가 설정되지 않은 경우에는 엔클로저 아이콘이 경고(노란
색) 상태도 표시합니다. 배터리가 만료되면 심각한(빨간색) 상태가 표시됩니다. 장치 상
태 기호의 설명을 보려면 75페이지의 "장치 상태"를 참조하십시오. 

배터리 상태를 보려면 View → View Enclosure를 선택하거나 엔클로저를 두 번 누릅니
다. Summary 상자에 배터리 상태가 표시된 View Enclosure 창이 나타납니다.

종류, 상태, 제조일자, 사용 날짜 및 만료일자를 비롯한 배터리 정보를 보려면 Battery를 
누릅니다. Battery Information 창이 나타납니다.

주 – 배터리 종류가 초기 보드 모듈(FRU ID 370-5545 REVB)인 경우 배터리 만료일자
를 모니터링할 수 없습니다. 
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▼ 배터리 교체 시 사용 날짜를 확인하려면

Sun StorEdge Configuration Service가 배터리 FRU를 감지하면 다음 예제에서 볼 수 
있듯이 엔클로저 아이콘이 저하(노란색) 상태 기호를 표시합니다.
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1. 엔클로저 아이콘을 두 번 누릅니다.

Sun StorEdge Configuration Service는 호스트 시계를 기준으로 사용 날짜(배터리가 서
비스 상태로 들어간 날짜)를 사용하여 배터리 만료일자를 계산합니다. 프로그램이 다음 
메시지를 표시하여 날짜를 확인합니다.

2. 호스트 시계가 정확한 경우 Yes를 누릅니다.

다음과 같은 확인 메시지가 나타납니다. OK를 누릅니다.

Sun StorEdge Configuration Service가 사용 날짜를 설정하여 Battery Information 창
의 In-Service Date 필드에 이 날짜를 표시합니다.

3. 호스트 시계가 틀리면 No를 누르고, Sun StorEdge Configuration Service가 다시 확
인하고 사용 날짜를 설정하도록 시계를 재설정합니다.

주의 – 재설정하지 않고 사용 날짜를 확인하면 Sun StorEdge Configuration Service가 
배터리 만료 날짜를 정확하게 계산할 수 없습니다.

FRU 보기
FRU는 현장 대체 가능 장치입니다. FRU는 현장에서 새로운 시스템을 조립하거나 시스
템을 복구하는 데 사용됩니다. Sun FRU ID 프로그램은 FRU 고유의 구성, 진단 및 FRU
에서 나타나는 오류 정보를 캡처, 전송 및 분석하기 위해 Sun에서 널리 사용하는 솔루
션입니다. 
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Serial Number, Model, Description, Vendor ID, Time(해당 FRU가 프로그래밍된 시
간) 및 Location을 비롯하여 어레이에 있는 모든 FRU의 FRU ID와 관련 정보를 표시하
려면 View → View FRU를 선택합니다 .

주 – 또한 Sun StorEdge 3310 SCSI Array의 경우 View Controller Configuration 창, 
View Primary Controller Configuration 창 및 View Secondary Controller 
Configuration 창에서 View FRU를 눌러 특정 구성 요소에 대한 FRU도 볼 수 있습니다.

어레이 관리 진행
Array Admin Progress에는 새 논리 드라이브 초기화 작업의 진행률이 표시됩니다. 이 
명령에 액세스하려면 View → Array Admin Progress를 선택합니다.

에이전트 옵션 관리
Agent Options을 사용하면 폴링 시간, 장치 검색 주기, SMART 모니터링 등의 에이전
트 옵션을 사용자 정의할 수 있습니다.

Agent Options에 액세스하려면 View → Agent Options Management를 선택합니다. 
자세한 내용은 22페이지의 "에이전트 매개변수를 구성하려면"을 참조하십시오.
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이벤트 로그
콘솔은 관리 서버와 콘솔 자체에서 생성한 이벤트를 수신, 기록 및 표시합니다.

대부분의 이벤트는 관리 서버의 에이전트에서 생성하며 다음과 같은 경우 발생합니다.

■ 장치 오류, 고장, 연결 해제 등으로 인한 서버 자체 및 관리 서버의 장치 중 일부에 변
경이 있는 경우

■ 장치 추가 또는 삭제 등의 자원 목록 변경

■ 초기 구성 설정 및 후속 구성 변경 등의 구성 변경

■ 서버에서 실행 중인 어레이 프로세스(초기화, 패리티 검사, 재구성)

어레이 프로세스를 초기화하는 것은 콘솔이지만 이 프로세스가 서버에서 시작된 후에 
작업 알림 이벤트를 생성하는 것은 서버 에이전트입니다. 오류 발생 시 지정된 목록으
로 전자 우편 메시지를 보내는 것을 비롯하여 전체 이벤트 모니터링 및 전자 우편 통지 
기능에 대한 자세한 내용은 235페이지의 "전자 메일과 SNMP"를 참조하십시오.

콘솔은 훨씬 적은 수의 이벤트를 생성합니다. 예를 들어, Configuration Service는 관리 
서버에서 일정한 수의 연속적 하트비트를 받지 않는 경우 이벤트를 생성합니다.

콘솔은 이벤트를 수신하면 이 이벤트를 이벤트 로그 파일 eventlog.txt에 기록하고 
Event Log 창에 표시합니다. 이벤트가 서버에서 발생하면 해당 서버의 OS 이벤트 로그
로 이벤트 통지가 보내집니다. 또한 서버에서 이벤트가 발생하고 서버가 트랩을 HP 
OpenView와 같은 SNMP 엔터프라이즈 관리 콘솔로 보내도록 설정된 경우에는 서버 
에이전트도 트랩 메시지를 해당 컴퓨터에 보냅니다.

콘솔은 수신된 이벤트에 따라 관련 서버에 대한 마지막 정기 스캔으로부터 자원 목록을 
요청하기 위해 새로 고침 프로세스를 초기화할 수 있으므로 기본 창에서 서버의 자원 
목록을 업데이트할 수 있습니다. 

이 새로 고침 프로세스가 진행되는 동안 위성 접시 아이콘은 서버 아이콘에 부착되어 
있으며 새로 고침 작업이 완료되고 기본 창이 업데이트될 때까지 서버에서 구성 및 어
레이 작업 명령을 실행할 수 없습니다.
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이벤트 로그 파일
Event Log 창에는 한 번에 최대 500개의 이벤트가 표시될 수 있습니다. 이벤트가 500개 
넘게 있으면 최신의 500개만 Event Log 창에 표시됩니다. 그러나, Sun StorEdge 
Configuration Service에서는 이벤트가 10,000개 이상 기록될 때까지 이벤트 로그 파
일, eventlog.txt에서 이벤트를 삭제하지 않습니다.

■ 이벤트 수가 10,000개 이상이 되면 프로그램은 이벤트 로그 파일을 최근 500개의 이
벤트로 줄이고, 최대 한도인 10,000개를 다시 초과할 때까지 이벤트를 축적합니다.

■ 각 이벤트 레코드의 필드는 세미콜론으로 구분되기 때문에 파일을 데이터베이스로 
쉽게 가져올 수 있습니다.

■ eventlog.txt 는 콘솔 프로그램 파일이 설치된 디렉토리에 있습니다.

주 – 이벤트 로그에 관리되는 어레이의 이벤트가 모두 포함되어 있지 않으면 콘솔을 닫
았다가 다시 여십시오.

에이전트의 이벤트는 콘솔이 실행되고 있지 않더라도 해당 에이전트가 설치된 호스트
의 시스템 로그에 기록됩니다. 다음 표에서는 각 OS에 이벤트가 기록되는 위치에 대해 
설명합니다. 

표 6-5 이벤트 로그 위치

OS 이벤트 로그 위치

Solaris OS /var/adm/messages 

(콘솔에도 나타남)

Linux OS /var/log/messages

Microsoft Windows OS Event Viewer를 사용하면 볼 수 있는 시스템의 응용프
로그램 로그. 이벤트 로그를 다음 파일에서 직접 읽을 
수 있습니다.
\Program Files\Sun\sscs\eventlog.txt 

HP-UX OS /var/adm/syslog/syslog.log
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▼ IBM AIX 호스트의 경우 로그 파일에 이벤트 쓰기
IBM AIX OS의 경우 기본적으로 이벤트 로그가 기록되지 않습니다. 로그 파일에 쓸 수 
있도록 /etc/syslog.conf를 변경해야 합니다. 

1. 다음과 같이 아래의 행을 추가하도록 /etc/syslog.conf를 수정합니다.

2. 추가된 행에 지정된 파일이 존재하는지 확인합니다. 

지정된 파일이 없으면 만들어야 합니다. 예를 들어, 위의 구성에서 /tmp/syslog라는 
파일을 만듭니다.

3. 다음 명령을 입력하여 /tmp/syslog로 변경하고 syslog를 다시 시작합니다.:

이벤트 로그 창
Event Log 창에 액세스하려면 View → Event Log를 선택합니다. Close를 눌러 이 창을 
숨길 수 있습니다. 그런 다음 View 메뉴에서 내용을 그대로 다시 열 수 있습니다.

*.info /tmp/syslog rotate size 1000k

kill -HUP ëcat /etc/syslog.pidë
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콘솔은 실행 중인 경우 Event Log 창이 열려 있는지 여부와 관계없이 이벤트를 수신하
기 시작합니다.

1. 이벤트 로그 파일을 삭제하려면 Delete Logfile을 누릅니다. 

로그 파일을 저장하라는 메시지가 표시되는 확인 창이 나타납니다.

주 – 이벤트 로그 파일을 삭제하려면 서버가 온라인 상태여야 합니다.

2. 다음 옵션 중 하나를 선택합니다.

■ 프롬프트에서 yes를 선택한 후 폴더와 파일 이름을 선택하고 로그 파일을 저장합니
다. 

■ 프롬프트에서 no를 선택합니다.

로그 파일의 내용이 삭제됩니다.

주 – 도구 모음의 Save Event Log 및 Delete Event Log 아이콘을 사용하여 
eventlog.txt의 내용을 저장하고 삭제할 수도 있습니다.

각 이벤트 레코드에는 다음 표와 같은 필드가 포함되어 있습니다.

표 6-6 Event Record 필드

Date(날짜) 서버에서 이벤트가 발생한 날짜

Time(시간) 서버에서 이벤트가 발생한 시간

Server(서버) 서버의 IP 주소 및 서버 이름

Card(카드) 이벤트의 카드 이름(해당되는 경우)

Severity(심각도)
심각도 수준은 Critical, Warning 또는 Informational 중 하나입니다. 
이들 상태에 대한 자세한 내용은 다음 하위 단원을 참조하십시오.

Error Code(오류 코드) 대시로 구분된 기본 오류 코드와 확장 오류 코드

Text Message
(텍스트 메시지)

이벤트를 설명하는 텍스트 메시지
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심각도 수준
■ Critical – 네트워크 관리자의 작업이 필요하다는 메시지로, 장치, 전원 공급 장치 또
는 팬에 문제가 생긴 경우입니다.

■ Warning – Warning 메시지는 일반적으로 내부 프로그램 이벤트를 나타냅니다. 이런 
메시지가 자주 나타나면 서버나 네트워크에 문제가 있을 수 있습니다.

■ Informational – 서버의 장치에 대한 메시지로, 네트워크 관리자의 작업이 필요 없는 
경우입니다.

선택한 수준 및 그 이상 수준의 알람을 전달 받습니다. 따라서 Informational을 선택하
면 모든 알람 상태에 대한 통지를 받습니다. 그러나 Critical을 선택하면 Critical 알람에 
대해서만 통지를 받게 됩니다.

메시지에 대한 자세한 설명은 251페이지의 "문제 해결"을 참조하십시오. 

보고서 저장 
Save Report 옵션을 사용하면 프로그램에서 사용할 수 있는 특정 어레이의 모든 정보가 
포함된 XML 파일을 만들 수 있습니다.

1. File → Save Report를 선택합니다. 

Exportable to spreadsheets 옵션을 사용하면 스프레드시트로 내보낼 수 있도록 분리자
(쉼표, 세미콜론, 탭, 콜론 및 세로 막대)를 사용하여 보고서를 저장할 수 있습니다.
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2. Save report를 선택합니다. 

Save Report File 창이 나타납니다.

3. 파일을 식별할 수 있는 파일 이름을 입력하고 Save를 누릅니다. 

자원 목록 및 선택한 서버의 상태와 해당 장치에 대한 보고서가 기록됩니다. 

보고서 파일의 기본 저장 위치는 설치 디렉토리이고 기본 파일 확장자는 .xml입니다. 
저장 보고서의 서브 디렉토리를 만들어 설치 디렉토리를 차지하지 않도록 하는 것이 좋
습니다.

보고서에는 다음 정보가 포함됩니다.

■ 어레이에 대한 일반적인 세부 사항
■ 어레이 이름, 상태, 제조업체, 모델
■ 펌웨어 버전
■ 부트 레코드 버전
■ MAC, IP, 네트마스크 및 게이트웨이 주소
■ 제어기의 일련 번호

■ 어레이 구성에 대한 일반적인 개요
■ 논리 드라이브, 논리 볼륨 및 분할 영역의 총 개수

■ 제어기 매개변수
■ 호스트 및 드라이브 채널 설정 및 ID

■ 각 논리 드라이브의 상세 목록
■ RAID 수준
■ 논리 드라이브에 있는 물리 드라이브의 수 및 크기
■ 논리 드라이브 당 분할 영역의 수와 크기 및 매핑

■ SAF-TE/SES 정보
■ FRU 목록
■ 물리적 드라이브의 세부 사항
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다음은 .xml 형식의 Sun StorEdge 3510 FC Array에 대한 예제 보고서에서 발췌한 것
으로, 다른 프로그램의 입력으로 사용할 수 있습니다. 

코드 예 6-1 Sun StorEdge 3510 FC Array 보고서에서 발췌한 내용

<raidbaseview>
    <raidsystem>
        <name> SUN StorEdge 3510 A-A Array SN#000198 </name>
        <status>Good</status>
        <manufacturer>SUN</manufacturer>
        <model>StorEdge 3510</model>
        <firmware_version>3.27K</firmware_version>
        <bootrecord_version>1.31H</bootrecord_version>
        <mac_address>00:C0:FF:00:01:98</mac_address>
        <ip>206.235.238.198</ip>
        <netmask>255.255.255.0</netmask>
        <gateway>206.235.238.1</gateway>
        <primary_sn>3341275</primary_sn>
        <secondary_sn>3341258</secondary_sn>
        <controller_name>198</controller_name>
        <unique_id>198</unique_id>
        <id_of_nvram_defaults>327K 3510 v2.39</id_of_nvram_defaults>
        <total_logical_drives>8</total_logical_drives>
        <total_logical_volumes>0</total_logical_volumes>
        <total_partitions>278</total_partitions>
        <total_physical_drives>24</total_physical_drives>
        <total_safte_ses_devices>1</total_safte_ses_devices>
        <cache_size>1024MB ECC SDRAM</cache_size>
        <cpu>PPC750</cpu>
        <battery>Good</battery>
        <node_name>206000C0FF000198</node_name>
        <fru>
            <idx>0</idx>
            <item></item>
            <serial_number></serial_number>
            <revision></revision>
            <vendor_jedec_id></vendor_jedec_id>
            <manufacturing_date></manufacturing_date>
            <manufacturing_location></manufacturing_location>
6 장 어레이 모니터링 111



보고서 보기 
생성된 보고서를 검토하려면 View Report 옵션을 사용하십시오.

1. File → View Report를 선택합니다. 

보고서를 선택할 수 있는 Open 대화 상자가 나타납니다.

2. 검토하려는 보고서를 선택하고 Open을 누릅니다.

대역 외 저장 장치 관리 
대역 외 저장 장치 관리 기능으로 TCP/IP를 사용하는 네트워크 상의 어레이를 모니터
링하고 관리할 수 있습니다. 실제로 저장 장치에 연결된 서버에서 에이전트가 실행 중
이어야 하는 대역 내 저장 장치 관리(저장 장치 관리의 표준 방법)와는 달리, 대역 외 저
장 장치 관리는 실제로 저장 장치에 연결된 서버에서 에이전트가 실행 중이 아니어도 
됩니다. 대역 외 저장 장치 관리를 사용하면 저장 장치에 연결된 서버가 종료되더라도 
모니터링 및 유지 보수에는 영향을 주지 않습니다.

다음 그림에서는 대역 내 및 대역 외 저장 장치 관리 구성을 보여줍니다.
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그림 6-3 대역 내 관리

대역 외 관리용으로 어레이를 구성하는 방법에 대한 자세한 내용은 235페이지의 "전자 
메일과 SNMP"를 참조하십시오.

그림 6-4 대역 외 관리

 콘솔

1.1.1.1

SCSI/FC SCSI/FC

어레이

1.1.1.3 1.1.1.4에이전트 1.1.1.2

콘솔이 이더넷을 통해
서버 1.1.1.1에 설치된

 

 

에이전트와 통신합니다 . 에이전트는
SCSI/FC 연결을 통해
어레이와 통신합니다 .

1.1.1.1

SCSI/FC RJ45

어레이

1.1.1.2 1.1.1.3

1.1.1.4

1.1.1.0

에이전트

SCSI/FC

콘솔 및

콘솔은 서버 1.1.1.4에 설치된

 
 

에이전트와 통신합니다 . 에이전트는
이더넷을 통해 어레이와 직접
통신합니다 .
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▼ 대역 외 관리를 사용하려면

주 – 제어기, SAF-TE, SES, PLD 및 드라이브 펌웨어는 대역 외 관리를 통해 업그레이드
할 수 없습니다.

주 – 보안 상의 이유로 대역 외에서 관리하기 위해 어레이에 IP 주소를 할당한 경우 공
개적으로 라우트 가능한 네트워크 보다 개인 네트워크의 IP 주소를 사용해 보십시오. 
제어기 펌웨어를 사용하여 제어기에 암호를 설정하면 어레이에 무단으로 액세스할 수 
없습니다. 펌웨어의 Network Protocol Support 설정을 변경한 경우 HTTP, HTTPS, 텔
넷, FTP 및 SSH 같은 개별 프로토콜을 사용하여 어레이에 원격으로 연결되는 기능을 
해제하면 보안을 향상시킬 수 있습니다. 자세한 내용은 Sun StorEdge 3000 Family 
RAID Firmware Userís Guide에서 "Communication Parameters" 절을 참조하십시오.

1. 어레이의 정적 또는 동적 IP 주소를 설정해야 합니다.

프로그램이 대역 내 방법을 사용하여 어레이를 관리하도록 이미 구성된 경우 Change 
Controller Parameters(제어기 매개변수 변경)를 통해 IP 주소를 설정할 수 있습니다. 
IP 주소를 설정하려면 190페이지의 "Peripheral Device Status 상자에서 스크롤 막대를 
클릭하고 아래쪽으로 스크롤하여 환경 상태 정보를 표시합니다."를 참조하십시오. 프로
그램이 아직 구성되지 않은 경우에는 RS-232 터미널을 통해 IP 주소를 설정할 수 있습
니다. 해당 어레이의 Sun StorEdge 3000 Family 설치, 작동 및 서비스 설명서를 참조하
십시오.

2. IP 주소를 설정한 후에는 제어기를 재설정합니다. 

Array Administration → Controller Maintenance를 선택한 다음 Reset the Controller
를 누릅니다.

3. 서버를 선택합니다.

4. View → Agent Options Management를 선택합니다. 

5. IP Address 필드에 어레이의 IP 주소를 입력하고 Add를 누릅니다.

6. 펌웨어 응용프로그램을 사용하여 어레이에 대한 암호를 설정한 경우에는 Password 필
드에 해당 암호를 입력한 다음 Verify Password 필드에 다시 한 번 입력합니다.

주 – 기본적으로 어레이에 암호는 설정되어 있지 않습니다. 암호를 만들고 변경하는 방
법에 대한 자세한 내용은 해당 어레이의 Sun StorEdge 3000 Family RAID Firmware 
Userís Guide를 참조하십시오.

7. Out-Of-Band Agent preferred over In-Band 확인란을 선택하고 OK를 누릅니다. 
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주 – 이 옵션을 선택하면 대역 외 관리가 저장 장치를 관리하는 데 기본적으로 사용됩
니다. 대역 외 구성이 제거되면 프로그램은 사용자가 서비스를 시작/다시 시작한 후에 
대역 내 저장 장치 및 모니터링으로 되돌립니다.
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8. 프로그램이 대역 외 어레이를 인식하고 기본 창에서 대역 외 HBA 아이콘을 표시하도
록 서버에 Probe명령을 보내야 합니다.

View → View Server를 선택한 다음 Probe를 누릅니다.

9. 어레이를 관리하도록 프로그램을 구성하지 않은 경우에는 제어기를 관리할 서버를 할
당해야 합니다.

Array Administration → Controller Assignment를 선택합니다. Server to manage this 
controller 목록에서 서버를 선택하고 Apply를 누릅니다.

대역 외 HBA가 기본 창에 표시되고 View HBA Card의 View 메뉴의 메뉴 표시줄에 표
시됩니다.

주 – 대역 외 HBA가 창에 표시되지 않으면 제어기를 재설정하십시오.
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▼ 대역 외 관리에서 어레이를 제거하려면
1. 서버를 선택합니다.

2. View → Agent Options Management를 선택합니다.

3. 제거할 어레이의 IP 주소를 선택하고, Remove, OK를 차례로 누릅니다.

HBA가 기본 창에 표시된 채로 있습니다. 표시되지 않도록 하려면 관리 서버를 할당 해
제하고 다시 할당해야 합니다.

4. 기본 창에서 Array Administration → Controller Assignment를 선택합니다.

5. 서버의 할당을 해제할 어레이 제어기를 선택합니다.

6. Server to manage this controller 목록 상자에서 아무 것도 선택하지 않고 Apply를 누
릅니다.

7. Close를 확인합니다.

8. 19페이지의 "제어기를 관리할 서버를 할당하려면"의 단계를 따라 관리 서버를 다시 할
당합니다.
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웹을 통한 저장 장치 관리 
웹 기반 저장 장치 관리 기능을 사용하면 웹을 통해 어레이를 편리하게 관리할 수 있습
니다. 다음 절차는 웹 기반 관리를 위해 어레이를 설정하는 방법과 웹 브라우저를 통해 
액세스하는 방법입니다. 

주 – 이 기능을 사용하려면 Solaris 호스트에 Sun StorEdge Enterprise Storage 
Manager Topology Reporter(Sun StorEdge Enterprise Storage Manager 소프트웨어에 
포함)를 설치해야 합니다. 자세한 내용은 해당 어레이의 릴리스 정보에서 ìOther 
Supported Softwareî 절을 참조하십시오.

주 – 이 기능은 에이전트가 Linux 호스트에 설치된 경우 Linux 호스트에서 지원되지 
않으며, Custom Configure 창의 Configure Web Server 옵션을 사용할 수 없습니다. 
Linux 웹 브라우저를 사용하여 콘솔을 로드할 수 있지만 에이전트는 Solaris OS를 실행
하는 시스템에 설치해야 합니다.

웹 브라우저 요구 사항 
Sun StorEdge Enterprise Storage Manager Topology Reporter는 동일 네트워크에 연
결된 모든 시스템에서 URL을 통해 볼 수 있습니다. 이때 Solaris 호스트 시스템에서 계
정을 갖고 있어야 합니다.

UNIX OS
■ Netscape Navigator 4.79 
■ Java 플러그인 1.2.2_02

주 – IBM AIX OS의 경우 1.3 이전 버전의 Java Plug-in 소프트웨어는 지원되지 않습니
다.
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Microsoft Windows OS
■ Microsoft Internet Explorer(비전 5.0 이전 버전은 지원되지 않음)
■ Java Plug-in 1.2.2_02 소프트웨어

또는

■ Netscape Navigator 4.76
■ Java 플러그인 1.2.2_02 소프트웨어

어레이 설정
웹에서 어레이에 액세스하는 데 사용할 시스템에 전체 Sun StorEdge Configuration 
Service 패키지를 로드할 필요는 없지만 몇몇 프로그램 파일은 필요합니다. 따라서 전
체 Sun StorEdge Configuration Service 패키지를 다른 서버에 설치하여 어레이로 파일
을 전송할 수 있도록 해야 합니다. 다음 절차는 웹 관리를 설정하는 데 필요한 파일을 편
리하게 전송하는 방법입니다.

1. 네트워크에서 어레이로의 이더넷 연결이 있고 어레이의 IP 주소를 설정했어야 합니다.

2. 전체 Sun StorEdge Configuration Service 패키지가 설치된 서버에서 Configuration 
→ Custom Configure를 선택합니다.

3. Configure Web Server를 선택합니다.

4. 저장 장치에 직접 연결된 서버에서 실행되는 관리 에이전트의 IP 주소를 확인합니다.

5. 파일을 전송할 어레이의 IP 주소를 입력하고 OK를 누릅니다.

주 – 기본적으로 어레이에 암호는 설정되어 있지 않습니다. 펌웨어 응용프로그램을 사
용하여 암호를 만든 경우에는 해당 암호를 입력해야 합니다. 암호를 만들고 변경하는 
방법에 대한 자세한 내용은 해당 어레이의 Sun StorEdge 3000 Family RAID Firmware 
Userís Guide를 참조하십시오.
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파일이 전송되면 확인 메시지가 나타나고 웹을 통해 콘솔에 액세스할 수 있습니다.

▼ 웹 브라우저에서 콘솔에 액세스하려면
1. 웹 브라우저를 엽니다.

2. 다음 URL 주소를 입력합니다.

3. 이 설명서의 해당 장에 설명된 대로 저장 장치의 모니터링, 유지 보수 및 업데이트를 계
속하십시오.

http:// ip address of controller/esm.html
120 Sun StorEdge 3000 Family Configuration Service 2.0 사용 설명서 •  2005년 7월



7 장

어레이 유지 보수 

이 장에서는 Array Administration(어레이 관리)을 사용하여 어레이의 무결성을 관리
하는 방법에 대해 설명합니다. 이 장에서 다루는 내용은 다음과 같습니다.

■ 122페이지의 "어레이 관리 작업"
■ 122페이지의 "패리티를 검사하려면"
■ 123페이지의 "패리티 검사를 예약하려면"
■ 125페이지의 "물리 디스크에서 불량 블록 검색(매체 검색)"
■ 128페이지의 "논리 드라이브 또는 물리 드라이브에서 매체 검색 중지"

■ 128페이지의 "실패한 드라이브"
■ 129페이지의 "대기 드라이브를 사용하여 드라이브 자동 재구성"
■ 130페이지의 "대기 드라이브 없이 드라이브 재구성"
■ 130페이지의 "재구성 프로세스의 진행률을 확인하려면"
■ 131페이지의 "실패한 드라이브를 수동으로 재구성"
■ 132페이지의 "논리 드라이브 구성 복원"

■ 135페이지의 "제어기 유지 보수 옵션"
■ 135페이지의 "제어기 재설정"
■ 136페이지의 "제어기 종료"
■ 136페이지의 "제어기 경고음을 음소거하려면"
■ 137페이지의 "실패한 제어기를 다시 온라인 상태로 가져오기"
■ 137페이지의 "성능 통계를 표시하려면"
■ 138페이지의 "제어기 부트 시간 알아내기"
■ 139페이지의 "이중 제어기 어레이를 단일 제어기 어레이로 변환"
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어레이 관리 작업
초기화, 드라이브 재구성, 패리티 검사 등의 어레이 관리 작업은 관련 논리 드라이브나 
물리 드라이브의 크기에 따라 시간이 오래 걸릴 수 있습니다.

프로세스 중 하나가 시작되면 Controller Array Progress 창이 나타납니다. 창을 닫은 
경우 진행률을 보려면 Progress Indicator 아이콘 을 클릭하거나 View → Array 
Admin Progress를 선택합니다. Abort를 클릭하여 언제라도 프로세스를 중지할 수 있
습니다. 

▼ 패리티를 검사하려면    
패리티 검사는 결함 허용 논리 드라이브(RAID 1, 3 및 5)에 있는 중복 데이터의 무결성
을 검사하는 프로세스입니다. RAID 3 및 5 구성에 대한 논리 드라이브의 패리티 검사 
절차는 각 논리 드라이브의 RAID 스트라이프 세트에 있는 데이터 스트라이프의 패리
티를 다시 계산하여 이를 저장된 패리티와 비교합니다. 불일치가 발견되면 오류를 보고
하고 저장된 패리티를 올바른 패리티로 대체합니다. RAID 1 구성의 경우 불일치가 발
견되면 데이터가 마스터 디스크에서 슬레이브 디스크로 복사됩니다. 패리티를 재생성
할 때 불량 블록이 발견되면 데이터가 다른 디스크(마스터 또는 슬레이브)에서 불량 블
록을 재할당하는 보고 디스크 드라이브로 복사합니다.

1. 패리티 검사를 실행하려는 논리 드라이브를 선택합니다.

2. Array Administration → Parity Check를 선택합니다.

주 – 이 메뉴의 옵션에 액세스하려면 ssadmin 또는 ssconfig로 로그인해야 합니다.
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3. Logical Drive Parity Check 창이 나타나면 패리티 검사를 실행할 논리 드라이브를 선
택합니다.

여러 드라이브에서 패리티 검사를 실행하려면 Array Administration → Schedule 
Parity Check 명령을 선택하여 곧(예: 3분 이내) 실행되도록 패리티 검사를 예약합니
다. 예약된 패리티 검사가 실행되면 자동으로 패리티 검사를 하나씩 실행합니다.

4. 패리티 검사 프로세스를 시작하려면 Parity Check 버튼을 클릭합니다.

패리티 검사가 시작되면 Progress Indicator가 자동으로 나타납니다. 이 창이 닫혀 있는 
경우 View → Array Admin Progress를 선택하거나 Progress Indicator 아이콘을 두 번 
클릭하여 다시 열 수 있습니다. 각 어레이의 진행률을 백분율로 보여 주는 창이 나타납
니다.

패리티 검사를 중지하려면 Abort를 클릭합니다.

▼ 패리티 검사를 예약하려면      
예약된 시간 간격(예: 꺼진 시간 동안)으로 특정 논리 드라이브 어레이의 패리티를 검사
하려면 Array Administration → Schedule Parity Check를 선택합니다.

■ 관리 서버에 구성된 논리 드라이브는 수에 관계 없이 예약할 수 있지만 어레이 제어
기 당 하나만 예약이 가능합니다.

■ 여러 개의 논리 드라이브를 예약할 때 숫자가 낮은 논리 드라이브부터 순서대로 패
리티 검사가 수행됩니다.

■ 패리티 검사는 저장 장치의 GB당 평균 5분이 걸립니다.
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■ 재구성 우선 순위를 변경하여 패리티 검사에 할당되는 시스템 자원의 양을 조절할 
수 있습니다. 재구성 우선 순위를 변경하려면 181페이지의 "Disk Array 탭"을 참조
하십시오.

■ 패리티 검사가 시작된 후에 이 검사 작업을 중지시킬 수 있으며 이로 인한 손상은 없
습니다.

주 – 이 메뉴의 옵션에 액세스하려면 ssadmin 또는 ssconfig로 로그인해야 합니다.

1. 패리티 검사를 예약하려는 제어기를 선택합니다.

2. Array Administration → Schedule Parity Check를 선택합니다.

Schedule Parity Check 창이 나타납니다.

3. 이 창의 필드에서 적절하게 선택합니다.

■ Listed Logical Drives – 사용 가능한 결함 허용 논리 어레이의 목록. 드라이브를 여
러 개 선택하려면 Shift 키를 사용합니다.
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■ Rebuild Priority – 재구성을 수행하기 위해 할당되는 자원의 양(low, normal, 
improved, high). Rebuild Priority를 변경하려면 Custom Configuration Options 창
에서 Change Controller Parameters를 선택합니다.

■ How Often – 패리티 검사를 수행할 빈도 지정

■ Starting Day – 이 일정을 시작할 요일 지정

■ Starting Time – 이 일정을 시작할 시작 요일의 시간 지정

■ Existing Schedule – 현재 패리티 일정: 논리 드라이브, 빈도, 시작 요일 및 시작 시간

■ Next Parity Check – 다음 패리티 검사를 시작할 날짜와 시간

4. 예약을 완료한 후 OK를 클릭합니다.

▼ 물리 디스크에서 불량 블록 검색(매체 검색)
매체 검색 기능은 선택된 논리 드라이브에 있는 각 물리 드라이브에서 블록별로 불량 
블록이 있는지 순차적으로 검사합니다. 불량 블록이 발견되면 제어기는 물리 드라이브
에 양호한 블록이 있을 경우 잘못된 블록의 데이터를 양호한 블록으로 재구성합니다. 
물리 드라이브에 양호한 블록이 없으면 제어기는 물리 드라이브를 "Bad"로 지정하고, 
이벤트 메시지를 생성합니다. 그리고 예비 드라이브가 있을 경우 불량 물리 드라이브의 
데이터를 예비 드라이브로 재구성하기 시작합니다.

논리 드라이브에서 초기화가 완료된 후 매체 검색이 자동으로 시작되어 수동으로 중지
할 때까지 계속됩니다. 자동 연속 매체 검색을 중지한 경우 논리 드라이브나 논리 드라
이브를 구성하는 단일 물리 드라이브에서 수동으로 매체 검색을 시작할 수 있습니다. 
드라이브가 실패하거나, 드라이브 오류가 발견되거나, 드라이브 교체 후 재구성해야 할 
경우 매체 검색을 실행하면 유용합니다. 

1. 논리 드라이브를 선택합니다.

2. Array Administration → Media Scan을 선택합니다.
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잠시 후 Media Scan 창이 나타납니다.

3. 논리 드라이브에서 매체 검색을 시작하려면 Logical Drives 탭을 클릭하고 검색할 논
리 드라이브를 선택합니다.

논리 드라이브를 구성하는 물리 드라이브에서 매체 검색을 시작하려면 Disks 탭을 선
택하고 검색할 물리 드라이브를 선택합니다.
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4. Media Scan Priority를 다음과 같이 선택합니다.

■ Low – 다른 작업이 완료될 때까지 매체 검색이 수행되지 않습니다.
■ Normal – 매체 검색이 보통 3초 이내에 수행됩니다.
■ Improved – 매체 검색이 보통 1초 이내에 수행됩니다.
■ High – 매체 검색이 즉시 수행됩니다.

5. Iteration Count를 선택하여 물리 드라이브를 한 번만 검사할지 아니면 연속해서 검사
할지 여부를 지정합니다. 

기본값은 1회입니다.

6. Run Media Scan을 클릭하고 OK를 클릭하여 계속합니다.

주 – 매체 검색이 이미 실행 중인 경우에는 Run Media Scan 버튼을 사용할 수 없습니
다.

7. Starting Array Administration 창에서 Close를 클릭합니다.

Controller Array Progress 창에서 검색 진행률이 나타납니다.

논리 드라이브의 크기와 그에 포함되어 있는 물리 드라이브의 수에 따라 검색 프로세스
를 완료하는 데 오랜 시간이 걸릴 수 있습니다.

8. Controller Array Progress 창에 100% 완료가 나타나면 이벤트 로그를 검사하여 물리 
디스크의 상태를 확인합니다. 

이벤트 로그를 보는 방법에 대한 자세한 내용은 See 105페이지의 "이벤트 로그"를 참조
하십시오.
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▼ 논리 드라이브 또는 물리 드라이브에서 매체 검색 
중지

1. 논리 드라이브를 선택합니다.

2. Array Administration → Media Scan을 선택합니다.

잠시 후 Media Scan 창이 나타납니다.

3. 논리 드라이브에서 매체 검색을 중지하려면 Logical Drives 탭을 클릭하고 검색을 중
지할 논리 드라이브를 선택합니다.

논리 드라이브를 구성하는 물리 드라이브에서 매체 검색을 중지하려면 Disks 탭을 선
택하고 검색을 중지할 물리 드라이브를 선택합니다.

4. Abort Media Scan을 클릭합니다.

5. 계속하려면 OK를 클릭합니다.

6. Starting Array Administration 창에서 Close를 클릭합니다.

주 – 물리 드라이브에서 매체 검색을 중지하려면 Controller Array Progress 창에서 
Abort를 선택해도 됩니다.

실패한 드라이브 
이 절에서는 대기 드라이브가 있을 때와 없을 때 각각 드라이브 실패를 복구하는 절차
에 대해 설명합니다. 이 절차로 재구성 프로세스가 시작되지 않는 경우에는 설명에 따
라 수동으로 재구성 프로세스를 시작할 수 있습니다.

주의 – 초기 구성 시 각 논리 드라이브에 대해 로컬 또는 전역 대기 드라이브를 구성해
야 합니다. 사용된 RAID 수준의 유형과 구현된 보관 절차에 따라 단일 또는 다중 드라
이브가 실패했을 때 상당한 데이터 손실이 발생할 수 있습니다. 또한 고장 발생 시 즉시 
교체할 수 있도록 미리 테스트한 예비 드라이브를 준비해 놓으십시오. 
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▼ 대기 드라이브를 사용하여 드라이브 자동 재구성
결함 허용 논리 드라이브와 연결된 드라이브가 실패하는 경우 대기 드라이브가 전역 또
는 로컬 예비 드라이브로 이미 설치되고 구성되어 있으면 실패한 드라이브는 예비 드라
이브로 자동으로 대체되고 데이터는 지정된 예비 드라이브를 사용하여 재구성됩니다. 
이 작업이 오류 없이 완벽하게 진행되려면 항상 예비 드라이브의 용량이 교체할 실패한 
드라이브의 용량과 같거나 커야 합니다. 

일반적으로 재구성 프로세스는 1 ~ 2분 내에 시작됩니다. 제어기에 진행 중인 다른 작업
이 없는 경우 백그라운드에서 재구성하는 데 GB 당 약 8분이 걸립니다.

자동 재구성 프로세스 중 정상적인 작업은 진행되지만 성능은 떨어질 수 있습니다. 성
능 저하의 정도는 제어기에 설정된 재구성 우선 순위에 의해 결정됩니다. (재구성 우선 
순위를 변경하려면 181페이지의 "Disk Array 탭"을 참조하십시오.)

재구성 프로세스의 진행률을 보려면 View → Array Admin Progress를 선택합니다.

1. 해당 어레이의 Sun StorEdge 3000 Family 설치, 작동 및 서비스 설명서에 나와 있는 설
명에 따라 실패한 드라이브를 교체하여 자동 재구성 기능을 다시 설정합니다.

2. 실패한 드라이브를 제거한 후 새 드라이브를 넣기 전에 적어도 60초 이상 기다려야 합
니다. 

대체 드라이브의 크기는 엔클로저에 있는 최대 드라이브의 크기보다 크거나 같아야 합
니다. 대체 드라이브를 실패한 드라이브와 같은 슬롯(구동 장치 공간)에 설치하면 새 대
기 드라이브가 됩니다.

3. 재구성 프로세스가 완료되고 논리 드라이브가 온라인 상태가 되면 어레이 제어기 구성
을 외부 드라이브나 디스켓에 백업합니다.

27페이지의 "논리 드라이브 구성을 저장하려면"을 참조하십시오.
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▼ 대기 드라이브 없이 드라이브 재구성
어레이에 대기 드라이브가 없는 경우 자동 재구성 프로세스를 시작하기 전에 실패한 드
라이브를 교체해야 합니다.

1. 대기 드라이브가 없는 경우 드라이브 실패로부터 복구하려면 해당 어레이의 Sun 
StorEdge 3000 Family 설치, 작동 및 서비스 설명서의 설명을 참조하여 실패한 드라이
브를 교체합니다. 

2. 실패한 드라이브를 제거한 후 새 드라이브를 넣기 전에 적어도 60초 이상 기다려야 합
니다. 

대체 드라이브의 용량은 실패한 드라이브의 용량보다 크거나 같아야 합니다. 대체 드라
이브를 실패한 드라이브와 같은 주소(구동 장치 공간)에 설치합니다.

3. 같은 슬롯에서 실패한 드라이브를 교체한 후에는 검색해야 합니다.

드라이브에서 검색하는 방법에 대한 자세한 내용은 163페이지의 "새 하드 드라이브에
서 검색 (SCSI에만 해당)"을 참조하십시오.

4. 드라이브를 검색한 후 Array Administration → Rebuild를 선택하여 수동으로 드라이
브를 재구성해야 합니다.

▼ 재구성 프로세스의 진행률을 확인하려면
1. View → Array Admin Progress를 선택하거나 창 오른쪽 상단에 있는 Progress 

Indicator 아이콘 을 클릭합니다. 

재구성 작업의 완료율을 보여 주는 Controller Array Progress 창이 나타납니다. 그러나 
여러 제어기에서 작업(초기화, 재구성 또는 패리티 검사)이 진행 중인 경우에는 Select 
Controller Progress 창이 먼저 나타납니다. 

2. 진행률을 보려는 제어기를 선택하고 OK를 클릭합니다. 

선택한 제어기의 어레이 진행을 보여 주는 Controller Array Progress 창이 나타납니
다. 자세한 내용은 122페이지의 "어레이 관리 작업"을 참조하십시오.
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▼ 실패한 드라이브를 수동으로 재구성
대부분의 경우 교체된 드라이브는 자동으로 재구성되기 때문에 수동으로 재구성 프로
세스를 시작할 필요가 없습니다. 

실패가 발생할 때 예비 드라이브가 없거나 어떤 이유로 인해 드라이브가 재구성되지 않
는 경우에는 Rebuild를 사용하여 재구성 프로세스를 수동으로 시작할 수 있습니다. 또
한 재구성 프로세스가 재설정으로 인해 중단된 경우에도 Rebuild를 사용하여 이 프로
세스를 다시 시작합니다.

1. Sun StorEdge 3000 Family 설치, 작동 및 서비스 설명서의 설명을 참조하여 실패한 드
라이브를 교체합니다.

2. 실패한 드라이브를 제거한 후 새 드라이브를 넣기 전에 적어도 60초 이상 기다려야 합
니다. 

대체 드라이브의 용량은 엔클로저에 있는 최대 드라이브의 용량보다 크거나 같아야 합
니다. 

3. Array Administration → Rebuild를 선택합니다. 

Rebuild 창이 나타납니다. 
       

4. 대체 드라이브의 상태 레코드를 선택합니다.
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5. 재구성 프로세스를 시작하려면 OK를 클릭합니다.

어레이 제어기에 진행 중인 다른 작업이 없는 경우 재구성 프로세스는 백그라운드에서 
GB당 약 8분이 걸립니다. 재구성을 수행하는 중에 정상적인 작업은 진행되지만 성능은 
떨어질 수 있습니다. 성능 저하의 정도는 제어기에 설정된 재구성 우선 순위에 의해 결
정됩니다. (재구성 우선 순위를 변경하려면 181페이지의 "Disk Array 탭"을 참조하십시
오.)

6. 재구성 프로세스의 진행률을 보려면 View → Array Admin Progress를 선택하거나 창 
오른쪽 상단에 있는 Progress Indicator 아이콘을 클릭합니다.

재구성 프로세스의 완료율을 보여 주는 Controller Array Progress 창이 나타납니다.

여러 제어기에서 어레이 작업(초기화, 재구성 또는 패리티 검사)이 진행 중인 경우에는 
Select Controller Progress 창이 먼저 나타납니다.

7. 진행률을 보려는 제어기를 선택하고 OK를 클릭합니다. 

해당 제어기의 어레이 재구성 상태를 보여 주는 Controller Array Progress 창이 나타납
니다. 

▼ 논리 드라이브 구성 복원 
이 절에서는 백업 파일로부터 어레이 구성 정보를 복원하는 방법에 대해 설명합니다. 
60페이지의 "구성 파일"에 설명된 대로 Save 명령을 사용하여 백업 파일을 저장해 두었
어야 합니다. 어레이 제어기와 그 드라이브가 손상된 경우 저장 장치 어레이를 완전히 
재구성하지 않고도 어레이 구성을 새 제어기에 복원할 수 있습니다.

주의 – 구성 파일이 최신인 경우에만 파일에서 어레이 구성을 복원합니다. 오래되었거
나 잘못된 구성을 복원하면 데이터가 손실됩니다.

백업 파일의 어레이 구성 정보가 올바른 경우 다음 절차를 통해 구성을 복원합니다.

1. 해당 어레이의 제어기를 선택합니다.
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2. Configuration → Load Configuration을 선택합니다. 

Select Configuration File 창이 나타납니다. 

3. 백업 구성 파일의 이름과 위치를 지정하고 Open을 클릭합니다.

Load Configuration 창이 나타납니다. 구성의 트리 보기를 보려면 Configuration View 
탭을 클릭합니다.
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Saveset Description 탭에는 구성 파일이 만들어질 때 지정된 파일에 대한 설명이 표시
됩니다.

4. (Solaris OS에만 해당) OS에서 논리 드라이브를 사용할 수 있도록 논리 드라이브에 레
이블이 자동으로 지정되도록 하려면 Write a new label to the new LD를 클릭합니다.

5. 저장된 구성을 로드하려면 OK를 누릅니다.

Load Configuration Confirmation 창이 나타납니다.

계속 진행하기 전에 Load Configuration Confirmation 창에 표시된 정보를 자세히 검
토하십시오.
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6. Apply를 클릭하여 이 구성을 로드하거나 Cancel을 클릭하여 이 기능을 종료합니다.

Apply를 클릭하면 구성 작업이 진행되며 진행률 창이 나타납니다.

주 –  어레이 구성 백업 파일의 내용을 복원한 후 LUN을 초기화하지
마십시오.

제어기 유지 보수 옵션
제어기 유지 보수 옵션으로는 제어기 종료, 제어기 경고음 음소거, 실패한 제어기를 다
시 온라인 상태로 가져오기, 성능 통계 표시 및 제어기 부트 시간 결정 등이 있습니다. 
펌웨어 다운로드 옵션도 Controller Maintenance Options 창에 포함되어 있습니다. 펌
웨어 다운로드에 대한 자세한 내용은 141페이지의 "구성 업데이트"를 참조하십시오.

▼ 제어기 재설정
제어기 매개변수를 변경할 때마다 변경 사항이 적용되도록 제어기를 재설정할지 여부
를 묻는 메시지가 표시됩니다. 변경 사항이 여러 개인 경우 변경할 때마다 제어기를 중
지하고 재설정하려고 하지 않을 수 있습니다. 여러 매개변수를 변경한 후 수동으로 제
어기를 재설정하려면 Reset the Controller 옵션을 사용하십시오.

1. 기본 창에서 아무 저장 장치 아이콘을 선택합니다. 

2. Array Administration → Controller Maintenance를 선택합니다.

3. ssconfig로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니다. ssconfig 암
호를 입력합니다. 

Controller Maintenance Options 창이 나타납니다.

4. Reset the Controller를 클릭합니다.

주 – Sun StorEdge 3310 SCSI Array에 대한 제어기를 재설정하면 패리티 오류 및 동기 
오류 메시지 등의 호스트측 오류 메시지가 나타날 수 있습니다. 이 경우 별도의 작업을 
수행할 필요가 없으며 제어기를 다시 초기화하면 문제가 자동으로 해결됩니다.
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▼ 제어기 종료
어레이의 전원이 꺼질 때마다 먼저 제어기를 종료하여 백업 배터리(있을 경우)가 캐시 
메모리로 인해 소모되지 않게 쓰기 캐시가 디스크로 플러시되도록 해야 합니다.

주의 – 제어기를 종료하면 어레이가 호스트의 I/O 요청에 응답하지 않습니다. 따라서 
해당 어레이에 액세스하는 모든 응용프로그램을 종료하고 해당 어레이에서 마운트 된 
파일 시스템을 마운트 해제하여 모든 I/O 작업을 일시 중지하지 않으면 데이터가 손실
될 수 있습니다. 중복 제어기 구성에서 제어기를 종료하면 양쪽 제어기의 모든 LUN이 
영향을 받습니다.

1. 기본 창에서 아무 저장 장치 아이콘을 선택합니다. 

2. Array Administration → Controller Maintenance를 선택합니다.

3. ssconfig로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니다. ssconfig 암
호를 입력합니다. 

Controller Maintenance Options 창이 나타납니다.

4. Shut Down the Controller를 클릭합니다.

▼ 제어기 경고음을 음소거하려면
제어기에서 경고음을 유발하는 이벤트가 발생할 때(예: 재구성하는 동안이나 물리 드라
이브를 추가하는 중에 논리 드라이브가 실패하는 경우) 경고음이 나지 않도록 설정하려
면 다음 두 가지 방법 중 하나를 사용합니다.

1. 기본 창에서 제어기 아이콘을 선택합니다. 

2. Array Administration → Controller Maintenance를 선택합니다.

3. ssconfig로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니다. ssconfig 암
호를 입력합니다. 

Controller Maintenance Options 창이 나타납니다.

4. Mute Controller Beeper를 클릭합니다.

또는

1. 기본 창에서 원하는 제어기 아이콘을 선택합니다. 

2. Configuration → Custom Configure를 선택합니다.

3. Change Controller Parameters를 선택합니다.

4. Mute Beeper를 선택합니다.
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주 – 실패한 구성 요소로 인해 경보음이 나는 경우에는 경고음을 음소거하더라도 효과
가 없습니다. 어레이의 우측 손잡이에 있는 Reset 버튼을 눌러야 합니다. 구성 요소 실
패 알람에 대한 자세한 내용은 93페이지의 "엔클로저 보기"를 참조하십시오. 

▼ 실패한 제어기를 다시 온라인 상태로 가져오기
제어기가 실패하는 경우 다음 중 한 가지 방법을 사용하여 다시 온라인 상태로 되돌립
니다.

1. 기본 창에서 제어기 아이콘을 선택합니다. 

2. Array Administration → Controller Maintenance를 선택합니다.

3. ssconfig로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니다. ssconfig 암
호를 입력합니다. 

Controller Maintenance Options 창이 나타납니다.

4. Deassert Failed Redundant Controller를 클릭합니다.

또는

1. 기본 창에서 제어기 아이콘을 선택합니다. 

2. Configuration → Custom Configure를 선택합니다.

3. Change Controller Parameters를 선택합니다.

4. Redundancy 탭을 선택합니다.

5. Set Controller Config 필드에서 Redundant Deassert Reset을 선택합니다.

▼ 성능 통계를 표시하려면
Performance Statistics를 사용하여 데이터 전송 속도, 즉 어레이의 실행 속도를 확인할 
수 있습니다.

1. Array Administration → Controller Maintenance를 선택합니다.

2. ssconfig로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니다. ssconfig 암
호를 입력합니다. 

Controller Maintenance Options 창이 나타납니다.
7 장 어레이 유지 보수 137



3. Performance Statistics를 클릭합니다.

Performance Statistics 창이 나타납니다.

▼ 제어기 부트 시간 알아내기
제어기 이벤트 조사를 참조 지점으로 하여 설명하자면 제어기의 전원이 마지막으로 켜
진 시간이나 마지막으로 재설정된 시간을 확인하면 됩니다.

1. Array Administration → Controller Maintenance를 선택합니다.

2. ssconfig로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니다. ssconfig 암
호를 입력합니다. 

Controller Maintenance Options 창이 나타납니다.
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3. Get Controller Boot Time을 클릭합니다.

Controller Boot Time 창이 나타납니다. 제어기 날짜, 시간 및 시간대는 펌웨어 응용프
로그램을 사용하여 설정됩니다. 제어기 날짜 및 시간을 설정하는 방법에 대한 자세한 
내용은 Sun StorEdge 3000 Family RAID Firmware Users Guide를 참조하십시오.

▼ 이중 제어기 어레이를 단일 제어기 어레이로 변환
이중 어레이 제어기 구성에서 한 제어기가 실패하는 경우 어레이가 콘솔에 저하된 상태
로 표시되지 않도록 하기 위해 확장된 기간동안 단일 제어기를 실행하려고 할 수 있습
니다.

1. 제거할 제어기의 일련 번호를 알아야 합니다.

이벤트 로그를 확인하여 실패한 제어기의 일련 번호를 알아보거나 콘솔을 확인하여 주 
제어기의 일련 번호를 기록해 둘 수 있습니다.

2. 나머지 제어기의 중복성 설정을 해제로 변경합니다.

펌웨어 응용프로그램을 사용하여 제어기의 중복 기능을 해제해야 합니다. 펌웨어 응용
프로그램에 액세스하는 방법에 대한 자세한 내용은 해당 어레이의 Sun StorEdge 3000 
Family RAID Firmware Users Guide를 참조한 다음 Main Menu에서 "view and edit 
Peripheral devices → Set Peripheral Device Entry → Redundant Controller ñ Primary 
→ Disable redundant controller"를 선택합니다.

3. 에이전트를 중지합니다. 

에이전트를 중지하는 방법에 대한 자세한 내용은 Sun StorEdge 3000 Family 소프트웨
어 설치 설명서에서 사용하고 있는 OS에 해당하는 장을 참조하십시오.
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4. /var/opt/SUNWsscs/ssagent로 이동하여 sscontlr.txt 파일을 편집합니다.

이 파일의 마지막 줄에는 두 제어기의 일련 번호가 포함되어 있습니다. 이 줄에서 실패
한 제어기의 일련 번호를 제거합니다.

5. 해당 OS의 설치 관련 장에 나온 설명에 따라 에이전트를 시작합니다.

6. 이 절차를 진행하는 동안 콘솔을 연 경우 콘솔을 다시 검색합니다.

7. 단일 제어기 구성에서 데이터가 손상되지 않게 하려면 Write Back Cache를 해제합니
다.

Write Back Cache를 해제하는 방법에 대한 자세한 내용은 177페이지의 "Cache 탭"을 
참조하십시오.

# RAID_CONTROLLER=Enable:3197861:3179746
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8 장

구성 업데이트

현재 구성을 변경하거나 현재 구성에 추가하려면 이 장을 참조하십시오. 이 장에서 다
루는 내용은 다음과 같습니다.

■ 142페이지의 "논리 드라이브를 추가 또는 새 논리 드라이브에서 논리 볼륨 추가"

■ 147페이지의 "기존 논리 드라이브에서 논리 볼륨 추가"

■ 149페이지의 "논리 드라이브 또는 논리 볼륨을 삭제하려면"

■ 152페이지의 "파티션을 만들려면"

■ 155페이지의 "파티션을 삭제하려면"

■ 157페이지의 "논리 드라이브 또는 논리 볼륨의 용량 확장"

■ 159페이지의 "기존 논리 드라이브에 물리 드라이브 추가"

■ 161페이지의 "물리 드라이브 복사 및 교체"

■ 163페이지의 "새 하드 드라이브에서 검색 (SCSI에만 해당)"

■ 164페이지의 "RAID 제어기 펌웨어 다운로드"

■ 167페이지의 "펌웨어 및 부트 레코드 업그레이드"

■ 168페이지의 "하드 드라이브의 펌웨어 업그레이드"

■ 169페이지의 "SAF-TE 장치의 펌웨어 업그레이드"

■ 171페이지의 "제어기 매개변수 변경"

■ 172페이지의 "변경된 값 저장"

■ 189페이지의 "제어기의 환경 상태 보기"

■ 193페이지의 "제어기 경고음 음소거하기"

■ 194페이지의 "대기 드라이브 할당 또는 변경"

■ 196페이지의 "서버 항목 편집"

■ 198페이지의 "ODM 업데이트"
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패리티 검사와 같은 관리 프로세스를 실행 중인 경우 Configuration 메뉴 명령과 도구 
아이콘을 일시적으로 사용할 수 없을 수 있습니다. 콘솔이 서버의 자원 목록을 새로 고
칠 때에도 메뉴 명령이 비활성화되어 표시됩니다. 새로 고침 프로세스가 진행되는 동안 
서버 아이콘에 위성 접시 기호가 부착( )되어 있습니다.

주 – Configuration(구성) 옵션을 사용하려면 ssconfig 암호로 소프트웨어의 
ssconfig 보안 수준에 로그인해야 합니다. 구성 작업을 마치면 프로그램의 모니터링 
수준으로 다시 로그인합니다.

▼ 논리 드라이브를 추가 또는 새 논리 드라이브에서 
논리 볼륨 추가
이 옵션을 사용하여 하나 이상의 논리 드라이브를 기존 RAID 세트 구성에 추가하거나 
새 논리 드라이브에서 논리 볼륨을 추가합니다. 기존 논리 드라이브에서 논리 볼륨을 
추가하려면 147페이지의 "기존 논리 드라이브에서 논리 볼륨 추가"를 참조하십시오.

주 – Sun 클러스터 환경 같은 현재 구성에서는 논리 볼륨이 적절하지 않으며 이 같은 
구성에서는 논리 볼륨이 작동하지도 않습니다. 대신 논리 드라이브를 사용하십시오. 자
세한 내용은 36페이지의 "논리 볼륨"을 참조하십시오.

주 – 논리 드라이브가 253GB보다 큰 경우 47페이지의 "253GB보다 큰 논리 드라이브를 
준비하려면"을 참조하십시오.

주의 – UNIX 시스템에서는 기존 구성에 새 논리 드라이브를 추가하기 전에 해당 어레
이에 연결되어 있는 모든 파일 시스템을 마운트 해제해야 합니다.

1. 구성할 어레이를 선택합니다.

2. Configuration → Custom Configure를 선택합니다.

주 – 사용 가능한 물리 드라이브가 있는 어레이를 선택하지 않은 경우에는 이 선택은 
비활성 상태이므로 사용할 수 없습니다.

3. Custom Configuration Options 창에서 Add LDs/LVs to the Current Configuration
을 선택합니다.
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4. 창의 맨 위에 표시된 서버 및 제어기가 올바른지 확인합니다.

5. 새 논리 드라이브에 포함시킬 디스크를 선택하고 Add Disk를 클릭합니다.

잘못 선택했거나 변경하려는 경우에는 드라이브를 선택하고 Remove Disk를 클릭합니
다.

6. RAID Level을 선택합니다. 

RAID 수준의 정의에 대한 자세한 내용은 201페이지의 "RAID에 대한 기본 정보"을 참
조하십시오. 

7. Channel 및 ID 목록 상자에서 새 논리 드라이브를 매핑할 호스트 채널과 ID를 선택합
니다.

8. Max Drive Size를 설정합니다. 

Max Drive Size는 각 디스크의 전체 용량을 표시합니다. 이 값을 낮추어 논리 드라이브
를 더 작게 만들 수 있습니다.   

주 – Max Drive Size는 변경하지 않고 Partition Size만 변경하면 지정된 파티션 크기로 
새 파티션이 만들어집니다. 나머지 논리 드라이브 크기 용량은 마지막 파티션으로 이동
합니다. 나머지 용량은 157페이지의 "논리 드라이브 또는 논리 볼륨의 용량 확장"에서 
설명한 대로 드라이브를 확장하여 나중에 사용할 수 있습니다. 파티션이 만들어진 후에
는 드라이브 용량을 편집할 수 없습니다.

주 – 같은 제어기에서 또 다른 논리 드라이브를 만들려면 New LD를 클릭합니다. 새로 
정의한 논리 드라이브가 만들어지고 다른 논리 드라이브를 만들 수 있도록 창의 맨 위
로 돌아갑니다. 지원되는 최대 논리 드라이브 수에 대해서는 표 4-1를 참조하십시오. 

9. (Solaris OS에만 해당) OS에서 새 논리 드라이브를 사용할 수 있도록 새 논리 드라이브
에 대한 레이블이 자동으로 지정되도록 하려면 Write a new label to the new LD를 클
릭합니다.

10. 논리 드라이브를 지금 즉시 사용하려면 On-line Initialization을 선택합니다.

논리 드라이브 초기화 작업에는 몇 시간이 걸릴 수 있으므로 논리 드라이브를 온라인으
로 초기화하도록 선택할 수 있습니다.

온라인 초기화를 사용하면 초기화가 완료되기 전에도 논리 드라이브를 구성하고 사용
할 수 있습니다. 그러나 제어기가 I/O 작업을 수행하면서 논리 드라이브를 만들기 때문
에 논리 드라이브를 온라인으로 초기화할 경우 오프라인으로 초기화할 때보다 시간이 
많이 걸립니다.

On-line initialization을 선택하지 않은 경우 초기화가 완료된 후에야 드라이브를 구성
하고 사용할 수 있습니다. 제어기가 I/O 작업을 수행하지 않으면서 논리 드라이브를 만
들기 때문에 오프라인으로 초기화할 때가 온라인으로 초기화할 때보다 시간이 덜 필요
합니다.
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주 – 논리 볼륨에는 On-line Initialization이 적용되지 않습니다.

11. 스트라이프 크기를 선택합니다.

표 8-1에 지정된 것처럼 최적화 모드에 따라 스트라이프 크기를 할당하려면 Default를 
선택하거나 다른 스트라이프 크기를 선택합니다.

이미 스트라이프 크기를 선택했고 논리 드라이브에 데이터를 쓴 경우에 논리 드라이브
의 스트라이프 크기를 변경하려면 논리 드라이브의 데이터를 다른 위치로 백업하고, 논
리 드라이브를 삭제한 다음 원하는 스트라이프 크기를 가진 논리 드라이브를 만들어야 
합니다.

12. 논리 드라이브의 Write Policy로 Default, Write-through 또는 Write-back 중에서 지
정합니다.

기록 정책은 캐시된 데이터를 디스크 드라이브에 기록할 시기를 결정합니다. 디스크에 
데이터를 기록하는 동안 데이터를 캐시에 보관할 수 있으면 순차적으로 읽을 때 저장 
장치의 속도가 향상될 수 있습니다. Write policy 옵션으로는 write-through와 write-
back이 있습니다.

동시 기록 캐시를 사용하면 제어기가 호스트 OS에 프로세스가 완료되었음을 신호하기
도 전에 디스크 드라이브에 데이터를 기록합니다. 동시 기록(Write-Through) 캐시는 후
기록(Write-Back) 캐시보다 쓰기 작업의 성능과 처리량이 낮지만 정전이 발생할 경우 
데이터 손실의 위험이 가장 적으므로 보다 안전합니다. 그러나 배터리 모듈이 설치되어 
있기 때문에 전원이 메모리에 캐시된 데이터에 공급되며 전원이 다시 켜지면 데이터가 
디스크에 기록될 수 있습니다.

후기록 캐시를 사용하면 데이터가 실제로 디스크 드라이브에 기록되기 전에 제어기가 
디스크에 기록할 데이터를 받아서 메모리 버퍼에 저장한 다음 즉시 쓰기 작업이 완료되
었다는 신호를 호스트 OS에 보냅니다. 후기록 캐시를 사용하면 쓰기 작업의 성능과 제
어기 카드의 처리량이 향상됩니다. 후기록 캐시는 기본적으로 활성화되어 있습니다.

주 – Change Controller Parameters 창의 Cache 탭에 있는 Write Back 필드에서 지정
한 설정이 모든 논리 드라이브의 기본 전역 캐시 설정이 됩니다(177페이지의 "Cache 탭
" 참조).

13. OK를 클릭합니다.

표 8-1 최적화 모드에 따른 기본 스트라이프 크기

RAID 수준
Sequential I/O
(순차 I/O)

Random I/O
(임의 I/O)

0, 1, 5 128 32

3 16 4
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14. 이 논리 드라이브를 논리 볼륨에 추가하려면 New LD를 클릭하고 145페이지의 "논리 
볼륨에 논리 드라이브 추가"을 참조하십시오.

15. 이 창에서 모두 선택했고 다른 논리 드라이브를 정의하지 않으려면 Commit을 클릭합
니다. 

새 구성을 보여주는 확인 창이 표시됩니다.

16. 표시된 구성을 허용하려면 OK를 클릭하고 그렇지 않으면 Cancel을 클릭하여 콘솔로 
돌아갑니다.

주 – OK를 클릭한 후에는 논리 드라이브 구성을 변경할 수 없습니다.

주 – 초기화하는 동안 LD/LV 크기는 0MB로 표시됩니다.

17. (HP-UX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
ioscan -fnC disk 명령을 실행해야 합니다.

주 – System Administrator Manager(sam)를 사용하여 파일 시스템을 마운트 해제한 
경우 ioscan 명령을 실행하기 전에 닫아야 합니다.

18. (IBM AIX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
198페이지의 "IBM AIX 호스트에서 Object Data Manager 업데이트"에 설명되어 있는 
ODM(Object Data Manager)을 업데이트해야 합니다.

▼ 논리 볼륨에 논리 드라이브 추가 

논리 볼륨은 두 개 이상의 논리 드라이브로 구성되며 최대 32개의 파티션으로 분할할 
수 있습니다. 작업을 수행하는 동안 호스트는 분할되지 않은 논리 볼륨이나 논리 볼륨
의 파티션을 하나의 물리 드라이브로 인식합니다. 

주 – Sun 클러스터 환경 같은 현재 구성에서는 논리 볼륨이 적절하지 않으며 이 같은 
구성에서는 논리 볼륨이 작동하지도 않습니다. 대신 논리 드라이브를 사용하십시오. 자
세한 내용은 36페이지의 "논리 볼륨"을 참조하십시오.

주의 – UNIX 시스템에서는 기존 구성에 새 논리 드라이브를 추가하기 전에 해당 어레
이에 연결되어 있는 모든 파일 시스템을 마운트 해제해야 합니다.

1. 142페이지의 "논리 드라이브를 추가 또는 새 논리 드라이브에서 논리 볼륨 추가"의 1단
계- 15단계에 설명된 대로 논리 드라이브를 만듭니다.
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주 – 논리 볼륨에 추가할 논리 드라이브는 분할하지 마십시오. 분할된 논리 드라이브는 
논리 볼륨에 추가할 수 없습니다.

2. Commit을 클릭하기 전에 논리 드라이브를 논리 볼륨에 추가하려면 Add to LV를 클릭
합니다.

논리 드라이브가 LV Definition 상자에 추가됩니다. 논리 볼륨의 전체 크기가 Available 
Size (MB) 필드에 표시됩니다. 

주 – 논리 볼륨이 아직 분할되지 않았기 때문에 Part Size (MB) 및 Available Size (MB)
가 같습니다. 단일 논리 볼륨은 단일 파티션으로 간주됩니다.

주 – SATA 논리 디스크와 FC 논리 디스크를 섞어서 논리 볼륨을 만드는 것은 지원되지 
않습니다.

3. 논리 볼륨에 추가할 다른 논리 드라이브를 만들려면 New LD를 클릭합니다.

4. 논리 드라이브를 만들고 Add to LV를 클릭하여 논리 볼륨에 추가합니다.

논리 볼륨에 추가할 모든 논리 드라이브에 대해 이 단계를 반복하십시오.

5. 파티션을 만들려면 152페이지의 "파티션을 만들려면"을 참조하십시오.

6. 논리 볼륨에 논리 드라이브를 모두 추가한 다음 다른 논리 볼륨 또는 개별 논리 드라이
브를 또 만들려면 Commit LV를 클릭합니다.

논리 볼륨을 모두 만들었고 개별 논리 드라이브를 만들지 않으려면 Commit을 클릭합
니다.

주 – 논리 볼륨을 모두 만들었고 New Configuration 창을 종료하려고 할 때 Commit 
대신 Commit LV를 실수로 클릭한 경우에는 다른 논리 드라이브를 또 만들거나 Cancel
을 클릭하고 논리 볼륨을 다시 구성해야 합니다.

7. 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 ioscan -fnC disk 명령
을 실행해야 합니다(HP-UX OS에만 해당).

주 – System Administrator Manager(sam)를 사용하여 파일 시스템을 마운트 해제한 
경우 ioscan 명령을 실행하기 전에 닫아야 합니다.
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8. (IBM AIX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
198페이지의 "IBM AIX 호스트에서 Object Data Manager 업데이트"에 설명되어 있는 
ODM(Object Data Manager)을 업데이트해야 합니다.

매체 검색

논리 드라이브의 초기화가 완료되었을 때 데이터 무결성을 유지하기 위해 매체 검색이 
자동으로 시작되어 수동으로 중지할 때까지 계속 실행됩니다. 매개 검색이 실행 중인지 
확인하려면 이벤트 로그를 보십시오. 이벤트 로그 창에 대한 자세한 내용은 107페이지
의 "이벤트 로그 창"을 참조하십시오. 매체 검색에 대한 자세한 내용은 125페이지의 "물
리 디스크에서 불량 블록 검색(매체 검색)"을 참조하십시오.

▼ 기존 논리 드라이브에서 논리 볼륨 추가

주 – Sun 클러스터 환경 같은 현재 구성에서는 논리 볼륨이 적절하지 않으며 이 같은 
구성에서는 논리 볼륨이 작동하지도 않습니다. 대신 논리 드라이브를 사용하십시오. 자
세한 내용은 36페이지의 "논리 볼륨"을 참조하십시오.

주 – 기존 논리 드라이브에서 논리 볼륨을 추가하려면 논리 드라이브의 매핑을 해제해
야 합니다.

1. 구성할 어레이를 선택합니다.

2. Configuration → Custom Configure를 선택합니다.

주 – 사용 가능한 물리 드라이브가 있는 어레이를 선택하지 않은 경우에는 이 선택은 
비활성 상태이므로 사용할 수 없습니다.

3. Custom Configuration Options 창에서 Add LDs/LVs to the Current Configuration
을 선택합니다.

4. 창의 맨 위에 표시된 서버 및 제어기가 올바른지 확인합니다.
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5. Use existing LDs to create LVs를 선택합니다.

Select disks for logical drive에 논리 드라이브가 표시되지 않는 경우에는 논리 드라이
브의 매핑이 해제되지 않았기 때문에 선택할 수 없는 것입니다. 먼저 논리 드라이브의 
매핑을 해제해야 합니다.

6. 논리 드라이브를 선택하고 Add to LV를 클릭합니다.

7. 논리 볼륨에 논리 드라이브를 모두 추가한 다음 또 다른 논리 볼륨 또는 개별 논리 드라
이브를 만들려면 Commit LV를 클릭합니다.

논리 볼륨을 모두 만들었고 개별 논리 드라이브를 만들지 않으려면 Commit을 클릭합
니다.

주 – 논리 볼륨을 모두 만들었고 New Configuration 창을 종료하려고 할 때 Commit 
대신 Commit LV를 실수로 클릭한 경우에는 다른 논리 드라이브를 또 만들거나 Cancel
을 클릭하고 논리 볼륨을 다시 구성해야 합니다.

8. (HP-UX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
ioscan -fnC disk 명령을 실행해야 합니다.

주 – System Administrator Manager(sam)를 사용하여 파일 시스템을 마운트 해제한 
경우 ioscan 명령을 실행하기 전에 닫아야 합니다.
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9. (IBM AIX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
198페이지의 "IBM AIX 호스트에서 Object Data Manager 업데이트"에 설명되어 있는 
ODM(Object Data Manager)을 업데이트해야 합니다.

▼ 논리 드라이브 또는 논리 볼륨을 삭제하려면
이 옵션을 사용하여 하나 이상의 논리 드라이브 또는 논리 볼륨을 기존 RAID 세트의 구
성에서 삭제합니다.

주 – 논리 드라이브나 논리 볼륨을 삭제하려면 먼저 할당된 모든 LUN의 매핑을 해제
해야 합니다.

1. 삭제한 논리 드라이브나 논리 볼륨을 포함하고 있는 어레이를 선택합니다.

2. 기존의 논리 드라이브나 논리 볼륨을 보려면 View → Logical Drive를 선택합니다.

Use existing LDs to create
LVs
를 선택한 후 논리 드라이브가
표시되지 않으면 논리 드라이브의
매핑이 해제되지 않은 것입니다
논리 드라이브의 매핑을
해제해야 합니다 .
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3. 논리 드라이브나 논리 볼륨에 호스트 LUN이 할당되어 있으면 4단계로 진행하여 삭제
하고, 그렇지 않으면 8단계로 진행합니다.

4. Configuration → Custom Configure를 선택합니다.

5. Change Host LUN Assignments를 선택합니다.

6. 매핑을 해제할 논리 드라이브나 논리 볼륨에 연결된 호스트 LUN을 선택하고 Unmap 
Host LUN을 클릭합니다.

7. Close를 클릭합니다.

콘솔이 새로 고쳐지고 해당 논리 드라이브가 "UNMAPPED"로 표시됩니다.

8. Configuration → Custom Configure를 선택합니다.

9. Manage Existing LDs/LVs and Partitions를 선택합니다.

10. LDs/LVs 탭을 선택합니다.

11. 삭제할 논리 드라이브나 논리 볼륨을 선택한 다음 Delete를 클릭하고 OK를 클릭합니
다.

논리 볼륨을 삭제하는 경우 Delete를 클릭하면 논리 볼륨은 삭제되지만 논리 드라이브
를 구성하는 논리 드라이브는 표시됩니다.

12. Confirm Configuration Operation 창에서 OK를 클릭하여 작업을 완료한 후 Close를 
클릭합니다.

콘솔이 새로 고쳐지고 어레이가 다시 표시되지만 더 이상 해당 논리 드라이브가 표시되
지 않습니다.
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13. (HP-UX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
ioscan -fnC disk 명령을 실행해야 합니다.

주 – System Administrator Manager(sam)를 사용하여 파일 시스템을 마운트 해제한 
경우 ioscan 명령을 실행하기 전에 닫아야 합니다.

14. (IBM AIX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
198페이지의 "IBM AIX 호스트에서 Object Data Manager 업데이트"에 설명되어 있는 
ODM(Object Data Manager)을 업데이트해야 합니다.

논리 드라이브/논리 볼륨 번호

각 논리 드라이브와 함께 참조되는 논리 드라이브/논리 볼륨 번호는 동적이기 때문에 
논리 드라이브가 만들어지고 삭제될 때 변경됩니다. 이 번호는 Dynamically Grow 
and/or Reconfigure LDs/LVs, Change Host LUN Assignments, Manage Existing 
LDs/LVs and Partitions 창 및 기본 창을 비롯한 여러 창의 논리 드라이브(LDs/LVs) 
필드에 표시됩니다.

자리 표시자로 사용되는 이 번호는 논리 드라이브 및 논리 볼륨을 시각적으로 추적할 
수 있도록 하며 제어기에는 영향을 미치지 않습니다. 즉, 이 번호에 따라 제어기가 논리 
드라이브 또는 논리 볼륨에 대해 보고하지는 않습니다. 예를 들어, 네 개의 논리 드라이
브가 있는데, LD2가 삭제되면 기존의 LD3이 LD2로, LD4가 LD3으로 동적으로 변경됩
니다. 이 때 LD/LV 번호만 변경되고 논리 드라이브의 모든 LUN 매핑과 데이터는 그대
로 유지됩니다. 

제어기는 전체 논리 드라이브의 수를 보고하므로(이 경우 3개) LD/LV 필드에 표시되는 
것과 실제 LD/LV 번호는 관련이 없습니다. 이 예에서 새 논리 드라이브가 만들어지면 
삭제되었던 논리 드라이브의 LD 번호를 가져오며 제어기는 총 네 개의 논리 드라이브
가 있다고 보고합니다. 기존의 모든 논리 드라이브는 원래의 기본/보조 상태로 다시 지
정됩니다. 

주 – 다음 예에서 볼 수 있듯이 펌웨어 터미널 메뉴 옵션 View and Edit Logical Drives
의 LG 번호는 동적으로 표시되지 않습니다. 즉, 논리 드라이브를 삭제하면 빈 자리 표시
자가 표시됩니다. 논리 드라이브가 콘솔이나 터미널에서 만들어지면 이 빈 자리 표시자
에 새 논리 드라이브가 채워집니다.
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▼ 파티션을 만들려면

주 – 파티션을 만들기 전에 할당된 모든 LUN의 매핑을 해제해야 합니다.

1. 분할할 논리 드라이브를 포함하고 있는 어레이를 선택합니다.

2. 파티션을 만들 논리 드라이브를 확인합니다.

3. 논리 드라이브에 호스트 LUN이 할당되어 있으면 4단계로 진행하고, 그렇지 않으면 8
단계로 진행합니다.

4. Configuration → Custom Configure를 선택합니다.

5. Change Host LUN Assignments를 선택합니다.

6. 분할하려는 논리 드라이브에 연결된 호스트 LUN을 선택하고 Unmap Host LUN을 클
릭합니다.

7. OK를 클릭한 다음 Close를 클릭합니다.

8. Configuration → Custom Configure를 선택합니다.

9. Custom Configuration Options 창에서 Manage Existing LDs/LVs and Partitions을 
선택합니다.

오른쪽에 표시된 Manage Existing LDs/LVs and Partitions(기존 LD/LV 및 파티션 관리 ) 창의 LD 필
논리 드라이브가 만들어지고 삭제되면 변경됩니다 . 이 예에서는 LD2가 삭제되었기 때문에

Drives에서 LG 필드는 동적이 아니므로 빈 슬롯이 LD2가 삭제되었음을 나타냅니다 .
LD4가 LD3이되고 LD2가 LD1이 됩니다 . 왼쪽에 표시된 터미널 메뉴 옵션 View and Edit Logical
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10. Partitions 탭을 선택합니다.

11. 분할할 논리 드라이브 또는 논리 볼륨을 선택합니다.

12. Partition Size를 MB 단위로 지정하고 Create를 클릭합니다.

같은 크기의 파티션을 여러 개 만들려면 만들 파티션 수만큼 Add Partition을 클릭합니
다. Part Size 필드에 파티션의 크기를 입력하고 만들 파티션 수를 곱할 수도 있습니
다(예: 100 * 128). 나머지 MB는 마지막 파티션에 추가됩니다.

파티션을 추가할수록 Available Size(MB)에 표시된 남은 용량이 추가된 파티션 크기에 
비례하여 줄어듭니다.

13. 이전에 만든 파티션의 크기를 변경하려면 논리 드라이브 또는 논리 볼륨을 선택하고 
Modify Size를 클릭합니다. 

14. Partition Size 필드에 새 크기를 MB 단위로 지정하고 OK를 클릭합니다.
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15. Confirm Configuration Operation 창에서 OK를 클릭하여 작업을 완료한 후 Close를 
클릭합니다.

논리 드라이브 또는 논리 볼륨을 분할한 후에는 기본 창에서 논리 드라이브나 논리 볼
륨을 열 때 파티션이 로 표시됩니다.

16. 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 ioscan -fnC disk 명령
을 실행해야 합니다(HP-UX OS에만 해당).

주 – System Administrator Manager(sam)를 사용하여 파일 시스템을 마운트 해제한 
경우 ioscan 명령을 실행하기 전에 닫아야 합니다.

17. (IBM AIX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
198페이지의 "IBM AIX 호스트에서 Object Data Manager 업데이트"에 설명되어 있는 
ODM(Object Data Manager)을 업데이트해야 합니다. 

논리 드라이브/논리 볼륨 번호

Manage Existing LDs/LVs and Partitions 창의 LDs/LVs 필드에 표시되는 논리 드라
이브/논리 볼륨 번호에 대한 자세한 내용은 151페이지의 "논리 드라이브/논리 볼륨 번
호"를 참조하십시오.
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▼ 파티션을 삭제하려면

주 – 논리 드라이브 또는 논리 볼륨의 파티션을 삭제하려면 할당된 모든 LUN의 매핑
을 해제해야 합니다.

1. 파티션을 삭제할 논리 드라이브나 논리 볼륨을 포함하고 있는 어레이를 선택합니다.

2. 파티션을 삭제할 논리 드라이브 또는 논리 볼륨을 확인합니다. 

드라이브의 파티션에 호스트 LUN 매핑이 있으면 3단계으로 진행하고, 그렇지 않으면 
7단계로 진행합니다.

3. Configuration → Custom Configure를 선택합니다.

4. Change Host LUN Assignments를 선택합니다.

5. 삭제할 논리 드라이브 또는 논리 볼륨의 파티션에 매핑된 LUN을 선택하고 Unmap 
Host LUN을 클릭합니다.

6. OK를 클릭한 다음 Close를 클릭합니다.

7. Configuration → Custom Configure를 선택합니다.

8. Custom Configuration Options 창에서 Manage Existing LDs/LVs and Partitions을 
선택합니다.

9. Partitions 탭을 선택합니다.

10. 논리 드라이브 또는 논리 볼륨의 마지막 파티션에서 시작하여 수정하거나 삭제할 파티
션을 선택합니다.
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11. Delete를 클릭한 다음 OK를 클릭합니다.

12. Confirm Configuration Operation 창에서 OK를 클릭하여 작업을 완료한 후 Close를 
클릭합니다.

13. (HP-UX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
ioscan -fnC disk 명령을 실행해야 합니다.

주 – System Administrator Manager(sam)를 사용하여 파일 시스템을 마운트 해제한 
경우 ioscan 명령을 실행하기 전에 닫아야 합니다.

14. (IBM AIX OS에만 해당). 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
198페이지의 "IBM AIX 호스트에서 Object Data Manager 업데이트"에 설명되어 있는 
ODM(Object Data Manager)을 업데이트해야 합니다.
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▼ 논리 드라이브 또는 논리 볼륨의 용량 확장
이 옵션을 사용하여 기존 논리 드라이브나 논리 볼륨의 용량을 확장할 수 있습니다. 예
를 들어, 드라이브의 원래 용량은 72GB인데, 그 중에서 36GB만 논리 드라이브를 만들
기 위해 선택할 수 있습니다. 나머지 36GB를 사용하려면 논리 드라이브를 확장해야 합
니다. RAID 수준 0, 1, 3 및 5에서 확장을 지원합니다.

주 – 논리 볼륨을 확장하려면 먼저 논리 볼륨을 구성하는 논리 드라이브를 확장해야 합
니다.

1. 구성할 어레이를 선택합니다.

2. Configuration → Custom Configure를 선택합니다.

3. Custom Configuration Options 창에서 Dynamically Grow and/or Reconfigure 
LD/LV를 선택합니다.

4. 확장할 논리 드라이브 또는 논리 볼륨을 선택합니다.

5. Expand LD/LV 탭을 선택합니다.

6. Maximum Drive Expand Capacity 필드에서 확장할 논리 드라이브나 논리 볼륨의 용
량을 MB 단위로 지정하고 OK를 클릭합니다. 

Maximum Available Drive Free Capacity 필드에 표시된 용량은 해당 논리 드라이브에
서 가장 작은 물리 드라이브를 기준으로 물리 드라이브당 사용 가능한 최대 자유 디스
크 공간입니다. 지정한 용량이 논리 드라이브의 각 물리 드라이브에 추가됩니다.

아래 예제에서 설명하는 것처럼 논리 드라이브에 추가되는 총 용량은 RAID 수준을 기
준으로 자동으로 계산됩니다.

주 – 논리 드라이브를 확장할 때 예비 드라이브는 포함되지 않습니다. 최대 드라이브 
확장 용량을 계산할 때도 예비 드라이브를 포함시키지 마십시오.

■ RAID 0 – Maximum Drive Expand Capacity 필드에 입력한 양을 해당 논리 드라이
브에 포함되어 있는 전체 물리 드라이브 수로 곱합니다. 예를 들어, 논리 드라이브에 
추가되는 총 용량은 100MB x 3 = 300MB입니다.

■ RAID 1 – Maximum Drive Expand Capacity 필드에 입력한 양을 해당 논리 드라이
브에 포함되어 있는 전체 물리 드라이브 수를 곱한 다음 이중화 용량을 감안하여 2로 
나눕니다. 예를 들어, 논리 드라이브에 추가되는 총 용량은 100MB x 4= 400MB. 
400/2 = 200MB입니다. 
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■ RAID 3 및 5 – Maximum Drive Expand Capacity 필드에 입력한 양(c)을 해당 논리 
드라이브에 포함되어 있는 전체 물리 드라이브 수로 곱한 다음 패리티를 감안하여 c
를 뺍니다. 예를 들어, 논리 드라이브에 추가되는 총 용량은 c = 100, 100MB x 3 = 
300MB. 300MB - 100MB = 200MB입니다. 

논리 드라이브를 확장할 최대 드라이브 총 용량을 알고 있다면 RAID 수준을 기준으로 
다음 계산을 수행하여 Maximum Drive Expand Capacity 필드에 입력할 양을 결정하
십시오. 

■ RAID 0 – 최대 드라이브 총 용량을 해당 논리 드라이브에 포함되어 있는 전체 물리 
드라이브 수로 나눕니다. 예를 들어, 물리 드라이브를 4개 포함하고 있는 논리 드라
이브에 총 100MB를 추가하려면 최대 드라이브 확장 용량은 100MB/4 = 25MB입니
다.

■ RAID 1 – 해당 논리 드라이브에 포함되어 있는 전체 물리 드라이브 수를 2로 나누어 
n을 구합니다. 그런 다음 최대 드라이브 용량을 n으로 나눕니다. 예를 들어, 물리 드
라이브를 4개 포함하고 있는 논리 드라이브에 총 100MB를 추가하려면 최대 드라이
브 확장 용량은 4/2 = 2. 100/2 = 50MB입니다.

■ RAID 3 및 5 – 전체 물리 드라이브 수에서 드라이브 하나를 빼서 n을 구합니다. 그런 
다음 최대 드라이브 용량을 n으로 나눕니다. 예를 들어, 물리 드라이브를 5개 포함하
고 있는 논리 드라이브에 총 100MB를 추가하려면 최대 드라이브 확장 용량은 5-1 = 
4. 100/4 = 50MB입니다.

주 – Maximum Drive Expand Capacity는 Maximum Available Drive Free Capacity
을 초과할 수 없습니다.

7. 논리 드라이브를 즉시 사용하려면 OnLine Expansion을 선택합니다.

온라인 확장을 사용하면 확장이 완료되기 전에 논리 드라이브를 사용할 수 있습니다. 
그러나 제어기가 I/O 작업을 수행하면서 논리 드라이브를 만들기 때문에 논리 드라이
브를 온라인으로 확장할 경우 오프라인으로 확장할 때보다 시간이 많이 걸립니다.

OnLine Expansion을 선택하지 않은 경우 완료가 완료된 후에야 드라이브를 사용할 수 
있습니다. 제어기가 I/O 작업을 수행하지 않으면서 논리 드라이브를 만들기 때문에 오
프라인으로 확장할 때가 온라인으로 확장할 때보다 시간이 덜 필요합니다.
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주 – 논리 볼륨을 확장할 때는 Online Expansion 옵션을 사용할 수 없습니다.

8. Confirm Configuration Operation 창에서 OK를 클릭하여 작업을 완료한 후 Close를 
클릭합니다.

논리 드라이브/논리 볼륨 번호

Dynamically Grow and/or Reconfigure LDs/LVs 창의 LD/LV 필드에 표시되는 논리 
드라이브/논리 볼륨 번호에 대한 자세한 내용은 151페이지의 "논리 드라이브/논리 볼
륨 번호"를 참조하십시오.

▼ 기존 논리 드라이브에 물리 드라이브 추가 
1. 구성할 어레이를 선택합니다.

2. Configuration → Custom Configure를 선택합니다.

논리 드라이브를 만들 때
전체 용량을 사용한 경우에는
0이 표시됩니다 . 즉 ,
다른 논리 드라이브를
추가하지 않으면 확장할
공간이 없습니다 .
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3. Custom Configuration Options 창에서 Dynamically Grow and/or Reconfigure 
LD/LV를 선택합니다.

4. 드라이브를 추가할 논리 드라이브를 선택합니다.

5. Add SCSI Drives 탭을 선택합니다.

6. Available disks 목록에서 논리 드라이브에 추가할 드라이브를 선택합니다.

7. Add Disk를 클릭합니다. 

드라이브가 Add disk(s) to LD목록으로 이동합니다.

디스크를 잘못 선택했거나 변경하려면 Add disk(s) to LD 목록에서 디스크를 선택하고 
Remove를 클릭합니다.

8. 드라이브 추가를 마치면 OK를 클릭합니다.

9. Confirm Configuration Operation 창에서 OK를 클릭하여 작업을 완료한 후 Close를 
클릭합니다.

논리 드라이브/논리 볼륨 번호
Dynamically Grow and/or Reconfigure LDs/LVs 창의 LD/LV 필드에 표시되는 논리 
드라이브/논리 볼륨 번호에 대한 자세한 내용은 151페이지의 "논리 드라이브/논리 볼
륨 번호"를 참조하십시오.
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▼ 물리 드라이브 복사 및 교체
기존의 물리 드라이브를 용량이 같거나 더 큰 드라이브로 복사하거나 교체할 수 있습니
다. 논리 드라이브가 그 중 가장 작은 드라이브의 용량 크기를 사용하므로 모든 드라이
브를 용량이 같거나 그 보다 큰 드라이브로 교체해야 합니다. 예를 들어, 그림 8-1에서 
볼 수 있듯이 원래 36GB 구성원 드라이브를 3개 포함하고 있는 논리 드라이브를 새 
73GB 구성원 드라이브로 교체할 수 있습니다. 

주 – 더 큰 용량의 드라이브에서 제공하는 추가 용량을 사용하려면 157페이지의 "논리 
드라이브 또는 논리 볼륨의 용량 확장"에 설명된 대로 용량을 확장해야 합니다.

그림 8-1 물리 드라이브 복사 및 교체

1. 구성할 어레이를 선택합니다.

2. Configuration → Custom Configure를 선택합니다.

3. Custom Configuration Options 창에서 Dynamically Grow and/or Reconfigure 
LD/LV를 선택합니다.

4. 복사 및 교체 작업을 수행할 논리 드라이브를 선택합니다.

5. Dynamically Grow and/or Reconfigure LDs/LVs 창에서 Copy and Replace Drive 
탭을 선택합니다.

36GB36GB36GB
새 드라이브

73GB

73 GB73 GB 73 GB

RAID 5(72GB)
새 드라이브

73GB
새 드라이브

73GB

RAID 5(146GB)
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6. Drive to Copy Data From 목록에서 새 하드 드라이브를 선택합니다.

7. Drive to Copy Data To 목록에서 교체할 하드 드라이브를 선택하고 OK를 클릭합니다.

8. Confirm Configuration Operation 창에서 OK를 클릭하여 작업을 완료한 후 Close를 
클릭합니다.

9. 작업이 완료되면 진행률 창을 닫습니다.

10. 새 드라이브에서 제공하는 추가 용량을 사용하려면 157페이지의 "논리 드라이브 또는 
논리 볼륨의 용량 확장"의 지침을 따르십시오.

논리 드라이브/논리 볼륨 번호
Dynamically Grow and/or Reconfigure LDs/LVs 창의 LD/LV 필드에 표시되는 논리 
드라이브/논리 볼륨 번호에 대한 자세한 내용은 151페이지의 "논리 드라이브/논리 볼
륨 번호"를 참조하십시오.
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▼ 새 하드 드라이브에서 검색 (SCSI에만 해당)
SCSI Array의 전원을 켜면 제어기가 드라이브 채널을 통해 연결된 모든 물리 드라이브
를 검색합니다. FC 및 SATA Array와 달리 SCSI Array는 초기화를 완료한 다음 물리 드
라이브가 연결되어 있으면 다음 번에 제어기를 재설정할 때까지 새 드라이브를 자동으
로 인식하지 않습니다. 이러한 동작 차이는 FC 및 SCSI의 아키텍처와 프로토콜 차이로 
인한 것입니다.

아래의 절차를 수행하여 어레이를 종료하지 않고도 SCSI 하드 드라이브를 검색하여 사
용할 수 있습니다.

1. 해당 어레이를 두 번 클릭합니다.

2. View Controller Configuration 창이 나타납니다.

3. Physical Drives 탭을 선택하고 Scan SCSI Drive를 클릭합니다.

드라이브가 실패한 경우 Physical Drive 창에 Scan SCSI Drive 버튼도 나타납니다. 물
리 드라이브를 선택하고, View를 선택한 다음 View Physical Drive 창에서 Scan SCSI 
Drive를 클릭합니다.
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4. 드라이브가 입력된 올바른 채널과 ID를 선택합니다.

검색을 마치면 드라이브가 기본 창에 적절히 표시되고 사용할 수 있게 됩니다.

▼ RAID 제어기 펌웨어 다운로드
다음 절차를 수행하면 단일 및 중복 제어기 구성을 위해 제어기 펌웨어를 업그레이드할 
수 있습니다.

1. 제어기를 선택합니다. 

2. Array Administration → Controller Maintenance를 선택합니다.

3. ssconfig로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니다. ssconfig 암
호를 입력합니다. 
164 Sun StorEdge 3000 Family Configuration Service 2.0 사용 설명서 •  2005년 7월



Controller Maintenance Options 창이 나타납니다.
 

4. 부트 레코드가 아닌 펌웨어만 업그레이드하는 경우 Download Firmware 옵션을 선택
합니다. 

Select Firmware File 창이 나타납니다.
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5. 다운로드할 펌웨어를 선택하고 Open을 클릭합니다.

Confirmation Dialog 프롬프트가 나타납니다.

6. Yes를 클릭합니다. 

펌웨어를 RAID 제어기에 다운로드하면 진행 표시줄이 표시됩니다.

7. 진행 표시줄이 100%에 도달하면 OK를 클릭합니다. 

8. 펌웨어가 다운로드되면 설정을 확인하여 올바르게 구성되었는지 확인합니다.
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▼ 펌웨어 및 부트 레코드 업그레이드
1. Array Administration → Controller Maintenance를 선택합니다.

2. ssconfig로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니다. ssconfig 암
호를 입력합니다. 

Controller Maintenance Options 창이 나타납니다.

3. Download Firmware with Boot Record를 선택합니다.

Select Boot Record File 창이 나타납니다.

4. 부트 레코드를 선택하고 Open을 클릭합니다. 

5. 해당 펌웨어 파일을 선택합니다. 

Select Firmware File이 나타납니다.

6. Open을 클릭합니다. 

Confirmation Dialog 창이 나타납니다.

7. 앞 장의 하위 절에 있는 단계 6 ~ 8을 반복합니다.
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장치의 펌웨어 다운로드
이 옵션을 사용하여 하드 드라이브와 SAF-TE/SES 장치의 펌웨어를 업그레이드할 수 
있습니다.

▼ 하드 드라이브의 펌웨어 업그레이드
1. 어레이를 선택합니다.

2. Array Administration → Download FW for Devices를 선택합니다.

3. Download FW for Disks 탭을 클릭합니다.

4. To All disks under Controller를 선택하고 메뉴에서 어레이를 선택하거나 To All 
disks under LD를 선택하고 메뉴에서 논리 드라이브를 선택합니다.

■ 새 펌웨어를 다운로드하지 않으려는 드라이브가 있는 경우에는 Selected Disks에서 
해당 드라이브를 선택하고 Remove를 클릭합니다.

■ 추가할 논리 드라이브가 있는 경우 Available Disks에서 해당 드라이브를 선택하고 
Add를 클릭합니다.

■ 서로 다른 제품 ID가 있는 드라이브가 여러 개 있는 경우 Product ID 목록 상자에서 
펌웨어를 다운로드할 드라이브의 제품 ID를 선택해야 합니다.
168 Sun StorEdge 3000 Family Configuration Service 2.0 사용 설명서 •  2005년 7월



5. Browse를 클릭하고 다운로드 펌웨어 파일을 찾습니다. 

Open을 클릭합니다.

6. 다운로드 펌웨어 파일을 선택하고 Open을 클릭한 다음 OK를 클릭합니다.

펌웨어가 다운로드를 시작합니다.

7. 진행률이 100%에 도달하면 OK를 클릭합니다.

8. 펌웨어가 성공적으로 다운로드되었는지 확인하려면 View → View Physical Drive를 
선택하고 Product Revision 필드에서 펌웨어 버전이 변경되었는지 확인합니다.

9. 콘솔에 제대로 표시되는 경우 새 자원 목록을 조사해야 합니다.

서버 아이콘을 선택하고 View → View Server → Probe를 선택하여 선택한 서버로 명령
을 보내서 새 자원 목록을 조사합니다. 

▼ SAF-TE 장치의 펌웨어 업그레이드 

주 – SAF-TE 장치는 SCSI Array에 사용되고 SES 장치는 FC Array에 사용됩니다.

1. 어레이를 선택합니다.

2. Array Administration → Download FW for Devices를 선택합니다.

3. Download FW for SAFTE/SES Devices 탭을 클릭합니다.

■ 장치를 추가하려면 Available SAF-TE Devices에서 장치를 선택한 후 Add를 클릭합
니다.
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■ 장치를 제거하려면 Selected SAF-TE Devices에서 장치를 선택한 후 Remove를 클릭
합니다.

4. Browse를 클릭하고 다운로드 펌웨어 파일을 찾습니다. 

5. 다운로드 펌웨어 파일을 선택하고 Open을 클릭한 다음 OK를 클릭합니다.

펌웨어가 다운로드를 시작하면 두 개의 진행률 창이 나타납니다.

6. 진행률이 100%에 도달하면 OK를 클릭합니다.

7. 펌웨어가 성공적으로 다운로드되었는지 확인하려면 View → View Enclosure를 선택
하고 Firmware Rev 필드에서 펌웨어 버전이 변경되었는지 확인합니다.

8. 콘솔에 제대로 표시되는 경우 새 자원 목록을 조사해야 합니다.

서버 아이콘을 선택하고 View → View Server를 선택하여 선택한 서버로 명령을 보내서 
새 자원 목록을 조사합니다. 
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▼ 제어기 매개변수 변경
1. 어레이를 선택합니다.

2. Configuration → Custom Configure를 선택합니다. 

필요한 경우 ssconfig 암호를 사용하여 프로그램의 구성 수준에 로그인합니다. 
Custom Configuration Options 창이 나타납니다.

3. Custom Configuration Options 창에서 Change Controller Parameters를 선택합니
다. 

Channel 탭이 선택된 Change Controller Parameters 창이 나타납니다.

주 –  Sun StorEdge 3510 FC Array 및 Sun StorEdge 3511 SATA Array의 경우 CurClk
는 2.0GHz입니다.

■ Controller Name (선택 사항 – 제어기를 쉽게 식별할 수 있도록 이름을 지정하려면 
Controller Name을 선택하고 원하는 이름을 입력합니다. OK를 클릭하여 변경 사항
을 저장합니다. 이 제어기 이름이 편의를 위해 적용 가능한 여러 가지 Sun StorEdge 
Configuration Service 창에 표시됩니다.
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■ Controller Unique ID (예약됨) – 제어기 고유 ID는 SAF-TE(SCSI Accessed Fault-
Tolerant Enclosure) 또는 SES(SCSI Enclosure Services) 장치에서 자동으로 설정됩
니다. 이 ID는 이더넷 주소와 WWN을 만들고, 일부 네트워크 구성에 대한 장치를 식
별하는 데 사용됩니다. 

주의 – 섀시를 교체하지 않는 한 0이 아닌 값을 지정하지 마십시오. 원래의 섀시 일련 
번호를 유지해야 합니다. Sun Cluster 환경에서는 특히 한 클러스터에서 동일한 디스크 
장치 이름을 유지해야 합니다. 서비스 담당자의 지시가 없으면 제어기 고유 ID를 변경
하지 마십시오. Controller Unique ID를 변경한 경우 제어기를 재설정할 때까지 적용되
지 않습니다.

▼ 변경된 값 저장
표 8-2에서 지정한 Change Controller Parameters 창의 옵션의 변경 사항을 적용하려면 
제어기를 재설정해야 합니다. 

표 8-2 재설정이 필요한 Change Controller Parameters 창의 옵션과 탭

옵션 탭

Controller Unique ID All

Channel Mode Channel(Change Channel Settings)

Default Transfer Width

Termination

Default Sync Clock

Write Back Cache

(펌웨어 3.31 이상에만 
해당)

Cache

Optimization

SCSI I/O Timeout(s) Drive I/F

Max Queued IO Count Host I/F

Fibre Connection(FC 및 
SATA에만 해당)

LUNs Per Host

Controller Configuration Redundancy
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제어기를 재설정해야 변경 사항이 적용되는 경우 창의 왼쪽 아래에 다음 메시지가 표시
됩니다.

[Controller reset is required for changes to take effect.] (변
경 사항을 적용하려면 제어기를 재설정해야 합니다.)

제어기를 재설정하고 변경된 값을 저장하려면 변경을 수행할 때 Controller Reset 확인
란을 선택하거나 Controller Maintenance 창을 통해 나중에 제어기를 재설정합니
다(135페이지의 "제어기 재설정" 참조). 변경 사항이 여러 개인 경우 변경할 때마다 제
어기를 중지하고 재설정하지 않을 수 있습니다. Controller Reset 확인란을 선택하지 않
고 변경 사항을 적용하기위해 재설정해야 하는 경우 OK를 클릭하면 경고 메시지가 표
시됩니다.

1. Controller Reset 확인란을 선택합니다.

2. 변경을 수행하고 OK를 클릭합니다.

또는

1. Controller Reset 확인란을 선택하지 마십시오.

2. 변경을 수행하고 OK를 클릭합니다.

3. 135페이지의 "제어기 재설정"에 설명된 대로 나중에 제어기를 재설정합니다.
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Channel 탭

1. Channel Settings 탭에서 편집할 채널을 선택합니다.

2. Change Settings을 클릭합니다.

Change Channel Settings 창이 나타납니다. 서버에서 어레이를 인식하려면 호스트 채
널에 논리 드라이브에 할당한 ID와 해당 호스트 채널 및 ID에 매핑된 논리 드라이브가 
있어야 합니다. 이 창을 통해 호스트/드라이브 채널을 구성할 수 있습니다.

3. Channel Mode  목록 상자에서 Host 또는 Drive 중 하나를 선택합니다. 

Drive 채널은 드라이브가 내부 또는 외부에 연결되는 것입니다. 호스트 채널은 서버에 
연결되는 것입니다. 일반적으로 RAID 어레이에 확장 장치를 연결할 경우에 Channel 
Mode를 Host에서 Drive로 변경합니다.

주 – Sun StorEdge 3310 SCSI Array와 Sun StorEdge 3320 SCSI Array에서는 호스트 
채널을 최대 두 개까지 지원합니다.

주 – 제어기 구성에 따라 다음 단계에 설명된 대로 기본 및 보조 채널 ID를 선택해야 할 
수도 있습니다.
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주의 – Sun StorEdge 어레이는 호스트, 드라이브 및 RCCOM 채널 설정으로 미리 구성
됩니다. RCCOM 설정은 Sun StorEdge Configuration Service에서 구성하거나 표시할 
수 없습니다. 호스트 또는 드라이브 채널을 구성하기 전에 펌웨어 응용프로그램을 사용
하여 채널 할당을 검토하십시오. 중복 제어기 구성에서 Sun StorEdge Configuration 
Service를 사용하여 RCCOM 채널 설정을 덮어쓴 경우 제어기 간 통신이 중지되고 예기
치 않은 결과가 발생할 수 있습니다. 자세한 내용은 Sun StorEdge 3000 Family RAID 
Firmware User's Guide를 참조하십시오.

4. Available SCSI IDs 목록 상자에서 PID로 지정된 주 채널 ID를 선택하고 Add PID를 
클릭합니다.

5. 두 개의 제어기가 설치되어 있는 경우 Available SCSI Ids 목록 상자에서 보조 채널 ID
를 선택한 다음 Add SID를 클릭합니다.

주 – Sun StorEdge 3310 SCSI Array 및 Sun StorEdge 3320 SCSI Array에서 호스트 채
널 ID를 4개 넘게 추가하는 경우 LUNs Per Host ID 매개변수(184페이지의 "Host I/F 
탭" 참조)가 32 미만의 값으로 설정되어야 합니다.

6. 변경 사항을 적용하려면 제어기를 재설정합니다.

광 섬유 또는 SATA 구성에서 호스트 ID 변경

1. 15보다 큰 ID가 필요하면 Select SCSI Range 목록 상자에서 원하는 범위를 선택합니
다. 

주 – 각 채널의 ID는 같은 범위 내에 있어야 합니다.

2. Remove를 클릭하여 PID 또는 SID를 제거합니다.

3. 모두 선택한 후에는 OK를 클릭하여 이전 창을 다시 표시합니다.
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RS 232 탭

RS 232 매개변수를 사용하여 RS 232 연결의 데이터 전송 속도를 설정할 수 있습니다.

1. 채널 설정을 모두 완료하면 Change Controller Parameters 창에서 RS 232 탭을 선택
합니다.

2. 원하는 포트를 선택하고 Change Settings을 클릭합니다. 

Change RS232 Port Settings 창이 나타납니다.

3. 기본값을 38400으로 설정하는 등 적절한 데이터 전송 속도를 선택하고 OK를 클릭하여 
이전 창으로 돌아갑니다. 

4. OK를 클릭합니다.
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Cache 탭

1. Change Controller Parameters 창에서 Cache 탭을 선택합니다.

2. Write Back을 기본 캐시로 지정하려면 Write Back Cache 목록 상자를 클릭하고 
Enabled를 선택합니다.

기록 정책은 캐시된 데이터를 디스크 드라이브에 기록할 시기를 결정합니다. 디스크에 
데이터를 기록하는 동안 데이터를 캐시에 보관할 수 있으면 순차적으로 읽을 때 저장 
장치의 속도가 향상될 수 있습니다. Write policy 옵션으로는 write-through와 write-
back이 있습니다.

후기록 캐시를 사용하면 데이터가 실제로 디스크 드라이브에 기록되기 전에 제어기가 
디스크에 기록할 데이터를 받아서 메모리 버퍼에 저장한 다음 즉시 쓰기 작업이 완료되
었다는 신호를 호스트 OS에 보냅니다. 후기록 캐시를 사용하면 쓰기 작업의 성능과 제
어기 카드의 처리량이 향상됩니다. 기본적으로 후기록 캐시로 설정되어 있습니다.
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동시 기록 캐시를 사용하면 제어기가 호스트 OS에 프로세스가 완료되었음을 신호하기
도 전에 디스크 드라이브에 데이터를 기록합니다. 동시 기록(Write-Through) 캐시는 후
기록(Write-Back) 캐시보다 쓰기 작업의 성능과 처리량이 낮지만 정전이 발생할 경우 
데이터 손실의 위험이 가장 적으므로 보다 안전합니다. 그러나 배터리 모듈이 설치되어 
있기 때문에 전원이 메모리에 캐시된 데이터에 공급되며 전원이 다시 켜지면 데이터가 
디스크에 기록될 수 있습니다. 후기록 캐시를 해제하면 동시 기록 캐시가 기본 기록 정
책이 됩니다.

지정한 설정이 모든 논리 드라이브의 기본 전역 캐시 설정이 됩니다. 이 설정은 논리 드
라이브를 만들 때 각 논리 드라이브에서 덮어쓸 수 있습니다.

3. Optimization 모드를 선택합니다.

Optimization 모드는 각 드라이브에서 기록되는 데이터의 양을 나타냅니다. 제어기는 
순차 I/O와 임의 I/O의 두 가지 최적화 모드를 지원합니다. 이 중 순차 I/O가 기본 모
드입니다.

RAID 어레이의 캐시 최적화 모드는 제어기에서 모든 논리 드라이브에 대해 사용하는 
캐시 블록 크기를 결정합니다.

■ 순차 최적화의 캐시 블록 크기는 128KB입니다.
■ 임의 최적화의 캐시 블록 크기는 32KB입니다.

특정 응용프로그램이 크거나 작은 스트라이프 크기를 사용할 때 적절한 캐시 블록 크기
를 사용하면 성능이 향상됩니다.

■ 비디오 재생, 멀티미디어 제작 후 오디오 및 비디오 편집 같은 응용프로그램은 순차
적으로 대용량 파일을 읽고 씁니다.

■ 트랜잭션 기반 및 데이터베이스 업데이트 응용프로그램은 작은 파일을 임의 순서로 
읽고 씁니다. 

캐시 블록 크기는 사용자가 만든 각 논리 드라이브에 대해 캐시 최적화 모드에서 설정
한 기본 스트라이프 크기와 함께 사용되므로 기본 스트라이프 크기가 캐시 블록 크기 
설정과 맞습니다. 그러나 논리 드라이브를 만들 때 다른 스트라이프 크기를 지정할 수 
있습니다. 자세한 내용은 179페이지의 "기본값이 아닌 스트라이프 크기 지정"을 참조하
십시오.

캐시 최적화 모드에 대한 자세한 내용은 Sun StorEdge 3000 Family RAID Firmware 
Users Guide를 참조하십시오.

주 – 논리 드라이브를 만든 후에는 모든 논리 드라이브를 삭제하지 않고 RAID 펌웨어
의 "Optimization for Random I/O" 또는 "Optimization for Sequential I/O" 메뉴 옵션
을 사용하여 최적화 모드를 변경할 수 없습니다. 앞에서 설명한 것처럼 논리 드라이브
가 존재할 때 Sun StorEdge Configuration Service나 Sun StorEdge CLI set cache-
parameters 명령을 사용하여 최적화 모드를 변경할 수 있습니다. set cache-
parameters 명령에 대한 자세한 내용은 the Sun StorEdge 3000 Family CLI 2.0 사용 
설명서를 참조하십시오.
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기본값이 아닌 스트라이프 크기 지정

새로 만드는 논리 드라이브는 선택한 최적화 모드와 RAID 수준에 따라 표 8-3에 나와 
있는 기본 스트라이프 크기로 구성됩니다. 

논리 드라이브를 만들 때 기본 스트라이프 크기를 응용프로그램에 더 적합한 스트라이
프 크기로 대체할 수 있습니다. 

■ 순차 최적화의 경우에는 16KB, 32KB, 64KB, 128KB 및 256KB 같은 스트라이프 크
기 중에서 선택할 수 있습니다.

■ 임의 최적화의 경우에는 4KB, 8KB, 16KB, 32KB, 64KB 및 128KB 같은 스트라이프 
크기 중에서 선택할 수 있습니다.

주 – 기본 스트라이프 크기를 사용해도 대부분의 응용 프로그램 성능이 최적화됩니다.

논리 드라이브의 스트라이프 크기를 설정하는 방법에 대한 자세한 내용은 Sun 
StorEdge 3000 Family RAID Firmware User's Guide를 참조하십시오.

이미 스트라이프 크기를 선택했고 논리 드라이브에 데이터를 쓴 경우에 논리 드라이브
의 스트라이프 크기를 변경하려면 논리 드라이브의 데이터를 다른 위치로 백업하고, 논
리 드라이브를 삭제한 다음 원하는 스트라이프 크기를 가진 논리 드라이브를 만들어야 
합니다.

임의 및 순차 최적화의 최대 디스크 수 및 최대 사용 가능 용량

RAID 펌웨어에서 지원되는 논리 드라이브당 최대 용량은 다음과 같습니다.

■ 임의 최적화의 경우 16TB
■ 순차 최적화의 경우 64TB

실제 논리 드라이브 최대 용량은 보통 실제 고려 사항이나 사용 가능 디스크 공간 양에 
의해 결정됩니다.

표 8-3 최적화 모드에 맞는 기본 스트라이프 크기(KB)

RAID 수준
Sequential I/O
(순차 I/O)

Random I/O
(임의 I/O)

0, 1, 5 128 32

3 16 4
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주의 – 큰 드라이브 용량을 가진 FC 및 SATA 구성에서 논리 드라이브의 크기가 해당 
운영 체제의 장치 용량 한계를 초과할 수 있습니다. 논리 드라이브를 만들기 전에 반드
시 해당 운영 체제의 장치 용량 한계를 확인하십시오. 논리 드라이브 크기가 용량 한계
를 초과하는 경우 논리 드라이브를 분할해야 합니다.

RAID 수준 및 최적화 모드에 따른 논리 드라이브의 최대 사용 가능 용량에 대한 자세한 
내용은 Sun StorEdge 3000 Family RAID Firmware User's Guide를 참조하십시오.

4. Periodic Cache Flush Time을 설정합니다.

Periodic Cache Flush Time을 설정하면 제어기가 지정된 간격으로 캐시를 논리 드라이
브 저장 장치로 플러시할 수 있습니다. 이러한 안전 조치를 수행하면 전원 손실 시 캐시
에 누적된 데이터가 손실되는 것을 막을 수 있습니다. 

다음 값 중 하나를 선택합니다.

■ Disabled – 캐시의 데이터가 디스크에 기록될 때 제어기가 캐시를 플러시할 수 있도
록 주기적 캐시 플러시를 종료합니다.

■ Continuous Sync – 데이터를 계속 캐시에서 논리 드라이브 저장 장치로 플러시합니
다.

■ 30 sec – 30초 간격으로 캐시를 논리 드라이브 저장 장치로 플러시합니다.

■ 1 min – 1분 간격으로 캐시를 논리 드라이브 저장 장치로 플러시합니다.

■ 2 min – 2분 간격으로 캐시를 논리 드라이브 저장 장치로 플러시합니다.

■ 5 min – 5분 간격으로 캐시를 논리 드라이브 저장 장치로 플러시합니다.

■ 10 min – 10분 간격으로 캐시를 논리 드라이브 저장 장치로 플러시합니다.

주 – 이 값을 1분 미만의 간격(Continuous Sync 또는 30 sec)으로 설정하면 성능
에 영향을 줄 수 있습니다.

5. 변경 사항을 적용하려면 제어기를 재설정합니다.
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Disk Array 탭

1. Change Controller Parameters 창에서 Disk Array 탭을 선택합니다.

2. 3개의 Write Verify 목록 상자에서 Disabled 또는 Enabled 중 하나를 선택합니다.

일반적으로 하드 드라이브가 데이터를 쓸 때 오류가 발생할 수 있습니다. 쓰기 오류를 
방지하기 위해 제어기는 하드 드라이브가 쓴 데이터를 확인하도록 할 수 있습니다.

■ Write Verify on Initialization – 논리 드라이브를 초기화하는 동안 쓰기 후 확인을 수
행합니다.

■ Write Verify on Rebuild – 재구성하는 동안 쓰기 후 확인을 수행합니다.

■ Write Verify on Normal – 일반 I/O 요청 동안 쓰기 후 확인을 수행합니다.

3. Rebuild Priority 목록 상자에서 네 가지 옵션, Low, Normal, Improved 또는 High 중
에서 선택합니다.

RAID 제어기에서는 배경 재구성 기능을 제공합니다. 즉, 논리 드라이브를 재구성하는 
동안 제어기가 다른 I/O 요청을 처리할 수 있습니다. 드라이브를 재구성하는 데 필요한 
시간은 주로 재구성하는 논리 드라이브의 전체 용량에 따라 결정됩니다. 또한 재구성 
프로세스는 호스트 컴퓨터나 OS에 완전히 투명하게 수행됩니다.
8 장 구성 업데이트 181



■ Low – 기본값이며, 재구성할 때 해당 제어기의 최소 자원을 사용합니다.

■ Normal – 재구성 프로세스를 가속화합니다.

■ Improved – 재구성 프로세스에 더 많은 자원을 할당합니다.

■ High – 가능한 경우 재구성 프로세스를 가장 빠른 시간 내에 완료하기 위해 해당 제
어기의 최대 자원을 사용합니다.

Drive I/F 탭

1. Change Controller Parameters 창에서 Drive I/F 탭을 선택합니다.
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2. Drive Motor Spin Up 필드에서 Disabled 또는 Enabled 중 하나를 선택합니다.

Drive Motor Spin Up은 디스크 어레이에서 물리 드라이브를 시작하는 방법을 결정합
니다. 전원 공급을 동시에 받는 모든 물리 드라이브와 제어기에 공급되는 전류가 부족
한 경우에 전류 소비량을 줄이려면 물리 드라이브를 직렬로 켜야 합니다. 

Drive Motor Spin Up이 설정된 경우 드라이브에 순차적으로 전원이 공급되며 이러한 
드라이브 중 일부는 어레이에 전원이 공급될 때 제어기에서 액세스할 수 있도록 준비가 
되어 있지 않을 수도 있습니다. 드라이브가 준비될 때까지 오랫동안 제어기가 기다리도
록 디스크 액세스 지연 시간을 늘리십시오.

3. Disk Access Latency를 설정합니다.

이 기능은 전원이 켜진 후 제어기가 하드 드라이브에 액세스할 때까지의 지연 시간을 
설정합니다. 기본값은 15초입니다.

4. Tag Count Per drive를 설정합니다.

각 드라이브에 동시에 보낼 수 있는 최대 태그 수입니다. 드라이브에는 내장 캐시가 있
으므로 드라이브에 보내진 모든 I/O 요청(태그)을 정렬하여 요청을 보다 신속하게 완료
할 수 있습니다.

캐시 크기와 최대 태그 수는 드라이브의 브랜드와 모델에 따라 다릅니다. 기본값인 32
를 사용합니다. 최대 태그 수를 Disable로 변경하면 드라이브의 내부 캐시가 무시되어 
사용되지 않습니다.

제어기는 1부터 128까지의 조정 가능한 태그 수로 태그 명령 대기를 지원합니다.

5. SAF-TE/SES Polling Period(s) 필드에서 목록 상자에 있는 가변 시간 옵션을 선택하거
나, 설치된 모든 ERM(Event Recording Module)이 폴링되지 않도록 Disabled를 선택
하여 이 기능을 해제합니다.

6. SCSI I/O Timeout(s) 필드에서 0.5초에서 30초 사이의 값을 선택합니다.

SCSI I/O Timeout은 제어기가 드라이브의 응답을 기다리는 시간 간격입니다. 제어기
가 드라이브에서 데이터를 읽거나 드라이브에 데이터를 쓰려는 경우 드라이브가 SCSI 
I/O 시간 제한 값 내에 응답하지 않으면 드라이브는 실패한 것으로 간주됩니다. SCSI 
I/O Timeout의 기본 설정은 30초입니다. 

주의 – 이 설정을 변경하지 마십시오. 시간 초과 값을 낮게 설정하면 제어기는 드라이
브가 재시도 중이거나 SCSI 버스를 조정할 수 없는 동안 드라이브가 실패한 것으로 판
단하게 됩니다. 시간 초과 값을 높게 설정하면 제어기가 드라이브를 계속 기다려 호스
트 시간 초과를 초래할 수도 있습니다.
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드라이브가 드라이브 플래터에서 읽는 동안 미디어 오류를 감지하면 이전 읽기를 다시 
시도하거나 헤드를 다시 조정합니다. 드라이브가 미디어에서 불량 블록을 발견하면 같
은 디스크 드라이브의 다른 예비 블록에 이 불량 블록을 다시 할당합니다. 그러나 이 작
업을 수행하는 데에는 시간이 걸립니다. 이러한 작업을 수행하는 시간은 드라이브의 브
랜드와 모델에 따라 다를 수 있습니다.

SCSI 버스를 조정하는 동안 우선 순위가 높은 장치가 버스를 먼저 사용할 수 있습니다. 
우선 순위가 높은 장치가 버스를 계속 사용하는 경우 우선 순위가 낮은 장치에는 SCSI 
I/O Timeout이 종종 발생할 수 있습니다.

7. Drive Check Period(s) 필드에서 0.5초에서 30초 사이의 값을 선택합니다.

Periodic Drive Check Time은 SCSI 버스에서 제어기가 드라이브를 검사하는 시간 간격
입니다. 기본값은 Disabled이며 버스에 진행 중인 작업이 없는 경우 제어기가 드라이브
의 실패나 제거 여부를 알지 못합니다. 시간 간격을 설정하면 프로그램은 어레이 작업
이 없을 때 드라이브 실패를 감지할 수 있지만 성능은 저하됩니다.

8. Auto Assign Global Spare Drive.

이 기능은 기본적으로 해제되어 있습니다. 이 기능을 설정하면 시스템이 사용하지 않는 
드라이브의 최소 드라이브 D에 전역 예비 드라이브를 자동으로 할당합니다. 그러면 드
라이브 교체 시 사용자의 작업 없이도 어레이가 자동으로 재구성합니다.

Host I/F 탭

9. Change Controller Parameters 창에서 Host I/F 탭을 선택합니다.
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10. Max Queued IO Count를 설정합니다. 

이 기능을 사용하여 서버에서 받아들일 수 있는 논리 드라이브당 최대 I/O 작업 수를 
구성할 수 있습니다. 논리 드라이브당 1 - 1024 I/O 작업 수 범위로 미리 정의되어 있으
며, "Auto Compute"(자동 구성) 설정을 선택할 수 있습니다. 기본값은 논리 드라이브당 
1024 I/O 작업입니다.

적절한 설정은 연결된 서버와 제어기 자체가 수행하는 I/O 작업 수에 따라 달라집니
다. 적절한 설정은 제공된 호스트 메모리 양, 드라이브 수와 크기 및 버퍼 한계에 따라 
달라질 수 있습니다. 호스트 메모리 양을 늘리거나, 드라이브를 추가하거나, 더 큰 드라
이브로 드라이브를 교체한 경우 최대 I/O 수를 늘릴 수 있습니다. 그러나 "Auto 
Compute" 또는 "256" 설정을 사용하면 보통 최적의 성능이 얻어집니다

11. (FC 및 SATA에만 해당). Fibre Connection 유형을 선택합니다.

Sun StorEdge 3510 FC Array 및 Sun StorEdge 3511 SATA Array는 다음과 같은 Fibre 
connection 프로토콜을 지원합니다.

■ Point-to-point – 패브릭 스위치 네트워크에서만 사용할 수 있으며, SAN(Storage 
Attached Network) 구성이라고도 합니다. Point-to-Point 프로토콜은 전이중 통신을 
지원할 뿐 아니라 채널 당 하나의 ID도 허용합니다.

■ 루프 (FC-AL) – DAS(Direct Attached Storage) 또는 SAN 구성에서만 사용될 수 있
습니다. FC-AL은 반 이중 통신만 지원하지만 채널 당 ID를 8개까지 허용합니다.

지점간 및 루프 프로토콜에 대한 자세한 내용은 Sun StorEdge 3000 Family RAID 
Firmware User's Guide를 참조하십시오.

12. LUNs Per Host를 설정합니다.

이 기능은 호스트 ID당 구성할 수 있는 최대 LUN 수를 변경하는 데 사용됩니다. 호스트 
채널 ID가 추가될 때마다 이 설정에서 할당된 LUN 수를 사용합니다. 기본 설정은 LUN 
32개이며, 사용 가능한 LUN이 1개부터 32개 사이로 미리 정의됩니다.

주 – Sun StorEdge 3310 SCSI Array 및 Sun StorEdge 3320 SCSI Array의 경우 최대 
LUN 할당 수는 128이며, 기본 설정 32를 사용할 경우 4개의 호스트 채널 ID만 추가할 
수 있습니다(4 x 32 = 128). 호스트 채널 ID를 5개 이상 추가한 경우(174페이지의 
"Channel 탭" 참조) LUNs Per Host 매개 변수를 32 미만의 값으로 설정해야 합니다.

13. (선택적) 어레이에 저장된 데이터의 보안을 향상시키려면 In-Band External Interface 
Management에 대해 Disable를 선택하여 SCSI 또는 FC 인터페이스를 통한 대역 내 
관리를 금지시킵니다. 
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주의 – 대역 내 관리를 통해 어레이를 관리할 때 In-Band External Interface 
Management에 대해 Disable를 선택하면 어레이와 통신할 수 없게 됩니다. 이 어레이
를 계속 모니터링하려면 대역 외 관리를 통해 어레이를 관리할 때만 이 옵션을 선택하
십시오. 대역 외 관리로 전환하는 절차에 대해서는 114페이지의 "대역 외 관리를 사용하
려면"을 참조하십시오.

In-Band External Interface Management에 대해 Disable를 선택한 후 서버 아이콘을 
선택하고 View → View Server → Probe를 선택합니다. 콘솔을 업데이트하는 데 몇 분이 
걸립니다.

14. Fibre Connection 프로토콜을 변경한 경우 변경 사항을 적용하려면 제어기를 재설정
합니다.

Redundancy 탭

1. Change Controller Parameters 창에서 Redundancy 탭을 선택합니다.

2. Set Controller Config 필드에서 옵션을 선택합니다. 

■ Redundant Deassert Reset - 제어기에 실패가 발생했고 이를 다시 온라인 상태로 가
져오려는 경우
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■ Redundant Force Sec Fail - 보조 제어기에 강제로 오류를 발생시키려는 경우

■ Redundant Force Pri Fail - 주 제어기에 강제로 오류를 발생시키려는 경우

주 – 두 제어기를 모두 Redundant Primary 구성에서 설정하십시오. 그러면 제어기에
서 기본과 보조를 결정합니다. 이렇게 하면 제어기 간에 발생할 수 있는 충돌을 방지할 
수 있습니다.

3. 중복 제어기가 있는 어레이가 후기록 캐시가 설정된 상태로 작동하는 경우 Write-
Through Cache Synchronization 목록 상자에서 Not Synchronized를 선택하여 두 제
어기 사이의 캐시 동기화를 해제할 수 있습니다.

주의 – 캐시 동기화를 해제하고 제어기 사이의 데이터 이중화와 전송을 없애면 어레이 
성능이 향상될 수 있지만 제어기 중 하나가 실패하는 경우 캐시 동기화에서 제공하던 
안전 조치도 없어집니다.

4. 변경 사항을 적용하려면 제어기를 재설정합니다.

5. OK를 클릭하여 주 메뉴로 돌아갑니다.

Peripheral 탭

지정된 이벤트가 발생하거나 임계치가 초과되었을 경우 Peripheral 탭에서 기록 정책을 
후기록 캐시에서 동시 기록 캐시로 동적으로 전환하도록 어레이를 구성할 수 있습니
다. 문제를 해결하면 원래의 기록 정책이 복원됩니다. 또한 제어기가 온도 임계치를 초
과하면 제어기가 종료되도록 구성할 수도 있습니다. 

Peripheral Device Status 상자에서는 제어기의 모든 환경 센서의 상태를 볼 수 있습니
다. (섀시의 환경 상태에 대해서는 93페이지의 "엔클로저 보기"를 참조하십시오.)
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1. Change Controller Parameters 창에서 Peripheral 탭을 선택합니다.

2. 이벤트 트리거 작업을 활성화 또는 해제합니다.

후기록 캐시가 설정된 상태로 어레이가 구성된 경우 다음과 같은 이벤트가 발생할 때 
기록 정책이 후기록 캐시에서 동시 기록 캐시로 동적으로 전환되도록 할 것인지 여부를 
지정합니다.

■ 제어기 실패
■ 팬 실패
■ 전원 공급 장치 실패
■ 배터리 백업 장치 실패 또는 배터리가 충분히 충전되지 않은 경우

주 – 문제를 해결하면 원래의 기록 정책이 복원됩니다.

기록 정책이 동적으로 전환되지 않도록 하려면 이 옵션들을 Disable로 설정합니다. 이 
옵션들은 기본적으로 설정되어 있습니다.

후기록 및 동시 기록에 대한 자세한 내용은 142페이지의 "논리 드라이브를 추가 또는 새 
논리 드라이브에서 논리 볼륨 추가"을 참조하십시오.
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3. 과열 제어기 종료를 활성화 또는 해제합니다.

온도가 임계치 한계를 초과할 경우 즉시 제어기가 종료되게 하려면 Temperature 
Exceeds Threshold 필드에서 Enable를 선택하고 그렇지 않으면 Disable을 선택합니다.

제어기가 종료되면 기본 창의 제어기 아이콘이 노란색(저하) 장치 상태 기호 를 표
시합니다.

4. 온도가 임계치 한계를 초과한 후 지정된 간격이 지난 후에 제어기가 종료되게 하려면 
Temperature Exceeds Threshold Period 필드에서 다음과 같은 시간을 선택합니다.

■ 0초 
■ 2분
■ 5분
■ 10분
■ 20분
■ 30분 (기본값)

▼ 제어기의 환경 상태 보기
1. Change Controller Parameters 창에서 Peripheral 탭을 선택합니다.

2. 오른쪽 스크롤 막대를 클릭하고 Peripheral Device Status 상자가 나타날 때까지 아래
쪽으로 스크롤합니다.
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3. Peripheral Device Status 상자에서 스크롤 막대를 클릭하고 아래쪽으로 스크롤하여 
환경 상태 정보를 표시합니다.

주변 장치의 임계 범위는 펌웨어 응용프로그램을 사용하여 설정됩니다. 장치가 설정된 
임계 범위를 초과하면 상태가 "Over upper threshold"를 표시합니다. 장치가 임계 범위
에 미달하면 상태가 "Under lower threshold"를 표시합니다. 이 두 가지 이벤트가 발생
하면 기본 창의 제어기 아이콘이 빨간색(긴급) 장치 상태 기호 를 표시합니다. 

임계 범위를 설정하는 방법에 대한 자세한 내용은 Sun StorEdge 3000 Family RAID 
Firmware User's Guide를 참조하십시오.

Network 탭

1. Change Controller Parameters 창에서 Network 탭을 선택합니다.
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1. IP 주소, 서브넷 마스크 또는 게이트웨이 주소를 수동으로 구성하려면 Change 
Settings을 클릭합니다. 

Change Network Setting 창이 나타납니다.

주 – Sun StorEdge 3000 Family 어레이는 기본적으로 DHCP(Dynamic Host 
Configuration Protocol) TCP/IP 네트워크 지원 프로토콜이 설정된 상태로 구성됩니다
. 네트워크에서 DHCP 서버를 사용할 경우 어레이가 초기화될 때나 이후에 재설정할 
때 서버가 IP 주소, 네트마스크 및 게이트웨이 IP 주소를 RAID 어레이에 할당합니다.

2. RARP 서버가 있는 환경에서 어레이를 설정한 경우

a. Dynamic IP Assignment Mechanism List의 Selected 상자에서 DHCP를 제거합니
다.

b. Dynamic IP Assignment Mechanism List의 Selected 상자에 RARP를 추가합니
다.

주 – 펌웨어는 복수의 IP 할당 메커니즘을 지원하지 않습니다. 현재 프로토콜 하나가 
선택된 경우 다른 프로토콜을 추가하기 전에 제거해야 합니다.
8 장 구성 업데이트 191



3. 정적 IP 주소를 가지려면:

a. Enable Dynamic IP Assignment 확인란의 선택을 해제합니다.

b. Static IP Information 아래의 해당 상자에 정적 IP 주소, 서브넷 마스크 및 게이트웨
이 IP 주소를 입력합니다.

4. OK를 클릭합니다.

5. 제어기를 재설정할 것인지 묻는 메시지가 나타나면 Yes를 클릭합니다.

Protocol 탭

보안 상의 이유로 지원할 네트워크 프로토콜만 활성화할 수 있습니다. 이렇게 하면 보
안 누출이 제한됩니다.

1. Change Controller Parameters 창에서 Protocol 탭을 선택합니다.
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2. 활성화 또는 해제할 프로토콜을 선택합니다.

프로토콜은 다음과 같이 기본적으로 활성화 또는 해제되어 있습니다.

■ TELNET – IP 주소에 대한 텔넷 액세스가 활성화됩니다.

■ HTTP – Hypertext Transport Protocol 액세스가 해제됩니다.

■ HTTPS – Hypertext Transport Protocol Secure 액세스가 해제됩니다.

■ FTP – File Transfer Protocol 액세스가 해제됩니다.

■ SSH – Secure Socket Handling 프로토콜 액세스가 해제됩니다.

■ PriAgentAll – 제어기에서 사용하는 내부 통신 프로토콜이 활성화됩니다. 

주 – Sun StorEdge Configuration Service 및 CLI가 제어기 펌웨어로부터 정보를 받을 
수 있도록 PriAgentAll 프로토콜이 계속 활성화되어 있어야 합니다. 이 프로토콜을 해
제하지 마십시오.

■ SNMP – Simple Network Management Protocol 액세스가 해제됩니다. SNMP는 외
부 관리 소프트웨어와 통신할 때도 사용될 수 있습니다.

■ DHCP – Dynamic Host Configuration Protocol 액세스가 활성화됩니다. DHCP는 
일부 네트워크에서 네트워크 상의 시스템에 동적으로 IP 주소를 할당하는 데 사용됩
니다. 

■ Ping – Ping을 통해 네트워크의 호스트가 어레이가 온라인 상태인지 확인합니다.

▼ 제어기 경고음 음소거하기
제어기에서 경고음을 유발하는 이벤트가 발생할 때 (예: 재구성하는 동안이나 물리 드
라이브를 추가하는 중에 논리 드라이브가 실패하는 경우) 다음 두 가지 중 한 가지 방법
으로 경고음을 음소거할 수 있습니다. 

1. 기본 창에서 원하는 제어기 아이콘을 선택합니다. 

2. Array Administration → Controller Maintenance를 선택합니다.

3. ssconfig로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니다. ssconfig 암
호를 입력합니다. 

Controller Maintenance Options 창이 나타납니다.

4. Mute Controller Beeper를 클릭합니다.

또는

1. 기본 창에서 원하는 제어기 아이콘을 선택합니다. 

2. Configuration → Custom Configure를 선택합니다.
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3. Change Controller Parameters를 선택합니다.

4. Mute Beeper를 선택합니다.

주 – 실패한 구성 요소로 인해 경보음이 나는 경우에는 경고음을 음소거하더라도 효과
가 없습니다. 어레이의 우측 손잡이에 있는 Reset 버튼을 눌러야 합니다. 구성 요소 실
패 알람에 대한 자세한 내용은 93페이지의 "엔클로저 보기"를 참조하십시오. 

▼ 대기 드라이브 할당 또는 변경
RAID 0이 아닌 결함 허용 논리 드라이브 내의 물리 드라이브가 실패하면 대기 드라이
브가 자동으로 데이터를 재구성하는 예비 드라이브의 기능을 수행합니다. 대기 드라이
브가 다른 드라이브를 대체하려면 실패한 드라이브와 크기가 최소한 같아야 하며 실패
한 디스크에 연결된 모든 논리 드라이브가 중복(RAID 1, 3, 5, 또는 1+0)되어야 합니다.

이 기능을 사용하여 전역 또는 로컬 대기 드라이브를 할당하거나 준비된 드라이브의 상
태를 대기 상태로 변경하거나 또는 대기 드라이브의 상태를 준비된 상태로 변경할 수 
있습니다. 전역 예비 드라이브로 할당된 드라이브는 기존 드라이브의 구성원이 실패하
는 경우 재구성합니다. 어레이 제어기와 연결된 하나 이상의 대기 드라이브가 있을 수 
있습니다. 전역 예비 드라이브는 만든 순서대로 사용됩니다. 로컬 예비 드라이브는 특
정 논리 드라이브에 할당되어야 하며 해당 논리 드라이브 내에서만 구성원을 재구성합
니다.

1. 기본 창에서 원하는 어레이 제어기를 선택합니다.

2. Configuration → Custom Configure를 선택하거나 Custom Configuration 도구를 클
릭합니다.

필요한 경우 ssconfig 암호를 사용하여 프로그램의 구성 수준에 로그인합니다. 
Custom Configuration Options 창이 나타납니다.

3. Custom Configuration Options 창에서 Make or Change Standby Drives를 선택합
니다.
194 Sun StorEdge 3000 Family Configuration Service 2.0 사용 설명서 •  2005년 7월



Make or Change Standby Drives 창이 나타납니다.

4. 창의 맨 위에서 서버와 제어기 ID를 확인합니다.

다른 서버나 제어기를 선택하려면 Cancel을 클릭하여 기본 창으로 돌아가 트리 보기에
서 적절한 서버나 제어기를 선택한 다음 단계 2 및 3을 반복합니다.

5. 할당하거나 변경할 드라이브를 선택합니다.

6. Ready, Global StandBy 또는 StandBy for LD#(로컬)을 선택하여 드라이브의 상태를 
변경하거나 할당합니다.

7. Modify를 클릭합니다.

8. Apply를 클릭한 다음 Close를 클릭합니다.

9. 구성을 변경할 때마다 새 구성을 파일에 저장합니다. 자세한 내용은 60페이지의 "구성 
파일"을 참조하십시오.
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사용 가능한 서버
Server List Setup 창의 Available Servers 또는 Managed Servers 목록에서 항목을 편집
하거나 삭제해야 할 수도 있습니다.

▼ 서버 항목 편집
1. File → Server List Setup을 선택합니다. Server Setup 창이 나타납니다. 

필요한 경우 Server List Setup 창에서 서버 이름을 Managed Servers 목록에서 
Available Servers 목록으로 이동합니다. Available Servers 목록에 있는 서버 항목만 편
집할 수 있습니다.
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2. Available Servers 목록에서 서버 이름을 선택하고 Edit를 클릭합니다. 

Edit Server 창이 나타납니다. 
 

3. 필요한 사항을 변경합니다. OK를 클릭하여 변경 사항을 등록합니다.

이 창의 필드에 대한 자세한 내용은 12페이지의 "서버를 추가하려면"을 참조하십시오. 
Add Server 및 Edit Server 창의 필드는 동일합니다. 

IP 주소 바로 가기: 네트워크 주소가 변경된 경우에는 Get IP Addr by Name을 클릭합
니다. 서버의 이름을 네트워크에서 사용하는 이름 서비스에 의해 기록된 대로 입력하면 
프로그램이 올바른 IP 주소를 검색하여 표시합니다. 

서버에 사용된 이름이 서버의 네트워크 이름과 다르거나 이름 지정 서비스가 업데이트
되지 않은 경우 해당 서버를 삭제한 다음 다시 추가하십시오.

4. 서버 이름을 Managed Servers 목록으로 다시 이동합니다.

5. OK를 클릭하여 Edit Server 창을 닫습니다.
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IBM AIX 호스트에서 Object Data 
Manager 업데이트
IBM AIX 호스트에서는 구성을 변경한 후에 환경이 안정되고 정확한지 확인하려면 
ODM(Object Data Manager)을 업데이트해야 합니다. 

▼ ODM 업데이트
1. 삭제된 각 디스크에 대해 다음 명령을 실행합니다.

여기서 #는 제거된 디스크의 번호입니다.

주의 – hdisk0는 제거하지 마십시오.

여러 디스크(hdisk1에서 hdisk19까지)를 제거하려면 다음 명령을 실행합니다.

rmdev 명령에서 디스크 사용 중 오류가 반환되는 경우 명령줄, smit 또는 smitty 중 하
나를 사용하여 이전에 만든 볼륨 그룹이 off 상태로 변경되었고 장치에 마운트된 파일 
시스템이 없는지 확인합니다. 또한 지속 볼륨 그룹에 exportvg 기능을 수행해야 합니
다. exportvg가 작동하지 않으면 다시 부팅해 봅니다.

2. JBOD는 사용하는 경우 일반 장치에 대해 동일한 명령을 실행합니다. 다음 명령을 실행
하여 반환된 결과로부터 판단할 수 있습니다.

3. 다음 명령을 실행합니다.

# rmdev -l hdisk# -d

# /usr/bin/ksh93
# for ((i=1; i<20; i++))
> do
> rmdev -l hdisk$i -d
> done

# lsdev -Cc generic
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4. 다음 명령을 실행하여 /dev 디렉토리에서 참조를 삭제합니다.

5. 다음 명령을 실행하여 에이전트를 중지하고 시작한 다음 시스템 구성을 ODM으로 다
시 읽어 옵니다.

주의 – OS에 존재하는 장치 수에 따라 이 명령이 완료하는 데 몇 분이 걸릴 수 있습니
다. cfgmgr이 완료될 때까지 구성을 변경하지 마십시오.

# /usr/bin/ksh93
# for ((i=1; i<20; i++))
> do
> rmdev -l gsc$i -d
> done

# rm /dev/gsc*

# ssagent stop
# ssagent start
# cfgmgr -v
8 장 구성 업데이트 199
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부록 A

RAID에 대한 기본 정보

이 부록에서는 RAID 용어 및 RAID 수준을 비롯한 RAID에 대한 기본적인 정보를 제공
합니다. 다루는 내용은 다음과 같습니다.

■ 201페이지의 "RAID 용어 개요"
■ 206페이지의 "RAID 수준"
■ 212페이지의 "로컬 및 전역 예비 드라이브"

RAID 용어 개요
RAID(Redundant Array of Independent Disk)는 저장 장치 시스템의 처리 기능을 향
상시키는 데 사용되는 저장 기술입니다. 이 기술은 디스크 어레이 시스템에 안정성을 
제공하고 여러 디스크를 사용하는 어레이가 제공하는 성능 상의 이점을 단일 디스크 저
장 장치에서 활용하도록 설계되었습니다.

RAID의 두 가지 기본 개념은 다음과 같습니다. 

■ 여러 하드 드라이브에 데이터를 분산하면 성능이 향상됩니다.

■ 여러 드라이브를 적절히 사용하면 한 드라이브가 실패하더라도 데이터가 손실되지 
않으며 시스템이 중단되지 않고 가동될 수 있습니다.

디스크가 실패하는 경우에도 디스크 액세스는 정상적으로 계속되고 호스트 시스템은 
실패의 영향을 받지 않습니다.
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논리 드라이브
논리 드라이브는 독립적인 물리 드라이브들로 이루어진 어레이입니다. 논리 드라이브
를 만들면 가용성, 용량 및 성능이 향상됩니다. 호스트에 있어서 논리 드라이브는 로컬 
하드 디스크 드라이브와 동일한 것으로 인식됩니다. 

그림 A-1 여러 물리 드라이브를 포함하는 논리 드라이브

논리 볼륨
논리 볼륨은 두 개 이상의 논리 드라이브로 구성됩니다. 논리 볼륨은 FC의 경우 최대 32
개의 파티션으로 나눌 수 있습니다. 작업을 수행하는 동안 호스트는 분할되지 않은 논
리 볼륨이나 논리 볼륨의 파티션을 하나의 물리 드라이브로 인식합니다.

로컬 예비 드라이브
로컬 예비 드라이브는 지정된 하나의 논리 드라이브에 서비스를 제공하도록 할당된 대
기 드라이브입니다. 지정된 이 논리 드라이브의 구성원 드라이브가 실패하는 경우 로컬 
예비 드라이브는 구성원 드라이브가 되어 자동으로 재구성을 시작합니다.

전역 예비 드라이브
전역 예비 드라이브는 지정된 하나의 논리 드라이브에 서비스를 제공하는 것 이상의 역
할을 합니다. 어떤 논리 드라이브든 구성원 드라이브가 실패하는 경우 전역 예비 드라
이브는 해당 논리 드라이브에 연결하여 자동으로 재구성을 시작합니다.
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채널

확장 기능이 설정되어 있는 경우(16비트 SCSI) 하나의 SCSI 채널에 최대 15개의 장치
(제어기 자체는 제외)를 연결할 수 있습니다. 루프 모드에서는 하나의 FC 채널에 최대 
125개의 장치를 연결할 수 있습니다. 각 장치에는 SCSI 버스 또는 FC 루프에 장치를 식
별시켜주는 고유 ID가 있습니다. 

논리 드라이브는 SCSI 드라이브, FC 드라이브 또는 SATA 드라이브의 그룹으로 구성됩
니다. 하나의 논리 드라이브 내에 있는 여러 물리 드라이브는 같은 SCSI 채널에서 비롯
되지 않아도 됩니다. 또한 각각의 논리 드라이브는 서로 다른 RAID 수준으로 구성할 수 
있습니다.

드라이브는 하나의 특정 논리 드라이브에 로컬 예비 드라이브 또는 전역 예비 드라이브
로 할당할 수 있습니다. 예비 드라이브는 데이터 중복성이 없는 논리 드라이브(RAID 0)
에 사용할 수 없습니다. 

그림 A-2 논리 드라이브 구성에서의 드라이브 할당

드라이브 채널 0

논리 드라이브 1

전역 예비 드라이브 LD1의 로컬 예비 드라이

논리 드라이브 0

드라이브 채널 1

73
GB

ID5 ID0

ID6 ID1 ID0 ID14

ID3 ID2

RAID 5
146GB

RAID 3
146GB

73
GB

73
GB

73
GB

73
GB

73
GB

73
GB

73
GB
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논리 드라이브 또는 논리 볼륨을 여러 파티션으로 분할하거나 전체 논리 드라이브를 하
나의 파티션으로 사용할 수 있습니다.

그림 A-3 논리 드라이브 구성의 파티션

논리 드라이브 0

RAID 5 (8GB)

논리 드라이브 1

RAID 3 (4GB)

파티션 0 2GB

파티션 1 1GB

파티션 2 5GB

파티션 0 1.5GB

파티션 1 1GB

파티션 2 1.5GB
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각 파티션은 호스트 SCSI ID 또는 호스트 채널의 ID에 매핑됩니다. 각각의 SCSI 
ID/LUN는 호스트 컴퓨터에 대해 하나의 개별 하드 드라이브의 역할을 수행합니다.

그림 A-4 파티션을 호스트 ID/LUN에 매핑

그림 A-5 ID로 LUN에 파티션 매핑

ID 0 ID 1

LUN 0 LUN 0

LUN 1 LUN 1

LUN 2 LUN 2

논리 드라이브 1
파티션 0

논리 드라이브 0
파티션 1

논리 드라이브 1
파티션 2

논리 드라이브 0
파티션 2

논리 드라이브 1
파티션 1

논리 드라이브 0
파티션 0

2.5GB

1GB

5GB

1.5GB

2GB

2.5GB

ID 0

LUN 0LUN 1LUN 2LUN 3LUN 4LUN 5

논리 드라이브 0 논리 드라이브 1

호스트 SCSI 채널

논리 드라이브 1

논리 드라이브 1
파티션 0

논리 드라이브 0
파티션 2

논리 드라이브 0
파티션 0

파티션 1파티션 1 파티션 2

4.5GB 5GB 2GB

1GB 1.5GB 2GB
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RAID 수준
이중화(mirroring), 스트라이핑, 이중화(duplexing) 및 패리티 기술 등을 조합하여 
RAID 어레이를 다양한 방법으로 구현할 수 있습니다. 이와 같은 다양한 기술을 RAID 
수준이라고 합니다. 각 수준마다 성능, 안정성 및 비용이 조금씩 다릅니다. 각 수준에서
는 서로 다른 알고리즘을 사용하여 결함 허용을 구현합니다.

RAID 수준으로는 RAID 0, 1, 3, 5, 1+0, 3+0(30) 및 5+0(50)이 있으며 RAID 1, 3 및 5가 
가장 일반적으로 사용됩니다.

다음 표에서는 RAID 수준에 대해 간략하게 설명합니다. 

용량은 데이터 저장 장치에 사용할 수 있는 전체 물리 드라이브 수(N)를 말합니다. 예를 
들어, 용량이 N-1이고 논리 드라이브에 있는 전체 디스크 드라이브의 수가 36MB 드라
이브 6개이면 저장 장치에 사용할 수 있는 디스크 공간은 디스크 드라이브 5개(5 x 
36MB = 180MB)입니다. -1은 6개 드라이브의 스트라이핑 크기를 나타냅니다. 스트라이
핑은 데이터 중복성을 제공하며, 그 크기는 디스크 드라이브 하나와 동일합니다. 

표 A-1 RAID 수준 개요

RAID 수준 설명 지원되는 드라이브의 수 용량 중복성

0 스트라이핑 2-36 N 아니오

1 이중화 2 N/2 예

1+0 이중화 및 스트라이
핑

4-36 (짝수만) N/2 예

3 전용 패리티가 있는 
스트라이핑

3-31 N-1 예

5 분산 패리티가 있는 
스트라이핑

3-31 N-1 예

3+0 (30) RAID 3 논리 드라이
브의 스트라이핑

2-8개의 논리 드라이
브

논리 드
라이브
의 N-#

예

5+0 (50) RAID 5 논리 드라이
브의 스트라이핑

2-8개의 논리 드라이
브

논리 드
라이브
의 N-#

예
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RAID 3+0(30) 및 5+0(50)의 경우 용량은 전체 물리 드라이브의 수(N)에서 볼륨에 있는 
각 논리 드라이브에 대해 물리 드라이브 하나(#)씩을 뺀 값입니다. 예를 들어, 논리 드라
이브에 있는 전체 디스크 드라이브의 수가 36MB 드라이브 20개이고 전체 논리 드라이
브의 수가 2개이면 저장 장치에 사용할 수 있는 디스크 공간은 18개의 디스크 드라이브
(18 x 36MB = 648MB)입니다.

RAID 0
RAID 0은 데이터가 여러 논리 블록으로 나누어지고 몇 개의 드라이브에 스트라이핑되
는 블록 스트라이핑을 구현합니다. 다른 RAID 수준과 달리 중복 기능이 없습니다. 따라
서 디스크가 실패하는 경우 데이터가 손실됩니다.

블록 스트라이핑에서는 전체 디스크 용량이 어레이에 있는 모든 드라이브의 용량을 합
한 것과 같습니다. 이 드라이브 결합은 시스템에 단일 논리 드라이브로 나타납니다.

RAID 0은 가장 높은 성능을 제공하는데, 그 이유는 어레이에 있는 모든 디스크에서 데
이터를 동시에 주고 받을 수 있기 때문입니다. 또한 개별 드라이브에 대한 읽기/쓰기 작
업을 동시에 처리할 수 있습니다.

그림 A-6 RAID 0 구성

논리 드라이브

물리 디스크

스트라이핑

블록 1

블록 2

블록 3

블록 5

블록 7

블록 1블록 3

블록 4

블록 5

블록 6

블록 7

블록 8

블록 4

블록 6

블록 8

블록 2
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RAID 1
RAID 1은 동일한 데이터의 복사본이 두 개의 드라이브에 기록되는 디스크 이중화를 구
현합니다. 데이터의 복사본 두 개를 개별 디스크에 보관하여 디스크가 실패하는 경우에
도 데이터가 보호됩니다. RAID 1 어레이의 디스크가 실패하더라도 나머지 상태가 양호
한 디스크(복사본)가 필요한 모든 데이터를 제공할 수 있으므로 중단되지 않습니다.

디스크 이중화에서 사용 가능한 전체 용량은 RAID 1 어레이에 있는 한 드라이브의 용
량과 같습니다. 예를 들어, 1GB 드라이브를 두 개 결합하면 사용 가능한 전체 용량이 
1GB인 단일 논리 드라이브가 만들어집니다. 이 드라이브 결합은 시스템에 단일 논리 드
라이브로 나타납니다.

주 – RAID 1에서는 확장이 허용되지 않습니다. RAID 수준 3 및 5에서는 기존 어레이
에 드라이브를 추가하여 확장할 수 있습니다.

그림 A-7 RAID 1 구성

RAID 1은 데이터를 보호하는 것 외에 성능도 향상시킵니다. 동시 I/O가 여러 개 발생
하는 경우 이들 I/O를 디스크 복사본 간에 분산시킬 수 있으므로 총 유효 데이터 액세
스 시간을 줄일 수 있습니다.

논리 드라이브

물리 디스크
블록 1

블록 2

블록 3

블록 4

블록 5

블록 6

블록 7

블록 8

블록 2

블록 3

블록 4

블록 1

블록 2

블록 3

블록 4

블록 1
이중화
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RAID 1+0

RAID 1+0은 RAID 0과 RAID 1 즉, 이중화와 디스크 스트라이핑을 결합한 것입니다. 
RAID 1+0을 사용하면 여러 디스크를 한 번에 이중화하도록 구성할 수 있으므로 시간
이 절약됩니다. 선택할 수 있는 표준 RAID 수준 옵션이 아니므로 제어기에서 지원하는 
RAID 수준 옵션 목록에는 나타나지 않습니다. RAID 1 논리 드라이브에 대해 네 개 이
상의 디스크 드라이브를 선택하면 RAID 1+0이 자동으로 수행됩니다.

그림 A-8 RAID 1+0 구성

물리 디스크

이중화

스트라이핑

이중화

논리 드라이브

블록 1

블록 2

블록 3

블록 4

블록 5

블록 6

블록 7

블록 8

블록 2

블록 3

블록 4

블록 1

블록 2

블록 3

블록 4

블록 1

블록 6

블록 7

블록 8

블록 5

블록 6

블록 7

블록 8

블록 5
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RAID 3
RAID 3은 블록 스트라이핑과 전용 패리티를 구현합니다. 이 RAID 수준은 데이터를 디
스크 블록의 크기인 여러 논리 블록으로 나눈 다음 몇 개의 드라이브에 이들 블록을 스
트라이핑합니다. 하나의 드라이브가 패리티 전용입니다.  디스크가 실패하는 경우 패리
티 정보 및 나머지 디스크의 정보를 사용하여 원본 데이터를 재구성할 수 있습니다.

RAID 3에서 전체 디스크 용량은 패리티 드라이브를 제외하고 결합에 포함된 모든 드라
이브의 용량을 합한 것과 같습니다. 예를 들어, 1GB 드라이브를 네 개 결합하면 사용 가
능한 전체 용량이 3GB인 단일 논리 드라이브가 만들어집니다. 이 조합은 시스템에 단일 
논리 드라이브로 나타납니다.

RAID 3은 작은 청크에서 데이터를 읽거나 연속적으로 데이터를 읽을 때 빠른 데이터 
전송 속도를 제공합니다. 그러나 모든 드라이브에 적용되지 않는 쓰기 작업의 경우에는 
새 데이터를 입력할 때마다 패리티 드라이브에 저장된 정보를 다시 계산하고 다시 써야 
하기 때문에 성능이 떨어집니다. 이러한 이유로 동시 I/O는 제한됩니다.

그림 A-9 RAID 3 구성

논리 드라이브

블록 1

블록 2

블록 3

블록 1
스트라이핑

패리티 (1.2)

패리티 (3,4)

물리 디스크

전용 패리티

블록 3

블록 4

블록 5

블록 6

블록 7

블록 8

블록 7

블록 5

블록 4

블록 2

블록 8

블록 6 패리티 (5,6)

패리티 (7,8)
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RAID 5
RAID 5는 다중 블록 스트라이핑과 분산 패리티를 구현합니다. 이 RAID 수준에서는 어
레이의 모든 디스크에 분산된 패리티 정보를 통해 중복성을 제공합니다. 데이터와 패리
티는 같은 디스크에 저장되지 않습니다. 디스크가 실패하는 경우 패리티 정보 및 나머
지 디스크의 정보를 사용하여 원본 데이터를 재구성할 수 있습니다.

그림 A-10 RAID 5 구성

RAID 5는 큰 청크 단위로 또는 무작위로 데이터에 액세스할 때 향상된 데이터 전송 속
도를 제공하며 여러 개의 동시 I/O 주기가 수행되는 동안 데이터 액세스 시간을 단축합
니다.

논리 드라이브 물리 디스크

스트라이핑 + 비전용 패리티

블록 1

블록 2

블록 3

블록 4

블록 5

블록 6

블록 7

블록 8

블록 4

블록 1

블록 7

패리티 (5,6)

패리티 (3,4)

블록 2

블록 8

블록 5

패리티 (3,4)

블록 3

블록 6

패리티 (7,8)
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고급 RAID 수준
고급 RAID 수준을 사용하려면 어레이의 내장 볼륨 관리자를 사용해야 합니다. 이들 조
합 RAID 수준에서는 RAID 1, 3 또는 5의 보호 이점과 RAID 1의 성능 이점을 제공합니
다. 고급 RAID를 사용하려면 먼저 RAID 1, 3 또는 5 어레이를 두 개 이상 만든 다음 이
들 어레이를 결합하십시오. 다음 표에서는 고급 RAID 수준에 대해 설명합니다.

로컬 및 전역 예비 드라이브
외부 RAID 제어기에서는 로컬 예비 드라이브 및 전역 예비 드라이브 기능을 모두 제공
합니다. 로컬 예비 드라이브는 지정된 하나의 드라이브에만 사용되고, 전역 예비 드라
이브는 어레이에 있는 모든 논리 드라이브에 사용할 수 있습니다. 

로컬 예비 드라이브는 항상 전역 예비 드라이브보다 높은 우선 순위를 갖습니다. 따라
서 드라이브가 실패했을 때 두 유형의 예비 드라이브를 모두 사용할 수 있는 경우 또는 
실패한 드라이브를 교체하는 데 더 큰 크기의 드라이브가 필요한 경우 로컬 예비 드라
이브가 사용됩니다.

RAID 5 논리 드라이브에 실패한 드라이브가 있는 경우 이 드라이브를 새 드라이브로 
교체하여 논리 드라이브가 계속 작동되도록 합니다. 실패한 드라이브를 식별하려면 해
당 어레이의 Sun StorEdge 3000 Family RAID Firmware Users Guide를 참조하십시오.

주의 – 실패한 드라이브를 제거하려고 할 때 실수로 다른 드라이브를 제거한 경우에는 
다른 드라이브를 잘못하여 실패하게 한 것이기 때문에 더 이상 논리 드라이브에 액세스
할 수 없습니다.

로컬 예비 드라이브는 지정된 하나의 논리 드라이브에 서비스를 제공하도록 할당된 대
기 드라이브입니다. 지정된 이 논리 드라이브의 구성원 드라이브가 실패하는 경우 로컬 
예비 드라이브는 구성원 드라이브가 되어 자동으로 재구성을 시작합니다.

표 A-2 고급 RAID 수준

RAID 수준 설명

RAID 3+0 (30) 어레이의 내장 볼륨 관리자를 사용하여 결합된 RAID 3 논리 드라이브입
니다.

RAID 5+0 (50) 어레이의 볼륨 관리자를 사용하여 결합된 RAID 5 논리 드라이브입니다.
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로컬 예비 드라이브는 항상 전역 예비 드라이브보다 우선 순위가 높습니다. 즉, 드라이
브가 실패했을 때 로컬 예비 드라이브와 전역 예비 드라이브를 모두 사용할 수 있는 경
우 로컬 예비 드라이브가 사용됩니다. 

그림 A-11 로컬(전용) 예비 드라이브

전역 예비 드라이브는 하나의 논리 드라이브에만 사용되는 것이 아니라 모든 논리 드라
이브에 사용할 수 있습니다(그림 A-12 참조). 논리 드라이브의 구성원 드라이브가 실패
하면 전역 예비 드라이브가 해당 논리 드라이브에 연결하여 자동으로 재구성을 시작합
니다.

로컬 예비 드라이브는 항상 전역 예비 드라이브보다 우선 순위가 높습니다. 즉, 드라이
브가 실패했을 때 로컬 예비 드라이브와 전역 예비 드라이브를 모두 사용할 수 있는 경
우 로컬 예비 드라이브가 사용됩니다. 

그림 A-12 전역 예비 드라이브

로컬 예비 드라이브

논리 드라이브 0

전역 예비 드라이브

논리 드라이브 1 논리 드라이브 2

전역 예비 드라이브
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로컬 및 전역 예비 드라이브 모두 보유
그림 A-13에서 논리 드라이브 0의 구성원 드라이브는 9GB 드라이브이고, 논리 드라이
브 1 및 2의 구성원 드라이브는 모두 4GB 드라이브입니다. 

그림 A-13 로컬 및 전역 예비 드라이브 혼합

로컬 예비 드라이브는 항상 전역 예비 드라이브보다 우선 순위가 높습니다. 즉, 드라이
브가 실패했을 때 로컬 예비 드라이브와 전역 예비 드라이브를 모두 사용할 수 있는 경
우 로컬 예비 드라이브가 사용됩니다. 

그림 A-13에서는 용량이 부족하기 때문에 4GB의 전역 예비 드라이브를 논리 드라이브 
0에 결합할 수 없습니다. 논리 드라이브 0의 드라이브가 실패하면 9GB의 로컬 예비 드
라이브가 사용됩니다. 실패한 드라이브가 논리 드라이브 1 또는 2에 있으면 4GB의 전역 
예비 드라이브가 실패한 드라이브를 즉시 대체합니다.

로컬 예비 드라이브 전역 예비 드라이브
(4GB)(9GB)

(9GB)

(9GB)

(4GB)

(4GB)

(4GB)

논리 드라이브 0 논리 드라이브 1 논리 드라이브 2

(9GB)
(4GB)

(4GB)(4GB)
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부록 B

JBOD 모니터링

이 부록에서는 독립형 JBOD를 사용하고 모니터링하는 방법에 대해 설명합니다. 모든 
어레이 기능이 JBOD를 지원하는 것은 아닙니다. 다루는 내용은 다음과 같습니다.

■ 215페이지의 "JBOD 지원 사용하기"
■ 217페이지의 "구성 요소와 알람 특성을 보려면"
■ 219페이지의 "장치의 펌웨어 다운로드"
■ 219페이지의 "드라이브 검색"

주 – 대부분의 Sun StorEdge 3000 Family 제품이 독립형 JBOD를 제공합니다. Sun 
StorEdge 3120 SCSI Array는 독립형 JBOD입니다. 이 부록에 나와 있는 절차는 Sun 
StorEdge 3120 SCSI Array에만 적용됩니다.

▼  JBOD 지원 사용하기
주변 장치 상태와 JBOD의 이벤트를 모니터링하려면 우선 JBOD 지원을 사용할 수 있어
야 합니다. 

1. View → Agent Options Management를 선택합니다. 

ssconfig 또는 ssadmin으로 아직 로그인하지 않은 경우 암호 프롬프트가 나타납니
다. 암호를 입력합니다. Agent Options Management 창이 나타납니다.

2. Enable JBOD Support 확인란을 선택합니다.

3. 기본 창에 JBOD가 즉시 표시되도록 하려면 새 자원 목록을 조사해야 합니다. View → 
View Server를 선택한 후 Probe를 선택합니다.
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4. OK를 클릭합니다. 

기본 창에 JBOD가 표시됩니다.

단일 버스 구성에서는 JBOD의 두 포트가 모두 다음 예와 같이 서버의 한 HBA에 연결
됩니다.

이중 버스 구성에서는 다음 예와 같이 고유한 HBA에 연결됩니다. 포트 A와 포트 B에 
연결된 드라이브는 SAF-TE 제한으로 인해 기본 창에 나타나지 않습니다. 다음 예에서 
볼 수 있듯이 프로그램은 포트 B에 연결된 서버에서만 JBOD를 모니터링할 수 있습니
다.

주 – 이중 버스 구성에서 각 포트가 서로 다른 서버에 연결되어 있는 경우 프로그램은 
포트 B에 연결된 서버에서만 JBOD를 모니터링할 수 있습니다.
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▼ 구성 요소와 알람 특성을 보려면
View Enclosure 창은 JBOD의 구성 요소와 알람 특성을 표시합니다. JBOD의 상태가 주
의를 요하는 경우 기본 창에서 해당 JBOD 장치에 장치 상태 기호가 나타납니다. 기호에 
대한 설명을 보려면 75페이지의 "장치 상태"를 참조하십시오.

1. Sun StorEdge 3120 SCSI Array에 대한 엔클로저 아이콘 을 선택합니다.

2. View → View Enclosure를 선택합니다.

FRU ID 정보를 표시하려면 View FRU를 클릭합니다.

환경 상태
View Enclosure 창의 Environmental State 섹션은 전원 공급 장치, 팬 및 온도의 상태를 
보고합니다. 개별 구성 요소의 상태뿐 아니라 어레이의 전체 환경 상태도 제공합니다. 
Component/Status 목록에 대한 설명을 보려면 94페이지의 "환경 상태"를 참조하십시
오.
부록 B JBOD 모니터링 217



전원 공급 장치 및 팬 위치

아래의 그림은 Sun StorEdge 3120 SCSI Array의 전원 공급 장치 팬 위치를 나타낸 것입
니다.

그림 B-1 Sun StorEdge 3120 SCSI Array의 전원 공급 장치 및 팬 위치

SAF-TE 온도 센서 위치

어레이 내의 다른 지점에서 온도를 모니터링하는 것이 SAF-TE의 가장 중요한 기능 중 
하나입니다. 고온일 때 모르고 지나치면 상당한 손상을 초래할 수 있습니다. 엔클로저 
내의 주요 지점에 각각 센서가 설치되어 있습니다. 다음 표에서는 각 센서의 위치를 보
여 주는데, View Enclosure Component/Status 목록에 표시된 Temperature #에 해당
합니다.

표 B-1 Sun StorEdge 3120 SCSI Array의 SAF-TE 온도 센서 위치

온도 ID 위치

0, 1, 5 섀시 온도 센서

2 전원 공급 장치 #0 온도 센서

3 좌측 EMU 모듈 온도 센서

4 우측 EMU 모듈 온도 센서

6 전원 공급 장치 #1 온도 센서

어레이 전면
우측 사이드

좌측 사이드

팬 #0

전원 공급 장치 #0

팬 #1

전원 공급 장치 #1
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▼ 장치의 펌웨어 다운로드
Solaris 호스트용 디스크 드라이브로 펌웨어를 다운로드하는 방법의 지침에 대해서는 
해당 펌웨어가 포함된 패치의 README 파일을 참조하십시오. 패치 정보에 대해서는 
해당 어레이의 릴리스 정보를 참조하십시오.

▼ 드라이브 검색
심각한 상태에서는 JBOD에서 드라이브 실패가 발생할 수 있습니다. 기본 창에서 해당 JBOD 
장치에 빨간색 장치 상태 기호 가 나타납니다. 실패한 드라이브를 교체한 후 다음 단계를 
수행하여 드라이브를 검색하십시오.

Solaris OS 

아래의 절차는 Solaris OS를 실행하는 시스템에서 교체한 드라이브를 검색하는 방법을 
설명한 것입니다.

1. 드라이브가 자동으로 다시 온라인 상태가 되면 즉, 빨간색 장치 상태 기호가 사라지면 
다음 명령을 실행합니다. 

2. 다음 명령을 실행합니다.

3. 드라이브가 자동으로 다시 온라인 상태로 돌아오지 않으면 즉, 빨간색 장치 상태 기호
가 사라지지 않으면 다음 명령을 실행하여 재구성을 다시 시작합니다.

# devfsadm

# format

# reboot -- -r
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Linux OS

아래의 절차는 Linux OS를 실행하는 시스템에서 교체한 드라이브를 검색하는 방법을 
설명한 것입니다.

1. 시스템을 다시 부팅합니다.

2. 다음 명령을 실행합니다. 

3. dmesg 출력에서 "Detected scsi disk sdX at scsi<controller>, id 
<channel>, lun <target>"와 비슷한 행을 찾습니다. 여기서 sdX의 X는 디스크 번
호입니다.

4. /dev에서 장치 항목을 만들려면 다음 명령을 실행합니다.

여기서 sdX의 X는 디스크 번호입니다.

5. 그런 다음 fdisk를 실행하고, 포맷한 다음 파일 시스템을 만듭니다.

Microsoft Windows OS

아래의 절차는 Microsoft Windows OS를 실행하는 시스템에서 교체한 드라이브를 검
색하는 방법을 설명한 것입니다.

1. 해당 어레이의 Sun StorEdge 3000 Family 설치, 작동 및 서비스 설명서의 지침에 따라 
새 드라이브를 설치합니다.

2. View → View Server를 선택하고 Rescan을 클릭합니다.

3. 프로그램이 새 드라이브를 인식하는지 확인하려면 기본 창에서 해당 드라이브를 선택
합니다.

4. View → View Physical Drive를 선택하고 정보를 확인합니다.

# dmesg

# cd /dev; ./MAKEDEV sdX
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HP-UX OS

아래의 절차는 HP-UX OS를 실행하는 시스템에서 교체한 드라이브를 검색하는 방법을 
설명한 것입니다.

1. 다음 명령을 실행합니다.

2. View → View Server를 선택하고 Rescan을 클릭합니다.

3. 프로그램이 새 드라이브를 인식하는지 확인하려면 기본 창에서 해당 드라이브를 선택
합니다.

4. View → View Physical Drive를 선택하고 정보를 확인합니다.

5. 드라이브가 나타나지 않으면 호스트를 다시 부팅해야 합니다. 다음 명령을 실행합니다.

IBM AIX OS

아래의 절차는 IBM AIX OS를 실행하는 시스템에서 교체한 드라이브를 검색하는 방법
을 설명한 것입니다.

주 – 실패한 드라이브를 교체하는 데 필요한 명령을 실행하려면 수퍼유저 권한이 있어
야 합니다.

1. 논리 드라이브를 만들고 해당 LUN을 올바른 호스트 채널로 매핑합니다.

2. 다음 명령을 실행합니다.

# ioscan -fnC disk

# sync;sync;sync
# reboot

# cfgmgr
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3. 다음 명령을 실행합니다.

다음과 비슷한 출력이 나타납니다.

4. 드라이브 중 하나에 "None"이 나타나면 Physical Volume IDENTIFIER를 할당해야 
합니다.

5. 다음 명령을 실행합니다.

a. Devices를 선택합니다.

b. Fixed Disk를 선택합니다.

c. Change/Show Characteristics of a Disk를 선택합니다.

d. PVID가 없는 디스크를 선택합니다.

e. ASSIGN physical volume identifier를 선택하고, Tab 키를 한 번만 눌러 값에 Yes
를 표시하고 Return 키를 누릅니다.

f. Return 키를 다시 눌러 확인하고 필요한 경우 a단계- f단계를 반복합니다.

6. smitty 주 메뉴에서 System Storage Management (Physical & Logical Storage) → 
Logical Volume Manager → Volume Groups → Add a Volume Group을 선택합니다.

7. 볼륨 그룹에 이름을 지정하고, 저널된 파일 시스템의 파티션 크기가 충분한지 확인한 
다음 Physical Volume Name(s)을 선택합니다.

8. smitty 주 메뉴에서 System Storage Management (Physical & Logical Storage) → 
File Systems → Add / Change / Show / Delete File Systems → (Enhanced) Journaled 
File System을 선택합니다.

9. 볼륨 그룹을 선택하고 필드를 설정합니다.

다음 명령을 실행합니다.

# lspv

hdisk0 000df50dd520b2e rootvg
hdisk1 000df50d928c3c98 None
hdisk1 000df50d928c3c98 None

# smitty

# umount mount point
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부록 C

클러스터 구성 사용 (SCSI에만 해당)

Sun StorEdge 3310 SCSI Array에서는 Win32를 사용하는 경우 Sun StorEdge 
Configuration Service에서 공유 SCSI 저장 장치를 모니터링할 수 있습니다. 이 절에서 
다루는 내용은 다음과 같습니다.

■ 223페이지의 "클러스터 구성 계획"
■ 224페이지의 "클러스터 구성 요구 사항"

■ 224페이지의 "클러스터 구성 설정"

클러스터 구성은 우선 적절한 하드웨어로 설정해야 하며 Windows 2000 또는 2003 
Server 및 MSCS(Microsoft Cluster Server) 소프트웨어를 필요로 합니다.

클러스터 구성을 설정하려면 이 장을 반드시 참조하십시오.

클러스터 구성 계획
처음에 저장 장치를 구성하는 방법에 따라 유형이 다를 수 있으므로 클러스터 구성을 
설정하기 전에 원하는 구성 유형을 결정해야 합니다.

클러스터 구성에는 두 가지 기본 유형이 있습니다. 

■ 모든 LUN이 클러스터의 두 서버 중 하나에 속하는 핫 대기 서버 클러스터. LUN이 
있는 서버가 실패하는 경우 LUN은 유휴 상태였던 두 번째 서버로 이동합니다. 이 구
성에는 최소한 두 개의 LUN이 필요합니다.

■ 일부 LUN은 한 서버에서 관리되고 일부 LUN은 다른 서버에서 관리되는 로드 균형
이 조정된 클러스터. 두 서버가 데이터를 동시에 처리하지만 다른 LUN에서 I/O를 
처리합니다. 
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최소한 세 개의 LUN이 정의되어야 합니다. 그러면 작은 LUN은 쿼럼 디스크용으로 만
들어지고 큰 LUN은 클러스터의 각 서버에서 사용되도록 만들어집니다. 쿼럼 디스크는 
서버 실패 이벤트에서 클러스터를 회복하는 데 필요한 클러스터 구성 데이터를 관리합
니다.

클러스터 구성 요구 사항
MSCS 소프트웨어를 설치할 때 클러스터 정보를 관리하는 쿼럼 디스크에 사용할 디스
크를 정의합니다.

클러스터 구성에서 프로그램은 한 번에 쿼럼 디스크가 있는 하나의 서버에서만 실행됩
니다. Sun StorEdge Configuration Service와 함께 실행 중인 서버가 정상적으로 작동
하지 않는 경우 Cluster Administrator는 자동으로 첫 번째 서버의 디스크 로드를 두 번
째 서버로 변경하고 해당 서버에서 서비스를 시작합니다.

서버가 두 개인 클러스터 구성에서 고유한 IP 주소가 있는 클러스터 자체는 Managed 
Servers 목록의 관리 대상 서버가 됩니다. 클러스터를 설정하는 마지막 단계로 클러스
터를 Managed Servers 목록에 추가합니다.

▼ 클러스터 구성 설정
다음은 두 개의 호스트 서버가 있는 클러스터 구성에 어레이를 설정하는 데 필요한 단
계를 대략적으로 설명한 것입니다.

1. 다음과 같이 서버를 설정합니다.

a. PCI 버스와 공유 SCSI 저장 장치의 일부가 아닌 부트 디스크로 두 개의 서버를 각각 
설정합니다.

b. 각 서버의 Ultra-Wide 차동 호스트 어댑터 같은 호스트 어댑터 카드를 설치하고 공
유 SCSI 버스의 각 호스트 어댑터에 고유한 SI ID를 설정합니다.

c. 각 서버에 두 개의 네트워크 어댑터 카드를 설치합니다.

d. 각 서버의 부트 디스크에 최신 Windows 업데이트를 설치합니다.

2. 이중 활성-활성 저장 장치 서브 시스템을 설치하고 두 호스트 어댑터에 연결합니다. 

설치 단계는 제공된 설명서를 참조하십시오.

3. 다음과 같이 각 서버에 에이전트를 설치합니다. 

a. 다른 서버에 서비스를 설치하기 전에 한 서버에서 서비스를 중지합니다. 
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b. 주 제어기에 할당된 논리 드라이브에 매핑된 호스트 LUN에 대한 액세스 권한이 있
는 서버에서 서비스가 실행 중이어야 합니다.

c. 에이전트를 설치하기 위한 특정 단계는 해당 설치 관련 장을 참조하십시오. 

에이전트를 설치한 후 시스템을 다시 부팅하지 않아도 됩니다. 그러나 에이전트가 
일단 설치되면 서버 중 하나에서 서비스를 중지해야 합니다.

주 – 다음 몇 가지 단계에서는 하나의 서버만을 예제로 다룹니다.

4. 콘솔 소프트웨어를 설치합니다.

콘솔을 서버 중 하나에 또는 서버가 상주하는 네트워크 상의 컴퓨터에 설치할 수 있습
니다. 프로그램을 사용하면 어레이를 원격으로 구성하고 모니터링할 수 있습니다. 세부 
단계는 해당 설치 관련 장을 참조하십시오.

5. 서비스를 시작한 서버를 콘솔의 Managed Servers 목록에 추가합니다(12페이지의 "서
버를 추가하려면" 참조). 

Auto Discovery를 선택하고 ssmon 암호를 추가해야 합니다.

6. 콘솔 소프트웨어를 사용하여 활성 서버의 저장 장치를 확인 및 구성한 후 해당 서버를 
다시 부팅합니다.

저장 장치 어레이가 이중 활성-활성 저장 장치 서브 시스템에서 이미 구성되어 있을 수 
있습니다. 트리 보기에서 구성을 확인하여 이 경우에 해당하는지 여부를 확인하십시오.

저장 장치가 구성되어 있지 않거나 구성을 변경하려면 한 서버의 모든 LUN을 구성합
니다. MSCS 소프트웨어가 설치된 후 Cluster Administrator를 사용하여 저장 장치를 
두 서버 간에 할당할 수 있습니다.

7. Computer Management를 사용하여 다음과 같이 활성 서버에서 파티션을 만들고 
LUN을 포맷합니다. 

a. 필요한 경우 디스크의 드라이브 문자를 다시 할당합니다. 

파티션은 NTFS로 포맷해야 합니다.

Windows는 이중 활성-활성 제어기에 대한 LUN이 클러스터의 양쪽 서버에 있다고 
인식합니다. 하나의 서버에서만 파티션과 논리 드라이브를 만들 수 있습니다. MSCS
를 설치한 후 Cluster Administrator를 사용하여 두 서버 간에 저장 장치를 할당할 
수 있습니다.

두 서버의 공유 SCSI 저장 장치의 드라이브 문자는 같아야 합니다. 하나의 서버에만 
CD-ROM 드라이브가 하나 더 있거나 외장 하드 디스크가 있으면 공유 저장 장치의 
드라이브 문자를 다시 할당해야 합니다. 이 단계 이후에 다른 서버에서도 마찬가지
인지 확인합니다.

b. 공유 저장 장치에 할당된 드라이브 문자를 기록해 둡니다.
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8. 두 번째 서버에 액세스하여 Computer Management를 시작하고 두 번째 서버에도 첫 
번째 서버와 같은 드라이브 문자가 있는지 확인합니다. 

다른 경우 양쪽 서버가 같도록 드라이브 문자를 다시 할당합니다.

9. 두 번째 서버를 종료합니다.

10. 첫 번째 서버에 MSCS 소프트웨어를 설치하고 다시 부팅합니다. 

11. Cluster Administrator를 시작하여 해당 클러스터를 인식하는지 확인합니다.

12. 두 번째 서버에 액세스하고, 첫 번째 서버에 연결하여 MSCS를 설치한 다음 다시 부팅
합니다.

13. 두 번째 서버를 다시 부팅한 후 Cluster Administrator에서 두 서버가 모두 클러스터에 
포함되는지 확인합니다.

14. Cluster Administrator에서 디스크 그룹을 조정합니다. 

처음에 저장 장치를 구성한 서버에서 하나의 디스크 그룹 안에 쿼럼 디스크와 다른 디
스크가 모두 있도록 합니다. 이 단계를 수행하는 방법에 대한 자세한 내용은 MSCS 설
명서를 참조하십시오.

주 – 두 LUN을 같은 디스크 그룹에 할당하면 삭제할 수 있는 빈 디스크 그룹이 생깁니
다.

15. 서비스를 첫 번째 서버의 쿼럼 디스크가 있는 그룹에 추가합니다.

a. 각 서버에서 세 가지 서비스 즉, Configuration Service Startup, Configuration 
Service Monitor 및 Configuration Service Server를 중지하고 이를 수동으로 설정
합니다.

b. Cluster Administrator를 사용하여 각 서비스를 쿼럼 디스크가 있는 그룹의 자원으
로 설치합니다. 

각 서비스에 아래의 항목을 순서대로 입력하고 표시된 형식에 이름(함께 사용되는 
두 단어)을 입력합니다. 각 서비스가 설치되면 온라인으로 가져와 활성 서버에서 시
작합니다.

서비스를 일반 서비스로 입력합니다. 각 자원의 종속성을 표시하라는 메시지가 나타
납니다. 그룹의 종속성은 다음과 같습니다.

■ 쿼럼 디스크에 연결된 디스크
■ 이 그룹에 추가할 다른 디스크
■ Configuration ServiceStartup
■ Configuration ServiceMonitor
■ Configuration ServiceServer

Configuration ServiceStartup은 이미 그룹에 속해 있는 두 디스크에 종속적입니다. 
Configuration ServiceMonitor는 Configuration Service Startup에 종속적이고 
Configuration ServiceServer는 Configuration Service Monitor에 종속적입니다.
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16. 클러스터 IP 주소 아래에 두 클러스터 서버가 하나의 아이콘으로 표시되도록 
CLUSTER.TXT를 편집합니다.

이 파일은 콘솔 파일과 같은 디렉토리에 있습니다. 즉, 콘솔이 설치된 컴퓨터의 시스템 
디스크에 있습니다. C 드라이브가 시스템 디스크인 경우 경로는 다음과 같습니다.
C:\Program Files\Sun\sscs

다음 텍스트는 파일의 내용입니다.

17. 숫자 기호(#)를 제거하여 클러스터의 IP 주소와 클러스터를 구성하는 두 서버의 IP 주
소를 차례로 삽입하는 방법으로 파일의 마지막 행을 편집합니다.

18. 콘솔을 시작하고 Managed Servers 목록에서 첫 번째 서버를 제거한 후 클러스터를 서
버로써 목록에 추가합니다.

19. Server List Setup 기능에 액세스합니다. 12페이지의 "서버를 추가하려면"를 참조하십
시오.

Auto Discovery를 선택하고 ssmon 암호를 추가해야 합니다. 클러스터 이름을 입력하
면 네트워크에 DNS가 있을 경우 프로그램에서 IP 주소를 제공합니다.

이제 클러스터 구성이 프로그램과 함께 사용되도록 올바르게 구성되었습니다. 서비스
가 실행 중인 서버가 제대로 작동하지 않으면 디스크 그룹이 두 번째 서버로 전송되며 
Cluster Administrator는 자동으로 두 번째 서버에서 서비스를 시작합니다.

#Edit this file to map the cluster IP address to several
#servers constituting the cluster.
#The format of the entry is:
#<Cluster IP Address>=<server1 IP Address>:<server2 IP Address>
#The IP address must be in dot form.
#Example: If the cluster IP address is 151.239.130.70 and the
#IP addresses of individual servers are 151.239.130.71 and
#151.239.130.72,the entry would be:
# 151.239.130.70=151.239.130.71:151.239.130.72
#
#IMPORTANT NOTE:
#Use only the Cluster IP address to configure a cluster
#server on the Configuration Service console.
#
#151.239.130.70=151.239.130.71:151.239.130.72
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주 – 하나의 서버가 실패하면 콘솔의 클러스터 아이콘이 보라색에서 회색으로 바뀌는 
데 15분까지 소요되며 다시 보라색으로 바뀌는 데에는 10분 정도 더 소요됩니다.

일부 저장 장치가 다른 서버에서 실행 중인 상태로 로드 균형이 조정된 구성을 얻으려
면 Cluster Administrator를 사용하여 하나 이상의 디스크 그룹을 다른 서버로 이동해
야 합니다.
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부록 D

호스트 WWN 확인 (FC 및 SATA에만 
해당)

이 부록에서는 FC Array의 호스트 WWN(Worldwide Name), WWNN(Worldwide 
Node Name) 및 WWPN(Worldwide Port Name)을 확인하는 방법에 대해 설명합니다. 
다루는 내용은 다음과 같습니다.

■ 229페이지의 "WWN 확인"
■ 232페이지의 "WWNN을 확인하려면"
■ 233페이지의 "WWPN을 확인하려면"

▼ WWN 확인
LUN Filter 기능을 사용하기 전에 어떤 Sun StorEdge 3510 FC Array가 어떤 HBA 카드
에 연결되어 있는지 확인하고 각 카드에 할당된 WWN을 확인하는 것이 좋습니다.

Solaris OS

아래의 절차는 Solaris 호스트에서 WWN을 확인하는 방법을 설명한 것입니다.

1. 컴퓨터에 새 HBA 장치를 설치한 경우 컴퓨터를 다시 부팅합니다.

2. 다음 명령을 입력합니다.

# luxadm probe
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3. 목록의 아래로 이동하여 FC 장치 및 관련 WWN을 확인합니다.

Linux 및 Microsoft Windows OS

아래의 절차는 Microsoft Windows 호스트에서 WWN을 확인하는 방법을 설명한 것입
니다.

1. 특정 호스트를 부팅하고 BIOS 버전과 호스트에 연결된 HBA 카드 모델을 기록해 둡니
다. 

2. 적절한 명령(일반적으로 Alt-q 또는 Ctrl-a 사용)을 사용하여 HBA 카드의 BIOS에 액세
스합니다. 

호스트에 여러 개의 HBA 카드가 있는 경우 저장 장치에 연결된 카드를 선택합니다. 

3. 카드를 검색하여 해당 카드에 연결된 장치를 찾습니다. 이 때 일반적으로 Scan Fibre 
Devices 또는 Fibre Disk 유틸리티를 사용합니다.

노드 이름 또는 유사한 레이블이 WWN입니다.

Qlogic 카드를 예로 들면 다음과 같습니다.

HP-UX OS

아래의 절차는 HP-UX 호스트에서 WWN을 확인하는 방법을 설명한 것입니다. 

1. 다음 명령을 입력하여 장치 이름을 확인합니다.

ID 판매자  제품 개정 노드 이름 포트 ID

0 Qlogic QLA22xx Adapter B 210000E08B02DE2F 0000EF

# ioscan -fnC fc
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2. 다음을 입력합니다.

다음과 비슷한 출력이 나타납니다. 

IBM AIX OS

아래의 절차는 IBM AIX 호스트에서 WWN을 확인하는 방법을 설명한 것입니다. 

1. 다음 명령을 입력하여 장치 이름을 확인합니다.

2. 다음을 입력합니다.

다음과 비슷한 출력이 나타납니다. 네트워크 주소가 WWN입니다.

# fcmsutil/device name/

# lscfg |grep fc

# lscfg -vl device name
부록 D 호스트 WWN 확인 (FC 및 SATA에만 해당) 231



▼ WWNN을 확인하려면
1. Configuration Service의 기본 창에서 어레이 아이콘 을 두 번 클릭하거나 어레이 
아이콘을 선택하고 View → View Controller를 선택합니다.

View Controller Configuration 창의 Node name 필드에 노드 이름이 표시됩니다.

주 – WWNN 정보는 콘솔에서 생성하는 xml 보고서에도 포함됩니다.
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▼ WWPN을 확인하려면
1. Configuration Service의 기본 창에서 어레이 아이콘 을 두 번 클릭하거나 어레이 
아이콘을 선택하고 View → View Controller를 선택합니다.

2. View Controller Parameters를 클릭합니다.

RAID Controller Parameters(RAID 제어기 매개변수) 창이 나타납니다. Channel 탭에
서 오른쪽 끝으로 스크롤하여 WWPN을 표시합니다.

주 – WWPN 정보는 콘솔에서 생성하는 xml 보고서에도 포함됩니다.
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부록 E

전자 메일과 SNMP

Sun StorEdge Configuration Service에는 완벽한 이벤트 모니터링 및 전자 메일 알림 
기능이 있습니다. 콘솔은 SMTP 전자 메일 메시지를 지정된 전자 메일 주소록으로 보낼 
수 있습니다. Microsoft Exchange 같은 일부 전자 메일 시스템은 관리 담당자를 찾기 위
해 이벤트에 기반하여 스크립트로 구성되거나 프로그래밍될 수 있습니다. 일부 페이징 
서비스도 이러한 전자 메일 메시지를 호출기에 전송하는 것을 지원합니다.

에이전트는 OS 오류 로그에 이벤트를 기록하며 대용량 저장 장치 이벤트에 대한 
SNMP 트랩을 HP OpenView 같은 엔터프라이즈 관리 콘솔에 보낼 수도 있습니다. 
SNMP를 사용하는 모니터링 소프트웨어의 목록을 보려면 Sun Management 
Center(http://www.sun.com/software/solaris/sunmanagementcenter/)를 
방문하십시오.

이 부록에서는 전자 메일 메시지를 보내기 위해 콘솔을 설정하는 방법에 대해 설명하
며, 서버가 SNMP 관리 콘솔에 트랩을 보내는 방법과 트랩 형식에 대한 설명 및 SNMP
의 배경 정보를 제공합니다. 또한 Sun StorEdge Configuration Service가 필요 없는 추
가적인 SNMP 트랩 전송 방법에 대해서도 설명합니다. 이 장에서 다루는 내용은 다음과 
같습니다.

■ 236페이지의 "SNMP의 작동 방법"
■ 240페이지의 "Sun StorEdge Configuration Service를 사용하여 SNMP 트랩 보내기"

이벤트 모니터링에 대한 자세한 내용은 105페이지의 "이벤트 로그"를 참조하십시오.
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SNMP의 작동 방법
SNMP(Simple Network Management Protocol)는 네트워크 관리에 가장 널리 사용되
는 프로토콜 중 하나입니다. 이름에서 알 수 있듯이 비교적 간단한 방법으로 네트워크 
장치를 관리합니다. SNMP는 간단하면서도 확인 응답이 없는 비연결 프로토콜입니다.

SNMP는 인터넷 프로토콜군 아래에서, 주로 TCP/IP(Transmission Control 
Protocol/Internet Protocol) 전송 프로토콜에서 작동하도록 개발되었습니다. 그 후에 
SNMP는 Novell의 IPX/SPX(Internet Packet Exchange/Sequenced Packet Exchange) 
같은 다른 일반 전송 프로토콜에서 작동하도록 구현되었습니다.

SNMP 트랩 메시지
에이전트는 엔터프라이즈 관리 시스템에 정보를 보낼 때 SNMP를 사용합니다.

서버가 트랩을 보내도록 구성되면 이벤트 정보가 해당 시스템으로 보내집니다.

트랩 메시지에는 다음 정보가 포함됩니다.

■ OID (객체 식별자) 1.3.6.1.4.1.2294.1.2

■ Event Date (MM, DD,YY, 예: 01,22,98)

■ Event Time (HH:MM:SS, 예: 15:07:23)

■ Server Address and Name (IP 주소 이름, 예: 192.187.249.187 Administration)
■ Card Name

■ Event Severity (Informational, Warning, Critical)

■ 텍스트 메시지

표시되는 정보와 형식은 사용 중인 SNMP 관리 콘솔에 따라 다릅니다.

RST_OID.MIB 파일은 트랩을 받을 수 있도록 엔터프라이즈 관리 콘솔에 로드되어야 
합니다. Solaris, Linux 및 HP-UX OS의 경우 이 파일은 /opt/SUNWsscs/ssagent에 
있습니다. IBM AIX OS의 경우 /usr/SUNWsscs/ssagent에 있습니다. Microsoft 
Windows의 경우에는\Program Files\Sun\ssagent에 있습니다.
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에이전트 및 관리자
SNMP 소프트웨어 모델은 에이전트와 관리자로 구성됩니다. 에이전트는 관리 대상 장
치의 변수를 모니터링할 수 있도록 하는 소프트웨어입니다. 에이전트 소프트웨어는 관
리되거나 장치가 연결되는 컴퓨터에서 실행 중인 장치에 포함됩니다.

관리자 또는 관리 콘솔은 SNMP를 통해 에이전트에 변수에 대한 요청을 보내는 네트워
크 모니터링 소프트웨어입니다. 변수의 값이 변하기 때문에 관리자는 에이전트를 주기
적으로 검사합니다. SNMP 관리자는 일반적으로 에이전트로부터 받은 데이터를 분석
하고 사용자가 그래픽 디스플레이에서 사용할 수 있도록 합니다. 데이터는 내역 및 경
향 분석을 위해 데이터베이스에 저장될 수 있습니다.

SNMP 관리자의 요청에 응답하는 것 외에 에이전트는 임의의 알림이나 트랩을 관리 스
테이션에 보낼 수 있습니다. 이것은 기본 소프트웨어의 인터럽트와 유사합니다.

관리 콘솔은 다양한 방식으로 트랩에 응답할 수 있습니다. 일반적으로 트랩이 기록되면 
해당 정보는 알림 스키마를 통해 관련 사용자에게 전달됩니다. 트랩은 또한 SNMP 관리
자가 추가 요청으로 에이전트를 질의하는 것과 같이 추가 작업을 초기화하여 네트워크 
엔티티나 응용프로그램 시작의 현재 상태를 알아볼 수 있도록 합니다.

MIB (Management Information Base)
네트워크에서 SNMP 에이전트가 설치한 각 장치에는 하나 이상의 관련 변수 또는 객체
가 있습니다. 일반적인 변수의 예로는 장치의 이름을 추적하는 것이 있습니다. 이러한 
변수나 객체는 MIB(Management Information Base)라는 텍스트 파일에 설명되어 
있습니다. MIB는 관리되는 변수에 대한 정확한 텍스트 정의입니다. MIB를 정의하는 절
차는 ISO의 IETF에서 확립했습니다.

SNMP 객체
네트워크 관리의 일부 변수는 모든 LAN 네트워크 장치에 대해 공통적입니다. 이들 중 
많은 변수가 표준화되었으며 MIB-II 변수 및 MIB-II 확장자로 불립니다. 또한 IETF에서
는 표준 MIB-II 범주에 속하지 않는 MIB에 대한 절차를 정의했습니다. 이러한 변수는 
개인 엔터프라이즈 MIB에 나열되어 있습니다.
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변수는 개인 엔터프라이즈 MIB 항목 아래에 나열되어 있습니다. 예를 들어, 객체 ID 
1.3.6.1.4.1.2294.1.2는 한 Configuration Service의 MIB에 있는 에이전트 버전을 추적하
기 위해 변수의 객체 ID(또는 OID)를 참조합니다. 

그림 E-1의 차트는 OID가 파생되는 방법을 나타냅니다. 확인 표시는 OID 내의 노드를 
나타냅니다. MIB에서 특정 변수 또는 객체는 해당 OID 아래에 위치합니다.

Sun의 트리 노드는 2294입니다. 고유한 장치를 식별하기 위해 에이전트를 개발하려는 
모든 개인 엔터프라이즈는 IETF에 자신의 트리 노드를 적용할 수 있습니다.

SNMP 요청 유형
Get, GetNext 및 Set과 같은 SNMP 작업이 MIB 데이터에 대한 액세스를 지원합니
다. Get은 인덱스 값이 지정된 테이블 입력 항목 필드 값에서 스칼라 값을 가져옵니다. 
GetNext는 각 명령이 관련 열 또는 필드의 다음 순차 값을 반환하면서 테이블 입력 항
목의 인스턴스를 차례로 순회합니다. Set 작업은 MIB 변수의 값을 만들거나 변경합니
다.

SNMP 보안
값 설정으로 보안 문제가 제기됩니다. SNMP V1(버전 1)은 간단한 보안 체계입니다. 각 
PDU(Protocol Data Unit)에는 사용자 이름과 암호의 조합과 같은 커뮤니티 문자열이 
포함되어 있습니다. 각 에이전트는 특정 커뮤니티 문자열에 대해 구성될 수 있습니다. 
에이전트는 요청 PDU에 있는 커뮤니티 문자열이 에이전트의 구성에 있는 커뮤니티 문
자열과 일치하지 않으면 들어온 요청에 대해 응답하지 않습니다.
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그림 E-1 MIB 변수의 객체 식별자

internet (1)

directory (1)

mgmt (2)

mib-II-(1)

system (1)
interfaces (2)
at (3)
ip (4)
icmp (5)
tcp (6)
udp (7)
egp (8)
transmission (10)

experimental (3)

private (4)

enterprises (1)

ART (2294)

RS.mib (1)

agentVersion (2)

객체 ID
1.3.6.1.4.1.2294.1.2

확인 표시는 OID의 
노드를 나타냅니다 .

snmp (11)

ISO (1)

org (3)

dod (6)
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Sun StorEdge Configuration Service를 사
용하여 SNMP 트랩 보내기
이 절에서는 Sun StorEdge Configuration Service를 사용하여 각 서버의 전자 메일 메
시지를 보내는 방법에 대해 설명합니다. 

▼ 각 서버의 전자 메일 메시지 보내기
Server List Setup 기능을 통해 각 관리 대상 서버의 전자 메일 메시지를 보내도록 콘솔
을 구성합니다.

1. File →Server List Setup을 선택합니다. 

Server Setup 창이 나타납니다. 
 

2. Add를 클릭합니다. 

서버가 이미 추가된 경우 서버를 Available Servers 목록으로 이동하고 Edit를 클릭하여
야 합니다.
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Add Server 창이나 Edit Server 창이 나타납니다. 두 창의 필드는 동일합니다.

3. 서버를 아직 추가하지 않은 경우에는 Properties 탭에 대한 정보를 입력합니다. 

자세한 내용은 13페이지의 "다음과 같이 서버를 추가합니다."를 참조하십시오.

4. 전자 메일을 통해 이벤트 메시지를 보내려면 Mailing Lists 탭을 선택합니다. 

Mailing Lists가 선택된 Add Server 창이 나타납니다.

a. 각 사용자의 전자 메일 주소를 Mail Address 필드에 입력합니다.
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b. Severity 목록 상자에서 목록을 스크롤하여 원하는 항목을 선택합니다.

c. Add to List를 클릭합니다. 

목록에서 사용자를 삭제하려면 메일 주소를 선택하고 Delete from List를 클릭합니
다.

d. 메일 서버를 표시합니다. Setup Mail Server를 클릭합니다.  

Mail Server Setup 창이 나타납니다. 
 

전자 메일 메시지를 미리 지정한 대상 주소에 전달하는 SMTP(Simple Mail Transfer 
Protocol) 메일 서버의 IP 주소 또는 이름을 입력합니다.

e. Mail Server 창에 대한 정보가 올바르면 OK를 클릭합니다. 

Add Server 창이나 Edit Server 창이 나타납니다.

5. Add Server 또는 Edit Server 창에 대한 정보가 올바르면 OK를 클릭합니다. 

Server Setup 창이 나타납니다.

6. 서버를 더 추가하려면 각 서버에 대해 단계 2 ~ 5를 반복합니다.

7. 필요한 경우 이 콘솔이 관리할 서버를 Managed Servers 목록으로 이동합니다. 

서버를 편집하려는 경우 Available Servers 목록으로 다시 이동해야 합니다.

8. OK를 클릭하여 기본 창으로 돌아갑니다.
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▼ 트랩을 보내도록 서버 설정
네트워크에 HP OpenView 또는 IBM NetView 같은 엔터프라이즈 관리 콘솔이 있는 경
우 이벤트에 대한 트랩을 콘솔로 보내도록 서버를 구성할 수 있습니다. 이 절에서는 필
요한 구성 단계에 대해 설명합니다.

주 – SNMP 트랩을 다른 엔터프라이즈 관리 콘솔에 보내려는 경우에만 이 절의 지침을 
참조하십시오.

주의 – HP OpenView가 트랩을 보내려고 설정하는 서버와 동일한 서버에 설치되는 경
우 초기화 오류를 방지하기 위해 시스템 자원을 재구성해야 합니다. 시스템 자원을 재
구성하는 방법에 대한 지침은 문제 해결 항목 254페이지의 "증상: HP OpenView가 설
치되지 않거나 트랩 데몬이 시작되지 않습니다."를 참조하십시오.

Microsoft Windows 서버

Microsoft Windows 서버가 SNMP 트랩을 하나 이상의 엔터프라이즈 관리 콘솔에 보
내도록 구성하려면 서버의 각 SNMP 서비스를 구성하여 다음을 확인해야 합니다.

■ 서버가 엔터프라이즈 관리 콘솔의 커뮤니티 문자열 또는 커뮤니티 이름을 나열합니
다.

■ 서버가 엔터프라이즈 관리 콘솔을 Microsoft Windows 에이전트 소프트웨어의 트랩 
수신자로 나열합니다.

▼ Microsoft Windows 호스트의 커뮤니티 문자열 확인

기본 커뮤니티 이름 또는 공용 커뮤니티 문자열을 사용할 수 있습니다. 그러나 커뮤니
티 이름을 선택하면 특정 커뮤니티 문자열이 있는 컴퓨터로만 통신이 제한되므로 공용 
문자열이 아닌 커뮤니티 이름을 선택하는 것이 보다 안전합니다.

1. Windows 2000에서는 시작 → 프로그램 → 관리 도구 → 서비스를 선택합니다.

Windows 2003에서는 시작 → 모든 프로그램 → 관리 도구 → 서비스를 선택합니다.

2. SNMP Service를 두 번 클릭한 다음 등록 정보(Windows 2003에서는 속성)를 클릭합
니다. 

3. Microsoft SNMP 등록 정보 창이 나타납니다.
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Windows 2000 또는 Windows 2003에서 SNMP 서비스를 설치하지 않은 경우:

a. 시작 → 제어판 → 프로그램 추가/제거를 선택합니다.

b. Windows 구성 요소 추가/제거를 선택합니다.

c. Management and Monitoring Tools를 선택하고 자세히를 클릭합니다.

d. Simple Network Management Protocol을 선택하고 OK를 클릭합니다.

e. 다음을 클릭합니다.

f. 시작 → 제어판 → 네트워크 연결을 선택합니다.

g. 로컬 영역 연결을 선택합니다.

h. 등록 정보(Windows 2003에서는 속성)를 선택합니다.

주 – Windows 2000 또는 Windows 2003 CD를 넣어 컴퓨터가 SNMP 서비스에 필요한 
파일을 복사하도록 해야 합니다.

4. Microsoft SNMP 등록 정보 창의 Security 탭을 클릭하여 Security 설정을 표시합니다.

5. 서버에 사용할 커뮤니티 이름 또는 커뮤니티 문자열이 Accepted community names 
목록에 지정되어 있어야 합니다.

목록에 커뮤니티 이름이 없으면 Add를 클릭하여 SNMP Service Configuration 창을 
표시합니다. Community Name 필드에 새 이름을 입력하고, Community Rights 필드
에서 권한을 지정한 다음 같은 창에서 Add를 클릭합니다. Accepted Community 
Names 목록에 새 이름이 표시된 Security 탭이 나타납니다.

주 – 커뮤니티 이름이나 커뮤니티 문자열은 대소문자를 구분합니다.

6. (선택적) 원하는 경우 기본 설정인 Accept SNMP Packets from Any Host를 Accept 
SNMP Packets from These Hosts로 변경하고 서버의 에이전트에서 트랩을 받는 엔터
프라이즈 관리 컴퓨터의 네트워크 주소를 추가합니다. 

Sun StorEdge Configuration Service 콘솔 소프트웨어를 사용하는 컴퓨터의 네트워크 
주소를 아래의 목록 상자에 추가하려면 Add를 클릭하여 Security Configuration 창에 
액세스합니다. Entry 상자에 IP 주소를 입력하고 같은 창에서 Add를 클릭합니다. 
Configuration Service 관리 콘솔 컴퓨터의 주소가 표시된 상태로 Security 탭이 다시 
나타납니다.

7. OK를 클릭합니다. 
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▼ Microsoft Windows 호스트의 트랩 수신자 지정

이 절차에서는 서버로부터의 트랩 수신자로 엔터프라이즈 관리 콘솔을 나열합니다.

주 – 이 절차의 경우 트랩을 받는 엔터프라이즈 관리 콘솔의 IP 주소가 필요합니다. 또
한 이 절차에서는 앞에서 지정한 것과 같은 커뮤니티 이름이 필요합니다.

엔터프라이즈 관리 콘솔 컴퓨터를 에이전트 트랩의 수신자로 지정하는 단계는 다음과 
같습니다.

1. Microsoft SNMP Properties 창의 Trap 탭을 클릭하여 Trap 설정을 표시합니다. 

2. Security 탭에 이전에 표시된 커뮤니티 이름과 같은 커뮤니티 이름이 지정되어 있어야 
합니다.

커뮤니티 이름을 수정해야 할 경우 Community Name 필드에 이름을 입력하고 Add를 
클릭합니다. 다른 이름이 항목 필드에 이미 있으면 그 위에 입력해도 해당 이름이 유지
됩니다. 이름을 제거하려면 해당 이름을 선택한 후 Remove를 클릭합니다.

3. Trap Destination 목록에 엔터프라이즈 관리 콘솔의 IP 주소를 추가합니다.

a. Add를 클릭합니다.

Service Configuration 창이 나타납니다. 

b. Entry 필드에 IP 주소를 입력하고 Add를 클릭합니다.

Trap Destination 목록에 새 네트워크 주소가 표시된 Trap 탭이 나타납니다.

c. 각 IP 주소를 다음 형식으로 입력합니다. AAA.BBB.CCC.DDD

0으로 시작하는 것은 입력하지 않아도 됩니다. 적절한 주소의 예는 다음과 같습니다.
192.168.100.1

4. 선택적인 트랩을 다른 엔터프라이즈 관리 콘솔에 보내려면 해당 관리 워크스테이션의 
네트워크 주소를 입력합니다.

하나 이상의 엔터프라이즈 관리 콘솔이 있는 경우 각 콘솔에는 여기에 표시된 주소가 
필요합니다.

5. OK를 클릭하여 설정을 확인합니다.

6. Close를 클릭하여 Network 창에서 나갑니다.
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7. Microsoft Windows를 종료하고 서버를 다시 시작합니다.

Sun StorEdge Configuration Service를 설치하려는 경우 소프트웨어를 설치한 후 다시 
부팅하지 않아도 됩니다.

▼ Solaris 호스트 설정

Solaris 호스트의 경우 인터페이스를 통해 sstrapd라는 SNMP 트랩 데몬에 SNMP 버
전 1 트랩을 생성할 수 있습니다. 기본적으로 이 데몬은 부팅할 때 자동으로 시작되지 
않습니다. 다음 절차는 트랩 처리를 사용할 수 있도록 설정하는 방법입니다. 

1. 표준 텍스트 편집기를 사용하여 /var/opt/SUNWsscs/ssagent/sstrapd.conf 파
일을 만듭니다.

이 파일에는 SNMP 관리자 콘솔의 이름 또는 IP 이름이 들어 있습니다. 콘솔이 두 개 이
상인 경우 별도의 행에 나열합니다.

2. /etc/init.d/ssagent 파일을 편집하고 SNMP 관련 시작 섹션에서 주석 표시를 제
거합니다. 주석 행은 우물정자 두 개(##)로 시작됩니다.

3. 편집한 후 파일을 저장합니다.

다음에 부팅할 때 sstrapd 데몬이 시작됩니다. 또는 다음 명령을 실행하여 즉시 시작
할 수 있습니다.

이 명령은 현재 실행되고 있지 않은 sstrapd 데몬과 다른 두 데몬을 시작합니다. 데몬
이 이전에 실행 중이였는지 여부에 관계 없이 이 시점에는 각 데몬의 한 인스턴스만 실
행됩니다.

▼ Linux 호스트 설정

Linux 호스트의 경우 인터페이스를 통해 sstrapd라는 SNMP 트랩 데몬에 SNMP 버
전 1 트랩을 생성할 수 있습니다. 기본적으로 이 데몬은 부팅할 때 자동으로 시작되지 
않습니다. 다음 절차는 트랩 처리를 사용할 수 있도록 설정하는 방법입니다.

1. 표준 텍스트 편집기를 사용하여  /var/opt/SUNWsscs/ssagent/sstrapd.conf 
파일을 만듭니다.

이 파일은 SNMP 관리자 콘솔의 시스템 이름 또는 IP 주소(행 당 하나) 목록과 함께 만
들어져야 합니다. 파일에는 빈 행이나 주석 행이 포함될 수 있습니다.

/etc/init.d/ssagent uptrap
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2. /etc/init.d/ssagent 파일을 편집하고 SNMP 관련 시작 섹션에서 주석 표시를 제
거합니다.

주석 행은 우물정자 두 개(##)로 시작됩니다.

3. 편집한 후 파일을 저장합니다.

다음에 부팅할 때 sstrapd 데몬이 시작됩니다. 또는 다음 명령을 실행하여 즉시 시작
할 수 있습니다.

이 명령은 현재 실행되고 있지 않은 sstrapd 데몬과 다른 두 데몬을 시작합니다. 데몬
이 이전에 실행 중이였는지 여부에 관계 없이 이 시점에는 각 데몬의 한 인스턴스만 실
행됩니다.

▼ HP-UX 호스트 설정

1. 표준 텍스트 편집기를 사용하여  /var/opt/SUNWsscs/ssagent/sstrapd.conf 
파일을 만듭니다.

이 파일은 SNMP 관리자 콘솔의 시스템 이름 또는 IP 주소(행 당 하나) 목록과 함께 만
들어져야 합니다. 파일에는 빈 행이나 주석 행이 포함될 수 있습니다.

2. 표준 텍스트 편집기를 사용하여 /sbin/init.d/ssagent 파일을 편집합니다.

다음 행을 

다음으로 변경합니다. 

/etc/init.d/ssagent uptrap

# Look at environment variable from /etc/rc.config.d/ssagent to 
see if we should start SNMP trap daemon sstrapd: if [ì$SSTRAPDî=
1]; then P trap daemon sstrapd:

# Look at environment variable from /etc/rc.config.d/ssagent to 
see if we should start SNMP trap daemon sstrapd: if [ì$SSTRAPDî=
0]; then P trap daemon sstrapd:
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3. 편집한 후 파일을 저장합니다.

다음에 부팅할 때 sstrapd 데몬이 시작됩니다. 또는 다음 명령을 실행하여 즉시 시작
할 수 있습니다.

이 명령은 현재 실행되고 있지 않은 sstrapd 데몬과 다른 두 데몬을 시작합니다. 데몬
이 이전에 실행 중이였는지 여부에 관계 없이 이 시점에는 각 데몬의 한 인스턴스만 실
행됩니다.

▼ IBM AIX 호스트 설정 

IBM AIX 호스트의 경우 인터페이스를 통해 sstrapd라는 SNMP 트랩 데몬에 SNMP 
버전 1 트랩을 생성할 수 있습니다. 기본적으로 이 데몬은 부팅할 때 자동으로 시작되지 
않습니다. 다음 절차는 트랩 처리를 사용할 수 있도록 설정하는 방법입니다. 

1. 표준 텍스트 편집기를 사용하여  /var/opt/SUNWsscs/ssagent/sstrapd.conf 
파일을 만듭니다.

이 파일은 SNMP 관리자 콘솔의 시스템 이름 또는 IP 주소(행 당 하나) 목록과 함께 만
들어져야 합니다. 파일에는 빈 행이나 주석 행이 포함될 수 있습니다.

2. /etc/ssagent 파일을 편집하고 SNMP 관련 시작 섹션에서 주석 표시를 제거합니다. 

주석 행은 우물정자 두 개(##)로 시작됩니다.

3. 편집한 후 파일을 저장합니다.

다음에 부팅할 때 sstrapd 데몬이 시작됩니다. 또는 다음 명령을 실행하여 즉시 시작
할 수 있습니다.

이 명령은 현재 실행되고 있지 않은 sstrapd 데몬과 다른 두 데몬을 시작합니다. 데몬
이 이전에 실행 중이였는지 여부에 관계 없이 이 시점에는 각 데몬의 한 인스턴스만 실
행됩니다.

/sbin/init.d/ssagent start

/etc/ssagent uptrap
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Sun StorEdge Configuration Service를 사용하지 
않고 SNMP 트랩 보내기
Sun StorEdge Configuration Service를 사용하지 않고 SNMP 트랩을 보내는 다른 방법
에 대해서는 Sun StorEdge 3000 Family RAID Firmware Users Guide를 참조하십시오.
부록 E 전자 메일과 SNMP 249
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부록 F

문제 해결

이 장에서는 다음 증상에 대한 문제 해결 방법을 제공합니다.

■ 252페이지의 "증상: 서버가 응답하지 않거나 다운된 것 같습니다."

■ 253페이지의 "증상: 기존 논리 드라이브에서 논리 볼륨을 추가하려고 할 때 논리 드
라이브가 나열되지 않습니다."

■ 253페이지의 "증상: DHCP 환경에서 서버의 IP 주소가 변경되었습니다."

■ 254페이지의 "증상: 서버로부터 트랩을 받을 수 없습니다."

■ 254페이지의 "증상: HP OpenView가 설치되지 않거나 트랩 데몬이 시작되지 않습니
다."

■ 255페이지의 "증상: 하드웨어가 추가되거나 대체될 때 콘솔에 변경 사항이 표시되지 
않습니다."

■ 255페이지의 "증상: Solaris 호스트에서 논리 드라이브가 표시되지 않습니다."

■ 255페이지의 "증상: 환경 알람이 보고되지 않습니다."

■ 256페이지의 "증상: 알람 소리를 음소거할 수 없습니다."

■ 256페이지의 "증상: 콘솔이 느리게 작동하는 것 같습니다."

■ 256페이지의 "증상: Sun StorEdge Diagnostic Reporter가 작동하지 않습니다."

■ 257페이지의 "증상: (UNIX OS) 온라인 도움말이 표시되지 않습니다."
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증상: 서버가 응답하지 않거나 다운된 것 같습니다.

서비스가 서버에서 실행 중이어야 합니다.

1. (UNIX OS) 다음 명령을 실행합니다.

이름 ssmon과 ssserver가 모두 출력에 표시되어야 합니다. 시작되지 않았으면 단계 
2로 이동하고, 시작되었으면 단계 4로 이동합니다.

(Windows 2000) 시작 → 프로그램 → 관리 도구 → 컴퓨터 관리를 선택합니다. 서비스 및 
응용 프로그램 → 서비스를 클릭하고 SUNWscsd Monitor, SUNWscsd Server 및 
SUNWscsd Startup 서비스가 시작되었는지 확인합니다. 시작되지 않았으면 단계 2로 
이동하고, 시작되었으면 단계 4로 이동합니다.

(Windows 2003) 시작 → 관리 도구 → 컴퓨터 관리 → 서비스 및 응용 프로그램 → 서비스
를 선택하고 SUNWscsd Monitor, SUNWscsd Server 및 SUNWscsd Startup 서비스가 
시작되었는지 확인합니다. 시작되지 않았으면 단계 2로 이동하고, 시작되었으면 단계 4
로 이동합니다.

2. (UNIX OS) Sun StorEdge 3000 Family 소프트웨어 설치 설명서에 설명되어 있는 데몬
을 중지한 다음 시작합니다.

(Microsoft Windows) 시작하거나 중지할 서비스를 마우스 오른쪽 버튼을 클릭하여 서
비스를 중지한 다음 시작합니다.

3. 데몬/서비스가 제대로 중지/시작하지 않으면 재구성을 다시 시작합니다.

4. TCP/IP 프로토콜 소프트웨어가 로드되고 네트워크 카드와 네트워크 연결이 작동 중이
어야 합니다.

명령줄에서 TCP/IP 연결을 테스트하려면 다음을 입력하십시오.

응답이 없으면 TCP/IP 프로토콜 서비스에 문제가 있는 것입니다. MIS 부서에 연락하
여 도움을 요청하십시오.

5. 서버 이름과 암호를 올바르게 지정해야 합니다.

이름이나 암호가 올바르지 않으면 항목을 편집하여 수정합니다. Sun StorEdge 3000 
Family 소프트웨어 설치 설명서에서 해당 OS의 "관리자(사용자) 보안 수준 및 지침" 절
을 참조하십시오.

암호는 사용자를 설정하는 절차에서 사용한 것과 동일해야 합니다.

■ 사용자(ssmon, ssadmin, ssconfig)가 제대로 설정되어 있어야 합니다. 

# ps -e | grep ss

# ping {IP address of the server or the server name}
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■ 이름 지정 서비스(UNIX OS에서는 NIS 또는 NIS+)를 사용하는 경우 사용자가 이름 
지정 서비스에 올바르게 추가되어 있어야 합니다.

증상: 기존 논리 드라이브에서 논리 볼륨을 추가하려고 할 때 논리 드
라이브가 나열되지 않습니다.

Select a Logical Drive에 논리 드라이브가 표시되지 않는 경우에는 논리 드라이브의 매
핑이 해제되지 않았기 때문에 선택할 수 없는 것입니다. 먼저 논리 드라이브의 매핑을 
해제해야 합니다.

증상: DHCP 환경에서 서버의 IP 주소가 변경되었습니다.

DHCP 환경에서 서버가 3일 이상 오프라인 상태였으면 서버의 IP 주소가 원격으로 변
경되었을 수 있습니다.

이 경우 콘솔은 IP 주소를 통해 서버와 통신하므로 콘솔에 서버의 새 IP 주소를 통보해
야 합니다.

이 상황을 해결하려면 서버의 새 IP 주소를 콘솔 소프트웨어의 Edit Server 창에 입력해
야 합니다.

1. File → Server List Setup을 선택합니다.

2. 서버 이름을Managed Servers 목록에서 Available Servers 목록으로 이동합니다.

Edit Server 창이 나타납니다. 이 창에는 서버 이름과 구성된 IP 주소가 나타납니다.

3. Available Servers 목록에서 서버 이름을 선택하고 Edit를 클릭합니다.

Edit Server 창이 나타납니다. 이 창에는 서버 이름과 구성된 IP 주소가 나타납니다.

4. 네트워크 주소가 변경된 경우에는 Get IP Addr by Name을 클릭합니다. 

네트워크에서 사용하는 서비스에 의해 기록된 대로 서버의 이름을 제공하면 프로그램
에서 올바른 IP 주소를 검색하여 표시합니다. 그렇지 않으면 IP 주소를 입력해야 합니
다.

서버에 사용된 이름이 서버의 네트워크 이름과 다르거나 이름 지정 서비스가 업데이트
되지 않은 경우 IP 주소를 수동으로 입력해야 합니다.

5. 서버 IP 주소를 입력한 후 OK를 클릭하여 변경된 주소를 지정하고 Server List Setup
(서버 목록 설정) 창으로 돌아갑니다.

6. 서버 이름을 Managed Servers 목록으로 다시 이동합니다.

7. OK를 클릭하여 Server List Setup 창을 종료합니다.
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증상: 서버로부터 트랩을 받을 수 없습니다.
HP OpenView 같은 SNMP 관리 워크스테이션에서 서버의 트랩을 받지 못하는 문제를 
해결하려면 다음 단계를 수행하십시오.

1. SNMP 서비스가 서버에서 시작되어 있어야 합니다.

다음 명령을 실행하여 sstrapd가 실행되는지 확인합니다.

출력에 sstrapd라는 이름이 포함되어 있습니다. 없으면 Sun StorEdge 3000 Family 소
프트웨어 설치 설명서에 설명된 대로 에이전트를 시작하거나 중지합니다.

2. 엔터프라이즈 관리 콘솔의 대상 주소와 커뮤니티 문자열이 서버에 올바르게 설정되어 
있는지 확인합니다.

3. MIB가 SNMP 관리 콘솔에 컴파일되어 있어야 합니다.

Solaris, Linux 및 HP-UX OS의 경우 RST_OID.MIB 파일은 
/opt/SUNWsscs/ssagent에 있습니다. IBM AIX OS의 경우 
/usr/SUNWsscs/ssagent에 있습니다. Microsoft Windows의 경우에는
\Program Files\Sun\ssagent에 있습니다. MIB를 컴파일하는 방법에 대한 자세
한 내용은 SNMP 관리 콘솔 설명서(예: HP OpenView)를 참조하십시오.

증상: HP OpenView가 설치되지 않거나 트랩 데몬이 시작되지 않습니
다.
SNMP 트랩을 보내기 위해 설정한 것과 같은 서버에 HP OpenView를 설치한 경우 트
랩 데몬과 HP OpenView를 실행하기 위한 시스템 자원이 충분하지 않습니다. 다음 단
계의 설명에 따라 시스템 자원을 재구성하십시오.

1. 다음 행을 /etc/system의 끝에 추가합니다.

# ps -e | grep ss

set shmsys:shminfo_shmmax=0x2000000
set shmsys:shminfo_shmmin=1
set shmsys:shminfo_shmmni=256
set shmsys:shminfo_shmseg=256

set semsys:seminfo_semmap=256
set semsys:seminfo_semmni=512
set semsys:seminfo_semmns=512
set semsys:seminfo_semmsl=32
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주 – 시스템에 설치된 다른 응용프로그램의 요구사항으로 인해 /etc/system에 이미 
이러한 커널 매개변수 중 하나에 값을 할당하는 명령문이 포함되어 있을 경우 1단계에 
나와 있는 매개변수 할당을 각 매개변수가 한번만 할당되도록 파일에 합쳐야 합니다. 
이전 매개변수 값이 1단계에서 지정한 매개변수 값과 다른 경우 더 큰 값을 지정합니다.

2. 서버를 다시 부팅합니다.

증상: 하드웨어가 추가되거나 대체될 때 콘솔에 변경 사항이 표시되
지 않습니다.

새 장비를 추가하거나 디스크 드라이브, 테이프 드라이브, 전원 공급 장치 또는 팬 등의 
실패한 장치를 교체하는 경우 콘솔에서 항상 업데이트된 정보를 표시하지는 않습니다. 
트리 보기와 기타 관련 보기가 장치의 실제 상태를 반영하지 않는 경우가 있습니다.

새 장치를 추가하고 이 장치가 다음 검색 주기 전에 인식되도록 하려면 Sever View 창
에서 Rescan을 클릭합니다. 서버는 즉시 자원 목록을 다시 검색하고 콘솔은 서버의 정
보를 업데이트하여 트리 보기에 변경 사항을 표시합니다. 적절한 시기에 자원 목록을 
확인하려면 수동으로 검색합니다.

Rescan을 한 번 이상 클릭해야 할 수 있습니다. 서버가 다시 검색하는 중이고 콘솔이 자
원 목록에 대한 요청을 보내면 현재의 검사를 아직 완료하지 않은 상태이므로 서버는 
마지막으로 업데이트할 때의 서버 자원 목록을 콘솔에 보냅니다.

증상: Solaris 호스트에서 논리 드라이브가 표시되지 않습니다.

LG가 표시되지 않는 경우에는 논리 드라이브의 레이블이 지정되어 있고 Sun StorEdge 
Configuration Service(설치된 경우)에서 제외시키지 않았는지 확인하십시오.

증상: 환경 알람이 보고되지 않습니다.

SAF-TE 카드와 같은 SCSI 기반 엔클로저 모니터링 기능을 사용하는 저장 장치 엔클로
저는 콘솔에 환경 알람을 보냅니다. 알람 상태는 드라이브, 팬, 전원 공급 장치, 배터리 
또는 이상 기온에 의해 발생할 수 있습니다.

환경 알람이 발생하면 View Enclosure 창에서 Reset을 클릭하여 알람을 해제해야 합니
다. 소프트웨어에서 Reset을 클릭하려면 구성 보안 권한이 있어야 합니다. 
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증상: 알람 소리를 음소거할 수 없습니다.

SAF-TE 카드와 같은 SCSI 기반 엔클로저 모니터링 기능을 사용하는 저장 장치 엔클로
저는 콘솔에 환경 알람을 보냅니다. 알람 상태는 드라이브, 팬, 전원 공급 장치, 배터리 
또는 이상 기온에 의해 발생할 수 있습니다. 환경 알람 소리를 음소거하려면 어레이의 
우측 손잡이에 있는 Reset 버튼을 클릭해야 합니다.

알람은 논리 드라이브가 실패하거나, 재구성하는 동안 또는 드라이브를 추가할 때 같은 
제어기 이벤트 때문에도 발생할 수 있습니다. 제어기 이벤트에 대한 자세한 내용은 Sun 
StorEdge 3000 Family RAID Firmware Users Guide의 ìEvent Messagesî 부록을 참조
하십시오. 제어기 경고음을 음소거하려면 193페이지의 "제어기 경고음 음소거하기"를 
참조하십시오.

주 – 제어기 이벤트 알람의 경우에는 Reset 버튼을 클릭해도 소거되지 않고 실패한 구
성 요소 알람의 경우에는 경고음을 음소거해도 소거되지 않습니다.

증상: 콘솔이 느리게 작동하는 것 같습니다.

Sun StorEdge Configuration Service에서는 한 번에 최대 32대의 어레이를 모니터링하
고 관리할 수 있습니다. 그러나 관리하는 어레이 수가 증가할수록 콘솔 응답 시간이 감
소될 수 있습니다.

사용된 메모리의 양이 사용 가능한 총 가상 메모리(실제 메모리 + 페이지 파일 크기)에 
도달하면 초과하는 페이징은 워크스테이션의 모든 응용프로그램의 성능을 저하시키는 
결과를 초래할 수 있습니다.

실제 메모리와 페이지 파일 크기를 증가시켜 전체 가상 메모리를 증가시킵니다. 페이지 
파일 크기를 변경하려면 제어판 → 시스템을 선택한 다음 나타나는 시스템 등록정보 창
에서 성능 탭을 선택합니다.

증상: Sun StorEdge Diagnostic Reporter가 작동하지 않습니다.

(UNIX OS) Sun StorEdge Diagnostic Reporter가 작동되지 않고 그 상태를 보고하지 않
는 경우로는 다음의 세 가지 상황이 있습니다. 해결 방법은 Diagnostic Reporter를 중지
하고 다시 시작하는 것입니다.

■ 에이전트가 실패하거나 중지되었다가 다시 시작되면 Sun StorEdge Diagnostic 
Reporter가 작동을 중지합니다.

■ Config Tool이 실행 중인 상태에서 데몬이 중지되었다가 다시 시작되면 Config Tool
이 데몬과 통신하지 못하는 상황이 발생할 수 있습니다.
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■ 에이전트가 실패하거나 중지되면 데몬은 이를 감지하지 못하고 전자 메일 메시지의 
발신을 중단하며 Sun StorEdge Diagnostic Reporter가 아직 연결되어 있는 것처럼 
녹색 상태로 표시합니다.

Solaris 호스트와 Linux 호스트에서는 다음을 입력하여 Sun StorEdge Diagnostic 
Reporter를 중지하고 다시 시작합니다.

HP-UX 호스트에서는 다음을 입력하여 Sun StorEdge Diagnostic Reporter를 중지하고 
다시 시작합니다.

IBM AIX 호스트에서는 다음을 입력하여 Sun StorEdge Diagnostic Reporter를 중지하
고 다시 시작합니다.

증상: (UNIX OS) 온라인 도움말이 표시되지 않습니다.

온라인 도움말을 표시하는 데 사용할 웹 브라우저의 절대 경로 이름이 지정되어 있어야 
합니다.

1. Solaris, Linux 및 HP-UX OS의 경우 /opt/SUNWsscs/sscsconsole로 변경합니
다.IBM AIX OS의 경우 /usr/SUNWsscs/sscsconsole로 변경합니다.

2. 다음을 입력합니다.

3. 웹 브라우저의 절대 경로 이름을 입력합니다.

# /etc/init.d/ssdgrptd stop 
# /etc/init.d/ssdgrptd start

# /sbin/init.d/ssdgrptd stop 
# /sbin/init.d ssdgrptd start

# /usr/sbin/ssdgrptd start
# /usr/sbin/ssdgrptd stop

./config_sscon
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부록 G

오류 코드 및 메시지

이 부록에서는 Sun StorEdge Configuration Service의 오류 코드와 상태 메시지 목록을 
제공합니다. 제어기 오류 메시지 목록에 대해서는  Sun StorEdge 3000 Family RAID 
Firmware Users Guide를 참조하십시오.

■ 260페이지의 "오류 코드"
■ 278페이지의 "오류 및 상태 메시지"
■ 295페이지의 "설치 및 프로그램 프롬프트"
 259



오류 코드
Event Log에 설명된 것처럼 오류 코드는 문자 2개씩 4개의 필드로 이루어진 8자 코드입
니다. 대시(-)와 다른 8자 코드 앞에 몇몇 코드가 나타날 수 있으나 이는 내부용으로만 
사용됩니다.

다음 표에서는 각 필드에 사용된 오류 코드를 설명합니다. 두 문자로 이루어진 네 개의 
필드 형식은 다음과 같습니다.

d1d2d3d4-d5d6d7d8

각 필드의 의미는 다음과 같습니다.

d1= 심각도 필드

d2= 주 필드

d3= 부 필드(d4, d5, d6, d7 및 d8의 디코딩 방법을 결정)

표 G-1 심각도 필드

심각도 필드 설명

01 심각

02 경고

03 정보

표 G-2 주 필드

주 필드 설명

01 알 수 없음

05

06 모니터링 데몬

08 서버 데몬

09 JBOD(Just a Bunch Of Disks) 메시지

0A 통신

0B RAID 제어기
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부 필드는 다음 표에 정의되어 있습니다. 오류 필드의 정의는 부 필드에 따라 다르며, 이 
경우 적절한 표가 참조됩니다.

표 G-3 부 필드

부 필드 설명

01 알 수 없음

02 262페이지의 "오류 필드: 시스템 드라이브 상태"를 참조하십시오.

03 262페이지의 "오류 필드: 디스크 상태"를 참조하십시오.

04 263페이지의 "오류 필드: SAF-TE 상태"를 참조하십시오.

05 263페이지의 "오류 필드: 테이프 상태"를 참조하십시오.

06 265페이지의 "오류 필드: 중복 상태"를 참조하십시오.

07 265페이지의 "오류 필드: 내부 상태"를 참조하십시오.

08 266페이지의 "오류 필드: 장치 상태"를 참조하십시오.

09 266페이지의 "오류 필드: 초기화 상태"를 참조하십시오. 

0A 266페이지의 "오류 필드: 잘못된 클라이언트 매개변수"를 참조하십시오.

0B 267페이지의 "오류 필드: 전송 열기"을 참조하십시오.

0C 267페이지의 "오류 필드: 전송 닫기"을 참조하십시오.

0D 267페이지의 "오류 필드: 메모리 할당"을 참조하십시오.

0E RaidCard 오류가 감지되었습니다.

10 268페이지의 "오류 필드: 전송"을 참조하십시오.

11 268페이지의 "오류 필드: 기본 통신"을 참조하십시오.

12 269페이지의 "오류 필드: 통신 링크"를 참조하십시오.

13 269페이지의 "오류 필드: 통신 비동기"를 참조하십시오.

14 269페이지의 "오류 필드: 통신 보안"을 참조하십시오.

15 269페이지의 "오류 필드: 시간 초과"를 참조하십시오.

16 270페이지의 "오류 필드: 관리"를 참조하십시오.

17 271페이지의 "오류 필드: 펌웨어"를 참조하십시오.

18 271페이지의 "오류 필드: 시스템 종료"를 참조하십시오.

19 동적 확장 오류가 감지되었습니다. 

1C 272페이지의 "오류 필드: 구성 설정"을 참조하십시오.

1D 272페이지의 "오류 필드: 제어기 이벤트"를 참조하십시오.

1E 273페이지의 "오류 필드: 드라이브측 이벤트"를 참조하십시오.

1F 274페이지의 "오류 필드: 호스트측 이벤트"를 참조하십시오.
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오류 필드: 시스템 드라이브 상태

오류 필드: 디스크 상태

20 274페이지의 "오류 필드: 논리 드라이브 이벤트"를 참조하십시오.

23 277페이지의 "서버 관리/모니터링 이벤트 오류"를 참조하십시오.

2B 275페이지의 "오류 필드: 일반 대상 이벤트"를 참조하십시오.

표 G-4 시스템 드라이브 상태 오류

오류 필드

01 오프라인

02 저하

03 온라인

04 알 수 없음

05 패리티 검사

06 재구성

07 재구성

08 동적 확장

09 없음

0A 초기화

표 G-5 디스크 상태 오류

오류 필드 설명

01 오프라인

02 저하

03 온라인

04 알 수 없음

05 SMART

06 작동 안 함

표 G-3 부 필드 (계속)

부 필드 설명
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오류 필드: SAF-TE 상태

오류 필드: 테이프 상태

표 G-6 SAF-TE 상태 오류

오류 필드 설명

01 전원

02 팬

03 온도

04 알람

05 잠김

06 슬롯t

07 알 수 없음

08 SAF-TE 정보를 가져올 수 없음

09 배터리

0A 잘못된 슬롯 번호

0B 환경 데이터 사용할 수 없음

0C 개정이 호환되지 않음

표 G-7 테이프 상태 오류

오류 필드 설명

01 읽기

02 쓰기

03 하드 오류

04 미디어 오류

05 읽기 실패

06 쓰기 실패

07 미디어 수명

08 업그레이드할 수 없음

09 쓰기 금지

0A 제거되지 않음

0B 미디어 지우기
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0C 지원되지 않는 형식

0D 스냅 테이프

14 지금 지우기

15 주기적 지우기

16 미디어 지우기 만료

1E 하드웨어 A

1F 하드웨어 B

20 인터페이스

21 미디어 꺼내기

22 다운로드 실패

28 로더 하드웨어 A

29 로더 트레이 테이프

2A 로더 하드웨어 B

2B 로더 도어

C8 질의 로그 실패

C9 조회 테이프 실패

표 G-7 테이프 상태 오류 (계속)

오류 필드 설명
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오류 필드: 중복 상태

오류 필드: 내부 상태
 

표 G-8 중복 상태 오류

오류 필드 설명

01 정상 모드

02 협상 메모리 없음

03 보조 실패

04 보조 제거

05 보조 제거 감지

06 보조 삽입 감지

07 기본 실패

08 기본 제거

09 기본 제거 감지

0A 기본 삽입 감지

0B 알 수 없는 상태

0C 파트너 실패

0D 파트너 삽입

0E 파트너 제거

표 G-9 내부 상태 오류

오류 필드 설명

01 메모리 없음

02 세마포어

03 스레드

04 장치 없음
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오류 필드: 장치 상태

오류 필드: 초기화 상태

오류 필드: 잘못된 클라이언트 매개변수

표 G-10 장치 상태 오류

오류 필드 설명

01 조회

02 알 수 없음

표 G-11 초기화 상태 오류

오류 필드 설명

01 dll 초기화

02 dll 초기화 실패

표 G-12 클라이언트 매개변수 오류

오류 필드 설명

01 구성 설정 – 구성 비교 오류

02 구성 설정 – 잘못된 구성 장치

03 구성 설정 – 조회 비교 오류

04 구성 설정 – 조회2 비교 오류

05 잘못된 응용프로그램 길이

06 지원되지 않는 명령

07 잘못된 명령

08 구성 설정 – 일반 비교 오류

09 잘못된 길이

0A 잘못된 카드 식별자

0B 잘못된 카드 이름

0C 잘못된 매개변수

0D 잘못된 카드 유형 명령
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오류 필드: 전송 열기

오류 필드: 전송 닫기

오류 필드: 메모리 할당

0E 구성 설정 – 잘못된 추가 매개변수

0F 구성 설정 – 블록 중복

10 구성 설정 – 잘못된 장치 정보

표 G-13 전송 열기 오류

오류 필드 설명

01 전송 열기

표 G-14 전송 닫기 오류

오류 필드 설명

01 전송 닫기

표 G-15 메모리 할당 오류

오류 필드 설명

01 메모리 부족

02 관리 작업의 메모리 부족

표 G-12 클라이언트 매개변수 오류 (계속)

오류 필드 설명
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오류 필드: 전송

오류 필드: 기본 통신 

표 G-16 전송 필드 오류

오류 필드 설명

01 잠금 오류

02 메모리 부족

03 잠금 오류 인식

04 잠금 오류 해제

05 잘못된 명령

06 잘못된 길이

07 잘못된 카드 이름

08 잘못된 카드 ID

09 카드를 찾을 수 없음

0A 장치를 찾을 수 없음

0B 오류 열기

0C 카드 이름을 찾을 수 없음

표 G-17 기본 통신 오류

오류 필드 설명

01 소켓 오류

02 보고 오류

03 스레드 오류

04 잠금 오류

05 시스템 오류
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오류 필드: 통신 링크

오류 필드: 통신 비동기

오류 필드: 통신 보안

오류 필드: 시간 초과

표 G-18 통신 링크

오류 필드 설명

01 소켓 오류

표 G-19 통신 비동기

오류 필드 설명

01 소켓 오류

02 스레드 오류

03 콜드 링크 오류

04 이벤트 보내기 오류

표 G-20 통신 보안

오류 필드 설명

01 보안 위반

표 G-21 시간 초과 오류

오류 필드 설명

01 구성 업데이트

02 잠금 시간 초과
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오류 필드: 관리

표 G-22 관리 오류

오류 필드 설명

01 고객 이름 설정 오류

02 구성 설정 종료

03 초기화

04 초기화 종료

05 재구성

06 재구성 종료

07 패리티 검사

08 패리티 검사 종료

09 SAF-TE 슬롯 상태 설정

0A SAF-TE 수행 슬롯 설정

0B SAF-TE 전역으로 보내기 설정

0E 패리티 검사 예약

0F 패리티 검사 종료 예약

10 제어기 매개변수 설정

11 펌웨어 다운로드

12 일관성 검사 또는 재구성 종료

13 제어기 재설정

14 논리 드라이브 확장

16 논리 드라이브에 디스크 드라이브 추가

18 디스크 드라이브 복사 및 교체

1A 백그라운드 명령을 마쳤음

1B 백그라운드 명령이 취소됨

1C 디스크 레이블 만들기가 시작됨 (Solaris에만 해당)

1D 디스크 레이블 만들기를 마쳤음 (Solaris에만 해당)

1E 매체 검사

1F 제어기 종료
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오류 필드: 펌웨어

오류 필드: 시스템 종료

표 G-23 펌웨어 다운로드 오류

오류 필드 설명

01 SAF-TE 장치 아님

02 잘못된 데이터 길이

03 다운로드 실패

04 체크섬 오류

06 다운로드 성공

07 잘못된 펌웨어 파일

08 메모리 부족

09 잘못된 카드 ID

0A 제어기 종료 실패

0B 조회 오류

0C 잘못된 제품 ID

0D PostDataSet 실패

0E SendDataSection 실패

0F FreeResource 오류

10 잘못된 모듈 ID

11 잘못된 다운로드 데이터 길이

12 개정 다운로드 실패

13 잘못된 장치 유형

표 G-24 시스템 종료 오류

오류 필드 설명

01 시스템 종료 실패
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오류 필드: 구성 설정

오류 필드: 제어기 이벤트

표 G-25 구성 설정 오류

오류 필드 설명

01 구성 스레드 만들기 설정 실패

02 논리 드라이브 목록 명령 가져오기 실패

03 구성 명령 만들기 실패

04 완료 상태 명령 초기화 실패

05 구성 명령 가져오기 실패

06 볼륨 구성 명령 변경 실패

07 논리 드라이브 명령 삭제 실패

표 G-26 제어기 이벤트 오류

오류 필드 설명

01 제어기 재설정

02 제어기 DRAM 패리티 오류

03 제어기 중복 실패

04 제어기 전원 공급 장치 실패

05 제어기 팬 실패

06 제어기 온도 경고

07 제어기 UPS AC 정전

08 제어기 초기화 완료

09 제어기 전원 공급 장치 다시 온라인 상태

0A 제어기 팬 다시 온라인 상태

0B 제어기 온도 정상

0C 제어기 UPS AC 전원 다시 켜짐

0D 제어기 RCC SDRAM 오류

0E 제어기 배터리
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오류 필드: 드라이브측 이벤트

표 G-27 드라이브측 이벤트 오류

오류 필드 설명

01 선택 시간 초과 드라이브 채널

02 SCSI 버스 오류인 드라이브 채널

03 예기치 않게 연결이 끊긴 드라이브 채널

04 협상 오류가 있는 드라이브 채널

05 대상 시간이 초과한 드라이브 채널

06 패리티 오류가 있는 드라이브 채널

07 데이터 부족 또는 오버런인 드라이브 채널

08 알 수 없는 오류가 있는 드라이브 채널

09 SCSI 버스가 재설정된 드라이브 채널

0A 오류 준비가 되지 않은 드라이브 채널

0B 대상 HW 오류가 있는 드라이브 채널

0C 대상 미디어 오류가 있는 드라이브 채널

0D 예기치 못한 장치 경고를 받은 드라이브 채널

0E 예기치 못한 센스 데이터가 있는 드라이브 채널

0F 블록 재할당에 실패한 드라이브 채널

10 블록 재할당에 성공한 드라이브 채널

11 SCSI 중지 명령의 드라이브 채널

12 SCSI 채널에 오류가 있는 드라이브 채널

13 SMART에 오류가 있는 드라이브 채널

14 SCSI 드라이브를 검색하는 드라이브 채널
부록 G 오류 코드 및 메시지 273



오류 필드: 호스트측 이벤트

오류 필드: 논리 드라이브 이벤트

표 G-28 호스트측 이벤트 오류

오류 필드 설명

01 호스트 채널 SCSI 버스 재설정

02 호스트 채널 SCSI 버스 장치 재설정

03 호스트 채널 중지 태그 메시지

04 호스트 채널 패리티 오류

05 호스트 채널 재선택 시간 초과

표 G-29 논리 드라이브 이벤트 오류

오류 필드 설명

01 논리 드라이브 SCSI 드라이브 실패

02 논리 드라이브 초기화 실패

03 논리 드라이브 재구성 실패

04 논리 드라이브 초기화 시작

05 논리 드라이브 초기화 완료

06 논리 드라이브 재구성 시작

07 논리 드라이브 재구성 완료

08 논리 드라이브 패리티 검사 실패

09 논리 드라이브 확장 실패

0A 논리 드라이브 디스크 추가 실패

0B 논리 드라이브 패리티 검사 시작

0C 논리 드라이브 패리티 검사 완료

0D 논리 드라이브 확장 시작

0E 논리 드라이브 확장 완료

0F 논리 드라이브 디스크 추가 시작

10 논리 드라이브 디스크 추가 완료

11 논리 드라이브 디스크 추가 일시 중지

12 논리 드라이브 디스크 추가 계속
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오류 필드: 일반 대상 이벤트

13 논리 드라이브 복제 시작

14 논리 드라이브 복제 완료

15 논리 드라이브 복제 실패

16 논리 드라이브 매체 검사 시작

17 논리 드라이브 매체 검사 완료

18 논리 드라이브 매체 검사 계속

19 논리 드라이브 매체 검사 실패

1A 논리 드라이브 불량 블록 테이블

1B 논리 드라이브 불량 블록

1C 논리 드라이브 매체 검색 불량 블록 복구

1D 논리 드라이브 매체 검색 불량 블록이 복구됨

1E 논리 드라이브 패리티 이벤트

표 G-30 일반 대상 이벤트 오류

오류 필드 설명

01 일반 전원 공급 장치 실패 감지

02 DC 실패 감지

03 AC 실패 감지

04 DC 과전압 경고

05 DC 전압 부족 경고

06 DC 과전압 심각

07 DC 전압 부족 심각

08 일반 전원 공급 장치 상태 변경 심각

09 일반 전원 공급 장치 실패 상태 종료

0A DC 실패 상태 종료

0B AC 실패 상태 종료

0C DC 전압 부족 상태 종료

0D DC 과전압 상태 종료

표 G-29 논리 드라이브 이벤트 오류 (계속)

오류 필드 설명
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0E 온도 일반 상태 변경

0F 일반 온도 경고

10 고온 경고

11 저온 경고

12 고온 심각

13 저온 심각

14 일반 온도 상태 변경 심각

15 일반 온도 경고 종료

16 고온 상태 종료

17 저온 상태 종료

18 온도 일반 상태 변경

19 팬 일반 실패 감지

1A 저속 RPM 경고

1B 고속 RPM 경고

1C 저속 RPM 심각

1D 고속 RPM 심각

1E 일반 팬 상태 변경 심각

1F 일반 팬 실패 상태 종료

20 저속 RPM 상태 종료

21 고속 RPM 상태 종료

22 일반 UPS 상태 변경 통지

23 일반 UPS 실패 감지

24 AC 회선 실패 감지

25 DC 회선 실패 감지

26 배터리 실패 감지

27 일반 UPS 상태 변경 심각

28 일반 UPS 실패 상태 종료

29 AC 회선 실패 상태 종료

2A DC 회선 실패 상태 종료

2B 배터리 실패 상태 종료

표 G-30 일반 대상 이벤트 오류 (계속)

오류 필드 설명
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서버 관리/모니터링 이벤트 오류

2C 일반 UPS 상태 변경 통지

2D 일반 전압 경고

2E 고전압 경고

2F 저전압 경고

30 고전압 심각

31 저전압 심각

32 일반 전압 상태 변경 심각

33 일반 전압 경고 종료

34 고전압 상태 종료

35 저전압 상태 종료

36 일반 전압 상태 변경 통지

37 일반 전류 경고

38 고전류 경고

39 고전류 심각

3A 일반 전류 상태 변경 심각

3B 일반 전류 경고 종료

3C 고전류 상태 종료

3D 일반 전류 상태 변경 통지

3E 도어 잠금이 해제됨

3F 일반 도어 상태 변경 심각

40 도어가 현재 잠겨 있음

41 일반 도어 상태 변경 통지

표 G-31 서버 관리/모니터링 이벤트 오류 

오류 필드 설명

01 관리/모니터링할 서버가 변경되었습니다.

표 G-30 일반 대상 이벤트 오류 (계속)

오류 필드 설명
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오류 및 상태 메시지
대부분의 오류 및 상태 메시지는 그 자체로 설명이 됩니다. 표 G-32에는 메시지에 사용
되는 용어가 설명되어 있습니다. 표 G-33에는 오류/상태 메시지가 나열되어 있습니다. 

표 G-32 대체 값

값 설명

Channel SCSI 채널을 나타내는 카드 채널 번호. 값 1은 첫 번째 채널을 나타냅
니다.

Fan 팬 번호

Enclosure 엔클로저 번호

LogicalArray 논리 어레이 번호

LogicalDrive 논리 드라이브 번호

Lun LUN 번호

Name 텍스트 이름

Power 전원 공급 장치 번호

Slot 슬롯 번호

State 논리 어레이, 장치 또는 엔클로저의 상태를 텍스트로 표시. 값은 다음
과 같습니다. Critical, Online, Offline, Critical Rebuild, Non 
Existent, Low Battery, Normal

Target 대상 또는 SCSI ID 번호 

Temperature 섭씨 온도

표 G-33 오류/상태 메시지

오류 및 상태 메시지

A SCSI Drive Failed (Ch:%d,Id:%d). Replace the defective drive. (SCSI 드라이브 오류(채널
:%d,Id:%d). 결함 있는 드라이브를 교체하십시오.)

A tape has been left in the autoloader by a previous hardware fault. Insert an empty 
magazine to clear the fault. If the fault does not clear, turn the autoloader off and then on 
again.  If the problem persists, call the tape drive supplier helpline. (결함 있는 배치의 테이
프이거나 테이프 드라이브에 결함이 있습니다. 드라이브를 테스트하려면 성능이 좋은 테이프
를 사용하십시오. 문제가 계속되면 테이프 드라이브 공급업체에 문의하십시오.)

A user named ssconfig must be created for configuring SUNWsscs Diag Reporter. 
(SUNWsscs Diag Reporter를 구성하는 데 필요한 ssconfig라는 사용자 이름을 만들어야 합니
다.)
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Abort Clone SCSI Drive. (복제 SCSI 드라이브 중지)

Abort Initialization. (초기화 중지)

Abort Parity Check. (패리티 검사 중지)

Abort Rebuild. (재구성 중지)

Access denied for one or more servers. Log in as ssconfig user, and then try the operation 
again. (하나 이상의 서버에 액세스가 거부되었습니다. ssconfig 사용자로 로그인한 다음 작업
을 다시 시도하십시오.)

Access denied for one or more servers. Please log in as an ssadmin user and then try the 
operation again. (하나 이상의 서버에 액세스가 거부되었습니다. ssadmin 사용자로 로그인한 
다음 작업을 다시 시도하십시오.)

Active trap events is empty. (활성 트랩 이벤트가 비어 있습니다.)

Add Physical drive %d:%d has started on logical drive LogicalDrive(물리 드라이브 %d을(를
) 추가하십시오. %d이(가) 논리 드라이브 LogicalDrive에서 시작되었습니다.)

Add Physical drive has completed on logical drive LogicalDrive(물리 드라이브 추가 작업이 
논리 드라이브 LogicalDrive에서 완료되었습니다.)

Add SCSI Drive into Logical Drive information. (SCSI 드라이브를 논리 드라이브 정보에 추
가하십시오.)

Agent Name is empty. (에이전트 이름이 비어 있습니다.)

An error occurred while getting data from the server. (서버에서 데이터를 가져오는 중 오류
가 발생했습니다.)

An HBA card with this WWN already exists. (이 WWN이 있는 HBA 카드가 이미 존재합니
다.)

Another instance of this program is already running! (이 프로그램의 다른 인스턴스가 이미 
실행 중입니다.)

Array Admin in Progress. (어레이 관리를 처리 중입니다.)

At least one email address needs to be configured. (적어도 하나 이상의 전자 메일 주소를 구
성해야 합니다.)

Attempted to load a cartridge type, not supported by this drive. The cartridge has been 
automatically ejected. Attempted to load an unsupported tape format. (이 드라이브에서 지
원하지 않는 카트리지 유형의 로드를 시도했습니다. 카트리지가 자동으로 배출되었습니다. 지
원하지 않는 테이프 형식의 로드를 시도했습니다.)

Attempted to write to a write-protected cartridge. Remove the write-protection or use 
another tape. (쓰기 금지 카트리지에 쓰기를 시도했습니다. 쓰기 금지를 제거하거나 다른 테이
프를 사용하십시오.)

Audible alarm has an unknown status (경보음을 알 수 없는 상태입니다.)

Audible alarm has been triggered. (경보음이 트리거되었습니다.)

표 G-33 오류/상태 메시지 (계속)

오류 및 상태 메시지
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Audible alarm has been turned off. (경보음이 꺼졌습니다.)

Background check or rebuild operation in progress. (배경 확인 또는 재구성 작업을 처리 중입
니다.)

Background initialization in progress. (배경 초기화를 처리 중입니다.)

Background parity check in progress. (배경 패리티 검사를 처리 중입니다.)

Background rebuild operation in progress. (배경 재구성 작업을 처리 중입니다.)

Battery Expiration Monitoring of (Ch:%d,Id:%d) is not available. ((Ch:%d,Id:%d)의 배터리 
만료 모니터링을 사용할 수 없습니다.)

Cannot accept the incoming connection. (들어오는 연결을 수락할 수 없습니다.)

Cannot allocate memory. (메모리를 할당할 수 없습니다.)

Cannot bind TCP port with the opened TCP/IP communication. (TCP 포트를 열린 TCP/IP 
통신에 바인딩할 수 없습니다.)

Cannot connect with the incoming connection. (들어오는 연결에 연결할 수 없습니다.)

Cannot create a communication session for the incoming connection. (들어오는 연결에 대한 
통신 세션을 만들 수 없습니다.)

Cannot create host LUN filter; no host IDs were selected. (호스트 LUN 필터를 만들 수 없습
니다. 선택된 호스트 ID가 없습니다.)

Cannot create standard host LUN mapping, no host IDs were selected. (호스트 LUN 매핑을 
만들 수 없습니다. 선택된 호스트 ID가 없습니다.)

Cannot find the logical drive that was just created. It may have been aborted. (새로 만든 논
리 드라이브를 찾을 수 없습니다. 취소된 것 같습니다.)

Cannot get configuration from controller. The operation is canceled. (제어기에서 구성을 가
져올 수 없습니다. 작업이 취소되었습니다.)

Cannot get configuration in set configuration. (구성 설정에서 구성을 가져올 수 없습니다.)

Cannot listen on the opened TCP/IP communication. (열린 TCP/IP 통신에서 리스닝할 수 
없습니다.)

Cannot lock a resource. (자원을 잠글 수 없습니다.)

Cannot open TCP/IP communication. (TCP/IP 통신을 열 수 없습니다.)

Cannot perform IOCTL on the TCP/IP communication. (TCP/IP 통신에서 IOCTL을 수행할 
수 없습니다.)

Cannot query incoming data status of the connection. (연결에서 들어오는 데이터 상태를 질
의할 수 없습니다.)

Cannot receive data from the connected client. (연결된 클라이언트에서 데이터를 받을 수 없
습니다.)

Cannot report status. (상태를 보고할 수 없습니다.)
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Cannot send data to the connected client. (연결된 클라이언트에 데이터를 보낼 수 없습니다.)

Change logical drive failure. (논리 드라이브를 변경하지 못했습니다.)

Change logical volume failure. (논리 볼륨을 변경하지 못했습니다.)

Change or set local/global standby drives successful. (로컬/전역 대기 드라이브를 변경하거
나 설정하십시오.)

Changes made to Optimization will NOT take effect until all the logical drives are deleted 
and then the controller is RESET. (최적화의 변경 사항은 모든 논리 드라이브가 삭제되고 제어
기가 재설정될 때까지 적용되지 않습니다.)

Click View to select one file. (보기를 클릭하여 파일을 하나 선택하십시오.)

Close transport fail at set configuration. (구성 설정에서 전송 닫기를 수행하지 못했습니다.)

Collect mail canceled by user. (사용자가 메일 모으기를 취소했습니다.)

Communication is reestablished with controller. (통신이 제어기와 함께 다시 설정되었습니다
.)

Configuration information saved successfully! (구성 정보가 저장되었습니다.)

Connect and Login command error (연결 및 로그인 명령 오류입니다.)

Contact Fax number format is wrong. (연락처 팩스 번호 형식이 올바르지 않습니다.)

Contact Name is empty (연락처 이름이 비어 있습니다.)

Contact Phone number format is wrong. (연락처 전화 번호 형식이 올바르지 않습니다.)

Continue add drv on logical drive LogicalDrive. (논리 드라이브 LogicalDrive에 드라이브를 계
속 추가하십시오.)

Continue Media Check on Physical Drive %d:%d. (물리 드라이브 %d:%d에서 매체 검색을 
계속하십시오.)

Controller Event, Battery %s %s. Informational message. (제어기 이벤트, 배터리 %s %s. 정보 
메시지입니다.)

Controller Event, Battery %s %s. Likely battery module error or power cycle of array. If 
error persists, replace defective battery module. (제어기 이벤트, 배터리 %s %s. 배터리 모듈 
오류이거나 어레이가 전원 주기에 있는 것 같습니다. 오류가 계속되면 결함 있는 배터리를 교
체하십시오.)

Controller has been reset. (제어기가 재설정되었습니다.)

Controller has been shut down. (제어기가 종료되었습니다.)

Controllers back in redundancy mode! (제어기가 중복 모드로 돌아갔습니다.)

Controllers back in redundancy mode! (제어기가 중복 모드로 돌아갔습니다.)

Copy & Replace has completed on Physical drive %d:%d. (물리 드라이브 %d:%d에서 복사 
및 교체가 완료되었습니다.)

표 G-33 오류/상태 메시지 (계속)

오류 및 상태 메시지
부록 G 오류 코드 및 메시지 281



Copy & Replace has started from Physical drive %d:%d to %d:%d. (물리 드라이브 %d:%d에
서 %d:%d(으)로 복사 및 교체를 시작했습니다.)

Copy & Replace on Physical drive %d:%d has been aborted. (물리 드라이브 %d:%d에서 복
사 및 교체가 취소되었습니다.)

Create logical drive failure. (논리 드라이브를 만들지 못했습니다.)

Create logical volume failure. (논리 볼륨을 만들지 못했습니다.)

Creating Host LUN filter Entry; please wait... (호스트 LUN 필터 항목을 만드는 중입니다. 잠
시 기다려 주십시오.)

Creating standard Host LUN mapping; please wait... (표준 호스트 LUN 매핑을 만드는 중입
니다. 잠시 기다려 주십시오.)

Customer Fax number format is wrong. (고객 팩스 번호 형식이 올바르지 않습니다.)

Customer Name is empty. (고객 이름이 비어 있습니다.)

Customer Phone number format is wrong. (고객 전화 번호 형식이 올바르지 않습니다.)

Data is at risk. Media performance of this tape is severely degraded. Copy any data you 
require from this tape. Do not use this tape again. Restart the operation with a different 
tape. (드라이브 안의 테이프가 껴서 작업에 실패했습니다. 오래된 테이프는 사용하지 마십시
오. 다른 테이프로 작업을 다시 시작하십시오.)

Decrypt mail canceled by user. (사용자가 메일 암호 해독을 취소했습니다.)

Delete logical drive failure. (논리 드라이브를 삭제하지 못했습니다.)

Delete logical volume failure. (논리 볼륨을 삭제하지 못했습니다.)

Deleted disk successfully! (디스크가 성공적으로 삭제되었습니다.)

Deleting disk; please wait... (디스크를 삭제 중입니다. 잠시 기다려 주십시오.)

Deleting Host LUN filter Entry; please wait... (호스트 LUN 필터 항목을 삭제 중입니다. 잠시 
기다려 주십시오.)

Deleting standard Host LUN mapping; please wait... (표준 호스트 LUN 매핑을 삭제 중입니
다. 잠시 기다려 주십시오.)

Device at [Channel:Target] has failed the self-reliability test. ([채널:대상]의 장치가 자체 안정
성 테스트에 실패했습니다.)

Device information failed. (장치 정보가 실패했습니다.)

Disk is labeled successfully. (디스크의 레이블을 성공적으로 지정했습니다.)

Door lock has an unknown status. (도어 잠금이 알 수 없는 상태입니다.)

Door locked. (도어가 잠겼습니다.)

 Door unlocked. (도어 잠금이 해제되었습니다.)

Download Firmware with Boot Record. (부트 레코드로 펌웨어를 다운로드하십시오.)
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Downloading Firmware to the devices. (펌웨어를 장치에 다운로드 중입니다.)

Downloading Firmware to the RAID Controller. (펌웨어를 RAID 제어기에 다운로드 중입니
다.)

Drive SCSI Ch:%d; Id:%d Likely poorly seated or defective drive. If random drives, possible 
I/O module or cable failure. (시간 초과를 선택하십시오(채널:%d,Id:%d). 제대로 설치되지 않
았거나 결함 있는 드라이브입니다. 임의 드라이브인 경우 I/O 모듈 또는 케이블 오류일 수 있
습니다.)

Email address format is wrong. (전자 메일 주소 형식이 올바르지 않습니다.)

Enclosure #Enclosure state change: Information: [x} 

x is the raw data of SAFTE/SES data in hexadecimal format (엔클로저 #Enclosure 상태 변경
: 정보:  [x} x는 16진수 형식으로 된 SAFTE/SES 데이터의 원시 데이터입니다.)

Enclosure #Enclosure, temperature threshold has changed from a State state to a State state. 
Information: (엔클로저 #Enclosure, 온도 임계치가 State 상태에서 State 상태로 변경되었습니
다. 정보:)

Engaging firmware; a controller reset is not necessary. (펌웨어 사용 중. 제어기를 재설정할 
필요가 없습니다.)

Error in writing file, please try later! (파일을 쓰는 중 오류가 발생했습니다. 나중에 다시 시도
하십시오.)

Error occurred. Reset the config file. (오류가 발생했습니다 구성 파일을 재설정하십시오.)

Expand LD/LV information. (LD/LV 확장 정보)

Expand logical volume successfully. (논리 볼륨을 확장하십시오.)

Expansion has completed on logical drive LogicalDrive. (논리 드라이브 LogicalDrive에서 확장
을 완료했습니다.)

Expansion has started on logical drive LogicalDrive. (논리 드라이브 LogicalDrive에서 확장이 
시작되었습니다.)

Expansion logical drive LogicalDrive has been aborted. (논리 드라이브 LogicalDrive 확장이 취
소되었습니다.)

Fan #Fan has an unknown status. (팬  #Fan 이 알 수 없는 상태입니다.)

Fan #Fan is malfunctioning. (팬 #Fan이 제대로 작동하지 않습니다)

Fan #Fan is not present in the system. (팬 #Fan 이 시스템에 없습니다.)

Fan #Fan is operational. (팬  #Fan 을 작동할 수 있습니다.)

File I/O error. Configuration could not be restored! (파일 I/O 오류입니다. 구성을 복원할 수 
없습니다.)

Firmware downloaded to SAF-TE/SES device (Ch:%d,Id:%d) failed. (펌웨어를 SAF-TE/SES 
장치(채널:%d,Id:%d)에 다운로드하지 못했습니다.)
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Firmware downloaded to SAF-TE/SES device (Ch:%d,Id:%d) successfully. (펌웨어를 SAF-
TE/SES 장치(채널:%d,Id:%d)에 성공적으로 다운로드했습니다.)

Firmware downloaded to SCSI drive (Ch:%d,Id:%d) failed. (펌웨어를 SCSI 드라이브(채널
:%d,Id:%d)에 다운로드하지 못했습니다.)

Firmware downloaded to SCSI drive (Ch:%d,Id:%d) successfully. (펌웨어를 SCSI 드라이브(
채널:%d,Id:%d)에 성공적으로 다운로드했습니다.)

First select one Logical Drive! (먼저 논리 드라이브 하나를 선택하십시오.)

First select one physical device. (먼저 물리 드라이브 하나를 선택하십시오.)

First select one RAID controller. (먼저 RAID 제어기 하나를 선택하십시오.)

For RAID1 Logical Drive 'Add Drive'/'Copy and Replace' function is disabled. (RAID 1 논
리 드라이브 '드라이브 추가'/'복사 및 교체' 기능을 사용할 수 없습니다.)

Forward mail canceled by user. (사용자가 메일 전달을 취소했습니다.)

Generic File Mutex lock is not released. (일반 파일 뮤텍스 잠금이 해제되지 않았습니다.)

Get logical drive list failure. (논리 드라이브 목록을 가져오지 못했습니다.)

Getting Agent Options failed! (에이전트 옵션을 가져오지 못했습니다.)

Getting Controller Parameters failed! (제어기 매개변수를 가져오지 못했습니다.)

Getting Host LUN Assignments failed! Please try again. (호스트 LUN 할당을 가져오지 못했
습니다. 다시 시도하십시오.)

Getting the configuration failed! (구성을 가져오지 못했습니다.)

Group Name can not be empty. (그룹 이름은 반드시 지정해야 합니다.)

Host LUN filter Entry created successfully! (호스트 LUN 필터 항목이 성공적으로 만들어졌
습니다.)

Host LUN filter Entry deleted successfully! (호스트 LUN 필터 항목이 성공적으로 삭제되었
습니다.)

Host LUNs modified successfully. (호스트 LUN이 성공적으로 수정되었습니다.)

If file access is not properly coordinated when assigned to multiple hosts, data corruption 
and access contentions may occur. (여러 호스트에 할당될 때 파일 액세스가 제대로 조정되지 
않으면 데이터 손상과 액세스 경합이 발생할 수 있습니다.)

If Minimum interval is \"0\" or \"*\", then Content must be \"Event\" (최소 시간 간격이 \
"0\" 또는 \"*\"인 경우 내용은 \"이벤트\"여야 합니다.)

If the firmware download progress is interrupted the controllers/devices may become 
unusable. (펌웨어 다운로드가 중단되면 제어기/장치를 사용할 수 없게 될 수도 있습니다.)

Initialization has completed on logical drive LogicalDrive. (논리 드라이브 LogicalDrive에서 초
기화를 완료했습니다.)
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Initialization has started on logical drive LogicalDrive. (논리 드라이브 LogicalDrive에서 초기
화가 시작되었습니다.)

Initialization on logical drive LogicalDrive has been aborted. (논리 드라이브 LogicalDrive에서 
초기화가 취소되었습니다.)

Initialization operations have completed. (초기화 작업이 완료되었습니다.)

Initialization, rebuild, expand, or add SCSI drive activities are in progress. Try again later. (
초기화, 재구성, 확장 또는 SCSI 드라이브 추가 작업이 진행 중입니다. 나중에 다시 시도하십시
오.)

Inserted failed primary controller. (실패한 주 제어기를 삽입했습니다.)

Inserted failed secondary controller. (실패한 보조 제어기를 삽입했습니다.)

Invalid data received. (잘못된 데이터를 받았습니다.)

Invalid server IP address! (유효하지 않은 서버 IP 주소입니다.)

IOM SES Firmware Revision Level Mismatch (LogChl:%d,Id:%d). ses version=%s/%s, pld 
version=%s/%s. [CHASSIS BKPLN SN#%s} (IOM SES 펌웨어 개정 수준 불일치 
(LogChl:%d,Id:%d). ses 버전=%s/%s, pld 버전=%s/%s. [CHASSIS BKPLN SN#%s})

IP Address format error (must be xxx.xxx.xxx.xxx and 0 &amp;lt; xxx &amp;lt;255)! (IP 주소 
형식 오류입니다. xxx.xxx.xxx.xxx 및 0 &amp;lt; xxx &amp;lt;255여야 합니다.)

IP Address is duplicated! (IP 주소가 중복되었습니다.)

IP Address is empty. (IP 주소가 비어 있습니다.)

Location is empty. (위치가 비어 있습니다.)

Log in as \ìssconfigî\ user and try the operation again. ( \"ssconfig"\ 사용자로 로그인한 다
음 작업을 다시 시도하십시오.)

Logical array LogicalArray has changed from a state state to a state state. (논리 어레이  
LogicalArray이(가) state 상태에서 state 상태로 변경되었습니다.)

Logical Drive ID %d exceeds 2 TB size limitation for sequential optimized LD. (논리 드라이
브 ID %d 이(가) 순차 최적화된 LD에 대한 크기 한도인 2TB를 초과했습니다.)

Logical Drive ID %d exceeds 512 GB size limitation for random optimized LD. (논리 드라이
브 ID %d이(가) 임의 최적화된 LD에 대한 크기 한도인 512GB를 초과했습니다.)

Logical Drive ID %d, Rebuild Aborted. Informational message. (눈리 드라이브 ID %d 재구
성을 취소했습니다. 정보용 메시지.)

Logical Drive ID LogicalDrive rebuild has aborted. (논리 드라이브 ID LogicalDrive  재구성을 
취소했습니다.)

Logical Drive ID LogicalDrive rebuild has completed. (논리 드라이브 ID LogicalDrive  재구성
을 완료했습니다.)

Logical Drive ID LogicalDrive rebuild has started. (논리 드라이브 ID LogicalDrive  재구성을 
시작했습니다.)
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Logical Drive LogicalDrive has changed from a State state to a State state. (논리 드라이브 
LogicalDrive이(가) State 상태에서 State 상태로 변경되었습니다.)

Logical Drive LogicalDrive has changed from a State state to a State state. (논리 드라이브 
LogicalDrive이(가) State 상태에서 State 상태로 변경되었습니다.)

Logical Volume Components List. Total disks in this Logical Volume= (논리 볼륨 구성 요소 
목록. 이 논리 볼륨의 총 디스크 수=)

Login successful (로그인했습니다.)

Login unsuccessful (로그인하지 못했습니다.)

Logout command error. (로그아웃 명령 오류입니다.)

Mail information is empty (메일 정보가 비어 있습니다.)

Media Check has completed on Physical drive %d:%d. (물리 드라이브 %d:%d에서 매체 검사
가 완료되었습니다.)

Media Check has started on Physical drive %d:%d. (물리 드라이브 %d:%d에서 매체 검사가 
시작되었습니다.)

Media Check on Physical drive %d:%d has been aborted. (물리 드라이브 %d:%d에서 매체 
검사가 취소되었습니다.)

Memory Allocation Error. Unable to load daemon. (메모리 할당 오류입니다. 데몬을 로드할 
수 없습니다.)

Minimum interval between emails must be one of the following formats: \“*\” \“0\” 
“\nn\” \“nn:mm\” (전자 우편 간의 최소 간격은 \“*\” \“0\” “\nn\” \“nn:mm\” 중 한 가
지 형식이어야 합니다.)

Minimum interval can't meet Content value. (최소 시간 간격이 내용 값을 충족할 수 없습니
다.)

Minimum interval format error. (최소 시간 간격 형식 오류입니다.)

Minimum interval format is HH[:MM]. (최소 시간 간격의 형식은 HH[:MM]입니다.)

Minimum interval is empty. (최소 시간 간격이 비어 있습니다.)

Monitor Stopped. (모니터링이 중지되었습니다.)

Multiple IP assignment mechanisms are not supported. Select only one mechanism. (여러 IP 
할당 메커니즘은 지원되지 않습니다. 하나의 메커니즘만 선택하십시오.)

Mute beeper. (경고음을 음소거하십시오.)

Mute controller beeper failure. (제어기 경고음을 음소거하지 못했습니다.)

Mute controller beeper. (제어기 경고음을 음소거하십시오.)

Mutex Lock is not released. (뮤텍스 잠금이 해제되지 않았습니다.)

Mutex Lock timeouts. (뮤텍스 잠금이 시간 초과되었습니다.)
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Mutex Lock(s) cannot be created! (뮤텍스 잠금을 만들 수 없습니다.)

Mutex Lock(s) change state failed! (뮤텍스 잠금의 상태를 변경하지 못했습니다.)

New parity check schedule has been created. (새 패리티 검사 일정이 설정되었습니다.)

No admin progress exists. (관리 작업이 없습니다.)

No Admin progress was found. All activity should be complete! (관리 작업을 찾을 수 없습
니다. 모든 작업을 완료해야 합니다.)

No array administration activity in progress! (처리 중인 어레이 관리 작업이 없습니다.)

No more events to report. (보고할 이벤트가 더 이상 없습니다.)

No new controller was found; you do not need to reboot the system. (새 제어기가 없습니다
. 시스템을 다시 부팅할 필요가 없습니다.)

No online server, cannot delete event log. (온라인 서버가 없습니다. 이벤트 로그를 삭제할 수 
없습니다.)

No rebuildable drive available. (재구성 가능한 드라이브가 없습니다.)

Only the last partition of a LD/LV can be deleted. (LD/LV의 마지막 파티션만 삭제할 수 있
습니다.)

Open transport fail at set configuration. (구성 설정에서 전송 열기에 실패했습니다.)

Open transport, Lock fail, the original lock holder's IP address is %s. (전송 열기, 잠금 실패, 
원래 잠금 소유자의 IP 주소는 %s입니다.)

Open transport, LogIn fail. (전송 열기, 로그인 실패)

Operation completed successfully. (작업이 성공적으로 완료되었습니다.)

Operation failed. (작업이 실패했습니다.)

Operation in progress. (작업이 진행 중입니다.)

Operation on one of the servers failed. (한 서버에서 작업이 실패했습니다.)

Out of the scope! (범위를 벗어났습니다.)

Parity Check Aborted. (패리티 검사를 중지했습니다.)

Parity check confirmation. (패리티 검사 확인)

Parity check could not be started on logical drive LogicalDrive. (논리 드라이브  LogicalDrive
에서 패리티 검사를 시작하지 못했습니다.)

Parity check has completed on logical drive LogicalDrive. (논리 드라이브 LogicalDrive에서 패
리티 검사를 완료했습니다.)

Parity check has started on logical drive LogicalDrive. (논리 드라이브 LogicalDrive에서 패리
티 검사를 시작했습니다.)

Parity check on logical drive LogicalDrive has been aborted. (논리 드라이브 LogicalDrive에서 
패리티 검사를 중지했습니다.)
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Parity check schedule has been removed. (패리티 검사 일정이 제거되었습니다.)

Parity check schedule has been updated. (패리티 검사 일정이 업데이트되었습니다.)

Partition 0 cannot be deleted. (파티션 0은 삭제할 수 없습니다.)

Partition table is full. New partitions cannot be added. (파티션 테이블이 꽉 찼습니다. 새 파
티션을 추가할 수 없습니다.)

Password error! (암호 오류입니다.)

Password is empty. (암호가 비어 있습니다.)

Port is invalid (port must be between 1270 and 0). (포트가 유효하지 않습니다. 포트는 65535
과 1273 사이여야 합니다.)

Port is invalid (port must be between 1270 and 1273). (포트가 유효하지 않습니다. 포트는 
1270과 1273 사이여야 합니다.)

Power supply #Power has an unknown status. (전원 공급 장치 #Power가 알 수 없는 상태입니
다.)

Power supply #Power is malfunctioning and has been switched off. (전원 공급 장치 #Power
가 제대로 작동하지 않고 전원이 꺼졌습니다.)

Power supply #Power is malfunctioning or disabled. (전원 공급 장치 #Power가 제대로 작동
하지 않거나 사용할 수 없습니다.)

Power supply #Power is not present in the system. (전원 공급 장치 #Power가 시스템에 없습
니다.)

Power supply #Power is operational but disabled. (전원 공급 장치 #Power를 작동할 수 있지
만 사용할 수 없습니다.)

Power supply #Power is operational. (전원 공급 장치  #Power를 작동할 수 있습니다.)

Power supply #Power is present in the system. (전원 공급 장치 #Power가 시스템에 있습니다.)

Primary controller failed! (주 제어기 실패입니다.)

Probe Agent command error! (에이전트 조사 명령 오류입니다.)

Progress Not Available. (진행을 사용할 수 없습니다.)

RAID Controller firmware checksum failed - corrupt firmware data. (RAID 제어기 펌웨어 
체크섬 오류입니다. 펌웨어 데이터가 손상되었습니다.)

RAID Controller firmware download has failed. (RAID 제어기 펌웨어를 다운로드하지 못했
습니다.)

RAID Controller firmware has been updated. (RAID 제어기 펌웨어를 업데이트했습니다.)

RAID Controller is back online. (RAID 제어기가 다시 온라인 상태입니다.)

Read config file error. (구성 파일 읽기 오류입니다.)
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Rebuild on logical drive LogicalDrive has been aborted. (논리 드라이브 LogicalDrive에서 재구
성이 취소되었습니다.)

Rebuild or check operations have completed. (재구성 또는 확인 작업을 완료했습니다.)

Redundant Array State Change: Controller Failed. (중복 어레이 상태 변경: 제어기 실패입니
다.)

Redundant Array State Change: Controllers Back in Redundancy Mode. (중복 어레이 상태 
변경: 제어기가 다시 중복 모드가 되었습니다.)

Removed a failed primary controller. (실패한 주 제어기를 제거했습니다.)

Removed a failed secondary controller. (실패한 보조 제어기를 제거했습니다.)

Restoring configuration to the controller. (제어기에 대한 구성을 복원 중입니다.)

Retry the configuration operation after the update is complete. (업데이트을 완료한 후 구성 
작업을 다시 시도하십시오.)

SAF-TE/SES card Channel:Target firmware has been updated. (SAF-TE/SES 카드 채널:대상 
펌웨어가 업데이트되었습니다.)

SAF-TE/SES card Channel:Target global status has been updated. (SAF-TE/SES 카드 채널:대
상전역 상태가 업데이트되었습니다.)

SAF-TE/SES card Channel:Target slot perform status has been updated. (SAF-TE/SES 카드 
채널:대상슬롯 실행 상태가 업데이트되었습니다.)

SAF-TE/SES card Channel:Target slot status has been updated. (SAF-TE/SES 카드  채널:대상 
슬롯 상태가 업데이트되었습니다.)

Save a Copy in server. (서버에 복사본을 저장하십시오.)

Saving configuration information; please wait... (구성 정보를 저장 중입니다. 잠시 기다려 주
십시오.)

Scan SCSI drive (%d.%d) has succeeded. (SCSI 드라이브(%d.%d) 검색에 성공했습니다.)

Scan SCSI Drive information. (SCSI 드라이브 정보를 검색하십시오.)

Scheduled parity check could not be started on logical drive LogicalDrive. (예정된 패리티 검
사를 논리 드라이브 LogicalDrive에서 시작하지 못했습니다.)

Scheduled parity check has completed on logical drive LogicalDrive. (예정된 패리티 검사를 
논리 드라이브 LogicalDrive에서 완료했습니다.)

Scheduled parity check has started on logical drive LogicalDrive. (논리 드라이브에서 패리티 
검사를 시작했습니다.)

Scheduled parity check skipped to next schedule due to incompletion of previous check. (이
전 확인이 완료되지 않았기 때문에 예정된 패리티 검사가 다음 일정으로 건너 뛰었습니다.)

Secondary controller failed! (보조 제어기 실패입니다.)

Server Error. (서버 오류입니다.)
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Server failed the operation due to insufficient memory. (메모리 부족으로 인해 서버가 작업에 
실패했습니다.)

Server Name is empty. (서버 이름이 비어 있습니다.)

Server Not managed! (서버가 관리되지 않습니다!)

Set controller parameter(s) successful. (제어기 매개변수를 성공적으로 설정했습니다.)

Set or add configuration failed. (구성을 설정하거나 추가하지 못했습니다.)

Slot #Slot has had a device Name. (슬롯 #Slot에 장치 장치 이름이(가) 있습니다.)

SMTP From address format is wrong or empty. (SMTP 보낸 사람 주소 형식이 올바르지 않거
나 비어 있습니다.)

SMTP From address format is wrong. (SMTP 보낸 사람 주소 형식이 올바르지 않습니다.)

SMTP Server address is empty. (SMTP 서버 주소가 비어 있습니다.)

Specify how often you want the parity checked. (패리티 검사 빈도를 지정하십시오.)

Standard Configuration options provide a group of basic default RAID sets whereby the 
drive size, quantity, and assignments are preconfigured. (표준 구성 옵션은 드라이브 크기, 양
, 할당 등이 미리 구성되어 있는 기본 RAID 세트 그룹을 제공합니다.)

Standard Configuration will replace the existing configuration. (표준 구성이 기존 구성을 대
체합니다.)

Standard Host LUN mapping created successfully! (표준 호스트 LUN 매핑이 성공적으로 만
들어졌습니다.)

Standard Host LUN mapping deleted successfully! (표준 호스트 LUN 매핑이 성공적으로 삭
제되었습니다.)

Standard maps are available to all connected hosts in certain configurations. (표준 매핑을 특
정 구성의 연결된 모든 호스트에 사용할 수 있습니다.)

Standby rebuild operation completed with an unknown error. (알 수 없는 오류와 함께 대기 
재구성 작업이 완료되었습니다.)

Standby rebuild operation in progress. (대기 재구성 작업을 처리 중입니다.)

Startup state of the secondary controller. (보조 제어기의 상태를 시작합니다.)

State Change Mutex lock is not released. (상태 변경 뮤텍스 잠금이 해제되지 않았습니다.)

Sun StorEdge Configuration Service monitor daemon has started. (Sun StorEdge 
Configuration Service 모니터링 데몬이 시작되었습니다.)

Sun StorEdge Configuration Service server daemon has started. (Sun StorEdge 
Configuration Service 서버 데몬이 시작되었습니다.)

Sun StorEdge Configuration Service startup is complete. (Sun StorEdge Configuration 
Service 시동이 완료되었습니다.)
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Sun StorEdge Configuration Service trap daemon has started. (Sun StorEdge Configuration 
Service 트랩 데몬이 시작되었습니다.)

System Administrator (ssconfig) has started irrevocable System Shutdown and Restart. 
SAVE all data and LOG OFF IMMEDIATELY. (시스템 관리자(ssconfig)가 취소할 수 없는 시
스템 종료 및 재시작을 시작했습니다. 모든 데이터를 저장하고 즉시 로그오프하십시오.)

System ID is empty. (시스템 ID가 비어 있습니다.)

Tape operation has stopped because an error occurred while reading or writing data, which 
the drive cannot correct. (데이터 쓰기 또는 읽기 작업 중 드라이브가 고칠 수 없는 오류가 발
생했기 때문에 테이프 작동이 중지되었습니다.) 

TapeAlert notification. Device [Channel:Target]. (TapeAlert 통지. 장치 [채널:대상].) 

Target Media Error Reported (Ch:%d,Id:%d). Likely poorly seated or defective drive. 
Possible defective drive slot. (대상에서 예기치 않게 장치 주의를 받았습니다(채널:%d,Id:%d). 
제대로 설치되지 않았거나 결함 있는 드라이브입니다. 드라이브 슬롯에 결함이 있을 수 있습니
다.)

Temperature change from TemperatureC to TemperatureC. (온도가 온도C에서 온도C로 변경되
었습니다.)

The background command (s) has finished. (백그라운드 명령을 마쳤습니다.)

The background command(s) has been aborted. (백그라운드 명령을 중지했습니다.)

The battery on (Ch:%d,Id:%d) is expired on %s. Please install a new battery. Battery 
Information is (%s). ((Ch:%d,Id:%d)의 배터리가 %s에 만료되었습니다. 새 배터리를 설치하십
시오. 배터리 정보는 (%s)입니다.)

The battery on (Ch:%d,Id:%d) is going to expire on %s (after %d days). Please install a new 
battery before the current battery expires. Battery Information is (%s). ((Ch:%d,Id:%d)의 배
터리가 %s(%일 후)에 만료될 것입니다. 현재 배터리가 만료되기 전에 새 배터리를 설치하십시
오. 배터리 정보는 (%s)입니다.)

The changer mechanism is having difficulty communicating with the tape drive. Turn the 
autoloader off then on and restart the operation.  If the problem persists, call the tape drive 
supplier helpline. (결함 있는 배치의 테이프이거나 테이프 드라이브에 결함이 있습니다. 드라
이브를 테스트하려면 성능이 좋은 테이프를 사용하십시오. 문제가 계속되면 테이프 드라이브 
공급업체에 문의하십시오.)

The configuration has been updated. (구성이 업데이트되었습니다.)

The configuration was successfully updated. If new LDs/LVs were created, the server may 
need to be rebooted. (구성이 성공적으로 업데이트되었습니다. 새 LD/LV가 만들어지면 서버
를 다시 부팅해야 합니다.)

The Controller devices list changed. (제어기 장치 목록이 변경되었습니다.)

The controller parameters have been updated. (제어기 매개변수가 업데이트되었습니다.)

The current user is ssconfig; you cannot log in again. (현재 사용자는 ssconfig입니다. 다시 로
그인할 수 없습니다.)
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The daemons are not responding. (데몬이 응답하지 않습니다.)

The device does not belong to the same HBA card. The operations cannot continue. (장치는 
같은 HBA에 속할 수 없습니다. 작업을 계속할 수 없습니다.)

The drive letter (mounted point) cannot be assigned. (드라이브 문자(마운트 포인트)를 할당
할 수 없습니다.)

The encrypt key is empty. (암호화 키가 비어 있습니다.)

The firmware does not support multiple IP assignment mechanisms. (펌웨어는 여러 IP 할당 
메커니즘을 지원하지 않습니다.)

The firmware download failed because you have tried to use the incorrect firmware for this 
tape drive. Obtain the correct firmware and try again. (올바르지 않은 펌웨어를 이 테이프 드
라이브에 사용하려고 했기 때문에 펌웨어 다운로드에 실패했습니다. 올바른 펌웨어로 다시 시
작하십시오.)

The Host LUN filter map (StorEdge SN#%d LD %d Partition %d WWN:) has been created. 
(호스트 LUN 필터 맵(StorEdge SN#%d LD %d 파티션 %d WWN:)이 만들어졌습니다.)

The Host LUN filter map (StorEdge SN#%d LD %d Partition %d WWN:) has been deleted. 
(호스트 LUN 필터 맵(StorEdge SN#%d LD %d 파티션 %d WWN:)이 삭제되었습니다.)

The in-service date(%s) of new battery on (Ch:%d,Id:%d) is set. ((Ch:%d,Id:%d)에 있는 새 배
터리의 사용 날짜(%s)가 설정됩니다.)

The IP Address cannot be empty. (IP 주소는 반드시 지정해야 합니다.)

The last cleaning cartridge used in the tape drive has worn out. Discard the worn out 
cleaning cartridge, wait for the current operation to finish, and then use a new cleaning 
cartridge. (테이프 드라이브에 마지막으로 사용된 지우기 카트리지가 낡았습니다. 낡은 것을 
버리고 현재 작업이 끝날 때까지 기다렸다가 새 지우기 카트리지를 사용하십시오.)

The LD# is moved up after you delete the LD, so it may not be consistent with the LD# 
shown in the RS-232 terminal window. (LD를 삭제한 후 LD#가 위로 이동되어 RS-232 터미널 
창에 표시된 LD#와 맞지 않을 수 있습니다.)

The length of the Encrypt Key must be greater than 8 characters. (암호화 키의 길이는 8자보
다 길어야 합니다.)

The Mail Server field cannot be empty. (메일 서버 필드는 반드시 지정해야 합니다.)

The media has exceeded its specified life. (지정된 미디어 수명을 초과했습니다.)

The memory allocation Failed.(메모리 할당에 실패했습니다.)

The mount point (drive letter) cannot be written into file (registry). (마운트 포인트(드라이브 
문자)는 파일(레지스트리)에 쓸 수 없습니다.)

The new battery on (Ch:%d,Id:%d) is installed. Battery information is (%s). ((Ch:%d,Id:%d)
에 새 배터리가 설치됩니다. 배터리 정보는 (%s)입니다.) 
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The number of logical drives did not increase after creating a logical drive. (before:%d 
now:%d). (논리 드라이브를 만든 후 논리 드라이브의 수가 증가하지 않았습니다(이전:%d 현
재:%d).)

The operation failed because the autoloader door is open. Clear any obstructions from the 
autoloader door, eject the magazine, and then insert it again. If the fault does not clear, turn 
the autoloader off and then on again. (자동 로더 도어가 열려 있기 때문에 작업이 실패했습니
다. 자동 로더 도어에서 장애물을 지운 다음 매거진을 배출한 다음 다시 삽입하십시오. 결함이 
없어지지 않으면 자동 로더를 껐다가 다시 켜십시오.)

The operation failed because the tape in the drive has snapped. Discard the old tape. 
Restart the operation with a different tape. (드라이브 안의 테이프가 껴서 작업에 실패했습니
다. 오래된 테이프는 사용하지 마십시오. 다른 테이프로 작업을 다시 시작하십시오.)

The Selected Device list is empty! (선택한 장치 목록이 비어 있습니다.)

The server already exists! (서버가 이미 존재합니다.)

The Server Name cannot be empty or only contain any extra spaces. (서버 이름은 반드시 지
정해야 하며 추가 공간이 있으면 안됩니다.)

The server you selected might have already been shut down. (선택한 서버가 이미 종료된 것 
같습니다.)

The set configuration failed because there is another conflicting operation. (다른 충돌 작업
으로 인해 구성 설정이 실패했습니다.)

The set configuration Failed. (구성 설정에 실패했습니다.)

The WWN must be a Hex string that is less than 16 characters. (WWN은 16자 이하의 16진수 
문자열이어야 합니다.(

There are no available disks to configure. (구성할 수 있는 디스크가 없습니다.)

There are no LDs/LVs to manage. (관리할 LD/LV가 없습니다.)

There are not enough available disks to add a new LD/LV or there are no available LDs to 
create a LV. LDs must be unmapped and partitions must be deleted prior to being used in 
LVs. (새 LD/LV를 추가하는 데 사용할 수 있는 디스크가 충분하지 않거나 LV를 만드는 데 사
용할 수 있는 LD가 없습니다. LD의 매핑을 해제하고 LV에서 사용되기 전에 파티션을 삭제해
야 합니다.)

There is a map to more than one Host, therefore, the \ìMap to Multiple Hostsî\ property 
cannot be unchecked. Remove the map to multiple hosts before changing this setting. (둘 이
상의 호스트에 매핑되어 있으므로 \"여러 호스트에 매핑"\ 속성을 해제할 수 없습니다. 이 설
정을 변경하기 전에 여러 호스트에 대한 매핑을 제거하십시오.)

There is a problem with the autoloader mechanism. Loader mechanism has detected a 
hardware fault. (자동 로더 메커니즘에 문제가 있습니다. 로더 메커니즘이 하드웨어 결함을 감
지했습니다.)

There is no spare or replacement drive. Rebuild cannot continue. (대체 또는 예비 드라이브
가 없습니다. 재구성을 계속할 수 없습니다.)
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This may cause data loss. (데이터가 손실될 수 있습니다.)

This operation can take up to one minute. (이 작업은 최대 1분까지 걸릴 수 있습니다.)

This operation might take several seconds. Please wait... (이 작업에는 몇 초가 소요됩니다. 
잠시 기다려 주십시오.)

This operation will add to the existing configuration. (이 작업이 기존 구성에 추가됩니다.)

This operation will erase any existing configuration and data. (이 작업은 기존 구성과 데이터
를 모두 지웁니다.)

Unable to allocate memory for array inquiry. Unable to monitor this array. (어레이 조회에 
대해 메모리를 할당할 수 없습니다. 이 어레이를 모니터링할 수 없습니다.)

Unable to determine local host, terminating! (로컬 호스트를 확인할 수 없습니다. 종료 중입니
다.)

Unable to eject cartridge because the tape drive is in use. Wait until the operation is 
complete before ejecting the cartridge. (테이프 드라이브가 사용 중이기 때문에 카트리지를 꺼
낼 수 없습니다. 카트리지를 꺼내지 말고 작업이 완료될 때까지 기다리십시오.)

Unable to inquire RAID controller. (RAID 제어기를 조회할 수 없습니다.)

Unable to inquire SAF-TE device. SAF-TE monitoring for this enclosure disabled. (SAF-TE 
장치를 조회할 수 없습니다. 이 엔클로저의 SAF-TE 모니터링을 사용할 수 없습니다.)

Unable to inquire tape device. This device will be removed. (테이프 장치를 조회할 수 없습
니다. 이 장치는 제거됩니다.)

Unable to issue Self-Reliability Query on device at [Channel:Target]. ([채널:대상]에서 장치의 
자체 안정성 질의를 실행할 수 없습니다.)

Unable to log events. (이벤트를 기록할 수 없습니다.)

Unable to open bindings file -or- no bindings present. Check Bindings file. (바인딩 파일을 
열 수 없거나 현재 바인딩이 없습니다. 바인딩 파일을 확인하십시오.)

Unable to open I/O transport layer. (I/O 전송 계층을 열 수 없습니다.)

Unable to query TapeAlert log data. TapeAlert monitoring disabled for this device. 
(TapeAlert 로그 데이터를 질의할 수 없습니다. 이 장치의 TapeAlert 모니터링을 사용할 수 없
습니다.)

Unable to read license data. (라이센스 데이터를 읽을 수 없습니다.)

Unable to read response from SMTP server. (SMTP 서버의 응답을 읽을 수 없습니다.)

Unable to send e-mail to SMTP server. (SMTP 서버에 전자 메일을 보낼 수 없습니다.)

Unable to toggle the speaker on the SAF-TE/SES managed enclosure. (SAF-TE/SES 관리 대
상 엔클로저에서 스피커를 토글할 수 없습니다.)

Unable to validate recipient at SMTP server. (SMTP 서버에서 수신자를 확인할 수 없습니다.)

Unable to write license data. (라이센스 데이터를 쓸 수 없습니다.)
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설치 및 프로그램 프롬프트
표 G-34에는 설치 및 프로그램 프롬프트 목록이 나와 있습니다. 

UNMAPPED LUN, NOT AVAILABLE TO HOST (매핑되지 않은 LUN. 호스트에 사용할 수 
없습니다.)

Username is empty. (사용자 이름이 비어 있습니다.)

Wait for mutex failed. (뮤텍스를 기다리지 못했습니다.)

Write config file error. (구성 파일 쓰기 오류입니다.)

Wrong Fax number format. (팩스 번호 형식이 올바르지 않습니다.)

Wrong Phone number format. (전화 번호 형식이 올바르지 않습니다.)

You must first delete the host mapping for the partitions whose index number is greater 
before you can change this partition. (이 파티션을 변경하기 전에 인덱스 번호가 더 큰 파티션
의 호스트 매핑을 먼저 삭제해야 합니다.)

You must first delete the host mapping for this LD/LV before you can delete it. (삭제하기 전
에 이 LD/LV의 호스트 매핑을 먼저 삭제해야 합니다.)

You must first delete the host mapping of the last partition before you can add a new 
partition. (새 파티션을 추가하기 전에 마지막 파티션의 호스트 매핑을 먼저 삭제해야 합니다.)

You must have superuser/administrator privileges to run this program. exiting... (이 프로그
램을 실행하려면 수퍼유저/관리자 권한이 있어야 합니다. 종료합니다.)

표 G-34 설치 및 프로그램 프롬프트

설치 및 프로그램 프롬프트

An existing configuration for this package is found. Do you want to 
restore it? (이 패키지의 기존 구성을 찾았습니다. 복원하시겠습니까?)

Are you sure you want to continue? (계속하시겠습니까?)

Are you sure you want to delete the log file? (로그 파일을 삭제하시
겠습니까?)

Are you sure you want to delete the trap? (트랩을 삭제하시겠습니
까?)

Are you sure you want to overwrite the file? (파일을 덮어쓰시겠습
니까?)
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Are you sure you want to rebuild the drive? (드라이브를 재구성하
시겠습니까?)

Before starting to use SUNWsscsConsole, run 
/opt/SUNWsscs/sscsconsole/config_sscon to input the 
pathname of the default Web browser to access HTML help files. 
(SUNWsscsConsole을 사용하기 전에 
/opt/SUNWsscs/sscsconsole/config_sscon을 실행하여 
HTML 도움말 파일에 액세스할 기본 웹 브라우저의 경로 이름을 입력
하십시오.)

Begin downloading firmware to devices. Do you want to continue? 
(이 작업으로 인해 수정된 모든 파티션의 데이터가 손실됩니다. 계속
하시겠습니까?)

Cannot find the Java Runtime Environment 
$JRE_MAJOR.$JRE_MINOR or above! SUNWsscs Console needs 
JRE 1.2 or above to run. The Console will try to find it in 
/usr/java, /usr/jre, /usr/local/java, or /usr/local/jre. 
If you installed the JRE in a directory other than one mentioned 
above, make a link. (Java 런타임 환경 $JRE_MAJOR.$JRE_MINOR 
이상을 찾을 수 없습니다! SUNWsscs 콘솔을 사용하려면 JRE 1.2 이
상이 실행되어야 합니다. 콘솔이 /usr/java, /usr/jre, 
/usr/local/java 또는 /usr/local/jre에서 찾으려고 합니다. 
위에서 언급한 것 이외의 디렉토리에 JRE를 설치한 경우에는 링크를 
만드십시오.)

Changes made to this setting will NOT take effect until the 
controller is RESET. Prior to resetting the controller, the operation 
may not proceed normally. Do you want to RESET controller? (이 
설정의 변경 사항은 제어기가 재설정될 때까지 적용되지 않습니다. 제
어기를 재설정하기 전에 작업이 정상적으로 진행되지 않을 수 있습니
다. 제어기를 재설정하시겠습니까?)

Click View to select one file. (보기를 클릭하여 파일을 하나 선택하십
시오.)

Do you want to download firmware to the controller? (펌웨어를 제
어기에 다운로드하시겠습니까?)

Do you want to download firmware with boot record to the 
controller? (부트 레코드가 포함된 펌웨어를 제어기에 다운로드하시
겠습니까?)

Do you want to save the current event log file? (현재의 이벤트 로그 
파일을 저장하시겠습니까?)

Do you want to set up the mail server? (메일 서버를 설치하시겠습
니까?)

Enter a Contact Name. (연락처 이름을 입력하십시오.)
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Enter a Customer Name. (고객 이름을 입력하십시오.)

Enter a Location. (위치를 입력하십시오.)

Enter a mail address. (메일 주소를 입력하십시오.)

Enter a System ID. (시스템 ID를 입력하십시오.)

Enter a valid gateway address. (유효한 게이트웨이 주소를 입력하십
시오.)

Enter a valid IP address. (유효한 IP 주소를 입력하십시오.)

Enter a valid network mask. (유효한 네트워크 마스크를 입력하십시
오.)

Enter SMTP server information. (SMTP 서버 정보를 입력하십시오.)

Enter SMTP Server information. (SMTP 서버 정보를 입력하십시오.)

Enter the login password. (로그인 암호를 입력하십시오.)

Enter the ssconfig user password to login. (로그인할 때 ssconfig 사
용자 암호를 입력하십시오.)

Install JRE 1.2.2, 1.3, or 1.4 before installing the console. (콘솔을 설
치하기 전에 JRE 1.2.2, 1.3 또는 1.4를 설치하십시오.)

Issue Reset to the controller? (제어기를 재설정하시겠습니까?)

Mapped LUNs exist! These must be deleted before creating new 
LDs/LVs. If you proceed, this operation overwrites the present 
configuration. Any existing LDs/LVs are deleted and all data is 
lost!. If you want to keep your present configuration, use the \"Add 
LDs/LVs to the Current Configuration\" option. Do you want to 
continue? (매핑된 LUN이 존재합니다! 새 LD/LV를 만들기 전에 매
핑된 LUN을 삭제해야 합니다. 작업을 계속 진행하면 이 작업이 현재 
구성을 덮어씁니다. 기존의 LD/LV가 모두 삭제되고 모든 데이터가 
손실됩니다! 현재 구성을 유지하려면 \"Add LDs/LVs to the Current 
Configuration\" 옵션을 사용하십시오. 계속하시겠습니까?)

Please select a LD/LV! (LD/LV를 선택하십시오.)

Please select CH/ID. (채널/ID를 선택하십시오.)

Please select the Channel/ID of which you want to scan. (검색할 채
널/ID를 선택하십시오.)

Please specify at least one SSCS agent in command line or in 
ssdgrcli.cfg. (명령줄 또는 ssdgrcli.cfg에서 SSCS 에이전트를 하나 이
상 지정하십시오.)

Remove the package @PKG_NAME@ and then try to install this 
package. (패키지 @PKG_NAME@을 제거하고 이 패키지를 설치하십
시오.)
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Select a LD/LV. (LD/LV를 선택하십시오.)

Select a Product ID before downloading firmware. (펌웨어를 다운로
드하기 전에 제품 ID를 선택하십시오.)

Select Boot Record File. (부트 레코드 파일을 선택하십시오.)

Select Configuration File. (구성 파일을 선택하십시오.)

Select either AM or PM. (AM 또는 PM을 선택하십시오.)

Select Firmware File. (펌웨어 파일을 선택하십시오.)

Select only ONE LD/LV! (LD/LV를 하나만 선택하십시오.)

Select only one row to edit it. (편집할 행을 하나만 선택하십시오.)

Select only one row to remove it. (제거할 행을 하나만 선택하십시오
.)

Select Server for Managing Controller. (제어기를 관리할 서버를 선
택하십시오.)

Select the agent before clicking Remove. (제거를 클릭하기 전에 에이
전트를 선택하십시오.)

Select the agent item before clicking Edit. (편집을 클릭하기 전에 에
이전트 항목을 선택하십시오.)

Select the Channel/ID of the drive you want to scan. (검색할 드라이
브의 채널/ID를 선택하십시오.)

Select the firmware file before downloading it. (펌웨어 파일을 다운
로드하기 전에 선택하십시오.)

Select the Logical Drive(s). (논리 드라이브를 선택하십시오.)

Select the server item before clicking Edit. (편집을 클릭하기 전에 서
버 항목을 선택하십시오.)

Select the server item before clicking Remove. (제거를 클릭하기 전
에 서버 항목을 선택하십시오.)

Select the Starting Day. (시작 요일을 선택하십시오.)

Specify Map Information. (맵 정보를 지정하십시오.)

SUNWsscsConsole needs JRE 1.2.2, 1.3, or 1.4 to run. The Console 
will try to find it in /usr/java, /usr/jre,/usr/local/java, or 
/usr/local/jre. If you installed the JRE in a directory other than 
one mentioned above, make a link. (SUNWsscs 콘솔을 사용하려면 
JRE 1.2 이상이 실행되어야 합니다. 콘솔이 /usr/java, /usr/jre, 
/usr/local/java 또는 /usr/local/jre에서 찾으려고 합니다. 
위에서 언급한 것 이외의 디렉토리에 JRE를 설치한 경우에는 링크를 
만드십시오.)
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The client receives events only when it is running. Are you sure 
you want to exit? (클라이언트는 실행 중일 때만 이벤트를 받습니다. 
종료하시겠습니까?)

The Content of Periodic Trap cannot be \ìEvent\î. Please select 
another one. (주기적 트랩의 내용은 \"이벤트\"일 수 없습니다. 다른 
항목을 선택하십시오.)

The controller needs to be reset for the new firmware to take effect. 
Do you want to reset the controller? (새 펌웨어를 적용하려면 제어기
를 재설정해야 합니다. 제어기를 재설정하시겠습니까?)

The encrypt key you entered includes extra space in the beginning 
or at the end, which can cause encryption errors. Do you want to 
continue? (입력한 암호화 키에서 맨 앞 부분과 끝 부분에 추가 공백이 
있어 이로 인해 암호화 오류가 발생할 수 있습니다. 계속하시겠습니까
?)

This may cause data loss. Are you sure you want to move? (데이터
가 손실될 수 있습니다. 계속하시겠습니까?)

This operation overwrites the present configuration. Any existing 
LDs/LVs are deleted and all data is lost!. If you want to keep your 
present configuration, use the \"Add LDs/LVs to the Current 
Configuration\" option. Do you want to continue? (이 작업은 현재 
구성을 덮어씁니다. 기존 LD/LV가 모두 삭제되고 모든 데이터가 손
실됩니다. 현재 구성을 유지하려면 \"Add LDs/LVs to the Current 
Configuration\" 옵션을 사용하십시오. 계속하시겠습니까?)

This operation overwrites the present configuration. Any existing 
LDs/LVs are deleted and all data is lost!. If you want to keep your 
present configuration, use the \"Add LDs/LVs to the Current 
Configuration"\ option. Do you want to continue? (이 작업은 현재 
구성을 덮어씁니다. 기존 LD/LV가 모두 삭제되고 모든 데이터가 손
실됩니다. 현재 구성을 유지하려면 \"Add LDs/LVs to the Current 
Configuration\" 옵션을 사용하십시오. 계속하시겠습니까?)

This operation will result in the loss of data on ALL of the modified 
partitions. Do you want to continue? (이 작업으로 인해 수정된 모든 
파티션의 데이터가 손실됩니다. 계속하시겠습니까?)

To find out the java version currently installed, type "java-version" (
현재 설치된 Java 버전을 찾으려면 "java-version"을 입력하십시오.)

Trap information has been modified. Do you want to save it? (트랩 
정보가 수정되었습니다. 저장하시겠습니까?)

You selected "Event" as the Trap Type, therefore, you must select at 
lease one Active trap event. (트랩 유형으로 "이벤트"를 선택했으므
로 하나 이상의 활성 트랩 이벤트를 선택해야 합니다.) 

표 G-34 설치 및 프로그램 프롬프트 (계속)

설치 및 프로그램 프롬프트
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You selected "My SMTP server needs authorization," therefore, you 
must enter a Password. ("내 SMTP 서버에 인증이 필요합니다."를 선
택했으므로 암호를 입력해야 합니다.)

You selected "My SMTP server needs authorization," therefore, you 
must enter a Username. ("내 SMTP 서버에 인증이 필요합니다."를 선
택했으므로 사용자 이름을 입력해야 합니다.)

You selected "use encrypt," therefore, you must enter an encrypt 
key. ("암호화 사용"을 선택했으므로 암호화 키를 입력해야 합니다.)

표 G-34 설치 및 프로그램 프롬프트 (계속)

설치 및 프로그램 프롬프트
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용어

이 용어집에는 설명서에 사용된 약어와 RAID 용어가 정의되어 있습니다. 또한 디스크 
드라이브, 논리 드라이브 등의 작동 상태에 대한 정의도 포함되어 있습니다. 

활성-활성
제어기 하나 이상의 작업이 정상적으로 작동할 때 작업을 공유하는 결함 허용 RAID 어레

이의 저장 장치 제어기 같은 한 쌍의 구성 요소입니다. 둘 중 하나의 구성 요소가 
실패하면 다른 하나가 전체 로드를 담당합니다. 이중 활성 제어기는 같은 장치 세
트에 연결되며 단일 제어기보다 더 나은 I/O 성능과 결함 허용을 제공합니다. 

ANSI American National Standards Institute의 약어로, 미국 표준 협회를 의미합니다.

ARP Address Resolution Protocol의 약어입니다.

자동 재구성 드라이브가 실패하고 대기(예비) 드라이브에 쓰여진 후 자동으로 데이터를 재구
성하는 프로세스입니다. 새 드라이브가 실패한 드라이브가 있던 위치에 수동으로 
설치되는 경우에도 자동으로 재구성이 시작됩니다. 재구성 프로세스가 재설정에 
의해 중단되면 펌웨어 응용프로그램에서 Manual Rebuild 명령을 사용하여 재구
성 프로세스를 다시 시작합니다.

블록 스트라이핑 스트라이핑을 참조하십시오.

전용 패리티가 있는 블록
스트라이핑 (RAID 3) 이 기술은 데이터를 디스크 블록의 크기인 여러 논리 블록으로 나눈 다

음 몇 개의 드라이브에 이들 블록을 스트라이핑합니다. 하나의 드라이브가 패리
티 전용입니다.  디스크가 실패하는 경우 패리티 정보 및 나머지 드라이브의 정보
를 사용하여 원본 데이터를 재구성할 수 있습니다.

캐싱 데이터가 디스크의 미리 지정된 영역 또는 RAM(Random Access Memory)에 저
장되도록 합니다. 캐싱은 RAID 어레이, 디스크 드라이브, 컴퓨터와 서버 또는 다
른 주변 장치의 작업 속도를 높이는 데 사용됩니다. 

용량 RAID 어레이(논리 드라이브)에서 데이터 저장 장치로 사용할 수 있는 전체 물리 
드라이브 수. 예를 들어, 용량이 N-1이고 논리 드라이브에 있는 전체 디스크 드라
이브의 수가 36MB 드라이브 6개이면 저장 장치에 사용할 수 있는 디스크 공간은 
디스크 드라이브 5개(5 x 36MB = 180MB)입니다.

CH 채널
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채널 저장 장치와 저장 장치 제어기 또는 I/O 어댑터 간의 데이터 전송과 정보 관리에 
사용되는 모든 경로입니다. 또한 디스크 어레이 제어기의 SCSI 버스를 가리킵니
다. 각 디스크 어레이 제어기는 하나 이상의 채널을 제공합니다. 

CISPR International Special Committee on Radio Interference의 약어로, 국제 전파 장
애 특별 위원회를 의미합니다. 

DHCP Dynamic Host Configuration Protocol의 약어입니다.

디스크 이중화 이중화(RAID1)를 참조하십시오.

EMC Electromagnetic compatibility의 약어로, 전자기 적합성을 의미합니다.

EMU Event Monitoring Unit의 약어로, 이벤트 모니터링 장치를 의미합니다.

패브릭 하나 이상의 스위치 주변에 만들어진 FC 네트워크입니다. 

패브릭 스위치 패브릭 스위치는 데이터 전송을 원본에서 대상으로 지정하고 모든 연결을 중재하
는 라우팅 엔진의 역할을 합니다. 패브릭 스위치를 통한 노드당 대역폭은 노드가 
더 추가될 때 일관되게 유지되며, 스위치 포트의 노드는 최대 100Mbps 데이터 경
로를 사용하여 데이터를 주고 받습니다. 

장애 조치 구성 요소가 실패하면 그 기능을 중복 구성 요소가 맡는 결함 허용 어레이의 작동 
모드입니다. 

결함 허용 실패가 감지되었을 때 온라인 상태가 되는 백업 시스템을 사용하여 어레이의 데
이터 가용성을 방해하지 않고 하드웨어의 내부 문제를 해결하는 기능입니다. 어
레이는 단일 디스크 드라이브가 실패했을 때 데이터 손실을 방지하기 위해 RAID 
구조를 사용하여 결함 허용을 제공합니다. RAID 1(이중화), RAID 3 또는 5(패리
티로 스트라이핑), RAID 1+0(이중화 및 스트라이핑) 등의 기술을 통해 어레이 제
어기는 실패한 드라이브의 데이터를 재구성하여 이 데이터를 대기 또는 대체 드
라이브에 쓸 수 있습니다.

결함 허용 논리
드라이브 단일 드라이브가 실패하는 경우 RAID 1, 1+0, 3 또는 5를 통해 데이터 보호 기능

을 제공하는 논리 드라이브입니다.

FC-AL Fibre Channel-Arbitrated Loop의 약어로, FC-AL은 루프 또는 패브릭으로 구현
됩니다. 하나의 루프에는 최대 126개의 노드가 있으며 하나 또는 두 개의 서버에
서만 액세스할 수 있습니다. 

FC (Fibre Channel) 광범위한 하드웨어에 배포된 비용 효율이 높은 기가비트 통신 연결입니다.

Fibre Channel HBA 호스트 컴퓨터, 서버 또는 워크스테이션의 FC 어댑터입니다. 

광 섬유 허브 중재 루프 허브는 배선 집선 장치입니다. "중재"는 이 광 섬유 루프를 통해 통신하
는 모든 노드가 100M/초 세그먼트를 공유한다는 것을 의미합니다. 단일 세그먼
트에 장치가 추가될 때마다 각 노드에 사용할 수 있는 대역폭이 더 분할됩니다. 루
프 구성 요소를 사용하면 루프 내의 다른 장치도 토큰 링 스타일로 구성될 수 있습
니다. 광 섬유 허브를 사용할 경우 허브 자체가 내부 루프를 형성하는 포트 통과 
회로를 포함하고 있으므로 광 섬유 루프를 성형 구성으로 재배열할 수 있습니다. 
통과 회로는 장치를 제거하거나 추가할 때 다른 장치에 대한 물리 연결을 두절시
키지 않으면서 루프를 자동으로 재구성할 수 있습니다. 
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FRU Field-Replaceable Unit의 약어로, 현장 대체 가능 장치를 의미합니다.

GB 기가바이트 즉, 1,000,000,000(10억) 바이트입니다. 

GBIC Gigabit Interface Converter의 약어로 기가비트 이더넷 포트 또는 광 섬유 채널에 
꽂는 핫 스왑이 가능한 I/O 장치입니다.

전역 예비 드라이브 한 어레이에 있는 모든 논리 드라이브에 사용 가능한 예비 드라이브입니다. 예비 
드라이브는 자동 논리 드라이브 재구성의 일부가 될 수 있습니다.

그룹 그룹은 복수의 서버가 하나의 범주 아래 포함되도록 하는 데이터 객체입니다. 그
룹은 개념상 도메인과 비슷하며, 이를 사용하여 서버를 구성할 수 있습니다.

HBA Host bus adapter의 약어로, 호스트 버스 어댑터를 의미합니다.

핫 스패어 RAID 1 또는 RAID 5 구성에 있는 드라이브로, 데이터를 포함하고 있지 않으며 다
른 드라이브가 실패하는 경우 대기 드라이브의 역할을 수행합니다. 

핫 스왑 가능 RAID 어레이 전원이 켜져 있고 작동하는 상태에서 FRU(현장 대체 가능 장치)를 
제거하고 교체하는 기능입니다.

ID 식별자 번호

IEC International Electrotechnical Commission의 약어로, 국제 전자 위원회를 의미
합니다.

초기화 한 논리 드라이브 안에 있는 모든 드라이브의 모든 데이터 블록에 특정 패턴을 쓰
는 프로세스입니다. 이 프로세스는 디스크와 논리 드라이브에 있는 기존의 데이
터를 덮어써서 파괴합니다. 전체 논리 드라이브가 처음부터 일관성을 지닐 수 있
으려면 초기화가 필요합니다. 초기화를 수행하면 이후의 모든 패리티 검사가 올
바르게 실행됩니다.

JBOD Just a Bunch of Disks의 약어로, 제어기가 없는 드라이브로 구성된 저장 장치입
니다.

LAN Local Area Network의 약어로, 근거리 통신망을 의미합니다.

LD 논리 드라이브

논리 드라이브 디스크 저장 공간 영역의 한 구역으로, LUN이라고도 하며 호스트 운영 체제에는 
하나의 물리 드라이브와 같습니다. 논리 드라이브는 하나 이상의 물리 드라이브
에 위치할 수 있습니다.

LUN logical unit number의 약어로 논리 장치 번호를 의미합니다. 주 및 부 장치 번호
가 컴퓨터에 연결된 특정 장치의 논리 장치 번호 지정 순서를 구성합니다.

LUN 매핑 저장 장치에서 서버에 제공하는 것처럼 가상 LUN을 변경하는 기능입니다. SAN
에서 로컬 디스크 드라이브 없이 부팅하는 서버의 기능과 같은 이점이 있습니다. 
각 서버는 부팅하는 데 LUN 0이 필요합니다.

LUN 마스킹 관리자가 지정한 LUN에 HBA를 동적으로 매핑할 수 있는 기능입니다. 이 기능을 
통해 개별 서버 또는 여러 서버에서 개별 드라이브 또는 여러 드라이브에 액세스
할 수 있으며 같은 드라이브에 불필요한 서버가 액세스하는 것을 금지할 수 있습
니다.
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LVD 지원된 서버와 저장 장치 간의 데이터 통신을 가능하게 하는 저소음, 절전 및 저진
폭 신호 기술입니다. LVD 신호는 구리 전선을 통해 신호를 보내는 데 두 가닥의 
전선을 사용하며 길이는 25미터(82피트) 이내여야 합니다. 

관리 포트 RAID 어레이를 구성하는 데 사용되는 10/100BASE-T 이더넷 포트입니다.

MB megabyte의 약어로 메가바이트를 의미합니다. 1,000,000바이트 또는 1,000,000자
의 데이터 문자입니다. 

매체 검색 물리 드라이브에서 불량 블록이나 기타 매체 오류가 있는지 계속 검사하는 백그
라운드 프로세스입니다.

이중화(RAID 1) 한 디스크 드라이브에 기록되는 데이터가 다른 디스크 드라이브에도 동시에 기록
됩니다. 한 디스크가 실패하는 경우에도 나머지 디스크를 사용하여 어레이를 실
행하고 실패한 디스크를 재구성할 수 있습니다. 디스크 이중화의 주요 장점은 데
이터가 100% 중복된다는 것입니다. 디스크가 이중화되었기 때문에 디스크 중 하
나가 실패하더라도 별 문제가 없습니다. 양쪽 디스크에는 언제나 같은 데이터가 
있고 양쪽 모두 운영 디스크의 역할을 할 수 있습니다.

디스크 이중화로 100% 중복이 가능하지만 어레이의 각 디스크가 복제되는 것이
므로 가격이 비쌉니다.

전용 패리티가 있는
다중 블록
스트라이핑 어레이의 모든 디스크에 분산된 패리티 정보를 통해 중복성을 제공하는 RAID 기

술(RAID 5)입니다. 데이터와 패리티는 같은 디스크에 저장되지 않습니다. 디스크
가 실패하는 경우 패리티 정보 및 나머지 디스크의 정보를 사용하여 원본 데이터
를 재구성할 수 있습니다.

NDMP Network Data Management Protocol의 약어로 네트워크 데이터 관리 프로토콜
을 의미합니다.

NVRAM non-volatile random access memory의 약어로, 비휘발성 RAM을 의미합니다. 배
터리가 장착되어 주 전원이 꺼진 후에도 데이터가 그대로 유지되는 메모리 장치
입니다.

N 포트 지점간 또는 패브릭 연결 내의 FC 포트입니다.

OBP OpenBootô PROM(OBP)의 약어입니다. Solaris를 처음 시작하면 OK 프롬프트가 
나타나는데, 이것이 OBP입니다. 즉, 명령줄 인터페이스입니다.

대역 외 데이터 경로에 없는 연결과 장치를 말합니다. 

패리티 검사 결함 허용 어레이(RAID 3, 및 5)에 있는 중복 데이터의 무결성을 확인하는 프로세
스입니다. 논리 드라이브의 패리티 검사 절차는 각 논리 드라이브의 RAID 스트라
이프 세트에 있는 데이터 스트라이프의 패리티를 다시 계산하여 이를 저장된 패
리티와 비교합니다. 불일치가 발견되면 오류를 보고하고 저장된 패리티를 올바른 
패리티로 대체합니다. RAID 1 구성에서는 데이터가 이중화된 데이터와 비교되지
만 RAID 1이 패리티를 저장하지 않기 때문에 자동 수정이 불가능합니다.

파트너 그룹 상호 연결된 한 쌍의 제어기 장치입니다. 한 쌍의 제어기에 연결된 확장 장치도 파
트너 그룹의 일부가 될 수 있습니다.
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PID Primary controller identifier number의 약어로 주 제어기 식별자 번호를 의미합
니다.

PLA Programmable Logic Array의 약어로, 프로그램 가능 논리 어레이를 의미합니다. 
복잡한 설계에 대해서도 유연성 있는 기능을 제공합니다.

PLD Programmable logic device의 약어로 프로그램 가능 논리 장치를 의미합니다. 연
구소 등에서 복잡한 기능을 수행하기 위해 프로그래밍할 수 있는 통합 회로에 적
용되는 총칭입니다. 

RAID redundant array of independent disks의 약어로, 독립 디스크의 중복 어레이를 
의미합니다. 디스크 저장 공간의 추가 제공, 성능 향상, 데이터의 중복 백업 등을 
위해 둘 이상의 디스크 드라이브를 조합하여 하나의 가상 드라이브로 배열하는 
것을 말합니다. 이러한 기능의 여러 조합은 정의된 RAID 수준에 의해 설명됩니다
. 어레이는 RAID 0, 1, 1+0, 3 및 5를 지원할 수 있습니다.

RAID 수준 이중화(mirroring), 스트라이핑, 이중화(duplexing) 및 패리티 등을 조합하여 
RAID 어레이를 다양한 방법으로 구현하는 기술을 RAID 수준이라고 합니다. 각 
기술마다 별도의 알고리즘을 사용하므로 성능, 안정성 및 비용이 조금씩 다릅니
다.

RARP Reverse Address Resolution Protocol의 약어로, 역방향 주소 확인 프로토콜을 의
미합니다.

RAS Reliability, Availability 및 Serviceability의 머리 글자입니다. 이들 머리 글자는 
각각 장비 가동 시간과 평균 실패 간격 시간을 최대화하고, 가동 중단 시간과 실패
를 수리하는 데 필요한 시간을 최소화하며, 중복성을 통해 단일 실패 지점을 제거
하거나 줄이기 위한 다양한 기능과 독창성을 의미합니다.

읽기 정책 저장 장치가 데이터를 디스크에 저장하기 전에 캐시에 보관하는지 여부를 결정하
는 저장 장치 매개 변수입니다. 디스크에 데이터를 기록하는 동안 데이터를 캐시
에 보관할 수 있으면 순차적으로 읽을 때 저장 장치의 속도가 향상될 수 있습니다.

재구성 디스크가 실패하기 전에 디스크에 있던 데이터를 재구성하는 프로세스입니다. 데
이터 중복성이 있는 어레이(예: RAID 수준 1, 1+0, 3 및 5)에서만 재구성을 수행할 
수 있습니다.

재구성 우선 순위 RAID 제어기는 재구성 우선 순위를 통해 논리 드라이브를 재구성하는 동안 다른 
I/O 요청을 처리할 수 있습니다. 우선 순위 범위는 제어기의 최소 자원만을 사용
하여 재구성하는 low에서, 제어기의 최대 자원을 사용하여 재구성 프로세스를 완
료하는 high까지 입니다.

SAN storage area network의 약어로 저장 영역 네트워크를 의미합니다. 저장 장치와 
서버의 확장 가능한 개방형 네트워크로 속도가 빨라 신속하게 데이터에 액세스할 
수 있습니다.

SCSI Small Computer Systems Interface의 약어로, 디스크와 테이프 장치를 워크스테
이션에 연결하는 산업 표준입니다.

SES SCSI Enclosure Service 장치의 인터페이스입니다. 이 장치는 엔클로저 안의 실제 
상태를 감지하고 모니터링하며 엔클로저의 상태 보고 및 구성 기능(예: 엔클로저
의 표시기 LED)에 액세스할 수 있도록 합니다.
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SID 보조 제어기 식별자 번호

SMART Self-Monitoring Analysis and Reporting Technology의 약어로, IDE/ATA 및 
SCSI 하드 디스크 드라이브의 산업 표준 안정성 예측 표시기입니다. SMART가 있
는 하드 디스크 드라이브는 중요 데이터가 보호되도록 일부 하드 디스크의 실패
를 사전에 알려줍니다.

SMTP Simple Mail Transfer Protocol의 약어로, 서버 간에 전자 메일 메시지를 전송하고 
메일 클라이언트에서 메일 서버로 전자 메일 메시지를 전송하는 프로토콜입니다. 
POP 또는 IMAP를 사용하여 전자 메일 클라이언트에서 메시지를 가져올 수 있습
니다. 

SNMP Simple Network Management Protocol의 약어로 복잡한 네트워크를 관리하는 
일련의 프로토콜입니다. SNMP는 PDU(Protocol Data Units)라는 메시지를 네트
워크의 다른 부분에 보냅니다. 에이전트라는 SNMP 호환 장치는 자신에 대한 데
이터를 MIB(Management Information Bases)에 저장하며 이 데이터를 SNMP 요
청자에 반환합니다. 

확장 펌웨어의 스트라이핑 기능을 사용하여 두 개의 독립 RAID 논리 드라이브에서 데
이터를 스트라이프하는 것을 말합니다. 두 개의 확장된 논리 드라이브는 운영 체
제에 하나의 논리 드라이브로 인식됩니다.

대기 드라이브 논리 드라이브에 연결된 물리 드라이브가 실패하면 자동으로 데이터를 다시 작성
하는 여분의 드라이브로 표시된 드라이브입니다. 대기 드라이브가 다른 드라이브
를 대체하려면 실패한 드라이브와 크기가 최소한 같아야 하며 실패한 디스크에 
연결된 모든 논리 드라이브가 중복(RAID 1, 1+0, 3 및 5)되어야 합니다.

상태 디스크 드라이브, 논리 드라이브 또는 제어기의 현재 운영 상태입니다. RAID 어
레이는 드라이브, 논리 드라이브, 제어기 등의 상태를 비휘발성 메모리에 저장합
니다. 이 정보는 전원이 중단된 경우에도 유지됩니다.

스트라이프 크기 논리 드라이브의 각 물리 드라이브에서 스트라이프된 데이터의 양을 KB 단위로 
표시한 것입니다. 일반적으로 스트라이프 크기가 크면 어레이의 연속 읽기가 더 
효과적으로 이루어집니다.

스트라이핑 논리 드라이브 안의 서로 다른 모든 물리 드라이브에 들어오는 데이터의 연속 블
록을 저장하는 것입니다.

이런 방식의 데이터 쓰기는 여러 드라이브가 동시에 가져오고 저장하는 작업을 
수행하므로 디스크 어레이 처리량을 증가시킵니다. RAID 0, 1+0, 3 및 5가 모두 
스트라이핑을 사용합니다.

종단기 SCSI 버스를 종결하는 데 사용되는 부품입니다. 종단기는 무선 주파수 신호를 흡
수해 에너지가 전선으로 다시 반사되는 것을 방지합니다. 

UPS Uninterruptible Power Supply의 약어로 무정전 전원 공급 장치를 의미합니다.

볼륨 논리 장치 번호 또는 LUN이라고도 하며, 데이터 저장 장치 단위로 그룹화할 수 
있는 하나 이상의 드라이브입니다.
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후기록(Write-Back)
캐시 어레이 제어기가 디스크에 쓸 데이터를 수신하는 캐시 쓰기 방법으로, 메모리 버

퍼 안에 데이터를 저장하며 데이터가 실제로 디스크 드라이브에 쓰여질 때까지 
기다리지 않고 호스트 운영 체제에 쓰기 작업이 완료되었다는 신호를 즉시 보냅
니다. 제어기를 사용하고 있지 않을 때 짧은 시간 내에 데이터를 디스크 드라이브
에 씁니다.

쓰기 정책 쓰기 작업을 제어하는 데 사용되는 캐시 쓰기 전략으로, 후기록(Write-Back) 및 동
시 기록(Write-Through) 캐시 옵션이 있습니다.

동시 기록(Write-
Through) 캐시 어레이 제어기가 프로세스를 완료했다는 신호를 호스트 운영 체제에 보내기 전에 

데이터를 디스크 드라이브에 쓰는 방법입니다. 동시 기록(Write-Through) 캐시는 
후기록(Write-Back) 캐시보다 쓰기 작업의 성능과 처리량이 낮지만 정전이 발생
할 경우 데이터 손실의 위험이 가장 적으므로 보다 안전합니다.

WWN (worldwide name) 하드웨어를 식별하는 데 사용되는 세계적으로 고유한 하드 코
딩 및 내장 숫자로 제조업체로부터 할당되고 IEEE하에 등록됩니다.
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작동 방법, 236

SNMP 트랩
메시지 설명, 236
설정, 243

Sun StorEdge Configuration Service 사용
, 240

Sun StorEdge Configuration Service를 사용하
지 않고, 249

Solaris OS
LG가 표시되지 않음, 255
rstrapd, 254
SNMP 트랩, 246
이벤트 로그 위치, 106
콘솔 중지, 11

ssmon 암호 생략, 14

sstrapd 데몬, 246, 247, 248

Standard Configuration 아이콘, 9
Sun StorEdge 3120 SCSI Array

SAF-TE 온도 센서 위치, 218
모니터링, 215
전원 공급 장치 위치, 218
지원 기능, 4
팬 위치, 218

Sun StorEdge Configuration Service
개요, 1
기본 창, 73
로그인/로그아웃, 18
모니터링 프로세스, 79
시작, 6
에이전트 작업, 79
콘솔, 73
트리 보기, 77

Sun StorEdge Configuration Service를 설치하기 전
에
절차, 3

SuperFlex 저장 장치 어레이, 225

T
Tag Count Per drive 필드, 183
TCP/IP
연결 설정, 79

U
Use a standby drive 확인란, 40

V
View Controller Configuration, 85

View Enclosure 명령, 93

View Enclosure 창, 93
View FRU, 103

View FRU 창, 103
View HBA Card, 84

View Report 명령, 112

W
Write a new label to the new LD 확인란, 53, 134
WWN

HP-UX OS에서 확인, 230
IBM AIX OS에서 확인, 231
Linux OS에서 확인, 230
Microsoft Windows OS에서 확인, 230
Solaris OS에서 확인, 229

WWNN
확인, 232

WWPN
확인, 233

ㄱ
검사
드라이브, 163

경고
New Configuration, 47

구성
Change Host LUN Assignments, 58
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Clear 버튼, 57
Confirm Configuration Operation 창, 41
Custom Configuration, 42
Custom Configure, 42
Custom Configure 명령, 171, 194
Load Configuration Confirmation 창, 135
Load Configuration 창, 133
New Configuration, 47
New Configuration 경고, 47
New Configuration 옵션, 44
RAID 수준 선택, 45
Saveset Description 탭, 134
Security Configuration 창, 244
Security 탭, 244
Select Configuration File 창, 133
ssconfig에서 로그아웃, 57
Standard Configuration 창, 39
Standard Configure, 38
Use a standby drive 확인란, 40
논리 드라이브
저장, 27

논리 드라이브 구성 저장, 60
논리 드라이브 파티션 상자, 59
로딩, 133
복원, 132
새
사용하기 전에, 44

저장, 27, 60
주의, 35
지우기, 57
트랩 설정, 244
표준 구성, 37
확인, 25

구성 로드에 대한 자세한 내용은  논리 드라이브 구성 
복원을 참조하십시오.

구성 확인, 25

구성원 드라이브
복사 및 교체, 161

그룹
Group Name, 12
View Group 명령, 81
View Group 창, 82
기호 색상, 78
상태, 78

색상, 79

기본 창, 73

ㄴ
네트워크

DHCP, 193
RARP, 193
정적 IP, 193

노란색 장치 상태 항목, 75

논리 드라이브
RAID 수준의 최대 드라이브 수, 49
SCSI 드라이브 추가, 159
View Logical Drive 명령, 91
구성 복원, 132
구성 저장, 27
드라이브 할당, 203
삭제, 149
용량 확장, 157
정의, 202
추가, 142
파티션 만들기, 152
파티션 삭제, 155
파티션 상자, 59

논리 드라이브 구성 복원, 132

논리 드라이브 구성 저장, 27, 60

논리 드라이브 번호, 151

논리 볼륨
논리 드라이브가 나열되지 않음, 253
사용 않기, 36
생성, 54, 145
정의, 202

ㄷ
대기 드라이브
만들기/변경, 194

대역 외
저장 장치 관리, 112

도구 모음 아이콘, 8

동시 기록(Write-Through) 캐시
설정, 177
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동적 IP 할당 해제, 192

드라이브
Physical Drive Standby State 창, 195
대기 만들기/변경, 194
복사 및 교체, 161
새 하드 드라이브 검사, 163
재구성, 131
전역 예비 드라이브 할당, 184

드라이브 재구성, 128, 129, 130

디스크 용량, 46, 77

ㄹ
레이블
자동으로 쓰기, 53

로그아웃, 18

로그인, 18

로컬 예비 드라이브
전역 예비 드라이브와 비교, 212
정의, 202

ㅁ
매개변수
제어기, 171

매체 검색, 42, 56, 125, 147

매핑 해제
LUN, 59

메뉴 모음
개요, 8

메시지 변수, 278

모니터링 프로세스, 79

문제 해결, 251
물리적 드라이브 식별, 87
오류 메시지 참조
오류 코드 참조

물리 드라이브
기본 창에 표시, 10
불량 블록 검색, 125
식별, 87

물리 장치

Physical Drives 탭, 86
View Physical Device 창, 92
View Physical Drive, 92

ㅂ
배터리
만료 정보, 101
사용 날짜
설정, 102

상태
심각, 101
저하, 101

보고서 옵션, 109, 112

보기 메뉴, 상세 정보, 81

보라색 장치 상태 아이콘
장치 상태 설명, 75

복사
구성원 드라이브, 161

복원
논리 드라이브 구성, 132

부 필드, 261

분할 작업, 59, 155
기존 논리 드라이브, 152
요구 사항, 46

브라우저 요구 사항
웹을 통한 저장 장치 관리, 118

비퍼
음소거, 136, 193

빨간색 장치 상태 항목, 75

ㅅ
삭제, 155
논리 드라이브, 149
파티션, 155

상태
그룹, 78
온도, 94
전원 공급 장치, 94
팬, 94

서버
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Add Server 속성, 13
Add Server 창, 13, 197, 241
Available Servers 목록, 197, 240
Edit Server 창, 197, 241, 253
Managed Servers 목록, 197, 253
Managed Servers 목록에 추가, 12
Server List Setup 기능, 227, 240
Server List Setup 명령, 196
Server List Setup 아이콘, 8
Server List Setup 절차, 12
Server List Setup 창, 253
Server Login 창, 18
Server Setup 창, 196, 240, 253
View Server 명령, 82
View Server 창, 83, 84
관리, 17
그룹으로 구성, 16
삭제, 17
서버 설정, 253
서버의 TCP/IP 주소, 13
자원 목록, 80
콘솔을 통해 제어기에 할당, 19
터미널을 사용하여 관리 서버 수동으로 삭제, 22, 

139
트랩을 보내도록 설정, 243
편집, 196

서버 그룹화, 16

서버가 응답하지 않음, 251

설명서
이 설명서의 구성, xx

설치
Solaris OS에서의 Sun StorEdge Configuration 

Service
절차를 시작하기 전에, 3

성능 통계, 137

스캔
드라이브, 86

스트라이프 크기
순차 최적화, 40, 50, 144, 179
임의 최적화, 40, 50, 144, 179

시스템 사용자 암호 사용, 14

시작
Sun StorEdge Configuration Service

Microsoft Windows OS, 7

Solaris, Linux, HP-UX 및 IBM AIX OS, 6

실패한 드라이브 재구성, 128

심각
장치 상태, 75

심각도 수준(이벤트), 109

심각도 필드, 260

ㅇ
아이콘
기본 창, 26
도구 모음

Custom Configuration, 9
Save Event Log, 8
Save Report, 9
Server List Setup, 8
이벤트 로그, 8
표준 구성, 9

심각, 75
위성 접시 모양이 부착된 서버, 25
장치 상태 확인, 75
저하, 75

알람
음소거, 93, 193

알람 상태
재설정, 93

암호, 18

어레이
지원되는 최대 수, 19, 73, 103

업그레이드
펌웨어

SAF-TE 장치, 169
SES 장치, 169
제어기, 164
하드 드라이브, 168

에이전트
Agent Options Management 창, 22, 24, 215
SNMP 에이전트, 237
구성 가능한 매개변수, 22
옵션 관리, 104
작업, 79

예비 드라이브
전역 할당, 184
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예약
패리티 검사, 123

오류 메시지, 278

오류 코드, 260
SAF-TE 상태 오류, 263
관리 오류, 270
기본 통신 오류, 268
내부 상태 오류, 265
논리 드라이브 이벤트 오류, 274, 275
드라이브측 이벤트 오류, 273
디스크 상태 오류, 262
메모리 할당 오류, 267
서버 관리/모니터링 이벤트 오류, 277
시간 초과 오류, 269
시스템 드라이브 상태, 262
시스템 종료 오류, 271
장치 상태 오류, 266
전송 닫기 오류, 267
전송 열기 오류, 267
전송 필드 오류, 268
제어기 이벤트 오류, 272
중복 상태 오류, 265
초기화 상태 오류, 266
클라이언트 매개변수 오류, 266
테이프 상태 오류, 263
통신 링크 오류, 269
통신 보안 오류, 269
통신 비동기 오류, 269
펌웨어 다운로드 오류, 271
호스트측 이벤트 오류, 274

온도
상태, 94

온라인 도움말, 77

용량
최대 드라이브 확장 용량 계산, 157
확장
논리 드라이브 또는 논리 볼륨의 용량, 157

웹을 통한 저장 장치 관리, 118

음소거
비퍼, 193
알람, 193
환경 알람, 93

이벤트 로그, 105

Event Log 아이콘, 8
Event Log 창, 106
Event Log 파일, 106
eventlog.txt, 105, 106
Save Event Log 아이콘, 8
디렉토리 위치, 106
심각도 수준, 109
오류 코드, 260

이벤트 메시지
심각도 수준, 15
전자 메일 통지, 14

임의 I/O 최적화
스트라이프 크기, 40, 50, 144, 179

ㅈ
자동 검색
옵션, 80
프로세스, 79

자동 재구성, 129

장치
상세 보기 정보, 81
상태 확인, 75
재구성, 130
콘솔에 나타나지 않음, 255

재구성
대기 드라이브 (자동), 129
대기 드라이브가 없는 드라이브, 130
수동으로 드라이브, 131
실패한 드라이브, 128

재설정
제어기, 135

재설정 버튼
View Enclosure 창, 93
고장난 구성 요소 경보음 음소거, 93

저장 장치
웹을 통한 관리, 118
브라우저 요구 사항, 118

저하
장치 상태, 75

전역 예비 드라이브
로컬 예비 드라이브와 비교, 213
정의, 202
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할당, 184

전역 예비 드라이브 자동 할당, 184

전원 공급 장치
상태, 94
실제 위치, 96

전자 메일
Add Server, 242
Mail Address 입력 상자, 241
Mail Server Setup 창, 242
Mailing Lists, 241
Mailing Lists 탭, 14
Mailing Lists가 강조 표시된, 241
Severity 입력 상자, 242
SMTP 전자 메일 메시지, 235
메시지, 240
이벤트 메시지 통지, 14

정적 IP 할당 설정, 192

제어기
관리할 서버 선택, 19
매개변수
변경, 171

음소거, 136
이벤트 오류, 272
이중에서 단일로 변환, 139
재설정, 135, 172
콘솔을 통한 관리 서버 할당, 19

제어기 매개변수
변경 사항 저장, 172

제어기 매개변수의 변경 사항 저장, 172

제어기 할당
콘솔 이용, 19

조사, 83

주 필드, 260

주변 장치
환경 상태 확인
섀시, 93
제어기, 187

ㅊ
최대 드라이브 확장 용량, 157

최적화

논리 드라이브당 최대 용량
순차, 179
임의, 179

임의 I/O
스트라이프 크기, 40, 50, 144, 179

추가
논리 드라이브, 142
논리 드라이브에 SCSI 드라이브, 159
새 장치
조사, 83

서버, 12
호스트 LUN, 58

ㅋ
캐시
동시 기록, 177
후기록, 177

커뮤니티 문자열
확인, 243

콘솔
느리게 작동, 256
장치가 표시되지 않음, 255
전자 메일 설정, 240

클러스터 구성
CLUSTER.TXT, 227
IP 주소, 227
Microsoft Cluster Server 소프트웨어, 224
Sun StorEdge Configuration Service 시작, 224, 

226
계획, 223
설정, 224
요구 사항, 224

ㅌ
탐색, 10

탭
설명, 10

트랩
Card Name, 236
Community Name 상자, 245
Event Date, 236
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Event Severity, 236
Event Time, 236
HP-UX OS에서, 247
IBM AIX OS에서, 248
IBM AIX에서, 248
IP (Internet Protocol), 236
IP 주소 형식, 245
Linux, 246
Microsoft SNMP Properties 창, 245
OID (객체 식별자), 236
Server Address and Name, 236
Service Configuration 창, 245
SNMP 트랩 메시지, 236
Solaris, 246
TCP (Transmission Control Protocol), 236
Trap Destination 목록, 245
Trap 탭, 245
서버로부터 받지 못함, 254
트랩 수신자 설정, 245

트랩 데몬
문제 해결, 254

트랩 메시지, 236

트랩 설정, 243

트리 보기, 77

ㅍ
파티션
삭제, 155
생성, 152

패리티 검사, 122
예약, 123
중지, 123

팬
상태, 94
실제 위치, 96

펌웨어
업그레이드

SAF-TE 장치, 169
SES 장치, 169
제어기, 164
하드 드라이브, 168

편집
사용 가능한 서버, 196

폴링
장치의 상태 변화, 23

표준 구성, 37

프롬프트, 295

ㅎ
하드 드라이브
기본 창에 표시, 10

호스트 ID
광 섬유 구성에서 변경, 175

호스트 LUN
삭제, 59
추가, 58

호스트 LUN 할당 상자, 59

확장
논리 드라이브 또는 논리 볼륨의 용량
최대 드라이브 확장 용량 계산, 157

환경
상태, 93
알람이 보고되지 않음, 255

후기록(Write-Back) 캐시
설정, 177

흰색 장치 상태 항목, 75
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